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Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Use help icons @ to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support

You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 HCM Common Features Overview

Overview of Using HCM Common Features

This guide is for anyone who's using HCM, which means you! Use it to learn how to do general tasks that apply to some
or all product families. If you're looking for product-specific information, see the product-specific guides.

Some setup tasks are common and available within multiple offerings. The Application Extensions and other functional
areas comprise these common setup and implementation tasks.

The following table lists the task lists within Workforce Deployment that are covered in other guides:

Task List Guide

Define Batch Data Loads Oracle Fusion Cloud HCM HCM Data Loading Business Objects

Define Extracts
Note:

This guide also covers Oracle Taleo Recruiting Cloud Service Integration.

Oracle Fusion Cloud HCM HCM Extracts

Define Security for Human Capital Oracle Fusion Cloud HCM Securing HCM
Management
Define Payroll Oracle Fusion Cloud Human Resources Implementing Global Payroll

Define Payroll Legislations

Define Absences Oracle Fusion Cloud Human Resources Implementing Absence Management

Define Transactional Business Intelligence = Oracle Fusion Cloud HCM Administering Analytics and Reports for HCM
Configuration

Introduction
Title Contents
HCM Common Features Overview An introduction to the common features in HCM.
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Date Effectivity

Title

Date Effectivity

Chapter 1
HCM Common Features Overview

Contents

Describes how date-effectivity is used in HCM transactions and you can correct date-effective objects.

Responsive User Experience

Title

Responsive User Experience Setup

Oracle Search Cloud Service Setup

Contents

Using the HCM Design Studio and its components to tailor your user experience with responsive HCM
pages.

Setup Oracle Search Global Search.

Geographies and Currencies

Title

Geographies for HCM

Currencies and Currency Rates

Contents

Managing geography structures, hierarchies, and validation, setting up geocoding, and importing
geographies.

Managing currencies, conversion rate types, and daily rates.

Enterprise and Workforce Structures

Title

Enterprise Structures

Legal Entities, Business Units, and
Reference Data Sets

Enterprise Structures Configurator (ESC)
Divisions, Departments, Worker Unions,
Locations, and Trees

Jobs and Positions

Grades, Grade Rates, and Grade Ladders

ORACLE

Contents

An overview of the enterprise structures, modeling an enterprise structure in Oracle Fusion.

Managing reference data sets, legal jurisdictions and authorities, and legal entities for HCM.

Using the ESC workbench to create and manage an enterprise structure.

Setting up divisions, disability organizations, cost centers, departments, locations, worker unions, and

trees.

Defining jobs, positions, and setting up position synchronization.

Defining grades and grades ladders.
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Title

Workforce Structures - Configuration
Options

Workforce Profiles

Chapter 1
HCM Common Features Overview

Contents

Profile options, flexfields, and lookups related to workforce structures.

Using Profile Management to define rating models, content types and content items, talent profiles,
content sections, and questionnaires.

Common Applications Configuration

Title

Workflow Notifications and Approvals

Application Toolkit Configuration

Help configuration

Common Reference Objects

Enterprise Scheduler Job Definitions and
Job Sets

Audit Policies

Applications Core Configuration

Trees Setup

HCM Flexfields Setup

HCM Flexfields Maintenance

Contents

Defining approvals for HCM, managing approval rules, and understanding approver types and
approval-rule attributes.

Configuring and securing HCM Cloud mobile features.

Understanding help features choices and help options, and creating help security groups.

Defining application taxonomy and reference data sharing. Managing menu configurations, security
and audit policies, Oracle social network objects, and messages.

Managing scheduled processes, job definitions, and job sets

Audit policies for HCM business objects.

Defining lookups, messages, document sequences, profile options, and attachments.

Managing tree structures, tree labels, trees, and tree versions.

Configuring flexfields, managing and deploying flexfields, and managing value sets.

Managing descriptive flexfields, extensible flexfields, and key flexfields.

Common HCM Configuration

Title

HCM Cloud Mobile App

Alerts Composer
HCM Events

HR Help Desk Configuration

ORACLE

Contents
Configure the HCM mobile application.
Setting up alerts and notifications.

Define HCM event conditions.

Describes the tasks to set up and configure the HR Help Desk application.
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Title

Eligibility Profiles

Predictive Models for HCM

Payroll

Title

Process Configuration
Country Extensions and Address Rules

Elements, Balances, and Formulas Task
List

Organization Payment Methods

Payroll Definitions
Payroll Elements
Fast Formulas
Rate Definitions

Values Defined by Criteria

Compensation

Title

Base Pay

Individual Compensation Plans

ORACLE

Chapter 1
HCM Common Features Overview

Contents

Defining derived factors, user-defined criteria, and eligibility profiles.

Running predictive models for HCM, creating and editing predictive attributes, and removing
predictive models.

Contents

Defining sets of processing parameters, primarily related to logging and performance, for flows such as
a new hire flow, termination, or an extract or report.

Defining the country extension, address style, and address validation settings for each country or
territory in the enterprise.

An overview of payroll relationships, the payroll employment model, payroll legislative groups, and
object groups.

Creating accounts, setting up payment methods, and creating third parties and third-party payment
methods.

Creating and managing payroll definitions.

Maintaining elements and element eligibility, using element templates, and calculating gross earnings.

An overview of formulas, formula compilation errors and execution errors.

Creating and managing rate definitions.

Managing and using values defined by criteria.

Contents

Understanding salary basis and how it works with salary information.

Defining individual compensation plans, understanding plan access and actions, and tracking
compensation against a budget.
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Title Contents
Compensation History Understanding compensation history categories, configuring summary table, and managing stock
grants.

Others

Title Contents
Other Setup and Maintenance Task An overview of transactional business intelligence configuration and contextual addresses.
Moving Common Reference Objects Understanding creating configuration packages and moving common reference objects.

Diagnose and Synchronize Application Data

Sometimes, inconsistency errors might occur in the application data. To resolve these errors, you can run the Diagnose
and Synchronize Application Data scheduled process. Oracle Support might request you to run this process, or you can
proactively run the process as needed.

Using this process, you can do these tasks.
- Delete orphan rows in the base and translation tables
- Reconcile GUID and clear the data security cache

- Update the value set of empty flexfield segments

Run the Diagnose and Synchronize Application Data process from the Scheduled Processes work area.
- From the Operation Type list, select the task.

Note: Make sure to select an operation type, because if you leave it blank, the process might run into errors.

- From the Action Type list, select the required option. You can choose to just view any inconsistency errors, or
to view and fix the errors.

After the process is completed, you can check the log file of the process to see the details of any inconsistency errors.

Related Topics
« Submit Scheduled Processes and Process Sets
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2 Date Effectivity

Date Effectivity

Date effectivity preserves a history of changes made to the attributes of some objects. As a Professional user, you can
retrieve and edit past and future versions of an object.

Many Human Capital Management (HCM) objects, including person names, assignments, benefits plans, grades, jobs,
locations, payrolls, and positions are date-effective.

Logical and Physical Records

Date-effective objects include one or more physical records. Each record has effective start and end dates. One record is
current and available to transactions. Others are past or take effect in the future. Together, these records constitute the
logical record or object instance. For a date-effective logical row, which is a collection on contiguous temporal physical
rows, each physical row CreatedBy (CREATED_BY) and CreationDate (CREATION_DATE) are the same.

This table shows changes to the department manager attribute in a department business object. Each row represents a
single physical record.

Physical Record Effective Start Date Effective End Date Department Manager
4 18 January, 2022 C. Woods

3 15 October, 2021 17 January, 2022 A. Chan

2 13 June, 2020 14 October, 2021 T. Romero

1 22 March, 2019 12 June, 2020 G. Martin

I Note: The physical record number doesn't appear in the record.

Effective End Dates in Physical Records

Every physical record except the last has an effective end date. The update process adds this date, which is the day
before the effective start date of the next record, whenever you update the object.

Object End Dates

You can enter a final effective end date for some date-effective objects. For example, terminating an assignment adds
a final effective end date to the assignment. Alternatively, the End Date action may be available. If you end date a date-
effective object, then it isn't available to transactions after that date. But the object's history is retrievable.
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Status Values in Date-Effective Objects

Some date-effective objects, such as grades and jobs, have both effective dates and status values. When the object
status is Inactive, the object isn't available to transactions, regardless of its effective dates. Setting the status to
Inactive makes objects unavailable to transactions. If you can't enter an effective end date for an object, then changing
its status has the same effect.

Future-Dated Changes

For date-effective objects, you can enter future changes. For example, you enter the worker promotion shown in this
table on 25 July, 2022 to take effect on 18 October, 2022.

Physical Record Effective Start Date Effective End Date Grade
2 18 October, 2022 1C2
1 14 December, 2020 17 October, 2022 IC1

Physical record two becomes current on 18 October, 2022. From 14 December, 2020 until 17 October, 2022 physical
record one is current and available to transactions. If you can access the object history, you can see physical record two
before it takes effect.

When future-dated changes exist, other actions may be limited. For example, to end this worker's assignment before
the promotion takes effect, you must first delete the promotion.

Date-Enabled Objects

Some objects, such as work relationships, are date-enabled rather than date-effective. They have start and end dates
that define when they're available, but they have no history of changes. New attribute values overwrite existing attribute
values.

Related Topics
» Examples of Updating Date-Effective Objects

« Examples of Correcting Date-Effective Objects
« How You Make Multiple Updates to Date-Effective Objects in One Day
» How You Delete Physical Records from Date-Effective Objects

Examples of Correcting Date-Effective Objects

You can correct most attributes of date-effective objects, regardless of whether they occur in current, past, or future
physical records.

If you correct the effective start date of an object's first physical record, then the revised date must be before the current
effective start date. For the second and subsequent records, the revised date must be between the record's current
effective start and end dates.
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Correcting a Current Error

On 11 December, 2022 you create a location definition but enter the wrong phone. On 21 December, 2022, you search for
the definition and select the Correct action. Before correction, the object history is as shown in this table.

Physical Record Effective Start Date Effective End Date Location Phone

1 11 December, 2022 650.555.0175

After correction, the object history is as shown in this table.

Physical Record Effective Start Date Effective End Date Location Phone

1 11 December, 2022 650.555.0176

Because you corrected the object, no change history exists.

Correcting a Past Error

A worker's assignment history is as shown in this table.

Physical Record Effective Start Date Effective End Date Job Working at Home
4 20 October, 2022 Line Manager No
3 18 August, 2022 19 October, 2022 Senior Administrator No
2 10 May, 2022 17 August, 2022 Senior Administrator Yes
1 25 July, 2021 9 May, 2022 Administrator Yes

You learn that the worker's job was actually Project Leader from 10 May to 19 October, 2022. As this period spans
physical records 2 and 3, you must correct both.

To retrieve physical record 2, you set the effective as-of date in the person search to any date between 10 May and 17
August, 2022. You select the assignment from the search results and make the correction.

You then retrieve physical record 3 and make the same correction.
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Examples of Updating Date-Effective Objects

When you update a date-effective object, you insert a physical record in the object's history. Typically, the inserted

record follows the current record and the effective start date is today. However, you can also enter future-dated changes

and update past records.

Entering Future-Dated Changes

The grade EC3 exists from 17 June, 2019. Its ceiling step changes from 1 January, 2023. On 30 November, 2022, you
change the grade's ceiling step and enter an effective start date of 1January, 2023. This change creates a physical
record in the grade definition, as shown in this table.

Physical Record Effective Start Date Effective End Date Ceiling Step
2 1January, 2023 4
1 17 June, 2019 31 December, 2022 3

From 1 January, 2023 physical record 2 is in effect. Until then, physical record 1is in effect.

Applying Historical Updates to Later Records

Jennifer Watts has one assignment, as shown in this table.

Physical Record Effective Start Date Effective End Date Grade Location
2 18 September, 2022 Al Area Office
1 10 April, 2022 17 September, 2022 Al HQ

You promote Jennifer to grade A2 from 1 July, 2022. You update her assignment with an effective start date of 1 July,
2022 and enter grade A2. This update:

Inserts a physical record between existing records 1and 2

- Sets the effective end dates of physical record 1to 30 June, 2022 and of the inserted record to 17 September,
2022

You also correct existing physical record 2 to change the grade from A1to A2.

Jennifer's assignment history is now as shown in this table.

ORACLE
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Physical Record Effective Start Date Effective End Date Grade Location
3 18 September, 2022 A2 Area Office
2 1July, 2022 17 September, 2022 A2 HQ
1 10 April, 2022 30 June, 2022 Al HQ

Examples of Effective Sequencing

Some date-effective objects, such as assignments, create a physical record for each update on one day. Physical
records with the same effective start date have effective sequence numbers. This topic provides examples of effective
sequencing in assignment histories.

Changing the Assignment Working Hours

You create an assignment for a worker. Later the same day, you update the assignment working hours. This change isn't
a correction, but an update. The assignment history is as shown in this table.

Physical Record Effective Sequence Effective Start Date Effective End Date Working Hours
Number

2 2 28 Decmber, 2022 42

1 1 28 Decmber, 2022 40

Changing the Assignment Manager
You update a worker's assignment twice on 14 November, 2022. You change the:
1. Assignment manager from S. Taylor to J. Miles.
2. Assignment manager from J. Miles to M. Scott and the grade from C14 to C15.

Effective sequencing doesn't apply to assignment manager and work measures. Because effective sequencing applies
to grades but not assignment managers, the assignment history is as shown in this table after you make both updates.

Physical Record Effective Sequence Effective Start Date  Effective End Date Grade Assignment Manager
Number
3 2 14 November, 2022 Cc15 M. Scott
2 1 14 November, 2022 C14 M. Scott
1 1 30 December, 2021 13 November, 2022 C13 S. Taylor
n
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Physical Record Effective Sequence Effective Start Date = Effective End Date Grade Assignment Manager
Number

Changes to assignment managers and work measures are corrections rather than updates. Only the last change made
on any day remains in the object history. The change of manager to M. Scott overwrites the first change from S. Taylor
to J. Miles.

How You Delete Physical Records from Date-Effective
Objects

The effect of deleting a physical record from a date-effective object depends on the record's position in the object's
history.

Consider the date-effective object, which has three physical records, shown in this table.

Physical Record Effective Start Date Effective End Date Attribute Value
3 15 August, 2022 C
2 30 October, 2021 14 August, 2022 B
1 10 June, 2020 29 October, 2021 A

Intermediate Records

If you delete physical record two, where the attribute value is B, then the object is as shown in this table after the
deletion.

Physical Record Effective Start Date Effective End Date Attribute Value
2 15 August, 2022 C
1 10 June, 2020 14 August, 2022 A

If physical records exist both before and after the deleted record, then the deletion adjusts the dates of the surrounding
records automatically. The effective end date of the previous record is now the day before the effective start date of this
record. This change closes the gap in the object's effective dates.

First or Only Records

In most cases, you can't delete the first or only physical record.

12
ORACLE



Oracle Fusion Cloud HCM Chapter 2
Using Common Features for HCM Date Effectivity

If you can delete the first physical record, then the object exists from the effective start date of the next physical record
(30 October, 2010 in this example). If only one physical record exists, then deleting that record is the same as deleting
the object.

Final Records

If you delete the final physical record, then the deletion removes the effective end date automatically from the previous
physical record (14 August, 2011, in this example).

How You Make Multiple Updates to Date-Effective
Objects in One Day

For most date-effective objects, only one physical record exists per day. Therefore, the object history shows only the
latest update to each attribute in any one day. For example, if you update a location phone three times in one day, then
only

For some objects, such as assignments, the update process creates a physical record for each update in a day.
Such objects include an effective sequence number in each physical record to show the update order. Changes are
cumulative, and the physical record with the highest effective sequence number is available to transactions for that
date.

For example, this table shows multiple updates to a person's assignment working hours and job on 14 October, 2020
and 30 April, 2022.

Physical Record Effective Sequence Effective Start Date Working Hours Job

Number
6 2 30 April, 2022 40 Lead Technician
5 1 30 April, 2022 425 Lead Technician
4 3 14 October, 2020 425 Senior Technician
3 2 14 October, 2020 425 Technician
2 1 14 October, 2020 40 Technician
1 1 17 June, 2020 40 Junior Technician

Object Correction

Effective sequence numbers apply only when you update an object. If you correct an object, then the new value
overwrites the previous value. The correction process doesn't create a separate physical record for each change.

13
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This table shows the person's assignment record when you correct rather than update the working hours and job
attributes multiple time in one day.

Physical Record Effective Start Date Working Hours Job

3 30 November, 2022 40 Lead Technician
2 14 October, 2020 425 Senior Technician
1 17 June, 2020 40 Junior Technician

FAQs for Date Effectivity

What's the difference between updating and correcting a date-
effective object?

When you update an object, you insert a physical record in the object's history. Typically, the inserted record follows the
current physical record, and the effective start date is today's date. However, you can edit the object history or create a
future-dated change by

When you correct a date-effective object, you edit the information in an existing physical record. You don't create a
physical record.

What's the effective as-of date?

A date value that filters search results. For any date-effective object that matches the other search criteria, the search
results include the physical record for the specified effective as-of date. The effective as-of date is one of the search
criteria.

How can | see future-dated or past records for a date-effective
object?

When searching for a date-effective object, you can enter an effective as-of date. The search returns the physical record
from the object with an effective date range that includes the specified effective as-of date.

While viewing or editing an object, you can see its history, which includes all current, past, and future physical records.
You can select any of these records from the object history.
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Can | delete a date-effective object?

In most cases, yes. If the Delete icon appears in the search results table when you search for the object, then you can
delete it. Deletion purges all of the object's physical records and isn't reversible.

After deletion, the object's history is no longer available.

You can also enter an effective end date for the object or change its status to make it unavailable to transactions. With
these approaches, the object's history remains available.

What happens when | end date an object?

The date that you enter becomes the final effective end date for the object. If physical records exist for the object
beyond the effective end date, either they're deleted automatically or you delete them.

The object's history remains available. For example, the object may appear in search results if the search criteria include
an effective as-of date that's within the object's effective dates.

What's an effective sequence number?

A number that's added automatically to physical records with the same effective start date in a single date-effective
object, such as an assignment. The number differentiates the physical records and identifies the update order. The
physical record with the highest effective sequence number is available for transactions for that date.
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5 Responsive User Experience Setup

HCM Experience Design Studio

You can do these actions in the HCM Experience Design Studio:

- Configure HCM actions
- Configure person spotlight
- Add background images for landing pages for redesigned HCM actions

® Watch video

How to Configure HCM Actions

You can do these actions in the Transaction Design Studio:

- Create rules to configure pages to include sections and fields applicable to your business.
- Change the required status of optional attributes.
- Control the availability of the questionnaire page for actions that use the guided process design.

Enable flexfields and the segments that you want to make visible.

You can specify these common criteria for a rule:

Legal Employers: Select the legal employers covered by the rule.
Business Unit: Select the business unit covered by the rule.
Roles: Select the applicable roles. This is the role of the user that's performing the action.
You can hide unused or optional sections and fields on the redesigned actions and pages. For example, for the promote

action for the India legal employer, you can show the salary section if a worker's salary is adjusted during promotion.
You can choose to hide the position section and the position fields if you don't use position management.

You can create multiple rules for an action. The criteria help determine which rule applies to which employees. If an
employee meets multiple criteria for a page or action, then the rules are applied in the order displayed in the transaction
design studio. You can set a rule to be active or inactive. You can have only one active rule for any action at any time.

I Note: You can configure the Convert Pending Worker flow using the Create Work Relationship action.

How is it Different from the Page Composer

The Transaction Design Studio doesn't replace the ADF Page Composer completely. It reduces the need to create EL
expression to vary pages for different roles or legal employers. You can use either of the tools depending on your
requirement. Use the ADF Page Composer advanced configuration options to configure changes not supported by the
Transaction Design Studio.
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How to Configure the Person Spotlight

® Watch video

You configure the person spotlight using the person spotlight page in the HCM Experience Design Studio. You can
change the sequence in which they appear on a person's spotlight. In addition, you can hide a tab completely or use an
EL expression to make the tab available to a select group of employees.

Transaction Design Studio

The Transaction Design Studio (TDS) is available within the HCM Experience Design Studio. The TDS enables you to
create rules to configure transactions and pages in the responsive user pages.

You can change how sections and fields are displayed, based on the user's role and the employee's business unit or
legal employer. You can do these actions in the TDS.

- Control the visibility of regions and sections on the page

- Control the visibility for attributes within a page, region, or a section

- Change the required status of optional attributes

- Control the availability of the questionnaire page for actions that use the guided process design

- Specify whether a user must visit a specific region for actions that use the guided process design
Enable Save and Save and Close action buttons for actions where the feature is available

You can create one or more rules for any page available in the TDS to manage your business needs. For example:

Make different fields visible and required in the new hire flow for employees in the US and employees in other
countries.

If employees in the US don’t get salary increases as part of a promotion, hide the Salary and Compensation
regions for US employees only, while making these regions available for employees in other countries when
being promoted.

Hide the Ethnicity and Religion fields from the Personal Details page for countries or legal employers that you
don’t want to store that information.

Use Transaction Design Studio to Configure Field
Displays
Use the Transaction Design Studio (TDS) to configure transactions and pages for responsive applications. TDS is

available within the HCM Experience Design Studio.

You can control the visibility of attributes that are displayed either as Delivered or Enabled, and the availability of fields
and sections of a transaction based on the user's role, person's business unit, or legal employer.

By default, the responsive pages display the often used attributes and hide the less often used attributes. Use Page
Composer to personalize the responsive pages and display the attributes and tabs delivered within the feature.
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Here's how you start HCM Experience Design Studio:

1. Signin to the application as Human Capital Management Application Administrator with Access HCM Page
Configurator (HRC_ACCESS_HCM_TRANSACTION_CONFIGURATOR_PRIV) privilege. This privilege provides
you access to TDS in HCM Experience Design Studio.

2. Enable a sandbox to compose data for configuring business objects. On the Home page, click the HCM
Experience Design Studio quick action under the My Client Groups tab.

3. Under Settings and Actions, click Edit Pages.

4. Select the site layer and click OK.

Related Topics
« Overview of Page Modification

How You Configure Rules in the Transaction Design
Studio

Let’s look at how you configure a rule for responsive pages in the Transaction Design Studio (TDS).

To get started, select the action and enter these basic rule details:
Name
Description

Parameters that determine when and for whom the rule is applied

Configuration Parameters

Parameters vary according to the selected action. You can set all, some, or none of the parameters. When evaluating the
rule at runtime, the application ignores the criteria for parameters that you haven't set. You can select multiple values
for some parameters. Here is a list of parameters that you can use to configure a rule.

Role: User security roles assigned for performing the action or viewing the page. This LOV shows all delivered
and custom security roles.

Legal Employer: Legal employers being acted on.
- Country: Used when the legal employer doesn’t fully support the requirement to create rules by country.

Legislative Data Group: Used when the legal employer doesn’t fully support the requirement to create rules by
country.

Business Unit: Used when the legal employer doesn’t fully support the requirement to create rules by country.

- Worker Type: Worker types being acted on such as contingent worker, employee, nonworker, offer, and
pending worker.

- When is the rule applied? View other’s info or Viewing own info is used when the page you're configuring is
available to both workers and other users, such as HR specialist.

- Action (HCM): Available for transactions that use actions such as Create and Edit Job Offers.

Recruiting Type: Recruiting types of the job requisition or the job requisition related to the object being acted
on.
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- Site Name: Name of the external candidate experience site that external candidates use to search and apply
jobs.

- Application Flow Name: Name of an application flow that is used for external candidate's job application,
requesting additional information or talent community sign-up.

- Performance Document: Name of the performance document as defined in the performance template.

Show or Hide Regions

This section applies to actions that include different sections. For example, Promote, Transfer, and Hire an Employee
actions use the guided process design, which includes various sections of specific information. The Show questionnaire
page field is set to Yes for actions that use the guided process. This allows users to mandate and show or hide the
regions that they want to manage during the transaction.

TDS configuration rules take precedence over any other setting. If you enable the profile option Questionnaire
Displayed in Guided Processes (HCM_TASK_CONFIGURATOR_RESPONSIVE_ENABLED) to show the questionnaire, it will
display in the transaction page. Later, if you create a rule to hide the questionnaire it will be hidden even if the profile
option is enabled. If you hide the questionnaire page, you navigate directly into the transaction details page to complete
the transaction.

This section is shown even for actions that don’t use the guided process design but have different sections of
information. You can rename a section, hide sections that aren’t delivered as required, and make optional sections
required.

Required Sections

You can improve the quality of your data by ensuring that your users complete the required fields before submitting the
transaction. For example, the Payroll Details and Salary sections are required in the Hire an Employee flow. When you
initiate the process, Payroll Details and Salary aren’t displayed as options on the questionnaire because they are already
part of the guided process. You need to complete these required sections before submitting the transaction. You can
change the severity of the message from a warning to an error for some actions, to ensure that the required information
is provided.

You set up required sections from the Reference Info Regions in the Page Attributes section in the TDS. Click the Show
error message for mandatory sections that haven’t been viewed option to show an error message when the required
sections aren’t visited. You can see a warning message if you configure sections as required in the TDS but don't visit
the mandatory sections in employment flows.

Page Attributes

When an action or page includes regions, you select the region to see a list of available attributes on the Page by
Region. When attributes are read-only, there’s no option to change the required setting. You can’t add new attributes
to a page, but you can hide fields not delivered as required, make delivered optional fields as required, and enable
descriptive flexfields segments.

Flexfields

A flexfield attribute is identified by a pencil icon. A point to note is that when a flexfield is defined as a check box,
making the attribute mandatory will not force the user to select the check box. There’s always a value stored for each
state of the attribute, whether selected or not. To enable a flexfield that’s already been compiled, click the pencil
icon. For Employment or Contract pages, you can also decide which segments under a specific context are hidden or
displayed. This doesn’t apply for Person pages.
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Create Rule to Configure Promote Action

In this example, you create a rule to configure the Promote action. You must hide the Compensation region in the
Promote flow for all UK legal employers. This rule is applicable for line manager performed promotions only.

Prerequisites

1. You must activate a sandbox before defining a rule.
2. Enable page-level configuration at the Site level.

Select the Action

1. On your Home page, select My Client Groups > Employment > HCM Experience Design Studio.
2. Select the Transaction Design Studio tab.
3. Select Promote from the Action list.

Add Rule

1. Click Add to add a new rule.
2. Enter these rule details:

Field Value

Name UK Promotion

Description Hide Compensation region for UK LE only

Legal Employers Vision Corporation UK

Action Promotion

Business Unit Vision Operations

Worker Type Employee, Contingent worker

Roles Line Manager (ORA_PER_LINE_MANAGER_ABSTRACT)
Active Yes
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Configure Rule

In the Show or Hide Regions section, scroll down to the Compensation row and select Not visible.
Scroll down to the Page Attributes region and select Promotion from the Region list.

In the Grade attribute row, select Not visible from the list.

Click Save.

PUWNA

Displayed, Conditionally Displayed, and Hidden Fields in
Global Human Resources

Responsive user experience pages, by default display the frequently used fields and hide the less frequently used
fields. This topic helps you to identify which fields are displayed, conditionally displayed, or hidden in Global Human
Resources.

If there are hidden fields your company wants to display, you can personalize the responsive pages using Page
Composer. Visibility of fields displayed either as delivered or enabled using Page Composer can then be controlled using
the Transaction Design Studio. Use the Transaction Design Studio to control the availability of fields and sections of a
transaction for new redesigned transactions by legal employer and role.

Related Topics
- Responsive User Experience- Global Human Resources - Displayed, Conditionally Displayed, and Hidden Fields
(Doc ID 2709404.1)

How You Personalize the Save and Save and Close
Actions in the Toolbar

You can personalize the toolbar to add the save actions in the toolbar. You can save your transaction at any point of
time.

For example, you're adding a new contractor and you have already provided half of the required info. If you need to
switch to another task, you can save your work and resume later where you left off.

Here's a list of actions for which you can configure Save and Save and Close buttons.

- Add Assignment

- Add Contingent Worker

- Add Pending Worker

« Add a Nonworker

« Administer Compensation
- Change Assignment

- Change Location

- Change Manager
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- Change Salary

- Change Working Hours

- Create Job

- Create Location

- Create Work Relationship
Direct Reports
Edit Pending Worker
Eligible Jobs
Employment Contracts
Employment Start Dates
Hire an Employee
Individual Compensation

- Job Details
Local and Global Transfer
Location Details
Manage Personal Contributions
Position Details
Promote
Request a New Position
Request a Position Change
Resignation

- Salary History

- Termination

- Transfer

- Work Relationship

The Save and Save and Close buttons are hidden, out-of-the-box. You can enable these buttons from the Reference
Info Regions region in the Page Attributes section in the TDS.

A point to note is that rules are evaluated for each attribute for active rules in the TDS. If the same attribute is defined in
multiple rule definitions, only the first in order of active rule attribute conditions is applied.

For example, if you define 2 rules where rule 1is a generic rule and states that the Save and Close is available
unconditionally, but not Save and a rule 2 where Save is available only for a specific legal employer. As a result, rule 1is
evaluated as the first rule in order of active rules and so the Save button isn't displayed for all legal employers selected
inrule 2.

Configuration Report

You can check the Configuration Report to understand why a page acts in a certain way. The report provides a
comprehensive list of configurations done in the TDS or Page Composer, or both, across various pages.
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You access the View Configuration Report from the Transaction Design Studio home page. Select the action and then
the page that you want to analyze. Select All to analyze all pages of the selected action. You can access information on
which tool was used to show or hide the attributes on pages, either the TDS or Page Composer.

Properties
Page
- Attribute
- Attribute ID

Required Property Configured From: Tools from where the required property was configured: Values can be
Transaction Design Studio, Page Composer, or both.

Rendered Property Configured From: Tools from where the rendered property was configured: Values can be
Transaction Design Studio, Page Composer, or both.

- Visible Property Configured From: Tools from where the visible property was configured: Values can be
Transaction Design Studio, Page Composer, or both.

The configuration report is useful in understanding if a field on a page is customized or not and the tool used to
customize a field. You can download and export the information in the configuration report into a .csv file. Oracle can
use this file for troubleshooting Ul issues instead of the earlier method of downloading customizations from MDS and
providing sandbox details.

Guided Journeys in HCM Flows

You can provide guidance such as tutorials, company policies, and best practices, in the context of an HCM flow, using
guided journey tasks.

For example, tasks to help a line manager transfer an employee. You need to first configure a guided journey in
Checklist Templates, and then create a rule for the action in the TDS.

There are some of the best practices to follow when implementing guided journeys.

- A recommended best practice when creating multiple guided journeys and adding in TDS is to follow a naming
convention to help identify the guided journey. Something like this: actionName_ruleConfigParams_pagelLevel
or actionName_ruleConfigParams_sectionName. For example, Transfer_Employee_Page or
Transfer_USManager_AssignmentDetails.

It's recommended to use only one guided journey per TDS action.

Related Topics
« Overview of Guided Journeys

Deep Links

You can use deep links to provide easy navigation directly to a page in the HCM Cloud application.
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You can also use deep links for mobile responsive pages on your intranet, custom and third-party applications, or in a
document. This helps people run transactions in the HCM cloud and provides quick access to their HR information.

To access deep links:

1. Open the main menu.
2. Goto Tools > Deep Links.
3. Copy the URL for a deep link.
4. Paste the URL in the appropriate location.
When you open Deep Links, you find a list of all available deep links.

Quick Actions

Quick actions are links on the Home page that enable you to initiate actions quickly on yourself, your team, or your
client groups. You can view the quick actions grouped under the following tabs:

Me - This tab lists actions to manage your own information.
My Team - This tab lists actions to manage your team.
My Client Groups - This tab lists actions to manage people within your area of responsibility.

Click the Show More link to view all the available actions grouped under a specific head.

The set of actions that you see are displayed based on your security privileges. The people that you can act on differ
based on the tab you're on. Consider that you're both a line manager and an HR Specialist. You can access the Promote
action from both the tabs: My Team and My Client Groups. Also, you will see a different set of employees on each tab
whom you can promote. You can promote only your direct reports using the Promote task in the My Team tab. You can
promote only those employees that you have access to as an HR Specialist, using the Promote task in the My Client
Groups tab.

Related Topics
« Configure Quick Actions

Search Logic Profile Options for Client List of Values in
Global Human Resources

You can use the logic CONTAINS to create the client list of values. This returns results containing the characters you
enter.

Optionally, for individual list of values, you can change this logic to starTs wrTs, to return results that start with the
search characters you enter.

For example, when you search for a person with the name John Smith while using the logic conTains, you can search by
'jo' or 'sm' or 'th'. When you use the logic starTs wiTh, your search must start with 'j'.

Use the logic starTs w1t when your list contains thousands of values (more than 15,000 records) to improve the search
performance. Or, if you don't partition your data by set ID.
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Note: If you change the search logic for a client list of values, the logic changes in all pages where the list of values is

used.

You can use these profile options to change the search logic for a client LOV in Global Human Resources.

Object

Address Attributes

Bargaining Unit

Business Unit

Collective Agreement

Country (including Phone Country Code)

Department

Department Trees

Document Type

Cost Center

Grade

Grade Ladder

HCM Trees

Job

Job Families

Legal Employer

Location

Organization Trees

Person (Worker, Manager, Employee)

Position

Position Trees

ORACLE

Profile Option Code

PER_LOV_SEARCH_ADDRESSES_STARTSWITH (Site level value is delivered as Y)

PER_LOV_SEARCH_BARGAININGUNITS_STARTSWITH

PER_LOV_SEARCH_BUSINESSUNITS_STARTSWITH

PER_LOV_SEARCH_COLLECTIVEAGREEMENTS_STARTSWITH

PER_LOV_SEARCH_HCMCOUNTRIES_STARTSWITH

PER_LOV_SEARCH_DEPARTMENTS_STARTSWITH

PER_LOV_SEARCH_DEPARTMENTTREENODES_STARTSWITH

PER_LOV_SEARCH_HRDOCUMENTTYPES_STARTSWITH

PER_LOV_SEARCH_HCM_COSTCENTER_STARTSWITH

PER_LOV_SEARCH_GRADES_STARTSWITH

PER_LOV_SEARCH_GRADELADDERS_STARTSWITH

PER_LOV_SEARCH_HCMTREES_STARTSWITH

PER_LOV_SEARCH_JOBS_STARTSWITH

PER_LOV_SEARCH_JOBFAMILIES_STARTSWITH

PER_LOV_SEARCH_LEGALEMPLOYERS_STARTSWITH

PER_LOV_SEARCH_LOCATIONS_STARTSWITH

PER_LOV_SEARCH_ORGANIZATIONTREENODES_STARTSWITH

PER_LOV_SEARCH_WORKERS_STARTSWITH

PER_LOV_SEARCH_POSITIONS_STARTSWITH

PER_LOV_SEARCH_POSITIONTREENODES_STARTSWITH
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Object Profile Option Code
Roles PER_LOV_SEARCH_ROLES_STARTSWITH
Sets ORA_PER_LOV_SEARCH_HCM_SETS_STARTSWITH
Union PER_LOV_SEARCH_UNIONS_STARTSWITH
User Accounts PER_LOV_SEARCH_USERACCOUNTS_STARTSWITH
User Roles PER_LOV_SEARCH_USERROLES_STARTSWITH
Related Topics

« Set Profile Option Values

How You Configure List of Values (LOVs)

You can centrally configure list of values (LOV) used in HCM so that the same search and display fields appear on all
pages that use this LOV. You can independently configure the search and display fields.

The configuration controls what your users will see in results; display or search-and-display fields, and what fields user
will be able to search against - search-only or search-and-display fields. For example, if you configure Name, Work
Email, and Person Number as searchable fields for the Workers LOV, these fields will appear on all pages that have the
Workers LOV and you can use them in searching for values.

You can do these actions, based on the particular LOV capabilities and your requirements.

Hide fields that aren't relevant for your organization
- Add more fields to enhance the search results and easily identify an individual record
Reorder fields to reflect their relevance in your organization

You can configure these LOVs on the Search Configuration page in the HCM Experience Design Studio.

- Countries
Departments

- Jobs
Locations
Phone Countries
Positions

- Workers

These are some key points to note:
If Oracle Search or database implementations of the same LOVs are available, then only the enabled one will be
listed.
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- The LOV configuration is a replacement for any personalization implemented through Page Composer. Any
personalization done using Page Composer may be overwritten on upgrade. It's recommended to revert any
personalization and use the LOV Configuration instead.

- The user must have the Access HCM Page Configurator
(HRC_ACCESS_HCM_TRANSACTION_CONFIGURATOR_PRIV) privilege to your user to access the LOV
configuration Ul.

LOV Configuration Options

You can configure these options on the individual LOV configuration pages.

Section What You Can Do

Search and Display Fields - Choose the fields to display in the search results. Use the Add and Delete actions to add or
remove fields respectively.

- Choose the display order of the fields. Use the Up and Down arrow icons to reorder the list of
fields as required.

- Choose the searchable (Search and display option) or not-searchable fields (Display only option)

Search Only Fields Choose the fields that you can use for search, but these fields may not appear in the search results. Use
Add and Delete actions to add or remove such fields respectively

Preview Test your configuration

Flows That Display the Configured LOVs

Product LoV Flow

Global Human Resources Countries - Add a Contingent Worker
- Add a Nonworker
- Add a Pending Worker
- Add Document Record
- Contact Info
- Create Work Relationship
- Edit Document Record
- Edit Pending Worker
- Family and Emergency Contacts
- Hire an Employee
- Identification Info
- Local and Global Transfer
- Location Details

- Personal Details
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Global Human Resources

Global Human Resources
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LoV

Departments

Jobs
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Add Assignment

Add a Contingent Worker
Add a Nonworker

Add a Pending Worker
Change Assignment
Create Work Relationship
Edit Pending Worker
Employment Details

Hire an Employee

Local and Global Transfer
Manage Job Offers

Mass Legal Employer Change
Pending Workers

Position Details

Promote

Request a New Position
Request a Position Change
Transfer

Vacancy

Add Assignment

Add a Contingent Worker
Add a Nonworker

Add a Pending Worker
Change Assignment
Create Work Relationship
Edit Pending Worker
Employment Details

Hire an Employee

Job Details

Local and Global Transfer
Manage Job Offers

My Team

Pending Workers
Position Details

Promote

Request a New Position
Request a Position Change

Transfer
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Global Human Resources

Global Human Resources

Global Human Resources
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LoV

Locations

Phone Countries

Positions
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Vacancy

Add Assignment

Add a Contingent Worker
Add a Nonworker

Add a Pending Worker
Change Assignment
Change Location

Create Work Relationship
Edit Pending Worker
Employment Details

Hire an Employee

Local and Global Transfer
Location Details

Manage Job Offers

Mass Legal Employer Change
Pending Workers

Position Details

Promote

Request a New Position
Request a Position Change
Transfer

Vacancy

Add a Contingent Worker

Add a Nonworker

Add a Pending Worker

Contact Info

Create Work Relationship

Edit Pending Worker

Family and Emergency Contacts
Hire an Employee

Local and Global Transfer

Location Details

Add Assignment

Add a Contingent Worker
Add a Nonworker

Add a Pending Worker

Change Assignment
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Product LoV Flow

- Create Work Relationship
- Edit Pending Worker

- Employment Details

- Hire an Employee

- Local and Global Transfer
- Manage Job Offers

+ My Team

- Position Details

- Promote

- Request a New Position

« Request a Position Change
- Transfer

- Vacancy

Global Human Resources Workers - Add a Contingent Worker
- Add a Nonworker
- Add a Pending Worker
- Add Assignment
- Change Assignment
« Change Location
- Create Work Relationship
- Edit Pending Worker
- Employment Details
« Hire an Employee
- Local and Global Transfer
- Location Details

- Mass Download of Document Records

Mass Legal Employer Change

- Position Details

Promote
- Request a New Position
- Request a Position Change
- Responsive Quick Action Person Search
- Share Info (Grantee)
- Termination

- Transfer

Talent Management - Career Development

- Goal Management
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Product LoV Flow

- Performance Management
- Profile Management

« Requested Feedback

- Succession Management

- Talent Review

Workers LOV

You need to enter a search term to display the search results. No workers are displayed when you don't enter any search
terms in the LOV. This is to prevent showing random workers initially, even before you search for a worker as most times
randomly listed people may not be the people that you're searching. This helps in improving both, user experience and
performance.

You can't search by business title; it's disabled by default. You can enable it on the Manage Administrator Profile
Values page by setting the PER_LOV_SEARCH_WORKERS_EXCLUDE_BUSINESS_TITLE profile option to N. You need
to then change the property of the Business Title field from Display only to Search and display in the Search and
Display Fields section.

Note: The Workers LOV attributes vary depending on whether Oracle Search is enabled for people.

FAQs for Responsive User Experience Setup

Why can't | see some quick actions on landing pages after an
upgrade?

These responsive landing pages are redesigned:

- Absences

- Career Development

- Compensation
Data Exchange

- Goals
Mass Updates
New Person
Performance
Profiles

- Workforce Structures
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Quick action tasks available on the My Client Groups tab are also available from the new landing pages as well. If you
don't see a task in the list of quick actions, you won't see it on the landing page and vice-versa. You need to enable the
quick actions to see these tasks in the landing pages. Here are the steps to enable the quick actions.

Navigate to Configuration > Sandboxes.

Click Create Sandbox.

Enter a name and description for the sandbox.

Add Structure and any other tools you require.

Click Create and Enter.

Navigate to Configuration > Structure.

Click My Client Groups and then click the Quick Actions tab.
Select the quick action you want to configure.

Change the Visible or other settings as needed.

Click Save and Close.

COVOONOSUAWNREA

-—

Does the Transaction Design Studio replace the Page Composer?

No. The Transaction Design Studio doesn't replace the Page Composer completely but reduces the need to create EL
(Expression Language) expression to vary pages for different roles or legal employers. You can use either of the tools
depending on your requirement.

Why isn't the Create Primary Work Relationship field visible for a
global transfer even though it's set to Visible in the Transaction
Design Studio?

When you set the Create Primary Work Relationship field in the Local and Global Transfer flow to Visible, this is what
happens:

- The field is visible when you create a global temporary assignment by selecting the transfer type as Temporary
in the Local and Global Transfer flow.

- The field isn't visible when you do a global transfer by selecting the transfer type as Permanent in the Local
and Global Transfer flow. This is because the work relationship is set to Primary by default in a global transfer.
There's no choice of whether to create a primary work relationship or not.

Why can't | see the roles | selected earlier in a rule for the
Additional Person Info action in the Transaction Design Studio?

In cases where you can select multiple roles for a rule in the Transaction Design Studio, the roles have to belong to any
of these categories to be visible in the Roles menu.

HCM_Job
HCM_Abstract
HCM_Data
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If the role belongs to any other category, then the role won't be visible in the Transaction Design Studio.

Related Topics
» Role Types

Why can't | see the direct reports action and action reason fields
in the When and Why section of the Resignation flow even though
they're enabled in the Transaction Design Studio?

You can't see the action and action reason fields for the direct reports in the Resignation page because the person
resigning can't reassign their own direct reports. The fields are visible to the approver of the resignation when the
resignation transaction goes for approval.

What's the difference between Autocomplete Rules and
Transaction Design Studio

The Transaction Design Studio enables you to configure the display of fields and sections in the responsive pages based
on a fixed set of parameters. Autocomplete Rules is a data model layer-driven application that enables you to default
values or validate fields irrespective of whether the fields actually appear in the user interface or not.

® Watch video

Though there are many differences between the Transaction Design Studio and Autocomplete Rules, there is one
overlapping functional feature. Transaction Design Studio enables you to specify if a field is required unconditionally
or conditionally based on parameters such as business unit, legal entity, and so on. However, Autocomplete Rules cant
determine when to show or hide a field like the Transaction Design Studio, it can simulate the field requirement by
enforcing a validation rule with an error message.

This table summarizes the differences between Autocomplete Rules and the Transaction Design Studio.

Autocomplete Rules Transaction Design Studio

Autocomplete Rules is a data model- Transaction Design Studio is based on the Ul components.
driven application.

Autocomplete rules are written based on Transaction Design Studio is used to configure fields and sections based on an action.
the underlying business object

A single rule applies for all actions that You can write a rule only for one action at a time.
use that business object. For example, the

When and Why business object applies to

Transfer, Hire, Promote, and so on.

There are over a hundred different criteria = There are about 8-10 predefined criteria that apply for each action.
that you can define in a rule.
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4 Oracle Search Cloud Service Setup

Set Up Oracle Search for HCM

You need to configure profile options and run the initial data ingestion process to set up Oracle Search index, which is
the foundation of Oracle Search based Global Search.

Set Oracle Search Profile Options

1. Navigate to Home > Setup and Maintenance > Manage Administrator Profile Values.
2. Search for and review the following profile options. Set the values with the corresponding level if not set

already.
Profile Option Code Profile Display Application Module Profile Level Profile Value
Name
ORA_FND_SEARCH_ Enable/Disable Oracle Middleware Oracle Middleware Site Yes
EXT_ENABLED Search Ext Extensions for Extensions for
Framework Applications Applications
HRC_ELASTIC_ HRC: Enable Elastic HCM Common Search Framework Site Y
SEARCH_ENABLED = Search Architecture
PER_SEARCH_ PER: User Login Global Human Security Site ATOM
LOGIN_EVENT_PUB  Event Publication for Resources
Search

Run Initial Data Ingestion

1. Navigate to Tools > Scheduled Processes.
2. Run the ESS job described in this table.

Note: If you need to set up the index for a feature, select the relevant parameter value. For example, fa-hcm-
person for person search or fa-hcm-position for positions search. If you're setting up multiple indices, then
you need to run multiple processes with different index name parameters.

Job Name Parameter Name Parameter Value

ESS job to create index definition and Index Name to Reingest <index_name>
perform initial ingest to OSCS
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Job Name Parameter Name Parameter Value

For example: fa-hcm-person

This process is secured with FND_MANAGE_SCHEDULED_JOB_DEFINITION_PRIV function
privilege. The privilege is available in the ORA_FND_APPLICATION_ADMINISTRATOR_JOB or
ORA_FND_APPLICATION_DEVELOPER_JOB job roles.

Refresh Indexes after Upgrade

You must run the initial data ingestion process for every created index after upgrading to a new release.

Refresh Indexes after P2T

You must run the initial data ingestion process for every created index after P2T (production-to-test) process.

Related Topics
« Enable Global Search

- Set Up Connections

Set Up Oracle Search for List of Values

You can set up Oracle Search for these List Of Values (LOVSs).

- Workers
Positions
Departments
Locations

- Jobs

Oracle Search for Workers List Of Values

Here are the steps to enable Oracle Search for workers list of values:

1. Create the person index, fa-hcm-person and set up Oracle Search. For details, see Set Up Oracle Search for
HCM.

2. Set up data security for Oracle Search. For details, see Set Up Data Security for Oracle Search.

ORACLE
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3. Enable Oracle Search for workers LOV:
a. Navigate to Home > Setup and Maintenance > Manage Administrator Profile Values.
b. Search and set these profile options.

Profile Option Profile Display Application Module Profile Level Profile Value
Code Name

ORA_PER_ Enable Oracle Global Human Personal Site Yes
ORACLE_SEARCH_ = Search Workers Lov Resources Information

WORKERSLOV_

ENABLED

4. Optionally, use the HCM Experience Design Studio to configure other properties and customize your LOV. You
can independently configure the search and display fields. For details, see How You Configure List of Values
(LOVs).

Note: Oracle Search based public person search doesn’t implement the public person security profile, it
always returns all results. Private Person security profile is fully implemented with Oracle Search.

Oracle Search for Positions List of Values

Here are the steps to enable Oracle Search for positions list of values:

1. Create the position index, fa-hcm-position and set up Oracle Search. For details, see Set Up Oracle Search for
HCM.

2. Set up data security for Oracle Search. For details, see Set Up Data Security for Oracle Search.
3. Enable Oracle Search for positions LOV using these steps:
a. Navigate to Home > Setup and Maintenance > Manage Administrator Profile Values.
b. Search and set these profile options.

Profile Option Profile Display Application Module Profile Level Profile Value
Code Name

ORA_PER_ Enable Oracle Global Human Personal Site Yes
ORACLE_SEARCH_ = Search for Positions Resources Information

POSITIONSLOV_ Lov

ENABLED

4. Optionally, use the HCM Experience Design Studio to configure other properties and customize your LOV. You
can independently configure the search and display fields. For details, see How You Configure List of Values
(LOVs).

Oracle Search for Departments List of Values

Here are the steps to enable Oracle Search for departments list of values:

1. Create the departments index, fa-hcm-organization and set up Oracle Search. For details, see Set Up Oracle
Search for HCM.

2. Set up data security for Oracle Search. For details, see Set Up Data Security for Oracle Search.

3. Enable Oracle Search for departments LOV using these steps:
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a. Navigate to Home > Setup and Maintenance > Manage Administrator Profile Values.
b. Search and set these profile options.

Profile Option Profile Display Application Module Profile Level Profile Value
Code Name

ORA_PER_ Enable Oracle Global Human Personal Site Yes
ORACLE_SEARCH_ = Search for Resources Information

DEPARTMENTSLOV, Departments Lov

ENABLED

4. Optionally, use the HCM Experience Design Studio to configure other properties and customize your LOV. You
can independently configure the search and display fields. For details, see How You Configure List of Values
(LOVs).

Oracle Search for Locations List of Values

1. Create the locations index, fa-hcm-location and set up Oracle Search. For details, see Set Up Oracle Search for
HCM.

2. Set up data security for Oracle Search. For details, see Set Up Data Security for Oracle Search.
3. Enable Oracle Search for locations LOV using these steps:

a. Navigate to Home > Setup and Maintenance > Manage Administrator Profile Values.
b. Search and set these profile options.

Profile Option Profile Display Application Module Profile Level Profile Value
Code Name

ORA_PER_ Enable Oracle Global Human Personal Site Yes
ORACLE_SEARCH_ = Search for Resources Information

LOCATIONSLOV_ Locations Lov

ENABLED

4. Optionally, use the HCM Experience Design Studio to configure other properties and customize your LOV. You
can independently configure the search and display fields. For details, see How You Configure List of Values
(LOVs).

Oracle Search for Jobs List of Values

1. Create the jobs index, fa-hcm-job and set up Oracle Search. For details, see Set Up Oracle Search for HCM.
2. Set up data security for Oracle Search. For details, see Set Up Data Security for Oracle Search.

38
ORACLE



Oracle Fusion Cloud HCM Chapter 4
Using Common Features for HCM Oracle Search Cloud Service Setup

3. Enable Oracle Search for jobs LOV using these steps:
a. Navigate to Home > Setup and Maintenance > Manage Administrator Profile Values.
b. Search and set these profile options.

Profile Option Profile Display Application Module Profile Level Profile Value
Code Name

ORA_PER_ Enable Oracle Global Human Personal Site Yes
ORACLE_SEARCH_ = Search for Jobs Lov Resources Information

JOBSLOV_

ENABLED

4. Optionally, use the HCM Experience Design Studio to configure other properties and customize your LOV. You
can independently configure the search and display fields. For details, see How You Configure List of Values
(LOVs).

Set Up Data Security for Oracle Search

Set up Oracle Search data security with dynamically computed access control lists (ACLs).

Set Logging Profile Options

You need to run ACL processes with some minimum logging capabilities. Set these profile options:

1. Navigate to Home > Setup and Maintenance > Manage Administrator Profile Values.
2. Search and set these profile options.

Profile Option Code Profile Display Application Module Profile Level Profile Value
Name

AFLOG_ENABLED FND: Log Enabled Oracle Middleware Application Logging = Site or User level for = Yes

Extensions for the user running

Applications ACL processes
AFLOG_LEVEL FND: Log Level HCM Common Application Logging = Site or User level for =~ Severe

Architecture the user running

ACL processes

AFLOG_MODULE FND: Log Module Global Human Application Logging  Site or User level for = %
Filter Resources the user running
ACL processes

Initiate ACL Ingestion

Run a process to erase any existing existing ACL index, create the required ACL index, and populate it with access
control lists for all users.

1. Navigate to Tools > Scheduled Processes.
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2. Run the process that's described in this table.

Job Name Description
HCM Access Control List Initial Creates HCM access control list and performs the initial ingestion.
Ingestion

Schedule ACL Processes

Schedule these ACL processes, if they're not yet scheduled.

1. Navigate to Tools > Scheduled Processes.
2. Schedule these processes.

Job Name Frequency
Compute Users ACL by Event Every 15-60 minutes
Job Name Parameter Name Parameter Value Frequency
Compute Users ACL User Population Logged in users Every 30-120 minutes
Compute Users with Large ACL ~ Action Compute Daily
User Population All users with Large ACL

Enable Global Search

You need to configure the Global Search profile option and review the configuration for HCM to enable Global Search.
After that, you need to create the person index.

1. Create Person Index

This feature requires an Oracle search index. Ensure that the required index, fa-hcm-person is created and data is
ingested. Follow the steps listed in Set Up Oracle Search for HCM.

Note: Oracle Search based public person search doesn’t implement the public person security profile, it always
returns all results. Private Person security profile is fully implemented with Oracle Search.

2. Set Global Search Profile Option

1. Navigate to Home > Setup and Maintenance > Manage Global Search Profile Options.
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2. Search and set this profile option.

Profile Option Code Profile Display Application Module Profile Level Profile Value
Name
FUSION_APPS_ Global Search Oracle Middleware Oracle Middleware Site Yes
SEARCH_ENABLED Enabled Extensions for Extensions for
Applications Applications

3. Review Global Search Configuration for HCM

1. Navigate to Home > Setup and Maintenance > Manage Global Search Configurations.
2. Ensure that Global Search is configured and enabled for HCM.
3. Ensure that the following Suggestion Group is enabled in the Global Search Configuration for HCM.

Short Name Display Name Description
HCM_PERSON_SEARCH Oracle HCM Cloud Global Search for Person = This is the Global Search for HCM Person.
Action

Using Oracle Search Cloud Service Features

Global Search

Use Oracle Search-based Global Search to quickly find all active employees, contingent workers, and nonworkers as of
today’s date.

Global search involves a complete search of people and displays matching results irrespective of the public person
security profile of the logged in user. Oracle Search-based global search provides a faster search experience. Here’s a list
of the new person search capabilities.

Improved relevancy of results - Only the relevant person records are displayed so you don't have to scan
through multiple records to find the one you were searching for.

Fuzzy person name search - Search allows for simple mistakes and typos up to two spelling differences.

Name synonyms search - Synonyms are defined for many English sounding names. You can search by
different forms of the name. For example, when you are searching for ‘Bill’, people named ‘William’ will also be
displayed in the results.

Field Weight - Primary search is by person name and person name matches are of highest relevancy.

- Ability to search by other person attributes - Although person name search is of highest relevancy, you can
also search using these person attributes - person display name, person number, work email address, and
business title.

Improved search results - Search results display direct reports at the top followed by others.
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5 Filtered Lists

Overview of Filtered Lists

Filtered Lists are lists created with custom-defined criteria containing attributes, operators, and other filters. You
associate a list with a business object, a subscriber, and conditions that form your criteria of the list. You can run lists
within a business process to easily identify the object records that qualify your criteria and use the lists for specific tasks.

Filtered Lists are dynamic in nature and the list results are based on current data. For example, if you create a list of
workers with criteria to return information about contingent workers, the results of the list now can be different from the
results of the list a month later. This is because the number of contingent workers might be different a month later.

You can create and access lists from the My Client Groups tab, Data Exchange work area, Filtered Lists quick action.

Related Topics
 Create a Predefined Audience Using Filtered Lists

« Suggested Skills to Set as Oracle Learning Related and Outcome Skills and Qualifications
« Mass Download Document Records

Enable Filtered Lists

To enable Filtered Lists, you need to set up Oracle Search with specific indexes existing for all objects. For details, see
Set Up Oracle Search for HCM.

To manage lists, you need the HRC_MANAGE_HCM_LISTS_PRIV functional privilege.

To create system lists that are available across the organization, you need the
HRC_MANAGE_HCM_SYSTEM_LISTS_PRIV functional privilege.

Create Filtered Lists

After you enable Filtered Lists for your application, here’s how you can create a list:

On the home page, click the My Client Groups tab.
Search for and click the Filtered Lists quick action.
On the Filtered Lists page, click Add.
On the New List page, enter these details:

o Name: A name for the list.

P OUN

o Object: Select the category of elements that the list returns. For example, Workers or Learning ltems.
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o Subscriber: Select the application that the list is used in. For example, use a list to return learning items
within the Skills Advisor application. You can create multiple lists with the same subscriber.

o Conditions: Define the criteria that the list uses to return results. You can build a list that uses a criteria
set with multiple conditions and operators to suit your business needs.

Examples of Filtered Lists

You need to send a monthly newsletter to the top workforce. Here's a sampile list:

Filtered List Object: Worker
- Subscriber: HCM Communicate
- Criteria: GradeCode = IC5, 1C6, IC7

You want a list of all the contingent workers from the Finance department. Here’s a sample list:

Filtered List Object: Worker
- Subscriber: Mass Download DoR

- Criteria:
o Worker Type = Contingent Worker

o Department = Finance
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6 Geographies for HCM

Overview of Geographies

Overview of Geographies, Geographic Entities, and Locations

Geography is a physical space on Earth, such as a location or region, that's defined by a boundary. For example, it
maybe existing geopolitical locations such as San Jose or Peru.

These geographical locations are used in applications to manage business requirements such as sales territories,
transportation deliveries, taxation, logistics, and so on.

Geography Type

A divisional grouping of geographies is named as Geography Types. It could be a geopolitical division such as Country,
First Order Administrative Divisions (example: State, Province, District, and so on), City, Town, Village, or Non-
Administrative Divisions (example: Southwest China, Northern California, and so on) or physical geographic divisions
such as Island, Continent, Mountain, and so on.

Geography Use

Specifying the purpose and use of these geographies is known as Geography Use. Data could be classified for use by
processes such as Taxation, Sales, Transportation, Marketing and so on.

Master Reference Geography Use

Master Reference Geography Use is data that's classified as being the source of truth. This data is used as a reference
for creating User-defined Geography Uses and as the source when working with geographical data such as validating
addresses or importing data. This data can be obtained from a third party or manually entered. It is defined by widely
recognized administrative or political boundaries such as States, Provinces, Counties, Cities, and so on.

Master Reference Geographies

Master Reference Geographies are geographical boundary names and physical boundaries that are classified as being
part of the Master Reference Geography Use. Examples include the State of California, the Province of Alberta, The
Country of India, and so on.

Master Reference Geography Type

Master Reference Geography Type is a layer of Master Reference Geographies. Examples of Master Reference
Geography Types would include States, Cities, Provinces, Countries, and so on.

How Geography Structure, Hierarchy, and Validation Fit Together

This topic presents the components of geographies.
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The following three components are dependent on each other when defining a country:

1. Geography structure
2. Geography hierarchy
3. Geography validation

Every country must have the geography structure defined first before the hierarchy can be defined, and the geography
hierarchy has to be defined before the validation can be defined.

Geography Structures

The first step for defining a country is to create a geography structure in which geography types are part of the country
structure, and then define how the geography types are hierarchically related within the country structure. For example,
you can create geography types called State, City, and Postal Code. Then you can rank the State geography type as the
highest level within the country, the City as the second level, and the Postal Code as the lowest level within the country
structure. Geography structure can be defined using the Manage Geographies task, or can be imported using tasks in
the Define Geographies activity.

Note: During import of geography data from any provider if one or more geography levels aren’t available, n/a
is substituted for those geography levels. For example, the list of values in the address Uls of accounts, contacts,
suppliers, persons, and so on are displayed as n/a for such geography levels.

A geography structure is a hierarchical grouping of geography types for a country. The following table describes the
geography structure for the United States.

Level Geography Type
1 State

2 County

3 City

4 Postal Code

You can use the geography structure to relate geography types for a country and define geography types for a country.

Relate Geography Types for a Country

You can determine how a country's geographies are hierarchically related by creating the hierarchy of the geography
types in the geography structure. When you define a country's structure, the geography type Country is implicitly at the
highest level of the geography structure with level as 1. The subsequent geography types that you add after country are
numbered in sequence.

You must add a geography type as a level in the country structure before you can define a geography for that geography
type in a country. For example, before defining the state of California, the State geography type must be added to the
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United States country structure. To quickly create country structure, you can copy a structure from another country and
modify the geography types for the country.

Define Geography Types for a Country

You can use any of the master reference geography types to create your geography structure. If required, you can create
a geography type, before adding it to the country structure. Each geography type is added at a lower level to the current
lowest level.

Note: You can't delete geography types that have associated geography data. You can only delete the lowest level
geography type of the country structure.

You can use a geography type that you create within the country structure for other country structures as well.

Geography Hierarchy

Once the geography structure is defined, the geographies for each geography type can be added to the hierarchy. For
example, in the hierarchy of United States you can create a geography called California using a State geography type.

As part of managing the geography hierarchy you can view, create, edit, and delete the geographies for each geography
type in the country structure. You can also add a primary and alternate name and code for each geography. A
geography hierarchy can be created using the Manage Geographies task, or can be imported using tasks in the Define
Geographies activity.

Geography hierarchy is a data model that creates conceptual parent-child relationships between geographies.

The application uses geography hierarchy information to facilitate business processes that rely on geography
information, such as, tax calculation, order sourcing rules, and sales territory definition. The geography hierarchy
information is centrally located and shared among other application offerings.

The geography hierarchy includes geography, geography type, geography usage, master reference geography hierarchy
and user defined zones.

If you delete a geography level, all the children in that geography hierarchy are also deleted. For example, under a state
you have defined zones using a range of postal codes. Later, you delete the state because you no longer support that
state in your business. All the zones defined within that state are also deleted.

How do | manage geography validation?

After defining the geography hierarchy, you need to specify the structure for the country.

You can choose which address style format you would like to use for the country, and for each selected address style
format you can map geography types to address attributes. You can also select which geography types to include in
address validation or tax validation, and which geography types will display in a list of values during address entry in
other user interfaces. The geography validation level for the country, such as error or warning, can also be selected.
Geography validation determines the geography mapping and validation for a country's address styles, and the overall
address validation control for a country.

47
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=s20033148

Oracle Fusion Cloud HCM Chapter 6
Using Common Features for HCM Geographies for HCM

The No Styles Format address style format is the default address style format for a country. By defining the mapping
and validation for this format you will ensure that validations can be performed for any address in the country. After the
No Styles Format is defined you can set up additional mapping for specific address styles.

For each address style format, you can define the following:

Map to attribute
Enable list of values
- Tax validation
- Address validation

- Address validation control

Attribute Mapping

For every address style format, you can map each geography type to an address attribute. For example, you can

map the State geography type to the State address attribute for the United States, or map the State geography type
to the County address attribute for the United Kingdom. The geography types that appear are based on how the
country structure is defined. The list of address attributes that appear are based on address formats delivered with the
application, or your customer defined address formats.

I Note: You only need to map geography types that you want to use for address or tax validation purposes.

Enable List of Values

Once a geography type is mapped to an attribute, then you can specify whether the geography type will appear in a
list of values during address entry in user interfaces. It is very important to review carefully if you want to enable a list
of values. You should only enable a list of values if you have sufficient geography data imported or created for that
geography. If the setup for master geography data is incomplete, then the geography data is either not imported or
created. As a result, the list of values for the address attribute doesn't list any geography data.

Once you have enabled a list of values for an address attribute, you can only select the geography data available for the
geography type. This means that if a specific geography value isn't available in the geography hierarchy, you can't create
an address with a different geography value.

Note: Enable List of Values applies to the Ul only. It doesn't apply to import, web services, nor REST APIs. For these,
all of the required geography types must have a value in the request when creating or updating an address.

Tax Validation

You can also specify whether a geography type will be included in tax validation. For example, for the United States
North America address style format you specify that County, State, and City are used for tax validation. This will mean
that when a transaction involves an address with the North America address style, the address must have the correct
county, state, and city combination based on the geography hierarchy data, to be considered valid for tax calculation.

Address Validation

You must set up address validation for those geography elements that you plan to use in your application. Address
validation checks whether geography elements of an address such as state, city, postal code, and soon are valid as per
master geography data. Setting up validation also helps ensure that the addresses are correct and deliverable during
entry. You can select states or other address elements from lists to ensure accuracy during entry. For example, when
you enter a postal code, the application can validate if the postal code exists. Note that address validation isn’t the same
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as address verification. Address Verification updates and enhances your address. Address verification depends upon
Oracle or any third-party address verification services to perform verification.

You can specify whether a geography type will be included in address validation. For example, when the user enters a
United States address using the North American address style format, the address must have the correct country, state,
and postal code combination based on geography hierarchy data to be considered geographically valid.

If an address element is mapped to a geography type, but not selected for geography validation usage, then during
address entry suggested values are provided for the address element, but the address element isn't validated.

You need to verify that the default mapping between Geography Type and Map to Attribute is valid in the Geography
Mapping and Validation region and update it if required when you define geography validation.

After setting geography validation, all features that directly and indirectly depend upon geographies are impacted. For
example, multiple applications such as ERP, CX, and SCM that use geographies are impacted.

Oracle recommends that you use the following valid mapping for the countries that Logate supports:

Country Name Country Code Geography Type Map to Attribute

Andorra AD Country Country
Parrogia State
Settlement City

Postal Code

Postal code

Angola AO Country Country
Provincia Province
e Municipio County
Comuna City
Localidad + Additional address
attribute 2
Argentina AR Country Country
Province Province
Department County
° Municipality City
Postal Code Postal code
Australia AU Country Country
State State
City City
Postal Code Postal code
Austria AT Country Country
Bundensland State
Bezirk County
Gemeinde City

ORACLE

Postal Code

Postal code

49


https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=s20072347

Oracle Fusion Cloud HCM

Using Common Features for HCM

Country Name

Belgium

Bolivia

Bosnia and Herzegovina

Brazil

Bulgaria

Canada

Cayman Islands

ORACLE

Country Code

BE

BO

BA

BR

BG

CA

KY

Geography Type

Country
Gewest
Provincie
Gemeente

Postal Code

Country
Departmento
Provincia

Canton

Country
District
Kanton
Opcine
Nasalje

Postal Code

Country
State
City

Postal Code

Country
Oblast
Obshhina
Settlement

Postal Code

Country
Province
City

Postal Code

Country
Island
District

Postal Code

Chapter 6
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Map to Attribute

Country

Additional address
attribute 1

Province
City

Postal code

Country

Additional address
attribute 1

Province

City

Country

Additional address
attribute 1

Province
County
City

Postal code

Country
State
City

Postal code

Country

Additional address
attribute 1

Province
City

Postal code

Country
Province
City

Postal code

Country
State
City

Postal code
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Country Name Country Code
Chile CL
China CN

Note:

China geography structure is
supported but geocoding isn't
supported.

Croatia HR
Cuba (V]
Cyprus cY
Czech Republic Ccz
Denmark DK
Dominican Republic DO

ORACLE

Geography Type

Country
Region
Provincia
Kommune

Postal Code

Country
Province
City

Postal Code

Country
Zupanije
Grad

Postal Code

Country
Provincia
Municipio
City

Postal Code

Country
Periochi
Dimos

Postal Code

Country
Kraj
Okres
Obec

Postal Code

Country
Amt
Settlement

Postal Code

Country

Provincia
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Map to Attribute

Country
State
County
City

Postal code

Country
Province
City

Postal code

Country
Province
City

Postal code

Country
Province
County
City

Postal code

Country
Province
City

Postal code

Country
State
County
City

Postal code

Country
Province
City

Postal code

Country

Province

51



Oracle Fusion Cloud HCM

Using Common Features for HCM

Country Name

Ecuador

Estonia

Finland

France

Germany

Great Britain

Greece

ORACLE

Country Code

EC

EE

FI

FR

DE

GB

GR

Geography Type

Municipio
Town

Postal Code

Country
Province
Canton
City

Postal Code

Country
Maakond
Vald

Postal Code

Country
Laani
Kunta

Postal Code

Country
Region
Department
Commune

Postal Code

Country
Bundesland
Gemeinde

Postal Code

Country
County
Township

Postal Code

Country
Periferia
Nomi
Dimotika

Postal Code
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Map to Attribute

County
City

Postal code

Country
Province
County
City

Postal code

Country
State
City

Postal code

Country
State
City

Postal code

Country

Additional address
attribute 1

State
City

Postal code

Country
State
City

Postal code

Country
State
City

Postal code

Country
State
County
City

Postal code
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Country Name

Guadalupe

Guam

Guernsey

Hungary

Iceland

India

Indonesia

ORACLE

Country Code

GP

GU

GG

HU

Geography Type

Country
Commune

Postal Code

Country
State

County
Municipality
Village

Postal Code

Country
City
Parishes
Villages

Postal Code

Country
Megye
Jaras
Telepules
Settlement

Postal Code

Country
Jaras
Telepules
Settlement

Postal Code

Country
State
City

Postal Code

Country
Province
City

Postal Code
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Map to Attribute

Country
City

Postal code

Country
State
County
City

Additional address
attribute 2

Postal code

Country
City

Additional address
attribute 2

Additional address
attribute 3

Postal Code

Country

Additional address
attribute 1

Province
County
City

Postal code

Country
Province
County
City

Postal code

Country
State
City

Postal code

Country
Province
City

Postal code
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Country Name

Ireland

Isles of Man

Israel

Italy

Jamaica

Japan

Jordan

Kenya

ORACLE

Country Code

IE

M

P

JO

KE

Geography Type

Country
Province
Post County

Postal_Code

Country
Locality
Settlement

Postal Code

Country
District
Subdistrict
City

Postal Code

Country
Regione
Provincia
Comune

Postal code

Country
Parish

Settlement

Country
Prefecture
City

Postal Code

Country
Muhafazat
Liwa
Tajma

Postal Code

Country
County

Division
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Map to Attribute

Country
State
City

Postal Code

Country
City

Additional address
attribute 2

Postal code

Country
State
County
City

Postal code

Country

Additional address
attribute 1

Province
City

Postal code

Country
State

City

Country
State
City

Postal code

Country
State
County
City

Postal code

Country
State

City
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Country Name

Latvia

Liechtenstein

Lithuania

Luxembourg

Malaysia

Malta

Martinique

Mexico

ORACLE

Country Code

Lv

LI

LT

LU

MY

MT

MQ

MX

Geography Type

« Country
- Rajons
- Pilseta

- Postal Code

¢« Country

- Wahlkreis
+ Gemeinde
« District

- Postal Code

« Country

« County

e Municipality
- Ward

< Postal Code

« Country

« Canton

+ Commune

- Settlement

< Postal Code

< Country

- State

« District

. Subdistrict

< Postal Code

« Country
- Region
e Local Council

- Postal Code

« Country

+ Department

< Arrondisement

< Commune

- Postal Code

« Country
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Map to Attribute

Country
State
City

Postal code

Country

Additional address
attribute 1

State
City

Postal code

Country
State
County
City

Postal code

Country
State
County
City

Postal code

Country
State
County
City

Postal code

Country
State
City

Postal code

Country
State
County
City

Postal code

Country
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Country Name

Netherlands

New Zealand

Norway

Oman

Peru

Poland

Portugal

ORACLE

Country Code

NL

NZ

NO

oM

PE

PL

PT

Geography Type

State

Municipality

Locality

Postal Code

Country

Province

Municipality

Town

Postal Code

Country
Region
Town

Postal Code

Country
Fylke
Kommune

Postal Code

Country
Muhafazah
District

City

Country
Region
Provincia
Distrito

Postal Code

Country
Wojewodztwo
Powiat
Gmina

Postal Code

Country
Distrito
Concelho

Settlement
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Map to Attribute

State
County

Additional address
attribute 2

Postal code

Country
Province
County
City

Postal code

Country
State
City

Postal code

Country
Province
City

Postal code

Country
State
County

City

Country
Province
County
City

Postal code

Country
Province
County
City

Postal code

Country
Province
County

City
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Country Name Country Code Geography Type Map to Attribute

- Postal Code - Postal code
Puerto Rico PR . Country Country

- Commonwealth State

¢ Municipio County

- Barrio City

- Postal Code

Postal code

Qatar QA + Country Country
e« Municipality State
¢ Zone City
Reunion Island RE - Country Country
- Region State
- Department County
- Commune City
< Postal Code Postal code
Romania RO - Country Country
+ Regiune Additional address
attribute 1
« Judet
Province
- Settlement
County
« Comuna
City
- Postal Code
Postal code
Russia RU . Country Country
+ Federal District Additional address
attribute 1
+ Federal_Subject
State
- Oblast
City
- Postal Code
Postal code
San Marino SM - Country Country
« Comune State
- Postal Code Postal code
Singapore SG + Country Country
- Region State
- District City
< Postal Code Postal code
Slovakia SK - Country Country

ORACLE
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Country Name

Slovenia

South Africa

South Korea

Spain

Sri Lanka

Swaziland

Note:
This country maybe labeled

Eswatini in Manage Territories.

ORACLE

Country Code

Sl

ZA

KR

ES

LK

Sz

Geography Type

Kraj
Okres
Obec

Postal Code

Country
Regija
Upravna Enota
Obcina
Settlement

Postal Code

Country

Province

District Municipality
Local Municipality

Postal Code

Country
Jibang
Siti

Postal Code

Country

Autonomous Community
Province

City

Postal Code

Country
Province
District
Divisional Secretariat

Postal Code

Country
District
Inkhundla
Town

Postal Code
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Map to Attribute

Province
County
City

Postal code

Country

Additional address
attribute 1

Province
County
City

Postal code

Country
Province
County
City

Postal code

Country
State
City

Postal code

Country

Additional address
attribute 1

Province
City

Postal code

Country
Province
County
City

Postal code

Country
Province
County
City

Postal code
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Country Name

Sweden

Switzerland

Taiwan

Thailand

Tunisia

Turkey

United Arab Emirates

United States

ORACLE

Country Code

SE

CH

T™W

TH

TN

TR

AE

us

Geography Type

Country
Lan
Settlement

Postal Code

Country
Kanton
Bezirk
Gemeinde

Postal Code

Country
County
Town

Postal Code

Country
Region
Changwat
Amphoe

Postal Code

Country
Governorate
Delegation

Postal Code

Country
Sehir
Ilce
Kasaba

Postal Code

Country
Emirate
City

Area

Country
State

County
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Map to Attribute

Country
Province
City

Postal code

Country
State
County
City

Postal code

Country
State
City

Postal code

Country

Additional address
attribute 1

State
City

Postal code

Country
State
City

Postal Code

Country
Province
County
City

Postal code

Country
State
City

Additional address
attribute 2

Country
State

County
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Country Name Country Code Geography Type Map to Attribute
. City ¢ City
Postal Code « Postal code
Uruguay Uy - Country + Country
- Departamento + State
- City + City
Postal Code - Postal code
Vatican City VA . Country - Country
¢ Municipal « Province
Settlement « City
Postal Code + Postal code
Vietnam VN + Country . Country
- Region + Additional address
A attribute 1
e Tihn
Province
¢ Quan
County
- Thank Pho
City

Postal Code
Postal code

Note: For either the tax or address validation, don't skip any level unless you're certain that the selected geography
types can uniquely identify geographies. For example, the United States country structure is: State, County, City,

and Postal Code, and you want to select just State and Postal Code for address or tax validation. However, for the
combination of California and 94065, the city can be either Redwood Shores or Redwood City. In this case, you should
also select at least the City geography type for address or tax validation.

Address Validation Control

You can select the address validation level for a country. Validation will check if the entered address maps to the
geography hierarchy data available for the country, and the address validation control determines whether you can save
an address that didn't pass validation during address entry. For example, if the validation level is Error, then an address
can't be saved if the values don't match the geography hierarchy data.

These are the address validation levels you can choose:

- Error - only completely valid addresses can be saved, with all mandatory address elements entered.

- No Validation - all addresses can be saved including incomplete and invalid addresses.

Regardless of the result of validation, the validation process will try to map any address attribute to a geography of

the country, and store any mapping it could establish based on the available data. This is called Geography Name
Referencing and it's executed as part of validation. The result of this referencing is used in several business processes
in the application to map an address to a specific geography or zone. Therefore, Geography Name Referencing is

the process of validating and mapping address elements of existing location table records against master reference
geographies. For example, CA value in the STATE column of the HZ_LOCATIONS table is mapped to the master
reference geography of CA (California).
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The Geography Dimension value in territories is derived from sell-to addresses of sales accounts. To use geography
dimensions in territories, you must validate the geography elements in the addresses, such as state, city, and postal
code. You can validate the address by enabling geography validation for each country using the Manage Geographies
task. Perform the following in the Manage Geographies task:

Enable at least one level in the geography hierarchy for geography validation.

Enable geography validation for all geography levels that you intend to use for territory definition for each
country.

If needed, enable a list of values containing specific geography elements. This will help users search and select
appropriate geography values during addresses entry and eliminate all possibilities of wrong address entry.

You can set geography validation control to Error in the Manage Geography Validation page. This ensures that users can
only use valid geography elements in addresses.

Note: If you have already created addresses before setting up address validation for a country, you must enable
geography validation and then execute the Validate Geographies of Addresses Against Master Geographies task for
that country. This validates all your geography elements.

Related Topics
- How can | save an address that didn't pass geography validation?
- Setting Up Geography Validation
- How do | validate geographies of addresses against master geographies and generate naming references?

Setting Up Geography Validation

You must set up geography validation to enable geography setup, help users fill in missing address information, and
validate address information. For example, if you enter the postal code you can retrieve the rest of the address, such as,
city and state.

For example, an organization named Vision Corp., wants its salespeople to use a list of values to enter the states in their
addresses. Also, it plans to set up territories at the state level. So validation must be set up at the state level.

To define geography validation for Vision Corp.:

1. Click Navigator > My Enterprise > Setup and Maintenance work area.

2. Click the Tasks menu and click Search. Search for Manage Geographies.

3. Search for a country. For example, you can search by entering either the country name United States or the two
letter ISO code US, and clicking Search. Search for a country. For example, you can search by entering either the
country name United States or the two letter ISO code US, and clicking Search.

4. Select the country, such as United States, in the Search Results area.

5. C(lick the Go to Task button in the Validation Defined column.

The Manage Geography Validation page appears. The geography types available for the country are shown in
the Geography Mapping and Validation region.

6. Ensure that the No Styles Format address style is selected. You define validation for the No Styles Format
address style so that the validations are performed for all addresses in the country.
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7. Select Enable List of Values in the Geography Mapping and Validation region to display the geography type as
list of values during address entry in user interfaces. For example, for Vision Corp, select Enable List of Values

for State.

This ensures correct values are entered for states, so that territory assignments work.

Note: You should only enable a list of values if you have sufficient geography data for that geography type.

8. Select Geography Validation for a geography type to include it in geography validation. For example, for Vision
Corp, select Geography Validation for State.

.Munuge Geography vValdation: United States
Address Style

Actions * Yiew + Format - +
Address Style Format
Mo Styles Format

Address Style Format Mapping: Ho Styles Format

Geography Mapping and validation

— Ge
Geagraphy Type Map to Atinbute Enable List of Vakmes Tax Valdaton .‘,:i'i?:f
State State [+

County County

City ity

WE]E]

|
|
Postal Code Posital code ]

Geography Validation Control

Geography Validation Level for Country Tl

You must enable geography validation for all geography levels that you intend to use for territory definition.
The territory assignments may fail if the geography data used isn't validated. If Vision Corp. decided to set up
territories at the postal code level, it would have to set up validation for state, city, county, and postal code.

Note: If an address element isn't selected for geography validation usage, then during address entry
suggested values will be provided for the address element, but the address element isn't validated.

9. Select the appropriate geography validation control level to determine whether you can save an address that
fails validation during address entry. For example, Vision Corp. wants to save all addresses including incomplete
and invalid addresses, so select No validation in the Geography Validation Level for Country list.

Note: If Vision Corp. decided to save only valid addresses, it would have to set the geography validation
control level to Error in the Geography Validation Level for Country list.

10. Click Save and Close.

Best Practices for Geography Validation

After geography data setup, you must configure geography validations.
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Here are some best practices to configure geography validation:

- The configuration of geography validation rules depends upon your application needs. If you want to ensure
that only valid addresses must are allowed:

a. Navigate to Manage Geographies, search for a country, and click Validation Defined.
b. Set Geography Validation based on the application requirements.

Note: For either the tax or geography validation, don't skip more than one consecutive level unless
you're certain that the selected geography types can uniquely identify geographies. For example, the
United States country structure is: State, County, City, and Postal Code, and you want to select just
State and Postal Code for geography or tax validation. However, for the combination of California and
94065, the city can be either Redwood Shores or Redwood City. In this case, you should also select at
least the City geography type for geography or tax validation.

c. Set the Geography Validation Level for Country in the Geography Validation Control section to Error.

If you require validated addresses for your downstream applications:
a. Go to Manage Geographies, search for a country, and click Validation Defined.
b. The best practice is Enable List of Values and setup validation for all geography levels and geography

types.
c. Run the Validate Geographies of Addresses Against Master Geographies scheduled process to review
address validation results.

- To ensure that the addresses are validated and there are no downstream impacts:

a. Go to Manage Administrator Profile Values and set the Number of workers for a given Geography Name
Referencing request (HZ_GNR_NUM_OF_WORKERS) profile option to 5.

b. Run the Validate Geographies of Addresses Against Master Geographies scheduled process with
Parameters: Location Table Name: HZ_LOCATIONS, Run Type: ALL, Country Code: [Country code for
which Geography Name Referencing (GNR) needs to be generated)].

c. Run the Validate Geographies of Addresses Against Master Geographies scheduled process with
Parameters: Location Table Name: PER_ADDRESSES_F, Run Type: ALL, Country Code: [Country code for
which GNR needs to be generated].

d. You can then use the report: to identify if the existing addresses are incorrect. Correct these addresses as
a onetime activity.

How do | manage Geography Structures, Hierarchies, and
Validation?

You can add geography structure by first defining the geography types using the Manage Geographies task. You can
then create geography hierarchy and geography validations also using the Manage Geographies task.

This example shows how you can configure the geography structure, geography types within the structure, geography
hierarchy, and geography validation for a country geography, using the United Kingdom country geography as an
illustration.

The following table summarizes the key decisions for this scenario.
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Decisions to Consider In This Example
Copy an existing country structure? No, create a new country structure.
What is the structure of the geography Create geography types with the following ranking structure:
types?
1. County

2. Post Town

What is the geography hierarchy? Create the following hierarchy:

1. Country of United Kingdom
2. County of Berkshire
3. Post Town of Reading

Which address style format will you use The default address style format called the No Styles Format.
when mapping geography validations?

Are you using Oracle Fusion Tax for tax No, don't select Tax Validation for the geography types.
purposes?

Define the Geography Structure
You can add the County and Post Town geography types to the United Kingdom geography structure.

1
2,

W

0o u b

On the Manage Geographies page, enter GB in the Code field. Click Search.
On the Manage Geographies page, click Structure Defined.

On the Manage Geography Structure page, click the Create button next to the Copy Country Structure From
field.

In the Geography Structure section, select the County list item in the Add Geography Type field.
Click Add.

Select the Post Town list item in the Create and Add Geography Type field.

Click Add.

Click Save and Close.

I Note: You can't modify or delete a geography type.

Define the Geography Hierarchy

You can add the geographies for the County and Post Town geography types using the geography hierarchy user
interfaces to create the geography hierarchy for United Kingdom. You can also use Import Management to import
geography hierarchies using a CSV or XML file.

1.

On the Manage Geographies page, enter GB in the Code field. Click Search.
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2. Onthe Manage Geographies page, click Hierarchy Defined.

OO U kW

Note: If there are many child geographies for the selected parent geography, a message asking you to
refine the search criteria is displayed. The child geographies are displayed after you refine the search
criteria. If there are many search results, you may have to further refine the search criteria. The maximum
number of child geographies that can be displayed is controlled by the ORA_HZ_GEO_HIERARCHY_LIMIT
profile option. You can change the value of this profile option by navigating to the Setup and Maintenance
work area, click the Tasks menu, and search for Manage Administrative Profile Values task. Search for the

ORA_HZ_GEO_HIERARCHY_LIMIT profile option and change the value.

In the Geography Hierarchy section, click United Kingdom to highlight the table row, and click Create.
In the Create County page, Primary and Alternate Names section, enter Berkshire in the Name field.
Click Save and Close.

In the Geography Hierarchy section, click Berkshire to highlight the table row, and click Create.

In the Create Post Town page, Primary and Alternate Names section, enter Reading in the Name field.
Click Save and Close.

Define the Geography Validations

You can define the geography mapping and validation for the United Kingdom default address style format to specify
the geography validations for the geography types you added to United Kingdom. You can then map the geography
types to attributes, enable the geography types for Lists of Values and Geography Validation, and set the geography
validation level.

OO U A WNRA

On the Manage Geographies page, click Validation Defined.

In the Address Style section, click No Styles Format to highlight the table row.

For the County geography type, click the County list item in the Map to Attribute field.

Select the Enable List of Values and Geography Validation options.

For the Post Town geography type, click the City list item in the Map to Attribute field.

Select the Geography Validation option.

In the Geography Validation Control section, select Error in the Geography Validation Level for Country list.
Click Save and Close.

Considerations While Working With Master Geographies

Considerations for working with master geographies:

- You can update master geographies using the Manage Geographies page, but you can't update master

geographies using Import Management.

- Countries are predefined so you can't delete them. You can delete the geography levels of a country in the

geography hierarchy, such as state, city, and so on using the Manage Geographies page.

If you delete the geography levels of a country in the geography hierarchy, such as state, city, and so on, you
must manage the impact of these changes in the downstream applications, such as SCM, ERP, HCM, and so on.

If you delete a geography level, all the children in that geography hierarchy are also deleted. For example, if you
define city and postal codes under a state, and you later delete the state, all the cities and postal codes under
this state are also deleted.
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Manage Geography Lookups

You can manage geography lookups using the Manage Geography Lookups.

Perform these steps:

Chapter 6
Geographies for HCM

1. Click Navigator > My Enterprise > Setup and Maintenance work area and go to the following:

o Offering: Sales

o Functional Area: Sales Foundation

o Task: Manage Geography Lookups

2. Onthe Manage Geography Lookups page, click any of the following lookups:

Lookup Type

HZ_GEOGRAPHY_USAGE

HZ_GEO_DISPLAY_ONLY

HZ_GEO_GNR_RUN_TYPE

HZ_GEO_IDENTIFIER_TYPE

HZ_GEO_POSTAL_CODE_RANGE_FLAG

HZ_GEO_DATA_PROVIDER

HZ_GEO_IDENTIFIER_SUBTYPE

ORACLE

Meaning

Geography Validation Purpose

Zone Definition

Geography Name Referencing Program Run
Type

Geography Identifier Type

Postal Code Range Provided

Geography Information Provider

Geography Identifier Subtype

Description

Purpose of geography validation, for
example, tax. This lookup type can't be
edited.

Interface elements used to define zones.
This lookup type can't be edited.

You can specify the type of records that
must be processed using the geography
name referencing (Validate Geographies
of Addresses Against Master Geographies)
scheduled process. This lookup type can't
be edited.

Identifier type for geography, for example,
name or code. This lookup type can't be
edited.

Values indicate whether a postal code range
was used to define a set of postal codes.
This lookup type can't be edited.

Names of the source of geography
information. You can add new geography
providers.

Identifier sub type for geography, for
example, primary. You can specify the
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Lookup Type Meaning Description

primary and secondary names and codes
for geographies.

3. View or edit the values as applicable.
4. Click Save and Close to return to the list of lookups.
5. Click Done to exit the page.

Manage Territory Geography Splits

You must group territory geographies into group zones to manage territory geography level splits. Grouping the
territory geographies involves two steps, selecting the geography level based on which you need grouping and initiating
the grouping.

Select the Geography Level for Grouping

You can perform these steps to select the geography level based on which you want to create the group zones:

1. Signin as a set up user such as Application Implementation Consultant.
In the Setup and Maintenance work area, go to the following:

o Offering: Customer Data Management
o Functional Area: Enterprise Profile
o Task: Manage Geographies

3. Search for the country for which you want to enable territory geography level grouping.

Click Structure Defined. Manage Geography Structure page appears.

5. Select the Subject to Grouping check box corresponding to the geography type level for which you want to
enable grouping.

>

You must select the geography level that suits your business requirements. For example, if your product
delivery is based on postal code, and your territory geographies don't have higher levels of master geographies
such as counties and cities, then you may have postal code splits. In this case you must select postal code as
the geography type level for grouping.

I Note: You can enable grouping for only one level at a time.

6. Click Save and Close.

Initiate Grouping
Here are the steps to initiate grouping:

1. Inthe Setup and Maintenance work area, go to the following:
o Offering: Sales
o Functional Area: Territories
o Task: Manage Territory Geographies
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The Manage Territory Geographies page opens.
2. (lick Initiate Grouping.
3. Click OK in response to the warning message and confirm the process.

Note: You can't automatically un-group the grouped territory geographies. You can manually undo the
grouping process by recreating territory geography hierarchy either through the Ul or import process.

The geography level that you selected for grouping appears as an expandable Group Zone when the grouping
is complete is shown in the following figure.

‘,
4. C(lick Save and Close.

How Territory Geographies are Grouped

This topic describes how we can overcome the problem of territory geography splits by grouping them into group
zones.

Note: The information in this topic is obsolete. Use the Address dimension for geographical territories.

You do a territory geography grouping when any of your territory geography levels has multiple splits. A territory
geography splits occur when the lower level master geographies are added to territory geography hierarchy, while
skipping the higher level master geographies. This may cause multiple occurrences of the lower geography level
members in a territory geography hierarchy.

For example, postal code split happens when a postal code overlaps across many master geography levels such as cities
and counties. Suppose that the business firm Vision Corp. delivers its product according to the postal codes. If counties
and cities aren't included in the territory geography hierarchy of Vision Corp., then the end user can see the multiple
occurrences of the postal code 97229.

When there is a territory geography level split, and if you want to group the split geographies, first you must specify

the master geography level for which you want the grouping to be performed, then initiate grouping. When grouping

is performed, all the splits of the selected master geography level get grouped under a new group zone. In the previous
example, if you select postal code in the master geographies as the level for grouping and initiate the grouping process,
then the 12 postal code splits for the postal code 97229 gets grouped together under one group zone named 97229. So,
the Territory Manager user can define territories on a clean list of postal codes or their ranges, although some of those
postal codes would in fact be the groupings of the postal code splits. The grouped splits are hidden for the Territory
Manager user.
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What are the best practices for managing Geography
mismatches?

This topic employs a couple of use cases to illustrate the best practices for setting up Master Reference Geographies
for sales customers using the Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) for Sales for data
enrichment and the Oracle Address, Email, and Phone Verification for address, email, and phone number verification.

When you perform the real-time enrichment of accounts or contacts using the Oracle Account and Contact Enrichment
by Dun & Bradstreet (D&B), if there's a geography data mismatch between the predefined master geography data

and the Dun and Bradstreet (D&B) data, then the Service enriches the accounts and contacts data but you can't edit

or save the enriched data unless the master geography data mismatches are resolved. In addition, you can verify the
enriched address using the Oracle Address, Email, and Phone Verification, however, in case of mismatches between
Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) (Logate) and predefined master geography data
you can't save the verified address.

The second use case describes the setup required to enable address verification and to avoid data conflicts between the
Oracle Address, Email, and Phone Verification and master reference geography data.

Use Case 1

You're a sales customer using master reference geographies for territory assignments or tax calculation and have
purchased Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) for data enrichment and Oracle
Address, Email, and Phone Verification. In this case, while the Loqate geography reference data is configured as master
geography, Tax calculation is being done using Vertex master geography data. Also, address validation is enabled based
on the customer's requirement.

Best Practice: Review geography mapping for the countries where you do business. If the geography mapping for
a specific country isn't mapped according to the country-specific address attributes, update the mapping. Oracle
recommends performing enrichment before verifying address.

Suppose that you're doing real time enrichment of account or contact. If there's a geography data mismatch between
the predefined master geography and the D&B data, the Oracle Account and Contact Enrichment by Dun & Bradstreet
(D&B) still enriches the accounts and contacts data but can't edit or save the enriched account or contact unless the
master geography data mismatches are resolved. However, you can verify the enriched address using the Oracle
Address, Email, and Phone Verification.

To save a verified address that has master geography data mismatch, you must add alternative names for the
mismatched hierarchy elements in master geography. The following are the steps to add alternative name for the
mismatched hierarchy element:

1. Inthe Setup and Maintenance work area, go to the following:

o Offering: Customer Data Management
o Functional Area: Enterprise Profile
o Task: Manage Geographies
2. Onthe Manage Geographies page, search for the country by the name or country code, for example US.
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3. Click the Go to Task button in the Hierarchy Defined column. The Manage Geographies Hierarchy page for the
particular country appears.

Note: If there are many child geographies for the selected parent geography, a message asking you to
refine the search criteria is displayed. The child geographies are displayed after you refine the search
criteria. If there are many search results, you may have to further refine the search criteria. The maximum
number of child geographies that can be displayed is controlled by the ORA_HZ_GEO_HIERARCHY_LIMIT
profile option. You can change the value of this profile option by navigating to the Setup and Maintenance
work area, click the Tasks menu, and search for Manage Administrative Profile Values task. Search for the
ORA_HZ_GEO_HIERARCHY_LIMIT profile option and change the value.

4. Highlight the mismatched hierarchy element, for example California State, and click the Edit icon.
5. Click the Add icon on the Edit page.

6. Add an alternative name CA for the California state geography element.

7. Click Save and Close

Once the alternative name is added for the mismatched hierarchy element in master geography, you can save the
enriched address.

Use Case 2

You're a sales customer who doesn't use geographies for territory assignment or tax calculation and has purchased
Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) for data enrichment and the Oracle Address, Email,
and Phone Verification for address verification. To enable address verification and to avoid data conflicts between the
Oracle Address, Email, and Phone Verification and master reference geography data you must do the following setups:

Deselect the Geography Validation option in the Geography Mapping and Validation region to avoid Oracle
Address, Email, and Phone Verification data conflicts with master reference geography data. By deselecting this
option you can avoid any Ul level validation against master geographies while adding address.

- Select Geography Validation Level for Country as No validation to verify address data by Oracle Address, Email,
and Phone Verification.

Perform the following steps on the Manage Geography Validation page to enable address verification and to avoid data
conflicts between the Oracle Address, Email, and Phone Verification and master reference geography data:

1. Inthe Setup and Maintenance work area, go to the following:
o Offering: Customer Data Management

o Functional Area: Enterprise Profile
o Task: Manage Geographies

On the Manage Geographies page, search for the country by the name or country code, for example US.

3. Click the Go to Task button in the Validation Defined column. The Manage Geography Validation page appears.
4. Deselect the Geography Validation check boxes for all the geography attributes to avoid any Ul level validation
against master geographies while entering the addresses. If the Enable List of Values check boxes are selected
then, in case of data conflicts, Geography Naming References records aren't created.

N

Note: If any of the Geography Types listed isn't applicable to the selected country's territory structure, then you must
deselect the geography validation for that type.

If you're planning to create territories based on a particular Geography Type, such as County, then you must deselect all
the Geography Validation levels under that Geography Type (in this case City and Postal Code) based on which you want
to create the territory.
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Tip: Review the Address Style Formats that are selected on the Manage Geography Validation page. The review is
required because on the Account or Contact Simplified Ul page, address attributes are displayed based on the address
formats and verified or enriched addresses are saved in Oracle Applications Cloud based on the selected address
formats.

Related Topics

Overview of Zone Types and Zones

Geography hierarchy is a data model that creates conceptual parent-child relationships between geographies.
Geography hierarchies can be classified as follows:

Master Reference Geography Hierarchy: This refers to the predefined geography hierarchy and is considered
as the source of truth. It is defined by widely recognized administrative or political boundaries such as States,
Provinces, Counties, Cities, and so on. This hierarchy can be obtained from a supplier or manually entered.
This geography hierarchy is the source when validating addresses or importing data. Examples are the State of
California, the Province of Alberta, The Country of India, and so on.

- User Defined Geography Hierarchy: This refers to geography hierarchy defined by the user. This geography
hierarchy may be created using the Master Reference Geography, obtained from a supplier, or entered
manually. A user-defined geography hierarchy can have:

o Zone Types

o Zones

Zone Types

Zone types categorize and group zones together, for example, the zone types of Income Tax and Shipping Regions.
Zone types need to be created before you define a zone for the geographical boundary. You can create a zone type
which will contain geographical boundaries from anywhere in the world, or you can create a zone type that will only

contain geographies from within a specified country. When you create a zone type that's bounded by a country you can
define which geography types or geographies you will be able to choose when you create a zone.

Zones
Zones are geographical boundaries for a zone type, for example, the San Jose Tax zone. Zones are based on the master
reference geography hierarchy data.

Zones are created within a zone type, and you can associate geographies to define the zone. For example, for

the Shipping Regions zone type you can create a West Coast zone which has the state of California as one of its
geographies. Within a geography you can specify a postal range. So, for the state of California, for example, you can
specify that the zone spans from postal code 90001 to 90011.

Zones Created in Master Geographies

Here is the list of zones created using master geographies in each product offering and the tasks to load them:
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Product Offering Task Name
Territory Geographies Manage Territory Geographies
Tax Manage Tax Zone Types
Shipping Manage Shipping Zones
Compensation Compensation Zones

Note: There are no bulk loaders for loading these zones.

For more information about creating zone types and zones, see the Related Topics section.

Related Topics
« Manage Zone Types and Zones for Shipping and Tax

» Configure Compensation Zone Types and Zones

Import Geographies and Zones

How do | import geographies?
A geography, such as Tokyo or Peru, describes a boundary on the surface of the earth.

You can use the following options when importing geographies:

- Oracle-licensed geography reference data

Import Management

Note: The processing time for importing geography data can vary based on several variables, such as, the volume of
data to be loaded and it could take several hours to complete.

Oracle-Licensed Geography Reference Data

You can import Oracle-licensed data from Logate, for those countries where the data is available. For more information
about the supported countries, see the List of Available Countries with Logate Geography Reference Data topic. You

can import geography data using the Manage Geographies task. Search for the country, and select Import Geography
Data from the Actions menu. If the licensed data isn't available or already set up for a particular country, then the
Import Geography Data action is disabled.
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Note:
If you are licensed to use HCM Cloud Payroll for the United States, you must import your geography data from
Vertex. For more information, see the United States Payroll implementation and administering guides.

If you are licensed to use HCM Cloud Payroll for Canada, you can import your geography data from either
Loqgate, or your own geography data vendor. Logate is the Oracle-licensed geography vendor across all Oracle
applications, but it isn’t mandatory. You may use any other geography vendor, but it must be comparable in
structure by using a 2-character province code. For more information, see the Canada Payroll implementation
and administering guides.

By exporting this "Geography" data from the Oracle environment to Your environment, You agree that (a)
Oracle is granting You only a restricted right to download the exported data specifically for Your use with the
Oracle Fusion services, (b) this data may not be used, transferred, or uploaded for any other purposes; and (c)
except for the restricted right granted in (a), all provisions of the Oracle Cloud Services Agreement (CSA) or
Schedule C, as applicable to You, remain in full force and effect, including specifically section 3.4 thereof.

Geography Round-Trip Export Import is currently not supported.

Import Management

The Import Management process reads the data included in your XML or text file and imports the data into the
application.

To access Import Management functionality, go to Navigator > Tools > Import Management

For more information, see the Import Your Geography Data topic.

Import Geography Data is disabled for a country if the geography data for that country isn't available from Logate or if
the geography structure or hierarchy is already defined for that country. The existing master geography hierarchy can
be from Logate or non-Logate. For example, Pakistan isn't supported currently in the supported list of 82 countries. If
you try to import geography data for Pakistan after defining geography structure or geography hierarchy for it, Pakistan
would be greyed out in the import list.

Related Topics
» Create Legal Jurisdictions, Addresses and Authorities

» Overview of Implementing Customer Data Management
« Setup Data Import and Export for Oracle Accounting Hub Cloud
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List of Available Countries with Logate Geography Reference Data

Oracle Applications Cloud provides third-party Logate geography data for import. Here's the list of countries for which
the Loqate geography data is available for import.

Country Name Country Code
Andorra AD
Angola AO
Argentina AR
Australia AU
Austria AT
Belgium BE
Bolivia BO
Bosnia and Herzegovina BA
Brazil BR
Bulgaria BG
Canada CA
Cayman Islands KY
Chile CL
China CN
Croatia HR
Cuba cu
Cyprus cY
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Country Name

Czech Republic

Denmark

Dominican Republic

Ecuador

Estonia

Finland

France

Germany

Great Britain

Greece

Guadalupe

Guam

Guernsey

Hungary

Iceland

India

Indonesia

Ireland

Isles of Man

Israel

Italy

ORACLE

Country Code

cz

DK

DO

EC

EE

Fl

FR

DE

GB

GR

GP

GU

GG

HU
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Country Name

Jamaica

Japan

Jordan

Kenya

Latvia

Liechtenstein

Lithuania

Luxembourg

Malaysia

Malta

Martinique

Mexico

Netherlands

New Zealand

Norway

Oman

Peru

Poland

Portugal

Puerto Rico

Qatar

ORACLE

Country Code

M

JP

JO

KE

Lv

LI

LT

LU

MY

MT

MQ

MX

NL

NZ

NO

oM

PE

PL

PT

PR

QA
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Geographies for HCM

76



Oracle Fusion Cloud HCM Chapter 6

Using Common Features for HCM Geographies for HCM
Country Name Country Code
Reunion Island RE
Romania RO
Russia RU
San Marino SM
Singapore SG
Slovakia SK
Slovenia Sl
South Africa ZA
South Korea KR
Spain ES
Sri Lanka LK
Swaziland SZ
Sweden SE
Switzerland CH
Taiwan TW
Thailand TH
Tunisia TN
Turkey TR
United Arab Emirates AE
United States us
Uruguay uy
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Country Name Country Code
Vatican City VA
Vietnam VN

How do | replace the existing master geography data with revised
Oracle-Licensed geography data?

You must import and set up reference geography data for the countries where you do business.

Using the Oracle-licensed geography reference data, you no longer have to source geography data from a third party.
You can import Oracle-licensed data from Loqate, including the country structure and hierarchy information, either to
create a new geography setup or replace your existing geography data.

All customers with the exception of United States HCM Payroll customers, can use the information in this section to
replace existing geography data with Loqgate geography data. You can follow these steps if you're using Nokia or any
other geography data and now want to move to Logate geography data.

Before you begin, perform the following steps:

Backup existing geography data including customizations, if any.
Backup territory geographies.

Perform impact analysis by contacting the support team to identify the use of geography IDs downstream.

Note: Before deleting the geography data, make sure that GEOGRAPHY_ID isn't referenced in any downstream
applications such as TAX, FIN, Legal, and so on. Geography data is used across Oracle Cloud applications such as
Human Capital Management, TAX, and Legal. Global Single Instance POD users share the same geography data and
before deleting geography data, the geography usage POD analysis is required. The Oracle Support team can help you
identify the downstream impact.

Create an Export File of All Territories

In case you have implemented Customer Data Management along with the sales functionality, you must export all
territories before deleting the master geography data because removing the master geography data invalidates the
territory definitions that are based on the Geography dimension. You can either export the definitions of all territories to
a file or make manual corrections. If there are a large number of territories, export the territories definition to a file for
the territories import process. However, if there are very few affected territories, then you can choose to either export
the territories definition to a file or make corrections manually.

This procedure is applicable only if there are territories defined using the Geography dimension.

Perform the following steps to create an export file of all territories.

From the Territories and Quotas work area, click View Active Territories in the Tasks pane.
In the View Active Territories page, select the territory at the highest level.

Click the Actions list, and select Export, and then Export Selected Territory Hierarchy.

In the Warning dialog box, click OK.

PUNA
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5. Click the Actions list and select Export, and then View Export Status.

6. Review the status of the export job and verify if it has completed successfully.

7. Inthe Exported Data File column, click the .zip file against your export job, and click Save. All the territories are
exported to a compressed file on your system.

8. Click OK.

9. Click Done in the View Active Territories page.

Delete the Territory Geography Data

A territory definition has references to the territory geography data and master geography data. Territory geography
data is based on the master geography data, in case you have implemented Customer Data Management along with the
sales functionality, you must delete the territory geography data prior to deleting the master geography data. When you
delete the territory geography data, all territories that are defined using geography dimension become invalid.

This procedure is applicable only if territory geographies are defined.

Perform the following steps to delete the territory geography data.

1. In the Setup and Maintenance work area, go to the following:
o Offering: Sales

o Functional Area: Territories
o Task: Manage Territory Geographies

N

On the Manage Territory Geographies page, click View All Hierarchies.

3. Select the highest level node for the country for which you want to replace the master geography data and click
the Delete icon.

4. Inthe Warning dialog box, click OK.

5. Inthe Confirmation dialog box, click OK. The parent node of the territory geography data and its children are
deleted.

6. Repeat steps 3 to 5 to delete all the higher nodes in the territory geography data.

7. Click Save and Close.

The Territory Management application retains a copy of the dimension members referenced in the territory definitions.
This copy is updated when you trigger the Load and Activate process from the Enable Dimensions and Metrics task.
Therefore, although the territory geography data is deleted, the territory definitions may appear to remain valid.

Delete the Master Geography Data

Delete the existing geography data one country at a time. We recommend that you raise a service request for assistance
in deleting the geography data.

Delete Geography Structure

If you have created a geography structure, it prevents the geography imports from working or working as desired. For
example, if the geography structure exists, the Import Geography option may not be enabled for a country in Manage
Geographies even if Loqate predefined geography data is available for that country and the geography hierarchy doesn't
exist yet.

Note: If any geography hierarchy was created manually, it must be deleted first.

If the geography structure was created manually, you can follow these steps to delete it. However, we recommend that
you raise a service request for assistance in deleting the geography structure.

1. Inthe Setup and Maintenance work area, go to the following:
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o Offering: Customer Data Management
o Functional Area: Enterprise Profile
o Task: Manage Geographies

2. Onthe Manage Geographies page, enter either the country name or the two-letter ISO code (for example, US),
and click Search.

3. Select the country in the search results and click Actions > Manage Geography Structure.

4. Inthe Manage Geography Structure page, delete each level of the structure.

5. Click Save and Close.

You can now proceed to importing geography data.

Note: If other setup or transaction data exists that's based on the geography data, replacement procedures for that
setup must also be followed.

Import Oracle-Licensed Geography Reference Data

Use this procedure to import Logate geography data in Manage Geographies one country at a time. If the country data
you want isn't supported by Logate geography seed data and point the Logate supported country list here, then the
Import Geography Data action is disabled.

The geography data is provided by Logate and is third-party content. As per Oracle policy, this software and
documentation may provide access to or information about content and services from third parties. Oracle and its
affiliates aren't responsible for and expressly disclaim all warranties of any kind with respect to third-party content and
services. Oracle and its affiliates aren't responsible for any loss, costs, or damages incurred due to your access to or use
of third-party content, products, or services.

Perform the following steps to import Oracle-licensed geography reference data.

1. Inthe Setup and Maintenance work area, go to the following:
o Offering: Customer Data Management
o Functional Area: Enterprise Profile
o Task: Manage Geographies

2. On the Manage Geographies page, enter either the country name or the two-letter ISO code (for example, US),
and click Search.

3. Select the country in the search results.

4. C(lick the Actions list, and select Import Geography Data.

Note: Import Geography Data is disabled for a country if the geography data for that country isn't available
from Loqgate or if the geography structure or hierarchy is already defined for that country. The existing master
geography hierarchy can be from Logate or non-Logate.

5. Inthe Warning dialog box, click OK.
6. In the Confirmation dialog box, click OK.

The import of larger countries may require several hours to complete.

You can track the progress of the import process by selecting Scheduled Processes from the Navigator.

Note: To access the Scheduled Processes work area, you must be signed in as a user with the Employee abstract role.
The initial user doesn't have this role assigned, but the other users you created do.
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After the import is complete, you can search for the country again in the Manage Geographies page. Check marks now
appear in the Structure Defined and Hierarchy Defined columns indicating the import completed successfully.

Next, click the Validation Defined icon to define the validations, enable List of Values, and choose address style format
for a country as set up before. For more information, see the Geography Validation topic.

The Geocoding Defined and Address Cleansing Defined columns are used for additional features which you must
license from Oracle and set up separately.

- Geocoding makes it possible to display customers in the vicinity of a mobile address. You set up Geocoding
Enabled for those countries where you're using Around Me functionality in CX Sales Cloud Mobile.

- Cleansing makes it possible to validate addresses down to the street level.

Add any geography customizations.

Run the Geography Name Referencing Process

The Geography Name Referencing (GNR) process validates address elements in location tables, such as
HZ_LOCATIONS, against the master geography data.

Run the GNR process in the following situations:

- When you are using geography based address validation (not third party address validation services).

- GNR data is needed for your business processes (such as ERP Tax).

Note: Note: You can't update existing data, such as effective start date, in the GNR process tables for the locations.

Perform the following steps to run the GNR process.

1. Navigate to Tools > Scheduled Processes work area.
On the Overview page, click Actions > Schedule New Process.

Click the Name list and search for Validate Geographies of Addresses Against Master Geographies, and
then click OK.

Click OK in the Schedule New Process dialog box.
In the Process Details dialog box, enter the following details:

WN

v B

o Location Table Name: HZ_LOCATIONS
o Run Type: ALL
o Usage Code: GEOGRAPHY

6. Enter the country code in the Country Code field.
7. Click Submit.
8. In the Confirmation dialog box, click OK.
9. C(lick Close.
10. In the Scheduled Processes page, click the Refresh icon.
11. Verify if the status of the process has completed successfully.

Find the locations failing in Geography Name References using: https://cloudcustomerconnect.oracle.com/posts/
ble16b0bae. Fix Geography Name References failures by updating addresses with the latest geography data.
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Recreate and Load the Territory Geography Data

In case you have implemented Customer Data Management along with the sales functionality, you can recreate the
territory geography data, after the master geography data is imported, using either of the following methods:

Import process: If you created the original territory geography data using the import process, then use the
same import file to recreate the territory geography structure. For more information about importing the
territory geography data using Import Management, see Import Your Sales Territory Data in the Oracle CX
Understanding Import and Export Management for CX Sales and Fusion Service guide.

Manual creation process: You can manually recreate the territory geography data structures, as they existed
before their deletion, using the Manage Territory Geographies task. For more information about creating zones
and adding geographies to a zone, see Managing Territory Geographies in the Related Topics section.

After you have recreated the territory geography data, perform the following steps to load the data.

1. Inthe Setup and Maintenance work area, go to the following:

o Offering: Sales
o Functional Area: Territories
o Task: Enable Dimensions and Metrics

2. On the Enable Dimensions and Metrics page, click the Actions list, and select Load and Activate. The
process loads the territory geography data to make dimension members available for selection when defining

territories.
3. Inthe Confirmation dialog box, click OK.
4. C(lick Done.

Restore the Invalid Territory Definitions

After recreating the territory geography hierarchies and running the Load and Activate option from the Enable
Dimensions and Metrics task, the geography dimensions are populated with the new geography members. The
geography members in the territory appear as invalid because your territories still reference the old copies of the
dimension members that were deleted. The new members aren't referenced automatically by the territories. You must
re-reference the territory definitions from the old geography dimension members to the new ones.

You can restore the invalid territory definitions by either importing the previously created export file or making manual
corrections to the territories.

To restore valid territory definitions using territories import:

1. Open the export file you saved in the Creating an Export File of All Territories step. The compressed file
contains four CSV files.

Open TERR_HEADER.CSV file.

Enter REPLACE in the Action column for all territories that are based on geography dimension.
Save the file in CSV format and compress it together with three other CSV files.

From the Territories and Quotas work area, click View Active Territories in the Tasks pane.
Click the Actions list, and select Import to Proposal, and then Import Territories.

Select the newly created compressed file and click OK.

Click the Actions list and select Import to Proposal, and then View Import Status.

Review the status of the export job and verify if it has completed successfully.

Click OK.

From the Tasks pane, click Manage Territory Proposals.
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12.

13.
14.
15.
16.
17.

In the Manage Territory Proposals page, on the Current Territory Proposals table, search for the proposal with
your import file name.

Click the import file name to open the territory proposal.

Click Edit Coverage to verify that the territory definitions are valid.

Verify that there are no values listed as invalid in the Selected Dimension Members section.

Click Save and Close.

Click Activate. The territory proposal of your import file is activated.

To restore valid territory definitions through manual corrections:

PUWUNA
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10.
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12.

From the Territories and Quotas work area, click Manage Territory Proposals in the Tasks pane.

In the Manage Territory Proposals page, click the Create icon.

In the Create Territory Proposals dialog box, enter a name and click Save and View.

In the Territory Proposals page, add all the territories with the Geography dimension value other than the value
Any to the proposal.

Select a territory and click Edit Coverage.

In the Edit Coverage page, select Geography from the Dimensions list. The invalid dimension members are
displayed in the Selected Dimension Members pane.

Expand the values in the Available Dimension Members section or search for the member that has the same
name as the one marked invalid in the Selected Dimension Members pane.

Select one or more new geography dimension members from Available Dimension Members pane and click
Add icon to the Selected Dimension Members pane.

Click the Remove icon to remove the invalid members from the Selected Dimension Members pane.

Click Save and Close.

Repeat steps 4 to 10 for all territories that were based on Geography dimension.

Click Activate. After the activation process is complete, your territory definitions are valid again and are
referencing to the new geography data.

Although this method is always applicable, it's most appropriate when you have to restore territory definitions for a
smaller number of territories.

To run the batch assignment process for opportunities:

1.

From Navigator, click Scheduled Processes.

In the Schedule Processes page, click Schedule New Process.

In the Schedule New Process dialog box, search for the Request Revenue Territory Assignment process and
select it.

Click OK.

In the Process Details dialog box, enter OpenOpportunitiesByCreationDate in the View Criteria Name field.
This selects all revenue lines belonging to open opportunities that were created in the last 'X' days.

Enter BindOptyCreationDateFrom= followed by the date.

For example, if BindOptyCreationDateFrom=2014-01-01, then all open opportunities which were created
between 1st January 2014 till the current date, are processed.

Click Submit to schedule the process.

In the Confirmation dialog box, make a note of the process identifier for monitoring the process, and click OK.
Click Close.

In the Schedule Processes page, click the Refresh icon.

Review the status of the process job and verify if it has completed successfully.

Note: Review a small subset of the open opportunities to confirm that the territory assignment is as
expected.
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To run the batch assignment process for sales accounts:

1.

PUunN
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Ensure that the ZCA_SA_AUTO_ASSIGN_ON_CREATE and ZCA_SA_AUTO_ASSIGN_ON_UPDATE profile
options are set to Yes in the Manage Customer Center Profile Options task.

From Navigator, click Customers.

In the Customers page, click Create Account.

In the Create Account page, enter a name and address of the sales account, and select the Address is sell to
check box.

Click Save and Close.

From Navigator, click Customers.

In the Search pane, search for the name of the sales account you created and select it.

In the section Customer Information, select Sales Account Team. The details of the sales account and
territories associated with the sales account are displayed.

This indicates that the sales account was created successfully and the batch assignment was run automatically
to assign the matching territories to the sales account.

To run the batch assignment process manually from the Scheduled Processes page, perform the following steps.

12
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From Navigator, click Scheduled Processes.

In the Schedule Processes page, click Schedule New Process.

In the Schedule New Process dialog box, search for the Request Account Assignment process and select it.
Click OK.

Enter SalesAccount_Work_Object in the Work Object Code field and
SalesAccountTerritory_Candidate_Object in the Candidate Object Code field.

Select Territory in the Assignment Mode list.

Enter AllSalesAccountsVC in the View Criteria Name field. This selects all sales accounts.

Click Submit to schedule the process.

In the Confirmation dialog box, make a note of the process identifier for monitoring the process, and click OK.
Click Close.

In the Schedule Processes page, click the Refresh icon.

Review the status of the process job and verify if it has completed successfully.

Note: Review a small subset of the accounts to confirm that the territory assignment is as expected.

Verify that the downstream applications using geography data is working fine.

Create Countries

This procedure lists the steps to create countries in the application.

The countries are seeded in the application. If you're unable to find a specific country in the Manage Geographies page,
then you can add it to the application.

Note: The application provides support for Loqate geography data for countries. For countries where Logate
geography data isn't available, you can purchase the geography data from a third-party data provider and load it into
the application using Import Management. For more information, see the Import Your Data chapter in the Oracle CX
Understanding Import and Export Management for CX Sales and Service guide. If countries aren't available in the
application, then use the procedure outlined in this topic to create them.
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Perform the following steps to create a new country.

1. Inthe Setup and Maintenance work area, go to the following:

o Offering: Customer Data Management
o Functional Area: Application Extensions
o Task: Manage Territories
2. On the Manage Territories page, click the New icon.
3. Enter the following details:
o Territory Code: Enter a unique code for the territory.
o Territory Name: Enter a unique name for the territory.
o Description: Enter a description for the territory.
4. Click Save and Close.

Note: After you have added a new country in the application, if you want to import the geography data for
that country, then you must perform Step 5 to 10.

5. In the Setup and Maintenance work area, go to the following:

o Offering: Customer Data Management
o Functional Area: Enterprise Profile
o Task: Manage Geographies

6. On the Manage Geographies page, click Actions > Create Country.
7. Inthe Create Country dialog box, select the name of the country and click Save.
8. Click Done.

Note: You can now import the geography data for the newly created country using Logate geography data available
in the application. In case geography data for your country isn't available from Logate, you can purchase the
geography data from a third-party data provider and import it using Import Management.

Related Topics
- How do | replace the existing master geography data with revised Oracle-Licensed geography data?

How do | import Non-Oracle Licensed geography data?

You can use Import Management to create Geography data. It's recommended to use import management if you're
importing Non-Oracle Licensed geography data or while loading your own geography from other vendors. You can
also add alternate name or code to existing geographies with import. For more information see Example of Importing
Geography Data.

To import Geography data, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
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4. Review the import results.

How You Map Your Source Data to Object Attributes
To import your Geography data into Oracle Applications Cloud, you must populate a .csv file with your source data and
map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.

- Create Country Structure before importing Geography data. For information on how to create Country
Structure, see Import Your Country Structure and Example of Importing Country Structure in Related Topics
Section.

- Identify the target object attributes that are required in the CSV file for a successful import as mentioned in the
table Required Attributes and Validations for the Geography Object below.

Before You Start

You must do some basic checks before starting your import. For example, make sure that:

- You have completed all the prerequisites for importing each attribute in your source data such as creating a
country structure.

Required Attributes and Validations for the Geography Object

To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure
that you provide values for the attributes. The following table lists the required attributes for importing new Geography
records, prerequisite setup tasks for the attributes, and specific validations, if any, for Geography import:

Attribute Description Prerequisite Setup Task/ Import Creating a Geography Record
Validations
CountryCode The code of the country to which This is validated against the Required
the geography belongs. country structure to check if
the structure is defined for this
country.
PrimaryGeographyName The primary name of the This is validated against the name = Required
geography. of country if geography type is

'‘Country' or LevelNumber is 1.

RecordTypeCode The record type code that No Validation Required
represents the intent of the import
data. The values are:

0 - indicates the geography
that already exists in the base
table.

1- indicates the intent to
create a new geography.

2 - indicates the intent to
add an alternate identifying
name or code to an existing
geography.
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Attribute Description Prerequisite Setup Task/ Import
Validations
LevelNumber The level number of the geography The level should exist in the
in the hierarchy. For example, country structure.

Country is at Level 1and State
(California) is at Level 2.

SourcelD The source ID for the geography, None
along with the parent source ID
is used to identify the geography
parent and child relationship
within the source file data and the
interface table data.

ParentSourcelD The parent source ID for the None
geography, along with the
source ID is used to identify the
geography's parent and child
relationship with records within the
source file data. This should be null
for the country record, as Country
is at the top of the hierarchy.

Chapter 6
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Creating a Geography Record

Required

Required

Required

You can view the Geography object and attributes in the Manage Import Objects page of the Import Management flow.
You can find attribute information like type, length, description, and so on, on this Manage Import Objects page.

Note: Keep a note of the following:

- You can't update geographies via import.

for any other geography name.

and PrimaryGeographyCode from the Ul after the import is complete.

— ' [N o~

Create the Source CSV File  ~

- You can't add alternate names or alternate code of country via import. You can do so only via Ul.

- Before adding a new alternate name, make sure that the alternate name does not exist with the same value

- You can enable high-volume import for the Geography import object in the Manage Import Objects page.

- PrimaryGeographyCodeType and PrimaryGeographyCode can't be added after PrimaryGeographyName is
created via import. You must create them together. Alternatively, you can add primaryGeographyCodeType

You include the data that you want to import into CX Sales and Fusion Service in a source CSV file.

You can use the templates available in the Import Objects Ul page to create the source CSV file. To download a template:

1. Go to Navigator > Tools > Import Management > Import Objects.
2. Select the Geography object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

ORACLE
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Note: For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues
When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity

After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click Create Import Activity in the Manage Imports page.

3. Inthe Enter Import Options page, provide a name for the import activity, and select Geography from the
Object drop-down list.

4. Select the CSV file in the File Name field, and click Next.

5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the
mappings if required.

6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.

7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results

Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and
unsuccessful imports. To check the status of the import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click All Imports and search for the import activity that you created earlier.

3. Check the Status column for the import activity. The import is successful if the status displays as Completed.
You can drill down on the import activity to go to the Import Status page which provides the status details of
the import activity.

Note: Geography names aren't translatable and are always displayed in the same language in which they were loaded
irrespective of the language of the signed in user. If you need different options of display, you can use the alternative
names option.

Related Topics
 Potential Issues When Opening CSV Files in Excel

» Import Your Country Structure Data

« Example of Importing Country Structure Data
- How do | import data?

- Example of Importing Geography Data

Example of Importing Geography Data

This example demonstrates how to import data using Import Management.

In this example, you have a source file containing geography data that you want to import into the application to
make the geography data available for real time address validation and tax purposes. A geography is any region with a
boundary around it, regardless of its size. It might be a state, a country, a city, a county, or a ward.
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Summary of the Tasks
You perform the following steps to create an import activity and activate the import:

1. Determine what information is in the source file.
2. Create and schedule the import activity.

Before You Start

1. You use the country structure of a country to define which geography types are part of the country. For more
information about an example of importing a country structure, see the topic "Example of Importing Country
Structure Data".

Ensure that Source ID values are unique for each row of data within a single import.

3. Ensure that all the parents of a child geography are included in your data file so that the child geography can be
added. For example, if you originally imported US, CA, and San Francisco, and now you want to import the city
of San Jose in CA, then your data file must include US, CA, and San Jose.

4. Check that your source data file has the correct values for the geography data that you have already loaded. For
example, if your initial import included the value US for country and CA as state, and in a subsequent import
you have California as a state, then your geography import creates two state records (CA and California) in the
application data, with the US as the country parent.

N

Determine the Information in the Source File

The source geography data files must include a unique Source ID value for each row of data and Parent Source ID value
for the parent of that row of data. You include the data that you want to import into CX Sales and Fusion Service in a
source CSV file. A sample input CSV file for country as US is shown in this table.

RecordTypeCode PrimaryGeography CountryCode LevelNumber Sourceld ParentSourceld LanguageCode
0 United States US 1 1 <blank> us
1 California us 2 M 1 us
1 San Mateo us 3 m n us
1 Redwood City us 4 m m us
1 94065 us 5 mm m us

Here is a sample CSV file to import geographies with alternate name and code for country India:

RecordType PrimaryGeogr. CountryCode LevelNumber Sourceld ParentSOurcel IdentifierType IdentifierSubT IdentifierValue
0 India IN 1 1
1 Karnataka IN 2 2 1
1 Bengaluru IN 3 3 2
89
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RecordType PrimaryGeogr. CountryCode LevelNumber Sourceld ParentSOurcel IdentifierType IdentifierSubT IdentifierValue
2 Bengaluru IN 3 3 2 NAME Standard_ Bangalore
Name

1 Whitefield |IN 4 4 3

1 560066 IN 5 5 4

2 560066 IN 5 5 4 CODE ISO_ N
COUNTRY_
CODE

Note: Keep a note of the following:

- The hierarchy is modeled in the CSV file using the Sourceld and ParentSourceld. The ParentSourceld for the
Country Record (level Number 1) is always null.

If defining an alternate name (recordTypecode = 2) for any level below the country (LevelNumber >1), ensure that
the Sourceld and ParentSourceld columns match the values for the original record respectively.

You can't update geographies via import.

You can't add alternate names or alternate code of country via import. You can do so only via UL.

Before adding a new alternate name, make sure that the alternate name doesn't exist with the same value
for any other geography name. You can check the existing values for alternate names in the Manage
Geographies task page under Hierarchy Defined.

- You can find the list of IdentifierSubTypes in Manage Geography Lookups page in the Ul.

- PrimaryGeographyCodeType and PrimaryGeographyCode can't be added after PrimaryGeographyName is
You must ariestied stuipbld.(Tow pils iteatiec bembogetbad Alporativedingahpurtacid Rageatyesgshiwmi ndeligpe

table. and PrimaryGeographyCode from the Ul after the import is complete.
Attribute Name Value Description
RecordTypeCode 1 The record type code that represents the intent

of the import data. The values are:

0O - indicates the geography that already
exists in the base table.

1- indicates the intent to create a new
geography.

2 - indicates the intent to add an alternate
identifying name or code to an existing
geography.
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Attribute Name

PrimaryGeographyName

CountryCode

LevelNumber

Sourceld

ParentSourceld

IdentifierType

IdentifierSubtype

IdentifierValue

Value

India

Name

Standard_Name or Standard_Code

Bangalore

Chapter 6
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Description

This is the primary geography name. This
will be marked as the primary name for the
Geography and also displayed in the Manage
Geographies Page.

This indicates the Country Code for the country
for which you're importing data.

The level number of the geography in the
hierarchy. For example, Country is at Level 1and
State (California) is at Level 2.

The source ID for the geography, along with
the parent source ID is used to identify the
geography parent and child relationship within
the source file data and the interface table data.

The parent source ID for the geography, along
with the source ID is used to identify the
geography's parent and child relationship with
records within the source file data. This should
be null for the country record, as Country is at
the top of the hierarchy.

The type of the identifier. It can be either Name
or Code.

The IdentifierSubtype can be Standard_Name
or Secondary_Name. The default value is
Standard_Name.

The valid Sub Types for Type "CODE" are FIPS_

CODE, GEO_CODE, ISO_COUNTRY_CODE,
PRIMARY_CITY, or UNKNOWN

The value of the identifier.

You can create an import activity, enter the import details, and schedule the import.

1. Go to Navigator > Tools > Import Management > Import Queue.

Click Create Import Activity in the Manage Imports page.
3. Inthe Enter Import Options page, provide a name for the import activity, and select Geography from the

Object drop-down list.

Note: In the Advanced Options section, the option Enable High-Volume Import is selected by default. This
mode is designed to import millions of records at once.

>

Select the CSV file in the File Name field, and click Next.

5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the

mappings if required.

6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.

ORACLE

91



Oracle Fusion Cloud HCM Chapter 6
Using Common Features for HCM Geographies for HCM

7. Review the import details on the Review and Submit page, and click Submit.

Example of Importing Country Structure Data

You use the country structure of a country to define which geography types are part of the country and how the
geography types are hierarchically related within the country.

For example, you can create geography types called State, City, and Postal Code. Then you can rank the State
geography type as the highest level within the country, the City as the second level, and the Postal Code as the lowest
level within the country structure.

To add a country structure using import management, your source file must contain information about the country to
which the country structure belongs. You can view the list of valid values for country codes in the Ul by navigating to
the Manage Geographies task and searching with % as the Country Code value. You also need to specify the level at
which the geography types need to be placed. By default, all countries are at Level 1. You create the country structure
by increasing the level number as you go down the country structure. You place the geography types such as states,
provinces, and so on at Level 2, districts or counties at Level 3, and so on. To add a country structure, your source file
must include the values that let the import process identify the existing records.

Sample Input CSV File

You include the data that you want to import into CX Sales and Fusion Service in a source CSV file. Here is a sample
input CSV file for country as US.

CountryCode LevelNumber GeographyType
us 1 COUNTRY

us 2 STATE

us 3 COUNTY

us 4 Ty

us 5 POSTAL CODE

Here is another input CSV file for importing the country structure for India.

CountryCode LevelNumber GeographyType
IN 1 COUNTRY

IN 2 STATE

IN 3 DISTRICT
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CountryCode LevelNumber
IN 4
IN 5
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GeographyType

Ty

POSTAL CODE

In case you want to import the country structure for Mexico, your input CSV file would look like this:

CountryCode LevelNumber
MX 1
MX 2
MX 3
MX 4
MX 5

GeographyType

COUNTRY

STATE

MUNICIPALITY

LOCALITY

POSTAL CODE

In this example, we are importing the Country Structure for US. You must create a source file (CSV) file with the

attributes as shown in this table and import it using Import Management.

Attribute Name Value
CountryCode us
LevelNumber 1
GeographyType COUNTRY

Create an import activity to import the information. To create an import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.

ORACLE

Description

The code for the country for which the country
structure is applicable.

The level number of the geography in the
hierarchy. For example, Country is at Level 1
(Top level) and State (California) is at Level

2. You need these to create parent-child
relationships between geography types for your
country.

Geopolitical divisions such as Country, State,
City, and so on. For example, for US the
different geography types would be State,
County, City, and Postal Code. For India, the
different geography types would be State,
District, City, and Postal Code. For Mexico,
it would be State, Municipality, Locality, and
Postal Code.
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2. C(Click Create Import Activity in the Manage Imports page.
3. Inthe Enter Import Options page, provide a name for the import activity, and select Country Structure from
the Object drop-down list.

Note: In the Advanced Options section, the option Enable High-Volume Import is selected by default. This
mode is designed to import millions of records at once.

4. Select the CSV file in the File Name field, and click Next.

5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the
mappings if required.

Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.

7. Review the import details on the Review and Submit page, and click Submit.

o

How You Import and Export Territory Geography Zones

Territory geography zones are geographical boundaries that you can set up to replicate your organization's regions,
such as a Pacific Northwest sales region.

You can set up territory geography zones in one application instance, and then after the territory geography zones are
defined you can export the territory zones and import them into another application instance.

To define your territory geography zones and then import your territory zones into another application instance, you
must complete the following steps:

1. Import the master reference geography data into the application.

2. Define your territory geography zones using the Manage Territory Geographies task.
3. Export the territory geography zones.

4. Import the territory geography zones into another application instance.

Import the Master Reference Geography Data

Firstly, you must import the master reference geography data. Master reference geography data includes geography
elements, such as country, state, and city, and is required for any geographical information that you store in the
application, such as address information used in customer and sales records. For more information, see the topic
Geography Hierarchy. Master reference geography data can be imported into the application using the Import
Management.

Define Your Territory Geography Zones

After the master reference geography data has been imported, you can then create your territory geography zones in
the application using the Manage Territory Geographies task in Setup and Maintenance. For more information, see the
Manage Territory Geographies topic in the Related Topics section.

Export the Territory Geography Zones

After you have completed importing the master reference geography data and defining your territory geography zone
tasks, you can create a configuration package to export the territory zone data. For more information, refer to the
Exporting Setup Data demo listed in the related topics section.

Import the Territory Geography Zones

After you have downloaded your configuration package for your territory geography zone setup, you can import the
territory zones into another application instance.
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Note: Ensure that you import your master reference geography data into the new application instance before you
import the configuration package.

Related Topics
- Geography Hierarchy

 Import Your Territory Geographies Data
« Example of Importing Territory Geography Data

Set Up Geocoding

Geocoding

This topic explains geocoding and how to enable this option in the application.

Geocoding is the process of finding latitude and longitude coordinates from geographic data such as street addresses
or postal codes. Once these coordinates are available, you can use the spatial services feature to identify points of
interest, such as customer and contact addresses, in the vicinity. The application integrates the Geocoding feature with
eLocation (http://elocation.oracle.com/maps_oracle_dot_com_main.html), which is a Geocoding service provided by
Oracle.

Note: Geocoding for Hong Kong isn't supported.

By default, the Geocoding option is turned off in the application. You can enable the Geocoding option by going to the
Setup and Maintenance work area and performing the following:

- Offering: Customer Data Management
Functional Area: Enterprise Profile
- Task: Manage Geographies

If the Geocoding feature is enabled, the feature can be scheduled to run at regular time intervals. This ensures that
newly created or updated locations are picked up and geocoded whenever you create or update an address using the
user interface, web services, bulk import, or using import management.

Related Topics
« What are Spatial Services?

- Set Up Geocoding

Set Up Geocoding

This procedure lists the steps to set up geocoding in Oracle Cloud applications.
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Geocoding is a process that determines the latitude and longitude coordinates for a location. By default, geocoding is
turned off in the application. You can use geocoding to display customers in the vicinity of a mobile address.

Enable Geocoding for a Country
To enable geocoding for a country, complete these steps:

1. Inthe Setup and Maintenance work area, go to the following:

o Offering: Customer Data Management
o Functional Area: Enterprise Profile
o Task: Manage Geographies
2. Onthe Manage Geographies page, search for the country for which you want to enable geocoding. You can
either search by the country name or country code.
3. Click Search. The search results for the matching country names are displayed.
4. Select the country for which you want to enable the geocoding option.
5. Select Geocoding Defined for the country.

Populate Location Latitude and Longitude Information

Once geocoding is enabled, you can schedule this feature to run at regular time intervals so that newly created or
updated locations are picked up and geocoded. To schedule the geocoding feature to run at regular intervals, complete
these steps:

Navigate to Tools > Scheduled Processes work area.

On the Overview page, click Actions > Schedule New Process.

Click the Name list and search for Populate Location Latitude and Longitude Information, and then click OK.
Enter the parameters such as Start Date and End Date, and click Submit.

P WNa

Related Topics
- Geocoding

« Populate Location Latitude and Longitude Information

Use Web Services to Populate Location Attributes for the Around
Me Feature

Use this procedure to populate location attributes using Web services for the Around Me feature in countries that aren't
supported by the eLocation service. The Around Me feature enables you to quickly locate information about your
surroundings.

This feature uses your current location to run a proximity search on objects with location information, such as contacts,
opportunities, and customers.
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Create an Address with the Location Attributes Using the LocationService Web

Service

Perform the following steps to create an address with location attributes, such as latitude and longitude, using the
createlLocation operation.

1. Extract the Web Services URL

a.
b.

c.
d.
e.

Sign in to the Oracle Enterprise Manager Applications Control using the WebLogic Server credentials.
Select Oracle Fusion Customer Relationship Management from the navigation tree, and then select
Fusion Applications.

From the tree, select CrmCommonApp, and then select cxmcommonaApp (CRMCommonServer 1).

In the Web Services pane, click Test for the LocationServiceSoapHttpPort port.

In the Test Web Service pane, copy the URL of a WSDL that appears in the WSDL field until "?wsdl", and
then paste to a notepad.

2. Derive the Payload

a.
b.
C.

Launch the WSDL URL in a Web browser to open the LocationService endpoint page.
In the LocationServiceSoapHttpPort pane, select createLocation from the Operation list.
In the Location pane, complete the fields, as shown in the following table.

Field Value

Country CN

Address1 Chaoyang District
City Shanghai

Postal Code 200233

State China
CreatedByModule AMS

Latitude 20.36789
Longitude -39.34444

Note: Deselect all the other parameters in this Location pane. Also, deselect LocationProfile,
OriginalSystemReference, and LocationIinformation options.
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d. Click the XML Source option.

Note: This option appears next to the Operation list.

e. Copy the XML source and paste to a notepad.
3. Call the Web Service

a. Open the Oracle Fusion Service Tester page.

b. Inthe WebService URL field, paste the WSDL URL that you derived from Step 5 of the Extracting the Web
Services URL section.

c. Enter the user name and password credentials.

d. Inthe Payload pane, paste the XML source that you derived from Step 5 of the Deriving the Payload
section.

e. Click rnvoke. The Output Payload pane displays the output payload.
4. Test the Web Service

Sign in to the Oracle Fusion Applications Home Page.

Navigate to the Customer Center work area.

Search the address that you added.

Click the Addresses section.

From the Actions list, select the View Geography Information option.
Verify the latitude and longitude details.

-0 9 n CT9

Update the Location Attributes of an Address Using the LocationService Web Service

Perform the following steps to update the location attributes of an address, such as latitude and longitude, using the
updatelLocation operation.

1. Extract the Web Services URL

a. Signin to the Oracle Enterprise Manager Applications Control using the WebLogic Server credentials.

b. Select Oracle Fusion Customer Relationship Management from the navigation tree, and then select
Oracle Fusion Applications.

c. From the tree, select CrmCommonApp, and then select cxrmCommonapp (CRMCommonServer 1)
d. Inthe Web Services pane, click Test for the LocationServiceSoapHttpPort port.

e. Inthe Test Web Service pane, copy the URL of a WSDL that appears in the WSDL field until "?wsdl", and
then paste to a notepad.

2. Derive the Payload

a. Launch the WSDL URL in a Web browser to open the LocationService endpoint page.
b. Inthe LocationServiceSoapHttpPort pane, select updateLocation from the Operation list.
c. Inthe Location pane, complete the fields, as shown in the following table.

Field Value

Locationld 300100078489616
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Field Value

Note:
Enter the location ID that was generated in Step 1 of the Testing the Results section.

Latitude 30.36789

Longitude -40.34444

Note: Deselect all the other parameters in this Location pane. Also, deselect LocationProfile,
OriginalSystemReference, and LocationIinformation options.

d. Click the XML Source option.

I Note: This option appears next to the Operation list.

e. Copy the XML source and paste to a notepad.
3. Call the Web Service

a. Open the Oracle Fusion Service Tester page.

b. Inthe WebService URL field, paste the WSDL URL that you derived from Step 5 of the Extracting the Web
Services URL section.

Enter the user name and password credentials.

d. Inthe Payload pane, paste the XML source that you derived from Step 5 of the Deriving the Payload
section.

e. Click invoke. The Output Payload pane displays the output payload.
4. Test the Web Service

o

Sign in to the Oracle Fusion Applications Home Page.

Navigate to the Customer Center work area.

Search the address that you updated.

Click the Addresses section.

From the Actions list, select the View Geography Information option.
Verify the latitude and longitude details.

-0 2 n T 9

How You Set up Address Cleansing

Address cleansing validates, corrects, and standardizes address information that you enter in the application. Address
cleansing, unlike geography validation, validates both the geography attributes and the address line attributes.

To use the address cleansing functionality, you need to have license for the customer data quality application, because
the feature is delivered using data quality integration.
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You can specify the real-time address cleansing level for each country by choosing either of these options:

None: Specifies no real time address cleansing.
- Optional: Provides option to cleanse addresses.

Once you have enabled address cleansing for a country, a Verify Address icon appears at address entry points in the
application. Click the icon to perform address cleansing and receive a corrected, standardized address. If the application
doesn't find a matching address, then an alert message is displayed.

FAQs for Logate Support

How to Import Nokia Geography Data

We recommend that you use Logate geography data. However, if you need to use Nokia data for one or more countries
for business reasons you can do so.

By default, Import Geography Data task invokes Logate geography data.

Note: Oracle doesn't support any Nokia geography data fixes.

Perform these steps to import Nokia geography data:

1. Set the profile value of the ORA_HZ_ENABLE_DAAS_LOQATE profile option to No in the Setup and
Maintenance work area by going to the following:
o Offering: Sales
o Functional Area: Sales Foundation
o Task: Manage Administrator Profile Values
2. Import the Nokia geography data for a country as follows:

a. Navigate to the Manage Geographies task in the Setup and Maintenance work area by going to the
following:

- Offering: Sales
- Functional Area: Sales Foundation
- Task: Manage Geographies
b. On the Actions menu, Click Import Geography Data for a country.

Note: The Import Geography Data action is disabled for a country if the geography data for that country isn't
available from Logate or if the country data is already imported using either Logate, Nokia, or any third party
geography data.

After the geography data is loaded, the data provider name (Logate or Nokia) is displayed in the Hierarchy
Defined section in Manage Geographies.
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How many countries does Logate support? How do | get support
for any additional country?

Logate supports 82 countries. Any additional country support beyond the 82 must be logged as an enhancement
request.

To log the enhancement request, go to Idea Lab.

Related Topics
« How to submit an enhancement request on Idea Lab

Will | be charged for Logate data?

There's no charge or licensing requirement for Logate geography data.

| am an existing customer, how will | be impacted? Can | import
both Logate and Nokia geography data?

No. You can import either Logate or Nokia geography data, but you can't import from both providers for a single
country. We recommend that you use Logate geography data because Logate supports 82 countries including existing
62 Nokia supported countries.

If you're already using Nokia geography data, you can select one of these two options:

- Option 1: You need not do anything and continue to use Nokia geography data. Oracle doesn't support any
Nokia geography data fixes.

- Option 2: You can replace Nokia geography data with Logate geography data. This is a manual process today.
You must follow manual steps and work closely with the support team to import new Logate geography data.
For more information about this process, see Replace Existing Master Geography Data with Revised Oracle-
Licensed Geography Data section in this chapter.

How frequent are updates to Oracle licensed geography reference
data available?

The geography reference data is updated on a quarterly basis but the update of the latest geography reference data
refresh isn't automated. You will be informed about the geography reference data refresh using release readiness
documents.
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How is geography data updated? Are updates available for all
countries at the same time?

When you import the geography data for a country for the first time you would get the latest Logate geography data.
But if your Logate geography data is more than three months old, you have to uptake the latest Logate geography data
by following the steps in the Replace Existing Master Geography Data with Revised Oracle-Licensed Geography Data
topic.

Related Topics
- How do I replace the existing master geography data with revised Oracle-Licensed geography data?

Can |l import Vertex or other third-party geography data in
Manage Geographies?

Yes, you can continue to import geography data of your choice. Oracle provides support for Logate geography data out
of the box.

Can | import geography data for multiple countries in one import
job?
No. You can submit only one import job for a country. After submitting the import job, you can search for a different

country and submit another import job for that country. Currently, you can only search and import Logate data for one
country at a time using the Manage Geographies task in Setup and Maintenance menu.

FAQs for Define Geographies

How You Search Geographies in the Language You Prefer

You can search geographical data using the language that you prefer.

For example, when you load geography data for Canada in English and French. When you search this data using say
Postal Code H4A 0A1, the following is the search result:

When you search this data using say Postal Code H4A 0A1, the following is the search result:

- H4A OA1, Montreal, QC
- H4A OA1, Montreal, Quebec
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H4A 0A1, Montréal, QC
H4A OA1, Montréal, Quebec

You may want the search results to be displayed in the language you prefer. So, if you set the language as English, the
following must be displayed:

H4A 0A1, Montreal, QC
H4A 0A1, Montreal, Quebec
And if you set the language as French, the following must be displayed:

H4A 0A1, Montréal, QC
H4A 0A1, Montréal, Quebec

This can be done after setting up the profile option Filter Geographies Using User Language
(HZ_GEO_FILTER_BY_USER_LANG). You must first define the profile option HZ_GEO_FILTER_BY_USER_LANG and
specify the language you want to use.

1. Create the profile option as follows:

a. Click Navigator > My Enterprise > Setup and Maintenance > Search and search for Manage Profile
Options.
b. Click Create new profile option icon and enter the following:

- Profile Option Code: HZ_GEO_FILTER_BY_USER_LANG
- Profile Display Name: Filter Geographies Using User Language
- Application: Trading Community Model
- Module: Trading Community Model
- Description: provide the description
- Start Date: specify a date
c. Click Save and close.
d. In Profile Option Levels table, select Enabled and updateable for the site level.
e. Click Save and Close.
2. Set the default value for the profile option as follows:

a. Click Navigator > My Enterprise > Setup and Maintenance > Search and search for Manage
Administrator Profile Values.

b. Search HZ_GEO_FILTER_BY_USER_LANG as the profile option code.

c. Add new Site level profile value.

d. Specify the new profile in the following format:

<COUNTRY_CODE1>:<GEOGRPHY_LEVEL1>,
<GEOGRAPHY_LEVEL2>;<COUNTRY_CODE2>:<GEOGRAPHY_LEVEL1>

Where Geography Level values start with value 1for country and increment for each level that's defined in
the country's geography structure setup.

For example, the following are the geography levels for Canada:
Country - 1, State - 2, Province - 3, City - 4, Postal Code - 5
Similarly, the following are the geography levels for United States:
Country - 1, State - 2, County - 3, City - 4, Postal Code - 5
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Example 1: If you want to filter data for Canadian Cities, then the profile value is CA:3 where CA is the
country code for Canada and 3 is geography level value for City.

Example 2: If you want to filter data for both State and Cities for United States, then value should be
us:2,4

Example 3: If you want to filter data for multiple countries as given in both example 1and example 2, then
use semi colon as delimiter, like CA:3;US:2,4

e. Click Save and Close.

When do | define address cleansing?

When address data entered into the application must conform to a particular format, to achieve consistency in the
representation of addresses. For example, making sure that the incoming data is stored following the correct postal
address format.

Why can't | update a geography structure by copying an existing
country structure?

You can only update a geography structure by adding existing geography types, or by creating new geography types
and then adding them to the geography structure.

You can only copy an existing country structure when you're defining a new country structure.

How many levels in a geography structure can | define?

We recommend that you add up to six levels, starting with country at level 1, while defining geography structures. If
you add more than six levels containing list of values or validations, then the sixth level and above may not work as
expected in the Address Ul of accounts, contacts, suppliers, persons, and so on.

Why can't | delete a level of the country geography structure?

If a geography exists for a country geography structure level then you can't delete the level.

For example, if a state geography has been created for the United States country geography structure, then the State
level can't be deleted in the country geography structure.
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How do | add a geography to the geography hierarchy?

You can add a new geography to the geography hierarchy. The new geography can be added under any level of the
hierarchy for an existing geography type in the country geography structure.

For example, we can add a new postal code 94065 under United State, California, San Mateo, Redwood City.

Click Navigator > My Enterprise > Setup and Maintenance work area.
Click the Tasks menu and click Search. Search for Manage Geographies.
On the Manage Geographies page, enter US in the Code field. Click Search.
Click Hierarchy Defined for United States.

PN

Note: If there are many child geographies for the selected parent geography, a message asking you to
refine the search criteria is displayed. The child geographies are displayed after you refine the search
criteria. If there are many search results, you may have to further refine the search criteria. The maximum
number of child geographies that can be displayed is controlled by the ORA_HZ_GEO_HIERARCHY_LIMIT
profile option. You can change the value of this profile option by navigating to the Setup and Maintenance
work area, click the Tasks menu, and search for Manage Administrative Profile Values task. Search for the
ORA_HZ_GEO_HIERARCHY_LIMIT profile option and change the value.

Search using State as the Geography Type and CA as the Code.

Drill down to San Mateo and select Redwood City.

Click Actions > Create.

Type 94065 for Name in the Primary Name and Alternative Names section.
Click Save and Close.

10. Click Save and Close.

11. Click Done.

B B 4

Edit a Specific Geography in the Geography Hierarchy

You can edit the following details of a geography hierarchy using the Manage Geography Hierarchy page:
- geography's date range
- primary and alternate names

- primary and alternate codes

- creating geographies within the hierarchy such as adding a postal code for a city.

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Geographies.
3. On the Manage Geographies page, enter US in the Code field. Click Search.
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4.

o

10.
1n.

Click Hierarchy Defined for United States.

Note: If there are many child geographies for the selected parent geography, a message asking you to
refine the search criteria is displayed. The child geographies are displayed after you refine the search
criteria. If there are many search results, you may have to further refine the search criteria. The maximum
number of child geographies that can be displayed is controlled by the ORA_HZ_GEO_HIERARCHY_LIMIT
profile option. You can change the value of this profile option by navigating to the Setup and Maintenance
work area, click the Tasks menu, and search for Manage Administrative Profile Values task. Search for the

ORA_HZ_GEO_HIERARCHY_LIMIT profile option and change the value.

Search using State as the Geography Type and CA as the Code.

Select CA and click Actions > Edit.

(Optional) Select the row that you want to specify as the primary name under the Primary and Alternative
Names section and click Actions > Set Primary.

(Optional) Select the row that you want to specify as the primary code under the Primary and Alternative
Codes section and click Actions > Set Primary.

Click Save and Close.
Click Save and Close.
Click Done.

Edit Alternative Names and Codes for an Existing Country

You can add or edit alternative names and codes for an existing geography in the geography hierarchy.

For example, you can add a FIPS code of 06 for the state of California.

PUWUNA

R R

10.
. Click Done.

Click Navigator > My Enterprise > Setup and Maintenance work area.
Click the Tasks menu and click Search. Search for Manage Geographies.
On the Manage Geographies page, enter US in the Code field. Click Search.
Click Hierarchy Defined for United States.

Note: If there are many child geographies for the selected parent geography, a message asking you to
refine the search criteria is displayed. The child geographies are displayed after you refine the search
criteria. If there are many search results, you may have to further refine the search criteria. The maximum
number of child geographies that can be displayed is controlled by the ORA_HZ_GEO_HIERARCHY_LIMIT
profile option. You can change the value of this profile option by navigating to the Setup and Maintenance
work area, click the Tasks menu, and search for Manage Administrative Profile Values task. Search for the
ORA_HZ_GEO_HIERARCHY_LIMIT profile option and change the value.

Search using State as the Geography Type and CA as the Code.
Select CA and click Actions > Edit.

In the Primary and Alternative Codes section, click Actions > Add.
Type 06 under Code and select FIPS code as the Code Type.

Click Save and Close.

Click Save and Close.
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How can | add a geography that's at a lower level to any geography
in a geography hierarchy?

Select the geography that you want to create a geography at lower level, and then click the Create icon. This lets you
create a geography for a geography type that's one level lower to the geography type you selected. The structure of the
country's geography types are defined in the Manage Geography Structure page.

How can | verify whether the third-party geography structure and
hierarchy | imported are available in the application?

You can track the progress of the geography structure and hierarchy import process by navigating to the Scheduled
Processes page and viewing the status of the third-party geography data import process.

Once the process completes, the status changes to Succeeded. You can then verify the newly imported geography
structure and hierarchy in the Setup and Maintenance work area by navigating to the following: offering: Customer Data
Management; functional area: Enterprise Profile; task: Manage Geographies, where you first loaded the third-party
geography data.

Note: Before you load geography data for a country from a third party provider, ensure that no geography structure
or hierarchy is saved for that country. If geography structure or hierarchy data is already available, the load process
fails.

How can | enable geocoding?

You can enable geocoding for a country by turning the Geocoding option for that country in the Setup and Maintenance
work area.

Navigate to the following:
- offering: Customer Data Management
- functional area: Enterprise Profile

- task: Manage Geographies

Search for the country for which you want to enable geocoding and click the Geocoding Defined icon. If geocoding is
enabled for a country, the Geocoding Defined icon displays a check mark.

Once you have enabled geocoding for a country, you must run the Run Geocode Generation scheduled process on the
Run Geocode Generation task. Before you run the job, however, ensure that you have specified the country code of the
country for which you want to generate the geocodes.
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Where can | view the geocode values of a location?

You can search for and view the geocode values of a party's location in the Party Center and the Customer Center
pages.

Navigate to the Addresses section of the party's profile and click either View, Columns, Latitude and View, Columns,
Longitude, or View, Columns, Manage Columns, Latitude and Longitude. This displays the latitude and longitude, or
geocode values, associated with the location of the party.

Note: Geocode information display is available only when geocoding is enabled for the country to which the address
belongs.

Related Topics
- Geocoding

What are Spatial Services?

Spatial services allow users to find points of interest such as customers, contacts, and so on using the latitude and
longitude coordinates of an address.

The Oracle Fusion Mobile Sales application provides these services for sales representatives to discover accounts and
contacts around their location.

Where can | update and view the geography name reference
information for parties?

To view the geography name reference information associated with parties, you need to ensure that you have created
an address for the party. You can create or update party addresses in the Organizations, Persons, and Groups work
areas.

Once you have updated an address, you must either wait for the Run Geocode Generation scheduled process to run
automatically as scheduled or start geocode generation manually from the Setup and Maintenance work area by
navigating as follows:

- offering: Customer Data Management
- functional area: Enterprise Profile

- task: Run Geocode Generation

Once the Run Geocode Generation job has updated the geography information for the country associated with the
party you updated, you can search for and view the geography name reference information associated with the party
in the Organizations, Persons, and Groups work areas. Navigate to the person, organization, or group whose address
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you want to verify and click Actions, View Geography Information. This displays a dialog box that displays the updated
geography information, complete with address values enhanced using geography name reference.

Note: Geography name reference enriched geography information display is available only when geography
validation is enabled for the country to which the address belongs.

How can | save an address that didn't pass geography validation?

Search and select for the country name in the Manage Geographies page, and then click the Validation Defined option.
In the Manage Geography Validation page, select No Validation in the Geography Validation Level for Country drop-
down list. This option saves addresses that don't pass the geography validation, including incomplete and invalid
addresses.

Why is Import Geography Data Disabled in Manage Geographies?

Import Geography Data is disabled for a country if the geography data for that country isn't available from Logate or
if the geography structure or hierarchy is already defined for that country. The existing master geography hierarchy

can be from Logate or non-Logate geography data providers. For example, Pakistan isn't supported currently in the

supported list of 82 countries. If you try to import geography data for Pakistan after defining geography structure or
geography hierarchy for it, Pakistan would be greyed out in the import list.

Note: If the hierarchy is defined, delete the geography hierarchy data first and then the geography structure.
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7 Currencies and Currency Rates

Manage Currencies

Considerations for Defining Currencies

Consider these points about entering the currency code, date range, or symbol for the currency, when you create or edit
currencies.

Currency Codes
You can't change a currency code after you enable the currency, even if you later disable that currency.

Date Ranges

You can enter transactions denominated in the currency only for the dates within the specified range. If you don't enter
a start date, then the currency is valid immediately. If you don't enter an end date, then the currency is valid indefinitely.

Symbols

Some applications support displaying currency symbols. You may enter the symbol associated with a currency so that it
appears along with the amount.

Related Topics
- What's the difference between precision, extended precision, and minimum accountable unit for a currency?

- What's a statistical unit currency type?
« Euro Currency Derivation

Euro Currency Derivation

Use the Derivation Type, Derivation Factor, and Derivation Effective Date fields to define the relationship between the
official currency (Euro) of the European Monetary Union (EMU) and the national currencies of EMU member states.

For each EMU currency, you define its Euro-to-EMU fixed conversion rate and the effective starting date. If you have to
use a different currency for Euro, you can disable the predefined currency and create a new one.

Derivation Type

The Euro currency derivation type is used only for the Euro, and the Euro derived derivation type identifies national
currencies of EMU member states. All other currencies don't have derivation types.

Derivation Factor

The derivation factor is the fixed conversion rate by which you multiply one Euro to derive the equivalent EMU currency
amount. The Euro currency itself must not have a derivation factor.
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Derivation Effective Date
The derivation effective date is the date on which the relationship between the EMU currency and the Euro begins.

FAQs for Manage Currencies

When do | create or enable currencies?

Create or enable any currency for displaying monetary amounts, assigning currency to ledgers, entering transactions,
recording balances, or for any reporting purpose. All currencies listed in the International Organization for
Standardization (ISO) 4217 standard are supported.

The default currency is set to United States Dollar (USD).

Related Topics
« Considerations for Defining Currencies

What's the difference between precision, extended precision, and
minimum accountable unit for a currency?

Precision refers to the number of digits placed after the decimal point used in regular currency transactions. For
example, USD would have 2 as the precision value for transactional amounts, such as $1.00.

Extended precision is the number of digits placed after the decimal point and must be greater than or equal to the
precision value. For calculations requiring greater precision, you can enter an extended precision value such as 3 or 4.
That would result in the currency appearing as $1.279 or $1.2793.

Minimum accountable unit is the smallest denomination for the currency. For example, for USD that would be .01 for a
cent.

You can set these values for a currency using the Manage Currencies task in the Application Extensions functional area
in the Setup and Maintenance work area.

Note: When setting up currencies, make sure you use the correct precision. Some currencies, for example, the
Chilean peso, don’t support precision at all.

What's a statistical unit currency type?

The statistical unit currency type denotes the Statistical (STAT) currency used to record financial statistics in the
financial reports, allocation formulas, and other calculations.
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Manage Conversion Rate Types

Guidelines for Creating Conversion Rate Types

Maintain different conversion rates between currencies for the same period using conversion rate types.
The following conversion rate types are predefined:

- Spot

- Corporate

« User

- Fixed

You can use different rate types for different business needs. During journal entry, the conversion rate is provided
automatically based on the selected conversion rate type and currency, unless the rate type is User. For User rate types,
you must enter a conversion rate. You can define additional rate types as needed. Set your most frequently used rate
type as the default. Conversion rate types can't be deleted.

Assign conversion rate types to automatically populate the associated rate for your period average and period end
rates for the ledger. For example, you can assign the conversion rate type of Spot to populate period average rates, and
the conversion rate type of Corporate to populate period end rates. Period average and period end rates are used in
translation of account balances.

Conversion rate types are used to automatically assign a rate when you perform the following accounting functions:

- Convert foreign currency journal amounts to ledger currency equivalents.
- Convert journal amounts from source ledgers to reporting currencies or secondary ledgers.
- Run revaluation or translation processes.

When creating conversion rates, decide whether to:

- Enforce inverse relationships

- Select pivot currencies

- Select contra currencies

- Enable cross rates and allow cross-rate overrides

- Maintain cross-rate rules

Enforce Inverse Relationships

The Enforce Inverse Relationship option indicates whether to enforce the automatic calculation of inverse conversion
rates when defining daily rates. The following table describes the impact of selecting or not selecting the option.

Action Results

Selected When you enter a daily rate to convert currency A to currency B, the inverse rate of currency B to
currency A is automatically calculated and entered in the adjacent column. If either rate is changed, the
application automatically recalculates the other rate.
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Action Results

You can update the application calculated inverse rate, but once you do, the related rate is updated.
The option enforces the inverse relationship is maintained but doesn't prevent you from updating the
rates.

Not Selected The inverse rate is calculated, but you can change the rate and update the daily rates table without the
corresponding rate being updated.

Select Pivot Currencies

Select a pivot currency that's commonly used in your currency conversions. A pivot currency is the central currency that
interacts with contra currencies. For example, you set up a daily rate between the US dollar (USD) and the Euro currency
(EUR) and another between the USD and the Canadian dollar (CAD). USD is the pivot currency in creating a rate between
EUR and CAD. EUR and CAD are the contra currencies. Select the pivot currency from the list of values which contains
those currencies that are enabled, effective, and not a statistical (STAT) currency. The description of the pivot currency is
populated automatically based on the currency definition.

If you want the application to create cross rates against a base currency, define the base currency as the pivot currency.
Selected pivot currencies can be changed in the Rate Types page.

Select Contra Currencies

Select currencies available on the list of values as contra currencies. The available currencies are those currencies which
are enabled, effective, not STAT currency, and not the pivot currency selected earlier. The description of the contra
currency is populated automatically based on the currency definition. Add or delete contra currencies in the Contra
Currencies region of the Rate Types page.

Enable Cross Rates and Allow Cross Rate Overrides

Check the Enable Cross Rates check box to calculate conversion rates based on defined currency rate relationships.
General Ledger calculates cross rates based on your defined cross rate rules. Associate your cross rate rules with

a conversion rate type, pivot currency, and contra currencies. Cross rates facilitate the creation of daily rates by
automatically creating the rates between contra currencies based on their relationship to a pivot currency. If the Enable
Cross Rates option is deselected after entering contra currencies, the application stops calculating cross rates going
forward for that particular rate type. All the earlier calculated cross rates for that rate type remain in the database unless
you manually delete them.

For example, if you have daily rates defined for the pivot currency, USD to the contra currency, EUR, and USD to another
contra currency, CAD, the application automatically creates the rates between EUR to CAD and CAD to EUR. You don't
have to manually define the EUR to CAD and CAD to EUR rates.

Select the Allow Cross Rates Override check box to permit your users to override application generated cross rates. If
you accept the default of not selected, the application generated cross rates can't be overridden.

Maintain Cross Rate Rules

Define or update your cross rate rules at any time by adding or removing contra currency assignments. Add a contra
currency to a cross rate rule and run the Daily Rates Import and Calculation process to generate the new rates. If you
remove a cross rate rule or a contra currency from a rule, any cross rates generated previously for that contra currency
remain unless you manually delete them. Changes to the rule aren't retroactive and don't affect previously stored cross

14
ORACLE



Oracle Fusion Cloud HCM Chapter 7
Using Common Features for HCM Currencies and Currency Rates

rates. The Cross Rate process generates as many rates as possible and skips currencies where one component of the set
is missing.

Note: With a defined web service that extracts daily currency conversion rates from external services, for example
Reuters, currency conversion rates are automatically updated for the daily rates and all cross currency relationships.

Related Topics
- Examples of Using Conversion Rate Types in a Journal

- What's the difference between calendar and fiscal period naming?

Examples of Using Conversion Rate Types in a Journal

The following conversion rate types are predefined: Spot, Corporate, User, Fixed.

Scenario

You are the general ledger accountant for Vision US Inc. You are entering a journal entry to capture three transactions
that were transacted in three different foreign currencies.

- Canadian Dollar CAD: A stable currency
- Mexican Peso MXP: A fluctuating currency

- Hong Kong Dollar HKD: An infrequently used currency

You enter two journal lines with accounts and amounts for each foreign currency transaction. Based on your company
procedures, you select the rate type to populate the rate for Corporate and Spot rate types from your daily rates table.
You manually enter the current rate for the User rate type.

The following table lists the currency, the rate type that you select, and the reasons for the rate type selection.

Selected Currency Selected Rate Type Reason

CAD Corporate Entered a periodic type of transaction. Your
company has established a daily rate to use
for the entire month across divisions for all
transactions in Canadian dollars, a stable
currency that fluctuates only slightly over the
month.

MXP Spot Entered a periodic type of transaction. Your
company enters daily rates each day for the
Mexican peso because the currency is unstable
and fluctuates.

HKD User Entered a one time transaction. Your company
doesn't maintain daily rates for Hong Kong
dollars.
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Your company doesn't currently use the Fixed rate type. From January 1, 1999, the conversion rate of the French franc
FRF against the Euro EUR was a fixed rate of 1 EUR to 6.55957 FRF. Your French operations were started in 2007, so you
maintain all your French business records in the Euro.

FAQs for Manage Conversion Rate Types

What's the difference between spot, corporate, user, and fixed rate
types?

Spot, corporate, user, and fixed conversion rate types differ based on fluctuations of the entered foreign currency and
your company procedures for maintaining daily rates.

« Spot: For currencies with fluctuating conversion rates, or when exact currency conversion is needed.
- Corporate: For setting a standard rate across your organization for a stable currency.

User: For infrequent entries where daily rates for the entered foreign currency aren't set up.

Fixed: For rates where the conversion is constant between two currencies.

If you have infrequent foreign currency transactions, the User rate type can simplify currency maintenance. The User
rate type can also provide an accurate conversion rate on the date of the transaction.

Manage Daily Rates

Enter Daily Rates Using the Daily Rates Spreadsheet

You are required to enter the daily rates for currency conversion from Great Britain pounds sterling (GBP) to United
States dollars (USD) for 5 days.

To load rates using the Create Daily Rates Spreadsheet, you must first install Oracle ADF Desktop Integration client
software. Oracle ADF Desktop Integration is an Excel add-in that enables desktop integration with Microsoft Excel
workbooks. You can download the installation files from the Tools work area by selecting Download Desktop Integration
Installer.

Entering Daily Rates

1. From the General Accounting work area, select the Period Close link.
2. From the Tasks panel, click the Manage Currency Rates link.

Use the Currency Rates Manager page to create, edit, and review currency rate types, daily rates, and historical
rates.

3. Click the Daily Rates tab.

Use the Daily Rates tab to review and enter currency rates.
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Click the Create in Spreadsheet button.

Use the Create Daily Rates spreadsheet to enter daily rates in a template that you can save and reuse.
Click in the From Currency field. Select the GBP - Pound Sterling list item.

Click in the To Currency field. Select the USD - US Dollar list item.

Click in the Conversion Rate field. Select the Spot list item.

Click in the From Conversion field. Enter a valid value: 10/2/2017.

Click in the To Conversion Date field. Enter a valid value: 10/6/2017.

Click in the Conversion Rate field. Enter a valid value: 1.6.

Click Submit and click OK twice.

Review the Record Status column to verify that all rows were inserted successfully.

Save the template to use to enter daily rates frequently. You can save the spreadsheet to a local drive or a
shared network drive.

Optionally, edit the rates from the Daily Rates user interface or resubmit the spreadsheet.

Related Topics
- Examples of Using Conversion Rate Types in a Journal

 Guidelines for Using Desktop Integrated Excel Workbooks

« Update Currency Rates

Update Currency Rates

You're required to change today's daily rates that were already entered. The rates you're changing are for currency
conversion from Great Britain pounds sterling (GBP) to United States dollars (USD) for your company InFusion America.

Currency conversion rates were entered by an automatic load to the Daily Rates table. They can also be entered through
a spreadsheet.

Updating Currency Rates

1.

1

©Ow0voOgouA

Navigate to the Period Close work area.

Use the Period Close work area to link to close processes and currency process.

. Click the Manage Currency Rates link.

Use the Currency Rates Manager page to create, edit, and review currency rate types, daily rates, and historical
rates.

Click the Daily Rates tab.

Use the Daily Rates tab to review and enter currency rates.

Click the From Currency list. Select the GBP - Pound Sterling list item.

Click the To Currency list. Select the USD - US Dollar list item.

Enter the dates for the daily rates that you are changing. Enter today's date.

Click the Rate Type list. Select the Spot list item.

Click the Search button.

Click in the Rate field. Enter the new rate of 1.7 in the Rate field.

Click in the Inverse Rate field. Enter the new inverse rate of 0.58822 in the Inverse Rate field.
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11. Click the Save button.

Related Topics
 Guidelines for Using Desktop Integrated Excel Workbooks
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8 Enterprise Structures

Overview of Enterprise Structures

Oracle Fusion Applications have been designed to ensure your enterprise can be modeled to meet legal and
management objectives.

The decisions about your implementation of Oracle Fusion Applications are affected by your:

+ Industry
- Business unit requirements for autonomy
- Business and accounting policies
- Business functions performed by business units and optionally, centralized in shared service centers
- Locations of facilities
Every enterprise has three fundamental structures that describe its operations and provide a basis for reporting.
- Legal
- Managerial
- Functional

In Oracle Fusion, these structures are implemented using the chart of accounts and organization hierarchies. Many
alternative hierarchies can be implemented and used for reporting. You are likely to have one primary structure that
organizes your business into:

- Divisions
« Business Units
- Departments

Align these structures with your strategic objectives.

This figure illustrates a grid with Business Axis, representing the enterprise division, Legal Axis representing the
companies, and the Functional Axis representing the business functions.
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Enterprise Structures

The figure illustrates a typical group of legal entities, operating various business and functional organizations. Your
ability to buy and sell, own, and employ comes from your charter in the legal system. A corporation is:

- Adistinct legal entity from its owners and managers.

- Owned by its shareholders, who may be individuals or other corporations.

Many other kinds of legal entities exist, such as sole proprietorships, partnerships, and government agencies.
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A legally recognized entity can own and trade assets and employ people in the jurisdiction in which the entity is
registered. When granted these privileges, legal entities are also assigned responsibilities to:

« Account for themselves to the public through statutory and external reporting.
- Comply with legislation and regulations.
- Payincome and transaction taxes.

- Process value added tax (VAT) collection on behalf of the taxing authority.

Many large enterprises isolate risk and optimize taxes by incorporating subsidiaries. They create legal entities to
facilitate legal compliance, segregate operations, optimize taxes, complete contractual relationships, and isolate risk.
Enterprises use legal entities to establish their enterprise's identity within the laws of each country in which their
enterprise operates.

The figure illustrates:

- A separate card represents a series of registered companies.

- Each company, including the public holding company, InFusion America, must be registered in the countries
where they do business.

- Each company contributes to various divisions created for purposes of management reporting. These are
shown as vertical columns on each card.

For example, a group might have a separate company for each business in the United States (US), but have its United
Kingdom (UK) legal entity represent all businesses in that country.

The divisions are linked across the cards so that a business can appear on some or all of the cards. For example, the
air quality monitoring systems business might be operated by the US, UK, and France companies. The list of business
divisions is on the Business Axis.

Each company's card is also horizontally striped by functional groups, such as the sales team and the finance team.
This functional list is called the Functional Axis. The overall image suggests that information might, at a minimum, be
tracked by company, business, division, and function in a group environment. In Oracle Fusion Applications, the legal
structure is implemented using legal entities.

Management Structure

Successfully managing multiple businesses requires that you segregate them by their strategic objectives, and measure
their results. Although related to your legal structure, the business organizational hierarchies don't have to be reflected
directly in the legal structure of the enterprise. The management structure can include divisions, subdivisions, lines

of business, strategic business units, profit, and cost centers. In the figure, the management structure is shown on the
Business Axis. In Oracle Fusion Applications, the management structure is implemented using divisions and business
units as well as being reflected in the chart of accounts.

Functional Structure

Straddling the legal and business organizations is a functional organization structured around people and their
competencies. For example, sales, manufacturing, and service teams are functional organizations. This functional
structure is represented by the Functional Axis in the figure. You reflect the efforts and expenses of your functional
organizations directly on the income statement. Organizations must manage and report revenues, cost of sales, and
functional expenses such as research and development and selling, general, and administrative expenses. In Oracle
Fusion Applications, the functional structure is implemented using departments and organizations, including sales,
marketing, project, cost, and inventory organizations.
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Model Your Enterprise Management Structure

This example uses a fictitious global company to demonstrate the analysis that can occur during the enterprise
structure configuration planning process.

Scenario

Your company, InFusion Corporation, is a multinational conglomerate that operates in the United States (US) and the
United Kingdom (UK). InFusion has purchased an Oracle Fusion Cloud Enterprise Resource Planning (ERP) solution
including Oracle General Ledger and all of the Oracle Fusion Cloud Applications subledgers. You are chairing a
committee to discuss creation of a model for your global enterprise structure including both your US and UK operations.

InFusion Corporation

InFusion Corporation has 400 plus employees and revenue of 120 million US dollars. Your product line includes all
the components to build and maintain air quality monitoring applications for homes and businesses. You have two
distribution centers and three warehouses that share a common item master in the US and UK. Your financial services
organization provides funding to your customers for the initial costs of these applications.

The following are elements you must consider in creating your model for your global enterprise structure.

- Your company is required to report using US Generally Accepted Accounting Principles (GAAP) standards and
UK Statements of Standard Accounting Practice and Financial Reporting Standards. How many ledgers do you
want to achieve proper statutory reporting?

- Your managers need reports that show profit and loss (revenue and expenses) for their lines of business. Do
you use business units and balancing segments to represent your divisions and businesses? Do you secure data
by two segments in your chart of accounts which represents each department and legal entity? Or do you use
one segment that represents both to produce useful, but confidential management reports?

- Your corporate management requires reports showing total organizational performance with drill-down
capability to the supporting details. Do you need multiple balancing segment hierarchies to achieve proper
rollup of balances for reporting requirements?

- Your company has all administrative, account payables, procurement, and Human Resources functions
performed at their corporate headquarters. Do you need one or more business units in which to perform all
these functions? How is your shared service center configured?

Global Enterprise Structure Model

The following figure and table summarize the model that your committee has designed and uses numeric values to
provide a sample representation of your structure. The model includes the following recommendations:

- Creation of three separate ledgers representing your separate legal entities:

o InFusion America Inc.
o InFusion Financial Services Inc.
o InFusion UK Services Ltd.
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- Consolidation of results for application components, installations, and maintenance product lines across the
enterprise

- All UK general and administrative costs processed at the UK headquarters
- US Systems' general and administrative costs processed at US Corporate headquarters

- US Financial Services maintains its own payables and receivables departments
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In this chart, the green globe stands for required and gold globe stands for optional setup. The following statements
expand on the data in the chart.

- The enterprise is required because it serves as an umbrella for the entire implementation. All organizations are
created within an enterprise.

- Legal entities are also required. They can be optionally mapped to balancing segment values or represented
by ledgers. Mapping balancing segment values to legal entities is required if you plan to use the intercompany
functionality. The InFusion Corporation is a legal entity but isn't discussed in this example.

- Atleast one ledger is required in an implementation in which you record your accounting transactions.

- Business units are also required because financial transactions are processed in business units.

- A shared service center is optional, but if used, must be a business unit.

- Divisions are optional and can be represented with a hierarchy of cost centers or by a second balancing

segment value.

- Departments are required because they track your employees.

- Optionally, add an item master organization and inventory organizations if you're tracking your inventory

transactions in Oracle Fusion Applications.
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Note: Some Oracle Fusion Cloud Human Capital Management implementations don't require recording accounting
transactions and therefore, don't require a ledger.

Guidelines for Configuring Global Enterprises

Start your global enterprise structure configuration by discussing what your organization's reporting needs are and how
to represent those needs in the Oracle Fusion Cloud Applications.

The following are some questions and points to consider as you design your global enterprise structure in Oracle Fusion
Applications.

Enterprise Configuration
Business Unit Management
- Security Structure

- Compliance Requirements

Enterprise Configuration

- What is the level of configuration needed to achieve the reporting and accounting requirements?
- What components of your enterprise do you need to report on separately?

- Which components can be represented by building a hierarchy of values to provide reporting at both detail and
summary levels?

« Where are you on the spectrum of centralization versus decentralization?

Business Unit Management

- What reporting do | need by business unit?

How can you set up your departments or business unit accounts to achieve departmental hierarchies that
report accurately on your lines of business?

- What reporting do you need to support the managers of your business units, and the executives who measure
them?

How often are business unit results aggregated?

- What level of reporting detail is required across business units?

Security Structure

- What level of security and access is allowed?

- Are business unit managers and the people that report to them secured to transactions within their own
business unit?

- Are the transactions for their business unit largely performed by a corporate department or shared service
center?

125
ORACLE



Oracle Fusion Cloud HCM Chapter 8
Using Common Features for HCM Enterprise Structures

Compliance Requirements

How do you comply with your corporate external reporting requirements and local statutory reporting
requirements?

Do you tend to prefer a corporate first or an autonomous local approach?

- Where are you on a spectrum of centralization, very centralized or decentralized?

Design an Enterprise Configuration

This example illustrates how to set up an enterprise based on a global company operating mainly in the US and the UK
with a single primary industry.

Scenario

InFusion Corporation is a multinational enterprise in the high technology industry with product lines that include all
the components that are required to build and maintain air quality monitoring systems for homes and businesses.
Its primary locations are in the US and the UK, but it has smaller outlets in France, Saudi Arabia, and the United Arab
Emirates (UAE).

Enterprise Details

In the US, InFusion employs 400 people and has company revenue of 120 million US dollars. Outside the US, InFusion
employs 200 people and has revenue of 60 million US dollars.

InFusion requires three divisions.

- The US division covers the US locations.
- The Europe division covers UK and France.
- Saudi Arabia and the UAE are covered by the Middle East division.

InFusion requires legal entities with legal employers, payroll statutory units, tax reporting units, and legislative data
groups for the US, UK, France, Saudi Arabia, and UAE, to employ and pay its workers in those countries.

InFusion requires a number of departments across the enterprise for each area of business, such as sales and
marketing, and a number of cost centers to track and report on the costs of those departments.

InFusion has general managers responsible for business units within each country. Those business units may share
reference data. Some reference data can be defined within a reference data set that multiple business units may
subscribe to. Business units are also required for financial purposes. Financial transactions are always processed within
a business unit.

Resulting Enterprise Configuration

Based on this analysis, InFusion requires an enterprise with multiple divisions, ledgers, legal employers, payroll statutory
units, tax reporting units, legislative data groups, departments, cost centers, and business units.

This figure illustrates the enterprise configuration that results from the analysis of InFusion Corporation.
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Enterprise Information for Non-HCM Users

The Manage Enterprise HCM Information task includes default settings for your enterprise such as the employment
model, worker number generation, and so on.

If you're not implementing Oracle Fusion Human Capital Management (HCM), then the only action you may need to
perform using this task is to change the enterprise name, if necessary. The other settings are HCM-specific and aren't
relevant outside of Oracle Fusion HCM.
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9 Legal Entities, Business Units, and
Reference Data Sets

Overview of Legal Entities, Business Units, and Divisions

The setup tasks for legal entities, divisions, business units and other organizations are in different functional areas in
the Setup and Maintenance work area.

The Legal Structures functional area covers tasks related to legal entity setup, the Organization Structures functional
area includes tasks related to business unit setup, and the Workforce Structures functional area includes tasks related to
department, division, trees, jobs, positions, and other organizations setup.

Overview
Alegal entity is a recognized party with rights and responsibilities given by legislation.

Legal entities have the following rights and responsibilities to:
- Own property
- Trade
Repay debt

- Account for themselves to regulators, taxation authorities, and owners according to rules specified in the
relevant legislation

Their rights and responsibilities may be enforced through the judicial system. Define a legal entity for each registered
company or other entity recognized in law for which you want to record assets, liabilities, expenses and income, pay
transaction taxes, or perform intercompany trading.

Alegal entity has responsibility for elements of your enterprise for the following reasons:

Facilitating local compliance
Minimizing the enterprise's tax liability
Preparing for acquisitions or disposals of parts of the enterprise

Isolating one area of the business from risks in another area. For example, your enterprise develops property
and also leases properties. You could operate the property development business as a separate legal entity to
limit risk to your leasing business.
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The Role of Your Legal Entities

In configuring your enterprise structure in Oracle Fusion Cloud Applications, the contracting party on any transaction is
always the legal entity. Individual legal entities:

- Own the assets of the enterprise
- Record sales and pay taxes on those sales
- Make purchases and incur expenses

- Perform other transactions

Legal entities must comply with the regulations of jurisdictions, in which they register. Europe now allows for companies
to register in one member country and do business in all member countries, and the US allows for companies to register
in one state and do business in all states. To support local reporting requirements, legal reporting units are created and
registered.

You are required to publish specific and periodic disclosures of your legal entities' operations based on different
jurisdictions' requirements. Certain annual or more frequent accounting reports are referred to as statutory or external
reporting. These reports must be filed with specified national and regulatory authorities. For example, in the United
States (US), your publicly owned entities (corporations) are required to file quarterly and annual reports, as well as other
periodic reports, with the Securities and Exchange Commission (SEC), which enforces statutory reporting requirements
for public corporations.

Individual entities privately held or held by public companies don't have to file separately. In other countries, your
individual entities do have to file in their own name, as well as at the public group level. Disclosure requirements are
diverse. For example, your local entities may have to file locally to comply with local regulations in a local currency, as
well as being included in your enterprise's reporting requirements in different currency.

Alegal entity can represent all or part of your enterprise's management framework. For example, if you operate in a
large country such as the United Kingdom or Germany, you might incorporate each division in the country as a separate
legal entity. In a smaller country, for example Austria, you might use a single legal entity to host all of your business
operations across divisions.

Model Legal Entities

Oracle Fusion Cloud Applications support the modeling of your legal entities. If you make purchases from or sell to
other legal entities, define these other legal entities in your customer and supplier registers.

These registers are part of the Oracle Trading Community Architecture.

When your legal entities are trading with each other, represent them as legal entities and as customers and suppliers in
your customer and supplier registers. Use legal entity relationships to determine which transactions are intercompany
and require intercompany accounting. Your legal entities can be identified as legal employers and therefore, are
available for use in Human Capital Management (HCM) applications.

Several decisions you should consider when you create legal entities.
- The importance of using legal entity on transactions
- Legal entity and its relationship to business units

- Legal entity and its relationship to divisions
- Legal entity and its relationship to ledgers
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Legal entity and its relationship to balancing segments

Legal entity and its relationship to consolidation rules

Legal entity and its relationship to intercompany transactions

Legal entity and its relationship to worker assignments and legal employer
Legal entity and payroll reporting

Legal reporting units

The Importance of Using Legal Entities on Transactions

All of the assets of the enterprise are owned by individual legal entities. Oracle Fusion Cloud Financials allow your users
to enter legal entities on transactions that represent a movement in value or obligation.

For example, a sales order creates an obligation on the legal entity that books the order and promises to deliver the
goods on the acknowledged date. The creation also creates an obligation on the purchaser to receive and pay for those
goods. Contract law in most countries contains statutes that state damages can be sought for both:

- Actual losses, putting the injured party in the same state as if they had not entered into the contract.

- What is called loss of bargain, or the profit that would have made on a transaction.

In another example, if you revalued your inventory in a warehouse to account for raw material price increases,

the revaluation and revaluation reserves must be reflected in your legal entity's accounts. In Oracle Fusion Cloud
Applications, your inventory within an inventory organization is managed by a single business unit and belongs to one
legal entity.

Legal Entity and Its Relationship to Business Units

A business unit can process transactions on behalf of many legal entities. Frequently, a business unit is part of a single
legal entity. In most cases, the legal entity is explicit on your transactions. For example, a payables invoice has an explicit
legal entity field. Your accounts payables department can process supplier invoices on behalf of one or many business
units.

In some cases, your legal entity is inferred from your business unit that's processing the transaction. For example,
Business Unit ACM UK has a default legal entity of InFusion UK Ltd. When a purchase order is placed in ACM UK,

the legal entity InFusion UK Ltd is legally obligated to the supplier. Oracle Procurement, Oracle Fusion Cloud Project
Management, and Oracle Fusion Cloud Supply Chain and Manufacturing applications rely on deriving the legal entity
information from the business unit.

Legal Entity and Its Relationship to Divisions

The division is an area of management responsibility that can correspond to a collection of legal entities. If wanted, you
can aggregate the results for your divisions by legal entity or by combining parts of other legal entities. Define date-
effective hierarchies for your cost center or legal entity segment in your chart of accounts to facilitate the aggregation
and reporting by division. Divisions and legal entities are independent concepts.

Legal Entity and Its Relationship to Ledgers

One of your major responsibilities is to file financial statements for your legal entities. Map legal entities to specific
ledgers using the Oracle General Ledger Accounting Configuration Manager. Within a ledger, you can optionally map a
legal entity to one or more balancing segment values.
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Legal Entity and Its Relationship to Balancing Segments

General Ledger supports up to three balancing segments. Best practices recommend one segment represents your legal
entity to ease your requirement to account for your operations to regulatory agencies, tax authorities, and investors.
Accounting for your operations means you must produce a balanced trial balance sheet by legal entity. If you account
for many legal entities in a single ledger, you must:

1. Identify the legal entities within the ledger.
2. Balance transactions that cross legal entity boundaries through intercompany transactions.

3. Decide which balancing segments correspond to each legal entity and assign them in General Ledger
Accounting Configuration Manager. Once you assign one balancing segment value in a ledger, then all your
balancing segment values must be assigned. This recommended best practice facilitates reporting on assets,
liabilities, and income by legal entity.

Represent your legal entities by at least one balancing segment value. You may represent it by two or three balancing
segment values if more granular reporting is required. For example, if your legal entity operates in multiple jurisdictions
in Europe, you might define balancing segment values and map them to legal reporting units. You can represent a legal
entity with more than one balancing segment value. Do not use a single balancing segment value to represent more
than one legal entity.

In General Ledger, there are three balancing segments. You can use separate balancing segments to represent your
divisions or strategic business units to enable management reporting at the balance sheet level for each. This solution
is used to empower your business unit and divisional managers to track and assume responsibility for their asset
utilization or return on investment. Using multiple balancing segments is also useful when you know at the time of
implementation that you're disposing of a part of a legal entity and want to isolate the assets and liabilities for that
entity.

Implementing multiple balancing segments requires every journal entry that isn't balanced by division or business unit,
to generate balancing lines. You can't change to multiple balancing segments after you begin using the ledger because
your historical data isn't balanced by the new balancing segments. Restating historical data must be done at that point.

If your enterprise regularly spins off businesses or holds managers accountable for utilization of assets, identify the
business with a balancing segment value. If you account for each legal entity in a separate ledger, no requirement exists
to identify the legal entity with a balancing segment value.

While transactions that cross balancing segments don't necessarily cross legal entity boundaries, all transactions that
cross legal entity boundaries must cross balancing segments. If you make an acquisition or are preparing to dispose of
a portion of your enterprise, you may want to account for that part of the enterprise in its own balancing segment even
if the portion isn't a separate legal entity. If you don't map legal entities sharing the same ledger to balancing segments,
you can't distinguish them using intercompany functionality or track individual equity.

Legal Entity and Its Relationship to Consolidation Rules

In Oracle Fusion Applications you can map legal entities to balancing segments and then define consolidation rules
using your balancing segments. You are creating a relationship between the definition of your legal entities and their
role in your consolidation.

Legal Entity and Its Relationship to Intercompany Transactions

Use Oracle Intercompany features to create intercompany entries automatically across your balancing segments.
Intercompany processing updates legal ownership within the enterprise's groups of legal entities. Invoices or journals
are created as needed. To limit the number of trading pairs for your enterprise, set up intercompany organizations
and assign then to your authorized legal entities. Define processing options and intercompany accounts to use when
creating intercompany transactions and to assist in consolidation elimination entries. These accounts are derived
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and automatically entered on your intercompany transactions based on legal entities assigned to your intercompany
organizations.

Intracompany trading, in which legal ownership isn't changed but other organizational responsibilities are, is also
supported. For example, you can track assets and liabilities that move between your departments within your legal
entities by creating departmental level intercompany organizations.

Tip: In the Oracle Fusion Supply Chain and Manufacturing applications, you can model intercompany relationships
using business units, from which legal entities are derived.

Legal Entity and Its Relationship to Worker Assignments and Legal
Employer

Legal entities that employ people are called legal employers in the Legal Entity Configurator. You must enter legal
employers on worker assignments in Oracle Fusion Cloud HCM.

Legal Entity and Payroll Reporting

Your legal entities are required to pay payroll tax and social insurance such as social security on your payroll. In Oracle
Fusion Applications, you can register payroll statutory units to pay and report on payroll tax and social insurance for
your legal entities. As the legal employer, you might be required to pay payroll tax, not only at the national level, but
also at the local level. You meet this obligation by establishing your legal entity as a place of work within the jurisdiction
of a local authority. Set up legal reporting units to represent the part of your enterprise with a specific legal reporting
obligation. You can also mark these legal reporting units as tax reporting units, if the legal entity must pay taxes as a
result of establishing a place of business within the jurisdiction.

Overview of Legal Jurisdiction and Authorities

You are required to register your legal entities with legal authorities in the jurisdictions where you conduct business.
Register your legal entities as required by local business requirements or other relevant laws.

For example, register your legal entities for tax reporting to report sales taxes or value added taxes.

Define jurisdictions and related legal authorities to support multiple legal entity registrations, which are used by Oracle
Fusion Tax and Oracle Fusion Payroll. When you create a legal entity, the Oracle Fusion Legal Entity Configurator
automatically creates one legal reporting unit for that legal entity with a registration.

Jurisdictions

Jurisdiction is a physical territory such as a group of countries, country, state, county, or parish where a particular piece
of legislation applies.

French Labor Law, Singapore Transactions Tax Law, and US Income Tax Laws are examples of particular legislation
that apply to legal entities operating in different countries' jurisdictions. Judicial authority may be exercised within a
jurisdiction.
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Types of jurisdictions are:
Identifying Jurisdiction
Income Tax Jurisdiction
- Transaction Tax Jurisdiction

Identifying Jurisdiction

For each legal entity, select an identifying jurisdiction. An identifying jurisdiction is your first jurisdiction you must
register with to be allowed to do business in a country. If there's more than one jurisdiction that a legal entity must
register with to commence business, select one as the identifying jurisdiction. Typically the identifying jurisdiction is the
one you use to uniquely identify your legal entity.

Income tax jurisdictions and transaction tax jurisdictions don't represent the same jurisdiction. Although in some
countries, the two jurisdictions are defined at the same geopolitical level, such as a country, and share the same legal
authority, they're two distinct jurisdictions.

Income Tax Jurisdiction

Create income tax jurisdictions to properly report and remit income taxes to the legal authority. Income tax jurisdictions
by law impose taxes on your financial income generated by all your entities within their jurisdiction. Income tax is a key
source of funding that the government uses to fund its activities and serve the public.

Transaction Tax Jurisdiction

Create transaction tax jurisdictions through Oracle Tax in a separate business flow, because of the specific needs and
complexities of various taxes. Tax jurisdictions and their respective rates are provided by suppliers and require periodic
maintenance. Use transaction tax jurisdiction for legal reporting of sales and value added taxes.

Legal Authorities

Alegal authority is a government or legal body that's charged with powers to make laws, levy and collect fees and taxes,
and remit financial appropriations for a given jurisdiction.

For example, the Internal Revenue Service is the authority for enforcing income tax laws in United States. In some
countries, such as India and Brazil, you're required to print legal authority information on your tax reports. Legal
authorities are defined in the Oracle Legal Entity Configurator. Tax authorities are a subset of legal authorities and are
defined using the same setup flow.

Legal authorities aren't mandatory in Oracle Fusion Cloud Human Capital Management (HCM), but are recommended
and are generally referenced on statutory reports.

Create Legal Jurisdictions, Addresses and Authorities

Define legal jurisdictions and related legal authorities to support multiple legal entity registrations, which are used by
Oracle Fusion Tax and Oracle Fusion Payroll.
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Legal Jurisdictions

Create a legal jurisdiction by following these steps:

ocCUuhWUNRA

8.
9.
10.
1.

In the Setup and Maintenance work area, go to the Manage Legal Jurisdictions task.

Select Create.

Enter a unique Name, United States Income Tax.

Select a Territory, United States.

Select a Legislative Category, Income tax.

Select Identifying, Yes. Identifying indicates the first jurisdiction a legal entity must register with to do business
in a country.

Enter a Start Date if desired. You can also add an End Date to indicate a date that the jurisdiction may no
longer be used.

Select a Legal Entity Registration Code, EIN or TIN.

Select a Legal Reporting Unit Registration Code, Legal Reporting Unit Registration Number.

Optionally enter one or more Legal Functions.

Save and Close.

Legal Addresses for Legal Entities and Reporting Units

Create a legal address for legal entities and reporting units by following these steps:

—

OCVWOgOUAWNRA

In the Setup and Maintenance work area, go to the Manage Legal Address task.
Select Create.

Select Country.

Enter Address Line 1, Oracle Parkway.

Optionally enter Address Line 2, and Address Line 3.

Enter or Select the postal code, 94065.

Select Geography 94065 and Parent Geography Redwood Shores, San Mateo, CA.
Optionally enter a Time Zone, US Pacific Time.

OK.

Save and Close.

Legal Authorities

Create a legal authority by following these steps:

1.
2.
3.

0 3o vk

In the Setup and Maintenance work area, go to the Manage Legal Authorities task.
Enter the Name, California Franchise Tax Board.
Enter the Tax Authority Type, Reporting.

Note: Create an address for the legal authority.

Select Create.

The Site Number is automatically assigned.
Optionally enter a Mail Stop.

Select Country, United States

Enter Address Line 1, 121 Spear Street, Suite 400.
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9. Optionally enter Address Line 2, and Address Line 3.
10. Enter or Select the postal code, 94105.
11. Select Geography 94105 and Parent Geography San Francisco, San Francisco, CA.
12. OK.
13. Optionally enter a Time Zone, US Pacific Time.
14. Optionally click the One-Time Address check box.
15. The From Date displays today's date. Update if necessary.
16. Optionally enter a To Date to indicate the last day the address can be used.
Note: You can optionally enter Address Purpose details.
17. Select Add Row.
18. Select Purpose.
19. The Purpose from Date will default to today's date.
20. Optionally enter a Purpose to Date.
21. OK.
22. Save and Close.
Related Topics

 Legal Authorities

» Overview of Legal Jurisdiction and Authorities

« How do | update existing setup data?

Chapter 9

Legal Entities, Business Units, and Reference Data Sets

Create Legal Entities, Registrations, and Reporting Units

Define a legal entity for each registered company or other entity recognized in law for which you want to record assets,
liabilities, and income, pay transaction taxes, or perform intercompany trading.

Legal Entity

Create a legal entity by following these steps:

NOoOUuRWNRA

o

10.
1.

In the Setup and Maintenance work area, go to the Manage Legal Entity task.
Accept the default Country, United States.

Enter Name, InFusion USA West.

Enter Legal Entity Identifier, USO033.

Optionally enter Start Date. When the start date is blank the legal entity is effective from the creation date.

Optionally enter an End Date.

Optionally, if your legal entity should be registered to report payroll tax and social insurance, select the Payroll

statutory unit check box.

Optionally, if your legal entity has employees, select the Legal employer check box.

Optionally, if this legal entity isn't a payroll statutory unit, select an existing payroll statutory unit to report

payroll tax and social instance on behalf of this legal entity.
Enter the Registration Information
Accept the default Identifying Jurisdiction, United States Income Tax.
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12.

13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23,

24.

Search for and select a Legal Address, 500 Oracle Parkway, Redwood Shores, CA 94065.

The legal address must have been entered previously using the Manage Legal Address task.
OK.

Optionally enter a Place of Registration.

Enter the EIN or TIN.

Enter the Legal Reporting Unit Registration Number.

Save and Close.

In the Setup and Maintenance work area, go to the Manage Legal Entity page and Select to set scope.
Select the Manage Legal Entity.

In the *Legal Entity list, select Select and Add.

Click Apply and Go to Task.

Select your legal entity.

Save and Close.

This sets the scope for your task list to the selected legal entity.
Save and Close.

Legal Entity Registrations

Alegal entity registration with the same name as that of the legal entity is created by default. To verify this, locate the
Manage Legal Entity Registrations task and then select Go to Task. To create another registration for the legal entity
follow these steps:

1.

8.

NOoOuhWN

In the Setup and Maintenance work area, go to the Manage Legal Entity Registrations task. Verify that the
Legal Entity scope value is set correctly.

Go to Task.

Select Create.

Enter Jurisdiction.

Enter Registered Address.

Enter Registered Name.

Optionally enter Alternate Name, Registration Number, Place of Registration, Issuing Legal Authority, and
Issuing Legal Authority Address, Start Date, and End Date.

Save and Close.

Legal Reporting Unit
When a legal entity is created, a legal reporting unit with the same name as that of the entity is also automatically
created. To create more legal reporting units or modify the settings follow these steps:

1.

VOO UhWN

In the Setup and Maintenance work area, go to the Manage Legal Reporting Unit task. Verify that the Legal
Entity scope value is set correctly.

Go to Task

Select Create.

Enter Territory, United States.

Enter Name.

Optionally enter a Start Date.

Enter Registration Information.

Search for and select Jurisdiction.

Enter Main Legal Reporting Unit information.
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10. Select the value Yes or No for the Main Legal Reporting Unit. Set value to yes only if you're creating a new
main (primary) legal reporting unit.

11. Enter the Main Effective Start Date, 1/1/11.

12. Save and Close.

Related Topics
« Overview

- Model Legal Entities
» Plan Legal Reporting Units
» How do | update existing setup data?

Legislative Data Groups

Legislative data groups are a means of partitioning payroll and related data. At least one legislative data group is
required for each country where the enterprise operates.

Each legislative data group is associated with one or more payroll statutory units. Each payroll statutory unit can belong
to only one legislative data group.

Payroll-related information, such as elements, is organized by legislative data group. Each legislative data group:

Marks a legislation in which payroll is processed.
Is associated with a legislative code, currency, and its own cost allocation key flexfield structure.
Is a boundary that can share the same set up and still comply with the local laws.

- Can span many jurisdictions as long as they're within one country.

- Can contain many legal entities that act as payroll statutory units.

How Legal Employers Work with Payroll Statutory Units
and Tax Reporting Units

You can designate legal entities as legal employers and payroll statutory units, which makes them available for use in
Oracle Fusion Human Capital Management (HCM).

You can have only one legal entity that's also a payroll statutory unit and legal employer, or multiple legal entities,
payroll statutory units and legal employers. Payroll statutory units and tax reporting units share a parent child
relationship with the payroll statutory unit being a parent of a tax reporting unit

Legal Employers and Payroll Statutory Units

You can designate payroll statutory units to group legal employers to do statutory calculations at a higher level. For
example, you can use payroll statutory units for court orders, or to calculate the United Kingdom (UK) statutory sick pay.
Alegal employer can exist independently of an enterprise or be a part of a payroll statutory unit. There can be many
legal employers belonging to a payroll statutory unit, but a legal employer can belong only to one payroll statutory unit.
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Legal Employers and Tax Reporting Units

Tax reporting units are indirectly associated with a legal employer through the payroll statutory unit. One or more
tax reporting units can be used by a single legal employer, and a tax reporting unit can be used by one or more legal
employers.

For example, if a single tax reporting unit is linked to a payroll statutory unit and two legal employers are associated with
this payroll statutory unit, then both legal employers are associated with the tax reporting unit. Use the Manage Legal
Reporting Unit HCM Information task to designate an existing legal reporting unit as a tax reporting unit. You need to
select a parent payroll statutory unit when you create a legal reporting unit belonging to a legal employer (that isn't a
payroll statutory unit as well). Next, you need to designate the legal reporting unit as a tax reporting unit and select the
legal employer.

Related Topics
» Examples of HCM Organization Models

« Overview

- What's a legal employer?

- What's a payroll statutory unit?
- What's a tax reporting unit?

Examples of HCM Organization Models

You can use any of these HCM organization models.

- Simple Configuration
Multiple Legal Employers and Tax Reporting Units

- One Payroll Statutory Unit and Two Tax Reporting Units

- One Payroll Statutory Unit with Several Tax Reporting Units
Multiple Payroll Statutory Units with Several Tax Reporting Units

These models include a legislative data group (LDG) that isn't an organization classification and show how you can
partition payroll data by associating them with a payroll statutory unit

Simple Configuration

This is an example of a simple configuration without any tax reporting units. The enterprise has only one legal entity,
which is both a payroll statutory unit and a legal employer, and shares the same boundaries. In this type reporting can
be done only at a single level. Countries such as Saudi Arabia and the United Arab Emirates (UAE) might use this type of
model, as these countries report at the legal entity level.
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This figure illustrates a simple configuration where the enterprise has only one legal entity, which is both a payroll

InFusion Corporation
Enterprise

Division

Legislative

r

Data Group |

Legal Entity

<
PSU

Legal v
Employer

statutory unit and a legal employer.

Multiple Legal Employers and Tax Reporting Units

In this configuration, you define one legal entity, InFusion US as a payroll statutory unit with two separate legal entities,
which are also legal employers. This model shows multiple legal employers that are associated with a single payroll
statutory unit. Tax reporting units are always associated with a specific legal employer (or employers) through the

payroll statutory unit.

The implication is that payroll statutory reporting boundaries vary from human resources (HR) management, and you

can categorize the balances separately as either a payroll statutory unit, legal employer, or a tax reporting unit.

This configuration is based on tax filing requirements, as some tax-related payments and reports are associated with a

higher level than employers. An example of a country that might use this model is the US
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This figure illustrates an enterprise that has one payroll statutory unit and multiple legal employers and tax reporting

units.
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One Payroll Statutory Unit and Two Tax Reporting Units

This model makes no distinction between a legal employer and a payroll statutory unit. You define tax reporting units as

subsidiaries to the legal entity.

In this enterprise, legal entity is the highest level of aggregation for payroll calculations and reporting. Statutory

reporting boundaries are the same for both payroll and HR management. An example of a country that might use this
model is France.
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This figure illustrates an example of an organization with one legal entity. The legal entity
is both a legal employer and a payroll statutory unit and that has two tax reporting units.

InFusion Corporation
Enterprise
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Legal ./
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InFusion Colombes InFusion Lyon
Tax Reporting Unit Tax Reporting Unit

One Payroll Statutory Unit with Several Tax Reporting Units

In this model, the enterprise has one legal entity. Legal employers and tax reporting units are independent from each
other within a payroll statutory unit, because there is no relationship from a legal perspective. Therefore, you can report
separately on both entities

Using this model, you can't report on tax reporting unit balances within a legal employer, and categorize balances by
either or both organizations, as required. An example of a country that might use this model is India.
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This figure illustrates an enterprise with one legal entity that's a payroll statutory unit
and a legal employer. The tax reporting units are independent from the legal employer.
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Multiple Payroll Statutory Units with Several Tax Reporting Units

In this model, the enterprise has two legal entities. The legal employers and tax reporting units are independent from
each other within a payroll statutory unit, because there is no relationship from a legal perspective. Therefore, you can
report separately on both entities.

Using this model, you can't report on tax reporting unit balances within a legal employer, and categorize balances by
either or both organizations, as required. An example of a country that might use this model is the United Kingdom
(UK).
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This figure illustrates an enterprise with two legal entities, and legal employers and tax reporting units are independent

from each other.

Related Topics

InFusion Corporation
Enterprise

| l

Legal Entity

« How Legal Employers Work with Payroll Statutory Units and Tax Reporting Units

« Legislative Data Groups

« Overview
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Examples of Creating Calculation Cards for Deductions
at Different Levels

You can create and manage calculation cards at several different levels, from an individual person to a payroll statutory
unit.

Use the cards to capture information specific to a person or organization, such as an employee's tax filing status or
an employer's tax identification number. Calculation card entries override default values defined at other levels. The
priority of information, from highest to lowest, is as follows:

1. Personal calculation card (payroll relationship level)

2. Tax reporting unit calculation card

3. Payroll statutory unit calculation card

4. Calculation value definitions (legislative data group level)

Note: Not all countries or territories support creating calculation cards for payroll statutory units and tax reporting
units. The enterable values at each level also vary by country or territory. The basic steps to create and manage
calculation cards are the same at all levels.

Use these examples to understand when you might define calculation cards at each level.

Personal Calculation Card

Scenario: An employee qualifies for a special reduced tax rate.

Task: Calculation Cards task in the Payroll section under My Client Groups.

Tax Reporting Unit Card

Scenario: The income tax exemption amount is 2000 at the legislative data group level, but a tax reporting unitin a
particular state or province uses an exemption amount of 2500. Enter this default value for the tax reporting unit, which
can be overridden on personal calculation cards.

Task: Manage Legal Reporting Unit Calculation Cards task in the Setup and Maintenance section.

Payroll Statutory Unit Card

Scenario: During application setup, the implementation team defines default contribution rates for the payroll statutory
unit.

Task: Manage Legal Entity Calculation Cards task in the Setup and Maintenance section.

Calculation Value Definition

Scenario: You can view the predefined income tax rates for your country, but you can't edit them.
Task: Calculation Value Definitions task in the Payroll section.

If an employer qualifies for a special tax rate, enter these values on a calculation card at the appropriate level.
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Business Units

A business unit is a unit of an enterprise that performs one or many business functions that can be rolled up in a
management hierarchy. A business unit can process transactions on behalf of many legal entities.

Normally, it has a manager, strategic objectives, a level of autonomy, and responsibility for its profit and loss. Roll
business units up into divisions if you structure your chart of accounts with this type of hierarchy.

Though there’s no direct relationship between business units and legal employers, it's recommended that you either
maintain a 1:1 relationship between the two or have many business units within a legal employer. Typically, a business
unit is used to roll up financial transactions within a legal entity. So, if you set up business units at a higher level than
legal entities, your financial transactions may fail.

In Oracle Fusion Cloud Applications you do the following:

- Assign your business units to one primary ledger. For example, if a business unit is processing payables
invoices, then it must post to a particular ledger. This assignment is required for your business units with
business functions that produce financial transactions.

- Use a business unit as a securing mechanism for transactions. For example, if you run your export business
separately from your domestic sales business, then secure the export business data to prevent access by the
domestic sales employees. To accomplish this security, set up the export business and domestic sales business
as two separate business units.

The Oracle Fusion Applications business unit model provides the following advantages:

- Enables flexible implementation
- Provides consistent entity that controls and reports on transactions
- Shares sets of reference data across applications

Business units process transactions using reference data sets that reflect your business rules and policies and can differ
from country to country. With Oracle Fusion Application functionality, you can share reference data, such as payment
terms and transaction types, across business units, or you can have each business unit manage its own set depending
on the level at which you want to enforce common policies.

In summary, use business units for:

- Management reporting
- Transaction processing
- Transactional data security

- Reference data sharing and definition

Brief Overview of Business Unit Security

A number of Oracle Fusion Applications use business units to implement data security. You assign roles like Accounts
Payable Manager to users to permit them to perform specific functions, and you assign business units for each role to
users to give them access to data in those business units. For example, users who have been assigned a Payables role
for a particular business unit, can perform the function of payables invoicing on the data in that business unit. Roles can
be assigned to users manually using the Security Console, or automatically using provisioning rules. Business Units can
be assigned to users using the Manage Data Access for Users task found in Setup and Maintenance.
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Related Topics
- Reference Data Sets and Sharing Methods

How Business Units Work with Reference Data Sets

Reference data sharing enables you to group set-enabled reference data such as jobs or grades to share the data across
different parts of the organization.

Sets also enable you to filter reference data at the transaction level so that only data assigned to certain sets is available
to be selected. To filter reference data, Oracle Fusion Human Capital Management (HCM), applications use the business
unit on the transaction. To set up reference data sharing in Oracle Fusion HCM, you create business units and sets, and
then assign the sets to the business units.

Common Set Versus Specific Sets

Some reference data in your organization may be considered global, and should therefore be made available for use
within the entire enterprise. You can assign this type of data to the Common Set, which is a predefined set. Regardless
of the business unit on a transaction, reference data assigned to the Common Set is always available, in addition to the
reference data assigned to the set that corresponds to the business unit on the transaction.

Other types of reference data can be specific to certain business units, so you can restrict the use of the data to those
business units. In this case, you can create sets specifically for this type of data, and assign the sets to the business
units.

Business Unit Set Assighment

When you assign reference data sets to business units, you assign a default reference data set to use for all reference
data types for that business unit. You can override the set assignment for one or more data types.

Example: Assigning Sets to Business Units

InFusion Corporation has two divisions: Lighting and Security, and the divisions each have two locations. Each location
has one or more business functions.
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The following figure illustrates the structure of InFusion Corporation.

Enterprise
InFusion Corporation

)\

| }

Division Division
InFusion Lighting InFusion Security
Legal Entity Legal Entity Leqal Entity Legal Entity
Japan us UK India
I 1 ¥ ¥ I l
Sales Marketing Sales Sales Sales Marketing

When deciding how to create business units, InFusion decides to create them using the country and business function

level. Therefore, they created the following business units:

- Sales_Japan

- Marketing_Japan
- Sales_US

- Sales_UK

- Marketing_India

- Sales_India

Because locations, departments, and grades are specific to each business unit, InFusion does not want to share these
types of reference data across business units. They create a reference data set for each business unit so that data

of those types can be set up separately. Because the jobs in the Sales business function are the same across many
locations, InFusion decides to create one additional set called Jobs. They override the set assignment for the Jobs

reference data group and assign it to the Jobs set. Based on these requirements, they create the following sets:

- Sales_Japan_Set
- Mktg_Japan_Set
- Sales_US_Set

-+ Sales_UK_Set

- Mktg_India_Set
- Sales_India_Set

- Grades_Set

The following table describes the default set assignment and the set assignment overrides for each business unit in

InFusion:
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Business Unit Default Set Assignment Set Assignment Overrides
Sales_Japan Sales_Japan_Set for grades, departments, and = Jobs set for jobs
locations

Marketing_Japan Mktg_Japan_Set for grades, departments, and =~ None
locations

Sales_US Sales_US_Set for grades, departments, and Jobs set for jobs
locations

Sales_UK Sales_UK_Set for grades, departments, and Jobs set for jobs
locations

Marketing_India Mktg_India_Set for grades, departments, and None
locations

Sales_India Sales_India_Set for grades, departments, and Jobs set for jobs
locations

When setting up grades, departments, and locations for the business units, InFusion assigns the data to the default set
for each business unit. When setting up jobs, they assign the Jobs set and assign the Common Set to any jobs that may
be used throughout the entire organization.

When using grades, departments, and locations at the transaction level, users can select data from the set that
corresponds to the business unit they enter on the transaction, and any data assigned to the Common Set. For example,
for transactions for the Marketing_Japan business unit, grades, locations, and departments from the Mktg_Japan_Set is
available to select, as well as from the Common Set.

When using jobs at the transaction level, users can select jobs from the Jobs set and from the Common Set when they
enter a sales business unit on the transaction. For example, when a manager hires an employee for the Sales_India
business unit, the list of jobs is filtered to show jobs from the Jobs and Common sets.

The following figure illustrates what sets of jobs can be accessed when a manager creates an assignment for a worker.
. . - can also select jobs

from...

can select jobs from...

|

Jobs Set Commaon Set
{ : ! l
Sales Sales Sales Administrative
Consultant Manager Executive Assistant
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Associate Business Unit with Legal Employer

You can associate multiple business units with a legal employer. This enables filtering business units by legal employer,
on responsive pages that have implemented this feature.You use the Associated Business Units extensible flexfield (EFF)
context for the business unit - legal entity association.

These are some key points to note:

By default, the Associated Business Units context isn't associated with any page. You need to configure the
mapping on the Manage Extensible Flexfields page. Thereafter, you can associate multiple business units with
the legal employer. Once the context is associated, it appears for all legal employers.

- Alegal employer must have at least one associated business unit to filter the business unit by legal employer.

- You can associate multiple business units with a legal employer, but can't associate the same business unit
twice with a legal employer.

- You can associate the same business unit with multiple legal employers.
- You can delete the legal employer - business unit association.
- You can associate business units when updating or correcting a legal employer.

- The business unit list of values displays all active and inactive business units configured. There isn't any
filtering for only active business units.

Business units are listed in the ascending order of business unit name.

In this example, Vision Enterprise has 3 legal employers in India - Vision India, Vision Corp India, and Vision India
Financial Services. Each legal employer has 5 business units defined. You want to filter the business units according
to the Vision India legal employer. So, you associate the business units with the legal employer using the Associated
Business Units extensible flexfield context.

Let's look at the steps to update the key values for this association. For other fields, you can use the default values.

Add Context to Manage Legal Entity HCM Information Page

Go to My Enterprise > Setup and Maintenance.

Search and select the Manage Extensible Flexfields task.

Search for Organization Information EFF on the Manage Extensible Flexfields page.

Click Edit.

Expand the Organization category and select Legal Employer.

In the Legal Employer: Details section, select the Associated Business Units delivered context and click the

Pages tab.

7. Inthe Legal Employer: Associated Contexts Details section, click the Select and Add icon.

8. In the Select and Add: Contexts window, enter Associated Business Units in the Name field and click Search.
9. Select the context.

10. Click Apply.

11. Click Save and Close.

12. Select the Organization Information EFF context on the Manage Extensible Flexfields page and click the

Deploy Flexfield button.

CUPUNA

Associate Business Units to Vision India

1. Go to My Client Groups > Quick Actions > Workforce Structures.
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2. Search and click the Manage Legal Entity HCM Information task.
3. Search and click the Vision India legal entity to associate the business units.
4. Click Edit > Update or Correct.
5. Click the Add Row icon in the Associated Business Units section.
6. Search and select these business units.
Number Business Unit
1 Legal
2 Human Resources
3 Facilities
4 Administration
5 Operations

Note: As a prerequisite, these business units should already exist.

Repeat step 5 to add more business units.
7. Click Submit.

Related Topics
- Filter Business Units Based on Legal Employers

FAQs for Legal Entities, Business Units, and Reference
Data Set

What's a legal employer?

Alegal employer is a legal entity that employs workers. You define a legal entity as a legal employer in the Oracle Fusion
Legal Entity Configurator.

The legal employer is captured at the work relationship level, and all assignments within that relationship are
automatically with that legal employer. Legal employer information for worker assignments is also used for reporting
purposes.
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What's a legal address?

Alegal address is the mailing address of a legal entity or legal authority. A legal address is also the address a legal entity
uses to register with a legal authority.

You can use legal addresses to send correspondence, such as invoices, bills, reports, and so on, to a legal entity or
authority.

Note:
- You must create legal addresses before creating legal entities

- You can create legal addresses for legal authorities when creating legal authorities

What's a payroll statutory unit?

Payroll statutory units are legal entities that are responsible for paying workers, including the payment of payroll tax and
social insurance.

A payroll statutory unit can pay and report on payroll tax and social insurance on behalf of one or many legal entities,
depending on the structure of your enterprise. For example, if you're a multinational, multiple company enterprise,
then you register a payroll statutory unit in each country where you employ and pay people. You can optionally register
a consolidated payroll statutory unit to pay and report on workers across multiple legal employers within the same
country. You associate a legislative data group with a payroll statutory unit to provide the correct payroll information for
workers.

What's a tax reporting unit?

Use a tax reporting unit to group workers for the purpose of tax and social insurance reporting. A tax reporting unit is
the Oracle Fusion Human Capital Management (HCM) version of the legal reporting unit in Oracle Fusion Applications.

To create a tax reporting unit, you use the Oracle Fusion Legal Entity Configurator to define a legal entity as a payroll
statutory unit. When you identify a legal entity as a payroll statutory unit, the application transfers the legal reporting
units that are associated with that legal entity to Oracle Fusion HCM as tax reporting units. You can then access the tax
reporting unit using the Manage Legal Reporting Unit HCM Information task.

If you identify a legal entity as a legal employer, and not as a payroll statutory unit, you must enter a parent payroll
statutory unit. The resulting legal reporting units are transferred to Oracle Fusion HCM as tax reporting units, but as
children of the parent payroll statutory unit that you entered, and not the legal entity that you identified as a legal
employer.
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What's an ultimate holding company?

The legal entity that represents the top level in your organization hierarchy, as defined by the legal name entered for the
enterprise. This designation is used only to create an organization tree, with these levels:

- Ultimate holding company as the top level
- Divisions and country holding companies as the second level

- Legal employers as the third level

What reference data objects can be shared across business units?

The following table contains the reference data objects for the Oracle Fusion Applications that can be shared across
business units and the method in which the reference data for each is shared.

Application Name Reference Data Object Method of Sharing

Trading Community Model Customer Account Relationship Assignment to one set only, no common values
allowed

Trading Community Model Customer Account Site Assignment to one set only, no common values
allowed

Trading Community Model Salesperson Assignment to one set only, no common values
allowed

Opportunity Management Sales Method Group Assignment to one set only, with common
values

Work Management Assessment Templates Assignment to one set only, with common
values

Enterprise Contracts Contract Types Assignment to one set only, with common
values

Sales Sales Method Assignment to one set only, with common
values

Common Components Activity Templates Assignment to one set only, with common
values

Payables Payment Terms Assignment to multiple sets, no common values
allowed
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Application Name

Receivables

Receivables

Receivables

Receivables

Receivables

Receivables

Receivables

Receivables

Receivables

Receivables

Receivables

Advanced Collections

Advanced Collections

Tax

Human Resources

Human Resources

ORACLE

Reference Data Object

Accounting Rules

Aging Buckets

Auto Cash Rules

Collectors

Lockbox

Memo Lines

Payment Terms

Remit To Address

Revenue Contingencies

Transaction Source

Transaction Type

Collections Setups

Dunning Plans

Tax Classification Codes

Departments

Jobs

Chapter 9
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Method of Sharing

Assignment to one set only, with common
values

Assignment to one set only, with common
values

Assignment to one set only, with common
values

Assignment to one set only, with common
values

Assignment to one set only, with common
values

Assignment to one set only, with common
values

Assignment to one set only, with common
values

Assignment to one set only, with common
values

Assignment to one set only, with common
values

Assignment to one set only, with common
values

Assignment to one set only, with common
values

Assignment to one set only, with common
values

Assignment to one set only, with common
values

Assignment to multiple sets, no common values
allowed

Assignment to one set only, with common
values

Assignment to one set only, with common
values
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Application Name Reference Data Object Method of Sharing

Human Resources Locations Assignment to one set only, with common
values

Human Resources Grades Assignment to one set only, with common
values

Project Billing Project and Contract Billing Assignment to multiple sets, no common values
allowed

Project Foundation Project Accounting Definition Assignment to one set only, no common values
allowed

Project Foundation Project Rates Assignment to one set only, with common
values

Order Management Hold Codes Assignment to one set only, with common
values

Order Management Orchestration Process Assignment to one set only, with common
values

What happens if | override the set assignment?

For the selected business unit, you can override the default reference data set for one or more reference data groups.

For example, assume you have three reference data groups: Vision 1 SET, Vision 2 SET, and Vision 3 SET, where Vision
SET 1is the default set for business unit United Kingdom Vision 1 BU. You can override the default so that:

- Grades are assigned to Vision 2 SET.
- Departments are assigned to Vision 3 SET.

- Jobs are assigned to the default set, Vision 3 SET.
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10 Enterprise Structures Configurator (ESC)

How You Establish Enterprise Structures Using the
Enterprise Structures Configurator

The Enterprise Structures Configurator is an interview-based tool that guides you through the process of setting up a
basic enterprise structure.

By answering questions about your enterprise, the tool creates a structure of divisions, legal entities, business units,
and reference data sets that reflects your enterprise structure. After you create your enterprise structure, you also
follow a guided process to determine whether to use positions, and whether to set up additional attributes for jobs and
positions. After you define your enterprise structure and your job and position structures, you can review them, make
any necessary changes, and then load the final configuration.

This figure illustrates the process to configure your enterprise using the Enterprise Structures Configurator.

Establl_sh Establlsl'! ._Job Review Load
Enterprise and Position Configuration Configuration
Structures Structures 9

Divisions Determine
Pasition Usage
¥ ¥
Define
Legal Entities Enterprise-Level
Attributes
¥ L 3
, , Define Contextual
Business Units Attributes
4
Reference Data
Sets
[ ]
Business Unit
Set Assignment
L]
Assign Reference
Data Sets to
Locations

To be able to use the Enterprise Structures Configurator, you must select the Enterprise Structures Guided Flow feature
for your offerings on the Configure Offerings page in the Setup and Maintenance work area. If you don't select this
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feature, then you must set up your enterprise structure using individual tasks provided elsewhere in the offerings, and
you can't create multiple configurations to compare different scenarios.

Establish Enterprise Structures

To define your enterprise structures, use the guided flow within the Establish Enterprise Structures task to enter basic
information about your enterprise, such as the primary industry. You then create divisions, legal entities, business
units, and reference data sets. The Establish Enterprise Structures task enables you to create multiple enterprise
configurations so that you can compare different scenarios. Until you load a configuration, you can continue to create
and edit multiple configurations until you arrive at one that best suits your enterprise.

Establish Job and Position Structures

You also use a guided process to determine whether you want to use jobs only, or jobs and positions. The primary
industry that you select in the Establish Enterprise Structures task provides the application with enough information to
make an initial recommendation. You can either accept the recommendation, or you can answer additional questions
about how you manage people in your enterprise, and then make a selection. After you select whether to use jobs or
positions, you're prompted to set up a descriptive flexfield structure for jobs, and for positions if applicable. Descriptive
flexfields enable you to get more information when you create jobs and positions.

Review Configuration

You can view a result of the interview process prior to loading the configuration. The review results, show the divisions,
legal entities, business units, reference data sets, and the management reporting structure that the application will
create when you load the configuration.

Load Configuration

You can load only one configuration. When you load a configuration, the application creates the divisions, legal entities,
business units, and so on. After you load the configuration, you then use individual tasks to edit, add, and delete
enterprise structures.

This table lists the order of creation of business objects by the Enterprise Structures Configurator

Business Object Task

Location Location Details

Division Manage Divisions

Business Unit Manage Business Units

Set Assignment Override Manage Set Assignments

Legislative Data Group Manage Legislative Data Groups
Enterprise Manage Enterprise HCM Information
Job and Position Flexfield Manage Descriptive Flexfields
Definitions

Legal Entity - Manage Legal Entities

Manage Legal Entity HCM Information
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Business Object Task

- Manage Legal Reporting Unit HCM Information

Organization Tree Manage Organization Trees

Configuration Workbench

The Oracle Fusion Enterprise Structures Configurator is an interview based tool to help you analyze how to represent
your business in the Oracle Fusion Applications.

The interview process poses questions about the name of your enterprise, legal structure, management reporting
structure, and primary organizing principle for your business. Based on your answers, the applications suggest the best
practices to use to implement business units in your enterprise. You can use or modify these answers to ensure that
both your reporting and administrative goals are met in your Oracle Fusion deployment.

How You Create Legal Entities in the Enterprise
Structures Configurator

Use the Enterprise Structures Configurator, to create legal entities for your enterprise automatically, based on the
countries in which divisions of your business operate, or you can upload a list of legal entities from a spreadsheet.

Automatically Creating Legal Entities

If you are not certain of the number of legal entities that you need, you can create them automatically. To use this
option, you first identify all of the countries in which your enterprise operates. The application opens the Map Divisions
by Country page, which contains a matrix of the countries that you identified, your enterprise, and the divisions that you
created. You select the check boxes where your enterprise and divisions intersect with the countries to identify the legal
entities that you want the application to create. The enterprise is included for situations where your enterprise operates
in a country, acts on behalf of several divisions within the enterprise, and is a legal employer in a country. If you select
the enterprise for a country, the application creates a country holding company.

The application automatically creates the legal entities that you select, and identifies them as payroll statutory units
and legal employers. For each country that you indicated that your enterprise operates in, and for each country that you
created a location for, the application also automatically creates a legislative data group.

Any legal entities that you create automatically cannot be deleted from the Create Legal Entities page within the
Enterprise Structures Configurator. You must return to the Map Divisions by Country page and deselect the legal
entities that you no longer want.

Example: Creating Legal Entities Automatically

InFusion Corporation is using the ESC to set up its enterprise structure. The corporation has identified two divisions,
one for Lighting, and one for Security. The Lighting division operates in Japan and the US, and the Security division
operates in the UK and India.
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This figure illustrates InFusion Corporation's enterprise structure.

Enterprise
InFusion Corporation

J\

l }

Division Division
InFusion Lighting InFusion Security

X J\

{ } | }

Japan us UK India

This table represents the selections that InFusion Corporation makes when specifying which legal entities to create on
the Map Divisions by Country page.

Country Enterprise InFusion Lighting InFusion Security
Japan No Yes No
us No Yes No
UK No No Yes
India No No Yes

Based on the selections made in the preceding table, the ESC creates the following four legal entities:

InFusion Lighting Japan LE
InFusion Lighting US LE
InFusion Security UK LE

InFusion Security India LE

Creating Legal Entities Using a Spreadsheet

If you have a list of legal entities already defined for your enterprise, you can upload them from a spreadsheet. To use
this option, you first download a spreadsheet template, then add your legal entity information to the spreadsheet, and
then upload directly to your enterprise configuration. You can export and import the spreadsheet multiple times to
accommodate revisions.
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Related Topics
» Examples of HCM Organization Models

« What's an ultimate holding company?
« Guidelines for Using Desktop Integrated Excel Workbooks
- How Legal Employers Work with Payroll Statutory Units and Tax Reporting Units

Considerations for Creating Business Units in the
Enterprise Structures Configurator

Business units are used within Oracle Fusion applications for management reporting, processing of transactions,
and security of transactional data. Using the Enterprise Structures Configurator, you create business units for your
enterprise either automatically or manually.

Automatically Creating Business Units

To create business units automatically, you must specify the level at which to create business units. Business units
within your enterprise may be represented at one of two levels:

Business function level, such as Sales, Consulting, Product Development, and so on.

- A more detailed level, where a business unit exists for each combination of countries in which you operate and
the functions in those countries.

You can automatically create business units at the following levels:

- Country

- Country and Division

- Country and business function
Division
Division and legal entity
Division and business function
Business function
Legal entity

Business function and legal entity

Select the option that best meets your business requirements, but consider the following:

If you use Oracle Fusion Financials, the legal entity option is recommended because of the manner in which
financial transactions are processed.

- The business unit level that you select determines how the application automatically creates reference data
sets.

After you select a business unit level, the application generates a list of business units, and you select the ones you
want the application to create. If you select a level that has two components, such as country and division, then
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the application displays a table listing both components. You select the check boxes at the intersections of the two
components.

The business units listed by the application are suggestions only, and are meant to simplify the process to create
business units. You aren't required to select all of the business units suggested. When you navigate to the next page in
the ESC guided flow, the Manage Business Units page, you can't delete any of the business units created automatically.
You must return to the Create Business Units page and deselect any business units that you no longer want.

Example: Selecting Business Unit Levels

InFusion Corporation is using the Enterprise Structures Configurator to set up its enterprise structure. InFusion has
identified two divisions, one for Lighting, and one for Security. They operate in four countries: US, UK, Japan, and India,
and they have created a legal entity for each of the countries. The sales and marketing functions are based in both India
and Japan, while the US and the UK have only the sales function.

This figure illustrates InFusion Corporation's enterprise structure.

Enterprise
InFusion Corparation

X

| }

Division Division
InFusion Lighting InFusion Security
Legal Entity Legal Entity Leqgal Entity Legal Entity
Japan us LK India
I l ¥ ¥ I l
Sales Marketing Sales Sales Sales Marketing

The following table lists the options for business unit levels and the resulting business units that the application
suggests for InFusion Corporation.

Business Unit Level Suggested Business Units
Country - US
UK
- Japan
India
Country and Division - InFusion Lighting: Japan

InFusion Lighting: US
Infusion Security: UK

Infusion Security: India
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Business Unit Level

Country and business function

Division

Division and Legal Entity

Division and Business Function

Business Function

Legal Entity

Legal Entity and Business Function

Suggested Business Units

- Sales: Japan

- Marketing: Japan
- Sales: US

- Sales: UK

- Marketing: India

- Sales: India

- InFusion Lighting

« InFusion Security

« InFusion Lighting: Japan
« InFusion Lighting: US
- Infusion Security: UK

- Infusion Security: India

- InFusion Lighting, Sales
- InFusion Lighting, Marketing
- InFusion Security, Sales

- InFusion Security, Marketing

. Sales

- Marketing

- Legal Entity: Japan
- Legal Entity: US

- Legal Entity: UK

« Legal Entity India

- Legal Entity: Japan, Sales

- Legal Entity: Japan, Marketing
- Legal Entity: US, Sales

- Legal Entity: UK, Sales

- Legal Entity India, Marketing

- Legal Entity India, Sales

Manually Creating Business Units

If none of the levels for creating business units meets your business needs, you can create business units manually, and
you create them on the Manage Business Units page. If you create business units manually, then no reference data sets
are created automatically. You must create them manually as well.
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Related Topics
« Business Units

- Reference Data Sets and Sharing Methods
« What reference data objects can be shared across asset books?

How You Create Reference Data Sets in the Enterprise
Structures Configurator

If you created business units automatically, then the Enterprise Structures Configurator automatically creates reference
data sets for you. The Enterprise Structures Configurator creates one reference data set for each business unit.

You can add additional sets, but you cannot delete any of the sets that were created automatically. The Enterprise
Structures Configurator creates one reference data set for each business unit. You can add additional sets, but you
cannot delete any of the sets that were created automatically. A standard set called the Enterprise set is predefined.

Common Set

The Common set is a predefined set that enables you to share reference data across business units. When you select
set-enabled data at the transaction level, the list of values includes data in the:

» Common set
- Set associated with the data type for the business unit on the transaction
For example, when you create an assignment, the list of values for grades includes grade in the:

« Common set

- Set that is assigned to grades for the business unit in which you creating the assignment

How You Roll Back an Enterprise Structure Configuration

The Enterprise Structures Configurator provides the ability to roll back an enterprise configuration.

Roll Back a Configuration Manually

You can manually roll back an enterprise configuration after loading it, for example, because you decide you don't
want to use it. Clicking the Roll Back Configuration button on the Manage Enterprise Configuration page rolls back any
enterprise structures that were created as a part of loading the configuration.
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Roll Back a Configuration Automatically

If an error occurs during the process of loading the configuration, then the application automatically rolls back any
enterprise structures that were created before the error was encountered.

FAQs for Enterprise Structures Configurator

What happens if | don't use the Enterprise Structures Configurator
to set up my enterprise structures?

The Enterprise Structures Configurator is an interview-based tool that guides you through setting up divisions, legal
entities, business units, and reference data sets.

If you don't use the Enterprise Structures Configurator, then you must set up your enterprise structure using the
individual tasks that correspond to each enterprise component. In addition, you can't set up multiple configurations and
compare different scenarios. Using the Enterprise Structures Configurator is the recommended process for setting up
your enterprise structures.
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11 Divisions, Departments, Worker Unions,
Locations, and Trees

Guidelines for Using Single or Multiple Classifications for
an Organization

Organization classifications define the purpose of the organization, whether it's a department, a division, or a legal
entity. In some enterprises, organization classifications overlap, which means that the same organization can be
assigned multiple classifications.

For example, one organization within an enterprise might be both a project organization and a department. The
classifications of organizations vary according to business objectives, legal structure, industry, company culture, size
and type of growth. You can create organizations in Oracle Fusion with one or more classifications to reflect your
enterprise structure.

Defining an Organization with One Classification

Define each organization in your enterprise as a separate organization with a single classification to reflect your
enterprise structure and provide flexibility for expansion. The advantage of setting up separate organizations is the
ability to add further organizations to expand the enterprise easily. For example, if your enterprise acquires another
company which has a different line of business in a country in which you employ people, you can create a division, a
legal entity, and additional departments. Classify the new legal entity as a legal employer and payroll statutory unit for
the company's payroll tax and social insurance.

Defining an Organization with Multiple Classifications

Define an organization with multiple classifications if the organization has multiple purposes. For example, use an
organization within the sales applications as a department that employs salespeople and classify it as a department and
a sales organization. Or, if your enterprise operates and employs people in multiple business verticals, create a division
for each such business using the Manage Divisions task. Then use the Manage Departments task to classify the division
as a department.

Related Topics
» Model Your Financial Reporting Structure

How You Configure Your Enterprise Structure After an
Acquisition

The InFusion Corporation is a global company with organizations in the United States (US), the United Kingdom (UK),
France, China, Saudi Arabia, and the United Arab Emirates (UAE).
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Its main area of business is in the high tech industry, but it recently acquired a financial services business, based in
Germany. InFusion wants to retain the financial services company as a separate business with all the costs and reporting
managed by the Financial Services division.

You need to set up organizations to reflect the newly acquired company and its organizations.

The following figure illustrates how to set up the new division for Germany, and how the new division fits into the

L
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enterprise.

The following table summarizes the key decisions for setting up the new division:

Decisions to Consider

Create a separate division?

How many departments?

How many cost centers?

ORACLE

In This Example

Yes, as you want to keep the Financial Services company as a separate line of business. By creating a
separate division, you can manage the costs and reporting separately from the InFusion Corporation.
Additionally, you don't have to modify any existing organizations in your enterprise setup.

The Financial Services company currently has three departments for sales, accounting, and marketing.
As InFusion has no plans to downsize or change the company, you can create the three departments to
retain the structure.

Three, to track the costs of each department.
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Decisions to Consider

How many legal entities?

Create legislative data group?

Create location?
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In This Example

You need one legal entity defined as a legal employer and payroll statutory unit. As the new division
operates only from Germany, you can configure the legal entity to suit Germany's legal and statutory
requirements.

Yes, you need a legislative data group as you currently don't employ or pay people in Germany. Create
one legislative data group to run payroll for your workers in Germany.

Create a new location address for each organization located differently. The financial services company
is based in Frankfurt, and the headquarters and departments are all in the same location.

You can use the following tasks to set up the enterprise structures that you need to include in the new Financial Services

company:
- Creating a Location
- Creating a Division

- Creating Departments

- Creating a Legislative Data Group

- Creating Legal Entities

- Defining Legal Employer and Payroll Statutory Unit Information

Creating a Location

1. Inthe Workforce Structures work area, click the Manage Locations tab to open the Manage Locations page.

2. Onthe Manage Locations page, click Create, and complete the fields shown in the following table. Use the
default values except where indicated.

Field

Name

Code

Country

Address Line 1

Postal Code

City

ORACLE

Value

Germany

DE

Germany

Hauptstrasse 85

6000

Frankfurt
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Click Submit.

Creating a Division

1.
2.
3.

o

0 03

10.

In the Workforce Structures work area, click Manage Divisions to open the Manage Divisions page.

On the Manage Divisions page, click Create.

On the Create Division: Division Description page, select the Create New option to create a division with a
single classification.

In the Division Description region, complete the fields shown in the following table. Use the default values
except where indicated.

Field Value
Name Germany Financial Services
Location Germany

Click Next.

On the Create Division: Division Details page, complete the fields shown in the following table. Use the
default values except where indicated.

Click Next.

On the Create Division: Review page, review the division details, and click Submit.

Click Yes.

Click OK.

Creating Departments

1.

O Now

In the Workforce Structures work area, click the Manage Departments tab to open the Manage Department
page.

On the Manage Departments page, click Create.

On the Create Department: Description page, select the Create New option to create a department with a
single classification.

Enter the details of the accounting department by completing the fields shown in the following table. Use the
default values except where indicated.

Field Value

Department Name Accounting

Location Germany
Click Next.
Associate a cost center in the Create Department: Department Details page.
Click Next.

On the Create Department: Review page, review the details of the department, and click Submit.
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9. Repeat steps 2 through 8 to create the sales and marketing departments.

Creating a Legislative Data Group

1. In the Setup and Maintenance work area, locate the Manage Legislative Data Groups task. Click Go to Task
to open the Manage Legislative Data Group page.

2. Onthe Manage Legislative Data Groups page, click Create.

3. On the Create Legislative Data Groups page, complete the fields shown in the following table. Use default
values except where indicated.

Field Value

Name Germany Financial Services
Country Germany

Currency Eur

4. Click Submit.

Creating Legal Entities

1. In the Setup and Maintenance work area, locate the Manage Legal Entity task. Click Go to Task to open the
Manage Legal Entity page.

2. Onthe Manage Legal Entity page, click Create.

3. Onthe page, complete the fields shown in the following table. Use default values except where indicated.

Field Value
Name Legal Entity
Legal Entity Identifier 123456
Payroll Statutory Unit Selected
Legal Employer Selected
Legal Address 123

EIN or TIN 123
Registration Number 123
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4. C(lick Save and Close.

Defining Legal Employer and Payroll Statutory Unit Information

1. In the Setup and Maintenance work area, locate the Manage Legal Entity HCM Information task. Click Go to
Task to open the Manage Legal Entity page.

Search for the new legal entity that you created in the "Creating Legal Entities" task.
Enter the payroll statutory unit and legal employer details.

Associate the legislative data group with the payroll statutory unit.

Click Save.

v huwN

Divisions
Managing multiple businesses requires that you segregate them by their strategic objectives and measure their results.

Responsibility to reach objectives can be delegated along the management structure. Although related to your legal
structure, the business organizational hierarchies don't reflect directly the legal structure of the enterprise. The
management entities and structure can include:

- Divisions and subdivisions

- Lines of business

- Other strategic business units

- Their own revenue and cost centers

These organizations can be included in many alternative hierarchies and used for reporting, as long as they have
representation in the chart of accounts.

Divisions
A division refers to a business-oriented subdivision within an enterprise, in which each division organizes itself

differently to deliver products and services or address different markets. A division can operate in one or more
countries, and can be many companies or parts of different companies that are represented by business units.

A division is a profit center or grouping of profit and cost centers, where the division manager is responsible for
achieving business goals including profits. A division can be responsible for a share of the company's existing product
lines or for a separate business. Managers of divisions may also have return on investment goals requiring tracking of
the assets and liabilities of the division. The division manager generally reports to a corporate executive.

By definition a division can be represented in the chart of accounts. Companies can use product lines, brands, or
geographies as their divisions: their choice represents the primary organizing principle of the enterprise.

Historically, divisions were implemented as a node in a hierarchy of segment values. For example, Oracle E-Business
Suite has only one balancing segment, and often the division and legal entity are combined into a single segment where
each value stands for both division and legal entity.
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Use of Divisions in Oracle Fusion Cloud Human Capital Management
(HCM)

Divisions are used in HCM to define the management organization hierarchy, using the generic organization hierarchy.
This hierarchy can be used to create organization-based security profiles.

Example of Adding a New Division After Acquiring a
Company

This example describes how you can restructure your enterprise after acquiring a new division.

Scenario

You are part of a senior management team at InFusion Corporation. InFusion is a global company with organizations in
the following countries:

- United States (US)

+ United Kingdom (UK)

- France

- China

- Saudi Arabia

- United Arab Emirates (UAE)

The company's main area of business is in the high tech industry, and it recently acquired a new company. You must
analyze the company's current enterprise structure and determine the new organizations to create in the new company.

Details of the Acquired Company

The acquired company is a Financial Services business based in Germany. The Financial Services business differs
significantly from the high tech business. Therefore, you want to keep the Financial Services company as a separate
business with all the costs and reporting managed by the Financial Services division.

The following table summarizes the key decisions that you must consider when determining what new organizations to
set up and how to structure the enterprise.

Decision to Consider In This Example

Create location? The Financial Services company and its departments are based in Frankfurt. Therefore, you only have
to create one location.

Create separate division? Yes. Although the new division will exist in the current enterprise structure, you want to keep the
Financial Services company as a separate line of business. By creating a separate division, you can
manage the costs and reporting separately from the InFusion Corporation. Additionally, you don't have
to modify any organizations in the enterprise setup.
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Decision to Consider

Create business unit?

How many departments?

How many cost centers?

How many legal entities?

Create legislative data group?
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In This Example

Yes. The Financial Services business requires you to create several jobs that don't exist in your high
tech business. You can segregate the jobs that are specific to financial services in a new business unit.

The Financial Services company currently has departments for sales, accounting, and marketing. As
you have no plans to downsize or change the company, you can create three departments to retain the
structure.

Although you can have multiple cost centers to track the department costs, you decide to create one
cost center for each department.

Define a legal entity for each registered company or some other entity recognized by law. Using the
legal entity, you can:

- Record assets

- Record liabilities

- Record income

- Pay transaction taxes

«  Perform intercompany trading

In this case, you only need one legal entity.

You must define the legal entity as a legal employer and payroll statutory unit. As the new division
operates only from Germany, you can configure the legal entity to suit Germany's legal and statutory
requirements.

Note:
You can identify the legal entity as a payroll statutory unit. When you do so, the application transfers
the legal reporting unit associated with the legal entity to Oracle Fusion HCM as a tax reporting unit.

Yes. Because you currently don't employ or pay people in Germany, you must create one legislative
data group to run payroll for the workers in Germany.

Resulting InFusion Enterprise Structure

Based on the analysis, you must create the following:

« One new division

- One new location

- Three new departments
- Three new cost centers

- One new legal entity

- One new legislative data group

ORACLE
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The following figure illustrates the structure of InFusion Corporation after adding the new division and the other
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Departments

A department is an organization to which you assign workers. It is an organization with one or more operational
objectives or responsibilities that exist independently of its manager.

You track the department's financial performance through one or more cost centers. For example, sales, research and
development, and human resources. You can report and keep track of headcount by creating a department hierarchy

using Oracle Fusion Trees.

Departments and cost centers example:

ORACLE
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This figure illustrates how departments belong to legal entities within the enterprise structure.
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Departments and Cost Centers

A cost center represents the smallest segment of an organization for which you allocate and report on costs. The
manager of a department is typically responsible for cost control by meeting a budget and may be responsible for the
assets used by the department. You can track the financial performance of a department through one or more cost

centers.

Uploading Departments Using a Spreadsheet

If you have a list of departments already defined for your enterprise, you can upload them from a spreadsheet. To use
this option, you first download a spreadsheet template, add your department information to the spreadsheet, and
then upload directly to your enterprise configuration. You can upload the spreadsheet multiple times to accommodate

revisions.

Related Topics
« Upload Workforce Structures Using a Spreadsheet

ORACLE

Trees
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How You Create a Chart of Account to Create a
Department

In this example you can see how to create a chart of account for HCM implementations. You must set up a minimal
chart of account to associate a company and cost center with departments.

This topic describes a simple scenario primarily intended for use within HCM. For more detailed information on setting
up a chart of account, refer to the Financials product documentation.

Vision Corporation US is a US-based legal entity with cost centers in Arizona and California. In this example, we will
create a Arizona cost center and associate it with the Sales Department.

The following table summarizes key decisions that you must consider when creating a chart of .

Decisions to Consider In this Example

What should be the validation type for the = Independent. Only this type is supported for creating General Ledger (GL) cost center information for
value set? departments in HCM.

What should be the segment labels for the = The first segment is Primary Balancing Segment and the second segment is Cost Center Segment.
chart of account? Selecting these labels in this order is crucial in specifying the General Ledger cost center information
for a department.

Summary of Tasks

In the Setup and Maintenance work area, create a chart of account and cost center value sets to create a chart of
account structure and instance, and then associate it with the department.

Create the chart of account value set for the Vision Corporation US enterprise.

Specify Arizona and California as the values for the chart of account value set

Create the cost center value set for the Vision Corporation US enterprise.

Specify Arizona and California as the values for the cost center value set.

Create the chart of account structure by associating it with the chart of account and cost center value sets you
created earlier.

Create the chart of account structure instance by associating it with the structure.

Specify the General Ledger cost center information by associating it with the chart of account and the cost
center you created earlier, for creating the sales department.

MhWND

N o

Create a Chart of Account Value Set

1. In the Setup and Maintenance work area, go to the following:.
o Offering: Workforce Deployment
o Functional Area: Financial Reporting Structures
o Task: Manage Chart of Accounts Value Sets

2. Click Create.

177
ORACLE



Oracle Fusion Cloud HCM

Using Common Features for HCM

3.

4.

Complete the fields as shown in this table.

Field Value

Value Set Code Vision Corporation US Value Set 1
Description Vision Corporation US Value Set 1
Module Common Shared Setups
Validation Type Independent

Value Data Type Character

Value Subtype Text

Maximum Length 5

Click Save and Close.

Specify Values for the Chart of Account Value Set

1.

w

5.

Chapter 1
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On the Manage Chart of Accounts Value Sets page, search and select Vision Corporation US Value Set 1from

the search results.

Click Manage Values.

Click Create.

Complete the fields as shown in this table.

Field Value

Value AZ

Description Arizona

Enabled Select the check box

Click Save and Close.

ORACLE
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6. Create additional values for the Vision Corporation US Value Set 1as shown in this table.

Field Value

Value CA

Description California

Enabled Select the check box

7. Onthe Manage Values page, click Save and Close.

Create a Cost Center Value Set
1. Inthe Setup and Maintenance work area, go to the following:

o Offering: Workforce Deployment
o Functional Area: Financial Reporting Structures
o Task: Manage Chart of Accounts Value Sets

2. Click Create.
3. Complete the fields as shown in this table.

Field Value

Value Set Code Vision Corporation US Cost Center Value Set 1
Description Vision Corporation US Cost Center Value Set 1
Module Common Shared Setups

Validation Type Independent

Value Data Type Character

Value Subtype Text

Maximum Length 5

4. C(lick Save and Close.
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Create a Chart of Account Structure

1. In the Setup and Maintenance work area, go to the following:.
o Offering: Workforce Deployment

o Functional Area: Financial Reporting Structures

o Task: Manage Chart of Accounts Structures

Click Create.

A WN

Field

Structure Code

Name

Description

Delimiter

6. Click Save.

Search and select the GL# key flexfield code.
Click Manage Structures.

Complete the fields as shown in this table.

Value

Vision Corp CoA Cost Center

Vision Corp CoA Cost Center

Vision Corporation Chart of Account Cost Center

Select any value

7. Inthe Segments section, click Create.
8. Complete the fields as shown in this table.

Field

Segment Code

APl Name

Name

Sequence Number

Prompt

Short Prompt

Enabled

ORACLE

Value

Vision_Corp_COA

visionCorpCoa

Vision Corporation COA

Vision Corporation COA

Vision

Select the check box

Trees
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Field

Display Width

Range Type

Column Name

Default Value Set Code

Selected Labels

9. C(lick Save and Close.

Chapter 1
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Value

Low

SEGMENT1

Vision Corporation US Value Set 1

Primary Balancing Segment

10. Create another segment with the following values

Field

Segment Code

APl Name

Name

Sequence Number

Prompt

Short Prompt

Enabled

Display Width

Range Type

Column Name

ORACLE

Value

Vision_Corp_CostCenter_COA

visionCorpCostcenterCoa

Vision Corporation Cost Center COA

Vision Corporation Cost Center COA

Vision1

Select the check box

Low

SEGMENT2

Trees
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Field Value
Default Value Set Code Vision Corporation US Cost Center Value Set 1
Selected Labels Cost Center Segment

11. Click Save and Close.
12. On the Create Key Flexfield Structure page, click Save and Close.
Create a Chart of Accounts Structure Instance

1. Inthe Setup and Maintenance work area, go to the following:

o Offering: Workforce Deployment
o Functional Area: Financial Reporting Structures

o Task: Manage Chart of Accounts Structure Instances

2. Search and select the GL# key flexfield code.
3. Click Manage Structure Instances.
4. C(lick Create.
5. Complete the fields as shown in this table.
Field Value
Structure Instance Code Vision COA Structure Instance
APl name VisionCoaStructurelnstance
Name Vision Corporation COA Structure Instance
Structure Name Vision Corp CoA Cost Center

6. Click Save and Close.

Specify the General Ledger Cost Center Information for Creating a

Department
1. In the Workforce Structures work area, click the Manage Departments tab.
2. Click Create.
3. Select the Create new option.
4. Enter Sales Department in the Name field.
5. Click Next.
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6. Inthe GL Cost Center Information section, complete the fields as shown in this table.

Field Value

Record Identifier 10

Company Value Set Vision Corporation US Value Set 1

Company AZ

Cost Center Value Set Vision Corporation US Cost Center Value Set 1
Cost Center AZ

7. Click Next to review the specified information.
8. Click Submit.

Cost Centers and Departments

The two important components to be considered in designing your enterprise structure are cost centers and
departments.

A cost center represents the smallest segment of an organization for which you collect and report costs. A department
is an organization with one or more operational objectives or responsibilities that exist independently of its manager
and has one or more workers assigned to it.

Cost Centers

A cost center represents the destination or function of an expense rather than the nature of the expense which is
represented by the natural account. For example, a sales cost center indicates that the expense goes to the sales
department.

A cost center is generally attached to a single legal entity. To identify the cost centers within a chart of accounts
structure use one of these two methods:

- Assign a cost center value in the value set for each cost center. For example, assign cost center values of
PLO4 and G3]1 to your manufacturing teams in the US and India. These unique cost center values allow easy
aggregation of cost centers in hierarchies (trees) even if the cost centers are in different ledgers. However, this
approach requires defining more cost center values.

- Assign a balancing segment value with a standardized cost center value to create a combination of segment
values to represent the cost center. For example, assign the balancing segment values of 001 and 013 with
cost center PLO4 to represent your manufacturing teams in the US and India. This creates 001-PL0O4 and 013-
PLO4 as the cost center reporting values. The cost center value of PLO4 has a consistent meaning. This method
requires fewer cost center values to be defined. However, it prevents construction of cost center hierarchies
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using trees where only cost center values are used to report results for a single legal entity. You must specify a
balancing segment value in combination with the cost center values to report on a single legal entity.

Departments

A department is an organization with one or more operational objectives or responsibilities that exist independently of
its manager. For example, although the manager may change, the objectives don't change. Departments have one or
more workers assigned to them.

A manager of a department is typically responsible for:

- Controlling costs within their budget
- Tracking assets used by their department
- Managing employees, their assignments, and compensation

The manager of a sales department may also be responsible for meeting the revenue targets.

The financial performance of departments is generally tracked through one or more cost centers. In Oracle Fusion Cloud
Applications, departments are defined and classified as Department organizations. Oracle Fusion Cloud Human Capital
Management (HCM) assigns workers to departments, and tracks the headcount at the departmental level.

The granularity of cost centers and their relationship to departments varies across implementations. Cost center
and department configuration may be unrelated, identical, or consist of many cost centers tracking the costs of one
department.

Department Classifications

A department can be classified as a project organization, sales and marketing organization, or cost organization.

A point to note is that a department name must be unique. This rule applies even when the department is classified as
a project organization or an inventory organization. For example, if you create a department with name Vision Corp.
Sales, you can't create another department with the same name. Also, if you classify this department as a project
organization, you can't create another project organization as well with the same name.

Or, if you create a division with the name Vision Corp. Marketing that is classified as a department, which in turn is
classified as a project organization, you can't create another division, department or project organization with the same
name.

Oracle Fusion Cloud Human Capital Management (HCM) uses trees to model organization hierarchies. It provides
predefined tree structures for department and other organizational hierarchies that can include organizations with any
classification.

Project Organization

Classify departments as a project owning organization to enable associating them with projects or tasks. The project
association is one of the key drivers for project access security.

In addition, you must classify departments as project expenditure organizations to enable associating them to project
expenditure items. Both project owning organizations and project expenditure organizations can be used by Oracle
Subledger Accounting to derive accounts for posting Oracle Fusion Cloud Project Management accounting entries to
Oracle General Ledger.
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Sales and Marketing Organization

In sales applications, you can define sales and marketing organizations. Sales organization hierarchies are used to
report and forecast sales results. Salespeople are defined as resources assigned to these organizations.

In some enterprises, the HCM departments and hierarchies correspond to sales organizations and hierarchies.
Examining the decision on how to model sales hierarchies in relationship to department hierarchies when implementing
Customer Relationship Management to eliminate any possible redundancy in the definition of the organizations is
important.

The following figure illustrates a management hierarchy, in which the System Components Division tracks its

expenses in two cost centers, Air Compressors and Air Transmission. At the department level, two organizations with a
classification of Department are defined, the Marketing Department and Sales Department. These two departments can
be also identified as a Resource Organizations, which enable assigning resources, such as salespeople, and other sales
specific information to them. Each department is represented in the chart of accounts by more than one cost center,
enabling granular as well as hierarchical reporting.

System Components Division

v v

Adr Adr
Compressors Transmission
Business Unit Business Unit

v ( v

Sales F N Marketing
Department r-—? Department

US East US West
Cost Center Cost Center

Cost Organization

Oracle Project Costing uses a cost organization to represent a single physical inventory facility or group of inventory
storage centers, for example, inventory organizations. This cost organization can roll up to a manager with responsibility
for the cost center in the financial reports.

A cost organization can represent a costing department. Consider this relationship when determining the setup of
departments in HCM. No system dependencies are required for these two entities, cost organization and costing
department, to be set up in the same way.

185
ORACLE



Oracle Fusion Cloud HCM Chapter 11
Using Common Features for HCM Divisions, Departments, Worker Unions, Locations, and
Trees

How You Configure the Department Title

The Title field for a department is hidden and optional, by default. You need to do these 2 steps to enable the field and
make it mandatory.

Enable Title Field

These are the steps to set the value of the profile option ORA_PER_ENABLE_DEPARTMENT_TITLE to Y.

1. Navigate to the Setup and Maintenance work area.

2. Search for and click the Manage Administrator Profile Values task.

3. Search for the ORA_PER_ENABLE_DEPARTMENT_TITLE profile option code and select the profile option in
the search results.

4. Inthe Profile Values section, enter Y in the Profile Value field.

5. Click Save and Close.

Once you set the profile option value to Y, you can see the Title field in all the department pages, including Create,
Update, Correct, and Review pages. Currently, the Title field appears in the Department LOV only on the responsive
position pages.

Make Title Field Mandatory

Prerequisite Tasks:

1. Create a sandbox and add the Page Composer tool.
2. Create a department from the Workforce Structures work area on the My Client Groups tab.

Do these steps to make the title field mandatory:

Click Edit Pages from the Settings and Actions menu.

Click Structure and place your cursor in the Title field.

Click Edit in the Confirm Shared Component Edit window.

Search for InputText:Title in the component list and click the Edit icon.

Scroll down to the Required field in the Edit Properties window and click the down arrow.
Select Expression Builder.

Add the #{pageFlowScope.makeTitleMandatory eq 'Y'} condition in the expression editor.
Click OK.

Scroll down to the Show Required field in the Edit Properties window and click the down arrow.
Select Expression Builder.

. Add the #{pageFlowScope.makeTitleMandatory eq 'Y'} condition in the expression editor.
Click OK.
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Disability Organizations

You can set up disability organizations to identify the external organizations with which disabled employees are
registered, and assess the degree of disability in the employee.
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You set up disability organizations using the Manage Disability Organizations task in the Workforce Structures work area
under My Client Groups.

Purpose of Disability Organizations

Disability organizations provide information and support to people with disabilities, for example, the Royal National
Institute of Blind People. You can create a disability organization as a Trading Community Architecture party using the
Manage Integration of Additional Applications task in the Setup and Maintenance work area. You can then select a
disability organization party usage code.

For employees with disability, you can select the disability organization in their person records, identify the registration
and expiration dates, and enter any other descriptive or legislative information about the disability.

Related Topics
« Person Records

« Third Parties Overview

Worker Union Management

These three components manage worker union information in Human Capital Management (HCM) Cloud:

- Worker Unions
- Bargaining Units

- Collective Agreements

Worker Unions

The worker union is a HCM organization. You can create a new worker union or select an existing organization to define
a worker union. The details of a worker union are country-specific and the country value is mandatory for a worker
union. You can optionally attach any supporting documents for the worker union. A worker union holds date-effective
attributes. Therefore, you can track the changes to the worker union over a period of time. You can also inactivate

the worker union. You can configure additional attributes specific to any legislation or customer using the available
descriptive flexfields and extensible flexfields.

You can optionally associate worker unions with their affiliated bargaining units. The values in the Bargaining Unit and
Location fields are filtered to match the country you selected. You can add more than one work union contact and enter
the contact details, such as contact name, union title, work phone, and work Email.

This figure illustrates the association between worker union, bargaining unit, and collective agreement:
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Trees

A worker union can be associated with multiple bargaining units. However, a bargaining unit can be associated with only
one worker union. A collective agreement can be associated with only one worker union and bargaining unit. A worker
union or bargaining unit can be associated with multiple collective agreements.

This figure illustrates the association between position or assignment and worker union, bargaining unit, and collective

agreement:
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Assignment Assignment Assignment Assignment
1 2 3 4
L ¥ ¥
Worker Worker Worker
Union 1 Union 2 Union 3
1 ¥ ¥
Bargaining Bargaining Bargaining
Unit 1 Unit 3 Unit 4
L w y
Collective Collective Collective
Agreement Agreement Agreement
1 4 =

A position or worker assignment can be associated with only one collective agreement, bargaining unit, and worker
union. However, a bargaining unit, worker union, or collective agreement can be associated with multiple positions or
worker assignments.

Bargaining Units

A bargaining unit is a specific group of employees who are represented by one authorized union or association for
purposes of collective bargaining. A bargaining unit is defined as a lookup type.

Collective Agreements

A collective agreement is a special type of commercial agreement that's negotiated collectively between the
management (on behalf of the company) and trade unions (on behalf of employees). The agreement regulates the
terms and conditions of employees in their workplace, their duties, and the duties of the employer.

Let's take a look at the collective agreement details:

A collective agreement is country-specific. You may enter the bargaining unit, legal employer, and union values
depending on the country. For example, you can create a collective agreement without the bargaining unit and legal
employer, or only with the legal employer. When you select the value in the Country field, the values in the Bargaining
Unit, Legal Employer, and Union fields are filtered to match the country selected. You can optionally associate collective
agreements with worker unions and attach documents to the collective agreement.
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You can provide details of the parties negotiating the collective agreement, such as the employee and employer
organizations. The employee organization can be the trade union or bargaining unit representing the employee while
the employer organization is represented by the company management.

A collective agreement is date-effective, therefore, you can track changes to a collective agreement over time.

You can also inactivate the collective agreement. You can configure additional attributes specific to a legislation or
customer using the available descriptive flexfields and extensible flexfields. If you specify a Valid To date for a collective
agreement, it lapses after that date and you can't link it to an employee.

Note: If the collective agreement is linked to an assignment, you can't edit the Identification Code, Country,
Bargaining Unit, Union, and Legal Employer fields. Additionally, you can't delete the collective agreement.

Here's how you can link collective agreements:

You can link a collective agreement to an assignment provided the bargaining unit, country, and legal employer of the
collective agreement are consistent with the assignment. If you created a collective agreement without associating

it with a legal employer or bargaining unit, you can link the collective agreement to any assignment within the same
country.

You can link a union, bargaining unit, or collective agreement with a worker assignment provided that its country and
legal employer is consistent with the assignment.

The union, bargaining unit, and collective agreement list of values (LOV) that you can select for linking with an
assignment or position are filtered as described in this table:

Attribute Linking Object Filter Conditions

Union Assignment The LOV is filtered to show unions that are
active as of the start date and whose country
matches the country of the legal employer on
the worker assignment.

Union Position The LOV is filtered to show unions that are
active as of the position start date. As there is
no legislation context available for a position,
the LOV isn't filtered based on the union
country. All unions configured in the application
are listed in the LOV.

Bargaining Unit Assignment - If you don't select a union, the LOV is
filtered to show bargaining units that are
active as of the start date, and whose
country matches the legal employer
country or have no country tag itself.

- If you select a union, the LOV is filtered to
show bargaining units that are active as of
the start date and are associated with the
selected union.

Bargaining Unit Position As there is no legislation context available for a
position, the LOV isn't filtered based on country
tags configured for the bargaining unit lookup
codes.
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Attribute Linking Object Filter Conditions

- If you don't select a union, the LOV is
filtered to show bargaining units that are
active as of the position start date.

- If you select a union, the LOV is filtered to
show bargaining units that are active as of
the position start date and are associated
with the selected union.

Collective Agreement Assignment

Note:

The LOV is filtered to show only those values
that match the country of the legal employer
on the worker assignment.

If you don't select a union or bargaining unit,
the LOV is filtered to show all active collective
agreements as of the start date.

If you select a union without selecting a
bargaining unit, the LOV is filtered this way:

- Shows collective agreements that are
active and match the selected union, but
don't have an associated bargaining unit
(union-specific values).

- Shows collective agreements that are
active and don't have an associated union
or bargaining unit value (global values).

If you select a bargaining unit without selecting
a union, the LOV is filtered this way:

- Shows collective agreements that are
active and match the selected bargaining
unit, but don't have an associated union
(bargaining unit-specific values).

- Shows collective agreements that are
active and don't have an associated union
or bargaining unit value (global values).

If you select a union and a bargaining unit, the
LOV is filtered this way:

- Shows collective agreements that are
active and match the selected union and
bargaining unit (union and bargaining
unit-specific values).

- Shows collective agreements that are
active and don't have an associated union
or bargaining unit value (global values).

Collective Agreement Position As there is no legislation context available on
for a position, the LOV isn't filtered based on
the collective agreement country.

If you don't select a union or bargaining unit,
the collective agreement LOV is filtered to
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show all active collective agreements as of the
position start date.

If you select a union without selecting a
bargaining unit, the LOV is filtered this way:

.

Shows collective agreements that are
active and match the selected union, but
don't have an associated bargaining unit
(union-specific values).

Shows collective agreements that are
active and don't have an associated union
or bargaining unit value (global values).

If you select a bargaining unit without selecting
a union, the LOV is filtered this way:

Shows collective agreements that are
active and match the selected bargaining
unit, but don't have an associated union
(bargaining unit-specific values).

Shows collective agreements that are
active and don't have an associated union
or bargaining unit value (global values).

If you select a union and a bargaining unit, the
LOV is filtered this way:

Shows collective agreements that are
active and match the selected union and
bargaining unit (union and bargaining
unit-specific values).

Shows collective agreements that are
active and don't have an associated union
or bargaining unit value (global values).
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Filter Conditions

Note:

The global collective agreement values
can be used on a position by configuring

the following profile option:

o Code: ORA_PER_ALLOW_GLOBAL_
CAGR_ON_POSITIONS

o Display Name: Allow Global Collective
Agreements on Position

By default, the profile value is set to

N. In this case, the global collective
agreement values can't be used on a
position even though the values are
available for selection in the LOV. If you
select a global collective agreement
value, the application will display an
error message when you submit the
position change or creation.

If you set the profile value to Y, the
global collective agreement values can
be used on a position.

Use the Manage Descriptive Flexfields and Manage Extensible Flexfields tasks in the Setup and Maintenance work
area to manage flexfields. You can configure these collective agreement-related flexfields as required, to meet your

enterprise requirements:

Application Table Name

PER_COL_AGREEMENTS_F

PER_COL_AGREEMENTS_F

ORACLE

Descriptive Flexfield Code Name

PER_COL_AGREEMENTS_
DDF

PER_COL_AGREEMENTS_
DFF

Collective Agreements
Legislative Information

Collective Agreements
Attributes

Used

For storing additional
legislative information
regarding collective
agreements.

For storing additional
information regarding
collective agreements.

Availability

Available only for Oracle
localization use.

Available for use.
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Application Table Name Descriptive Flexfield Code Name Used Availability
PER_COL_AGRS_EXTRA_ PER_COL_AGREEMENTS_ = Collective Agreements EIT = For storing additional Available for use.
INFO_F EFF Information EFF collective agreement

information as single and
multiple row extensible
flexfield contexts.

Locations

Alocation identifies physical addresses of a workforce structure, such as a department or a job. You create and manage
locations using the Location Details quick action in the Workforce Structures area on the My Client Groups tab.

You can also create locations to enter the addresses of external organizations that you want to maintain, such as
employment agencies, tax authorities, and insurance or benefits carriers.

When specifying the location address, you can default the country in the location responsive pages. You configure the
default location country on the Manage Enterprise HCM Information page. If you don't configure any default country,
then the country is automatically defaulted to United States in the location address.

The locations that you create exist as separate structures that you can use for reporting purposes, and in rules that
determine employee eligibility for various types of compensation and benefits. You enter information about a location
only once. Subsequently, when you set up other workforce structures you select the location from a list.

A point to note is that the Ship-to Site, Receiving Site, Bill-to Site, Office Site, and Designated Receiver fields in the
Shipping Details section of a location setup are for information purpose only and can be used to report upon. They
aren’t currently used by any feature or process within HCM.

Location Sets

When you create a location, you must associate it with a set. Only those users who have access to the set's business unit
can access the location set and other associated workforce structure sets, such as those that contain departments and
jobs.

Note the following:
- You can also associate the location to the common set so that users across your enterprise can access the
location irrespective of their business unit.
- You can also configure a location as an employee location on the Location Details page.

- When users search for locations, they can see the locations that they have access to along with the locations in
the common set.
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The following figure shows how locations sets restrict access to users.
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Upload Locations Using a Spreadsheet

If you have a list of locations already defined for your enterprise, you can upload them from a spreadsheet.

To use this option:

Download a spreadsheet template

- Add your location information to the spreadsheet

Upload directly to your enterprise configuration

You can upload the spreadsheet multiple times to accommodate revisions.

Update Location Details

If you need to update or correct the details of a location, here's how you can do that:

vihUWUNRA

Related Topics

« Why can't | see my location in the search results?

Go to My Client Groups > Location Details.
On the page, click Show Filters.
Search for the location you need to correct or update using the filters and select it.
On the location's details page, click Actions and select Update or Correct.

Update the details as required and click Submit.

« What happens if | inactivate a location?
« Upload Workforce Structures Using a Spreadsheet

ORACLE

Trees
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Associate Legal Employers with Locations

You can associate multiple legal employers with a location. This enables filtering locations by legal employer on pages
that have implemented this feature. You use the Legal Employers Operating At This Location extensible flexfield (EFF)
context for the legal employer - location association.

These are some key points to note:

- Alocation must have at least one associated legal employer to filter the location by legal employer.

- You can associate multiple legal employers operating at a location, but can't associate the same legal employer
twice with a location.

- You can associate the same legal employer with different locations.

- You can delete the legal employer - location association.

- The legal employer - location mapping is copied when you duplicate a location.

- You can associate legal employers when creating, updating, or correcting a location.

- The legal employer list of values displays all active and inactive legal employers configured. There isn't any
filtering for only active legal employers. Similarly, there is no filtering of legal employers by matching the legal
employer country with the location address country.

Legal employers are listed in the ascending order of legal employer name.

Locations are first filtered based on the set. And thereafter, if an association exists, they're filtered based on the
legal employers.

In this example, Vision Enterprise has 3 legal employers Vision Corporation, Vision US, and Vision Consulting operating
at multiple locations in the US. You want to filter locations from where Vision Corporation is operating.

Let's look at the steps to update this association.

Associate Vision Corporation with the Pleasanton Location

1. Go to My Client Groups > Quick Actions > Workforce Structures.

2. C(lick the Location Details task.

3. Click Add.

4. Select the Additional Info option on the questionnaire page and click Continue.

5. Enter these required details to create a location.
Section Field Value
When and Why When does this location start? 8/25/21
Location Details Name Pleasanton

Code PLS

Main Address Address Line 1 603
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Section Field Value
ZIP Code 94588
City Pleasanton
State CA
County Alameda

6. Inthe Additional Info section, click Add in the Legal Employers Operating At this Location section to associate
the Vision Corporation legal employer to this location.

7. Select Vision Corporation from the Legal Employer list.

Note: As a prerequisite, the legal employer should already exist.

o

Click OK.
Click Submit.

0

Related Topics
- Filter Locations Based on Legal Employers

HCM Trees

Trees graphically represent the hierarchical structures of your organization. You manage trees in the Workforce
Structures work area under My Client Groups.

These tree structures are supported - department, organization, position, and geography. What nodes can be added
to the tree is controlled by each structure type. With the exception of geography trees, you can create multiple trees for
each HCM tree type, and multiple versions of each tree. However, only one version of a tree is active at any time.

Each tree version contains a root node that's at the highest level in the hierarchy. The lines connecting the elements in
a tree structure are branches and the elements are referred to as nodes. These relationships are explained as follows: a
node is a parent of another node if it's one step higher in the hierarchy. Child nodes share the same parent node.

For example, in the Department Tree figure, Operations is the parent of Human Resources, Legal, and Finance, which
are its child nodes.

Department Trees

A department tree is a hierarchical representation of your departments. You can create versions of department trees but
only one tree version is active at a time. A department can’'t be added more than once in the same tree version.
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Department Tree Uses

- Maintain a hierarchy of all departments under one or multiple trees.

- Select the department hierarchy tree structure in the Secure by Organization Hierarchy setup of the
organization security profiles to secure access to departments within that tree.

- Secure Areas of Responsibility (AOR) data using the Hierarchy Type list. The areas of responsibility defined
for a hierarchy type can be used in securing by areas of responsibility while creating person security profiles to
secure person records.

- Use the responsibility types defined in the AOR setup to define approval rules so that representatives defined
using department tree can be approvers.

+ Use the department hierarchy in your analysis to build roll-up analysis reports.

- Default the line manager from the department manager in a worker assignment using the department tree. You
can use the PER_DEPARTMENT_TREE_FOR_MANAGER profile option to configure this setting.

Example of a Department Tree

The following figure illustrates a department hierarchy that you can establish using a department tree.

Cperations
Y ]’
Human Resources Legal Finance
| l
| l
Talent Acquisition Compliance Audit
¥ l
Recruiting and Training and
Onboarding Development

Organization Trees

An organization tree is a hierarchical representation of your various organizational entities. You can select any
organization including divisions, legal employers, business units, departments, and so on to create your organization
tree. You can create versions of organization trees but only one tree version is active at a time. An organization can’t be
added more than once in the same tree version.
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- Maintain a hierarchy of different organizational structures.

- Select the Generic organization hierarchy tree structure option in the Secure by Organization Hierarchy setup
of organization security profiles to secure access to organizations within that tree.

- Secure Areas of Responsibility (AOR) data using the Hierarchy Type list. The areas of responsibility defined
for a hierarchy type can be used in securing by areas of responsibility while creating person security profiles to

secure person

records.

- Use the responsibility types defined in the AOR setup to define approval rules so that representatives defined
using organization tree can be approvers.

- Use the organization hierarchy in your analysis to build roll-up analysis reports, if departments are at the lowest
level of the hierarchy.

Example of an Organization Tree

The following figure illustrates an organization hierarchy that you can establish using an organization tree.
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Position Trees

You can create multiple position trees using the predefined position tree structure in the Workforce Structures work
area. You can then create multiple versions to establish reporting relationships among positions. Position trees can have
only one top node.

Position Tree Uses

- Use position hierarchies for budgeting and organizational planning.

- Secure access to positions by identifying a position hierarchy in a position security profile. For example, you
can create a position security profile that includes all positions in a position hierarchy under a specified first
position. You can also include the position security profile in a person security profile to secure access to person
records. In this case, the person security profile includes the person records of the people who occupy the
positions in the position security profile.

Example of a Position Tree

The following figure illustrates a position hierarchy that you can establish using a position tree.

President and CEQ

{ ! }

Vice President - Vice President -
Administration Operations

I
' . !

General Auditor

Director of Director of .
Information Human " D'r;mﬂr of
Technology Resources anufacturing

Geography Trees

You can create versions of the predefined geography tree structure to represent countries in which your enterprise
operates. For each country, you can define lower-level nodes such as states and cities. For example, United Kingdom -
England - London. You manage trees in the Workforce Structures work area.

Although you can create multiple versions, you can create only one tree in the hierarchy. Geography trees also have only
one first node.

Calendar Events

You use the geography tree to specify the locations to which calendar events apply. You can create the tree using these
conditions.

- If an event applies to your entire enterprise, you can attach it to the first node in the tree, for example, Global.

200
ORACLE



Oracle Fusion Cloud HCM Chapter 11
Using Common Features for HCM Divisions, Departments, Worker Unions, Locations, and
Trees

- If an event applies only to specific countries in your enterprise, you can attach it to the nodes for those specific
countries, for example, United Kingdom.

- If an event applies only to specific states or cities in a country, you can attach it to the state or city level nodes.
For example, England, London.

Example of a Geography Tree

This figure illustrates the geographical hierarchy that you can establish using a geography tree.

Global
Y
GEB United Kingdom US United States IM India
4 1 ¥
England California Andhra Pradesh
r ¥ r
London San Mateo Hyderabad

Related Topics
« Guidelines for Managing Trees and Tree Versions

» Employment Profile Options
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FAQs for Divisions, Departments, Worker Unions,
Locations, and Trees

What's a reporting establishment?

A reporting establishment is an organization that's used for statutory reporting other than tax and social insurance
reporting. In some countries, such as France, a reporting establishment can also be a tax reporting unit.

A reporting establishment and a legal employer share a parent-child relationship with the legal employer being the
parent organization. A legal employer can be the parent of multiple reporting establishments. You create reporting
establishments using the Manage Legal Reporting Unit HCM Information task in the Setup and Maintenance work area.

Can | delete an organization?

No you can't. However, you can disable an organization if it's no longer required. For example, if the enterprise is
downsizing, then you can set the status of the organization to inactive.

Changing the status of the organization disables the organization and the organization is no longer available to select.

How do | create a disability organization?

Use the Manage Integration of Additional Applications task in the Setup and Maintenance work area. Disability
organizations are one of the choices when creating third-party organizations.

How can | identify my organization in a report?

Use the organization manager information in the Create and Edit Department pages to enter a reporting name to
identify the organization in a report. You use organization hierarchies for statutory, legal and management reporting.

You can see all employees in the Manager list.

What's the purpose of the legislative action attributes?

When you create transfer or termination related actions using the Configure Actions task in the Workforce Structures
work area, you can also enter legislative attributes for the actions. You can use the attributes to:

Indicate whether an action is transfer-related.

- Specify the termination type for termination-related actions.
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For example, the termination-related action Resignation can have the termination type as voluntary and the action
Reduction in Force can have the termination type as involuntary. Typically you enter this information to meet specific
legislative requirements or for reporting purposes.

What's the difference between department name and title?

A department name is unique but the department title is non-unique and can be the same across departments. You
can't have 2 or more departments with the same name, but you can have multiple departments with the same title.

For example, you can have a Human Resources department (title) that can be common across the enterprise but there
can only be one unique US Human Resources department (name) in the enterprise. A department name is mandatory
but the title is hidden and optional, by default. You can enable the Title field and make it mandatory.

Why can't | see my location in the search results?

You can search for approved locations only. Also, if you created a location in Oracle Fusion Trading Community Model,
then you can't access that location from Oracle Fusion Global Human Resources.

For use in Oracle Fusion HCM, you must recreate the location from the Manage Locations page.

How can | associate a location with an inventory organization?

From the Oracle Fusion Global Human Resources, go to the Manage Locations page. Use the Manage Locations task in
the Workforce Structures work area.

To appear on the Create or Edit Location pages, your inventory organization must be effective as of the current date and
must exist in the location set that you selected.

What happens if | select an inventory organization when | am
creating or editing a location?

The location is available for selection in purchase documents of that inventory organization in Oracle Fusion Inventory
Management. If you don't select an inventory organization, then the location is available in purchase documents across
all inventory organizations.

What happens if | select a geographic hierarchy node when |
create or edit a location?

The calendar events that you created for the geographic node start to apply for the location and may impact the
availability of worker assignments at that location.
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You manage locations using the Manage Locations task in the Workforce Structures work area.

The geographical hierarchy nodes available for selection on the Locations page display from a predefined geographic
hierarchy.

Related Topics
« How an Individual's Schedule Is Identified

What happens if | inactivate a location?

Starting from the effective date that you entered, you can no longer associate the location with other workforce
structures, assignments, or applications.

If the location is already in use, it will continue to be available to the components that currently use it.
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12 Jobs and Positions

Jobs

Jobs are typically used without positions by service industries where flexibility and organizational change are key
features. As part of your initial implementation, you specify whether to use jobs and positions, or only jobs.

Basic Details
Basic details for a job include an effective start date, a job set, a name, and a code.
A job code must be unique within a set. Therefore, you can create a job with the code DEVO1in the US set and another

job with the same code in the UK set. However, if you create a job with the code DEVO1in the Common set, then you
can't create a job with the same code in any other set.

Benchmark Information

You can identify a job as being a benchmark job. A benchmark job represents other jobs in reports and salary surveys.
You can also select the benchmark for jobs. Benchmark details are for informational purposes only.

Progression Information
A progression job is the next job in a career ladder. Progression jobs enable you to create a hierarchy of jobs and are
used to provide the list of values for the Job field in the Promote Worker and Transfer Worker tasks.

The list of values includes the next job in the progression job hierarchy. For example, assume that you create a job called
Junior Developer and select Developer as the progression job. Progression jobs show as suggested jobs; so when you
promote a junior developer, the Suggested Jobs list of values for the new job will show Developer. You can select this
value, or select another one.

Jobs and Grades

You can assign grades that are valid for each job. If you're using positions, then the grades that you specify for the job
become the default grades for the position.

Related Topics
 Guidelines for Using Desktop Integrated Excel Workbooks

- Considerations for Enforcing Grades at Assignment Level

Examples of Jobs

Jobs are typically used without positions by service industries where flexibility and organizational change are key
features.
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Software Industry

For example, XYZ Corporation has a director over the departments for developers, quality assurance, and technical
writers.

« Recently, three developers have resigned from the company.

- The director decides to redirect the headcount to other areas.

- Instead of hiring all three back into development, one person is hired to each department, quality assurance,
and technical writing.

In software industries, the organization is fluid. Using jobs gives an enterprise the flexibility to determine where to use
headcount, because the job only exists through the person performing it. In this example, when the three developers
leave XYZ Corporation, their jobs no longer exist, therefore the corporation has the flexibility to move the headcount to
other areas.

This figure illustrates the software industry job setup.
X¥Z Corporation

Technology
Department

¥ Y 4

Quality Assurance
Specialist

\J " Tiue/

Developer Technical Writer

Examples of Positions

Positions are typically used by industries that use detailed approval rules, which perform detailed budgeting and
maintain headcounts, or have high turnover rates.

Retail Industry

ABC Corporation has high turnovers. It loses approximately 5% of its cashiers monthly. The job of the cashier includes
three positions: front line cashier, service desk cashier, and layaway cashier. Each job is cross-trained to take over
another cashier's position. When one cashier leaves from any of the positions, another existing cashier from the

front line, service desk or layaway can assist where needed. But to ensure short lines and customer satisfaction, ABC
Corporation must replace each cashier lost to turnover. Since turnover is high in retail it's better for this industry to use
positions.

206
ORACLE



Oracle Fusion Cloud HCM Chapter 12
Using Common Features for HCM Jobs and Positions

Note the following:
- You have to create a vacancy manually when position synchronization is used and an employee terminates
employment (when an incumbent moves out of the position).

- The position exists even when there are no holders. Having the position continue to exist is important if the
person who leaves the company is a manager or supervisor with direct reports.

- All direct reports continue reporting to the position even if the position is empty.

- You don't have to reassign these employees to another manager or supervisor. The replacement manager is
assigned to the existing position.

Also, an added advantage to using Positions is when you hire somebody new, many of the attributes are inherited from
the position. This speeds up the hiring process.

This figure illustrates the retail position setup.

Store Manager

Phil Jones

Y

Assistant Store
Manager

Anita Camp
'

Cash Supervisor

Currently vacant

k4 Y l

Front Line Cashier Sepice IDesk Layaway Cashier
Cashier
10 positions 3 positions 2 positions

Health Care Industry

Health care is an industry that must regulate employment, roles, and compensation according to strict policies and
procedures. Fixed roles tend to endure over time, surviving multiple incumbents. Industries that manage roles rather
than individuals, where roles continue to exist after individuals leave, typically model the workforce using positions.

The hospital has a structured headcount and detailed budgeting. For example, a specific number of surgeons, nurses,
and interns of various types are needed. These positions must be filled in order for the hospital to run smoothly. Use
jobs and positions when you apply detailed headcount rules.
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This figure illustrates the hospital position setup.

Chapter 12
Jobs and Positions

Hospital
—Jobs—+ Surgeon Murse Intern
; 1 3 ¥ y 3
Cardiac Meural Registered I;:;s;a{: Cardiac Meural
Surgeon Surgeon Murse — Intern Intem
Fositions 1 v v
General Mursing General
Surgeon Aide Intern

Considerations for Using Jobs and Positions

Jobs and positions represent roles that enable you to distinguish between tasks and the individuals who perform those

tasks.

Note the following:

- The key to using jobs or positions depends on how each is used.

Positions offer a well-defined space independent of the person performing the job.

- Jobs are a space defined by the person.
- Ajob can be defined globally in the Common Set, whereas a position is defined within one business unit.
- You can update the job and department of a position at any time. For example, if you hire someone into a new

role and want to transfer the position to another department.

During implementation, one of the earliest decisions is whether to use jobs or a combination of jobs and positions. The

determinants for this deci

sion are:

- The primary industry of your enterprise

How you manage your people

Primary Industry of Your Enterprise

The following table outlines information about Primary industries and how they set up their workforce.

Primary Industry
Mining

Utilities

ORACLE

Workforce Setup

Positions

Positions
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Primary Industry Workforce Setup
Manufacturing Positions
Retail Trade Positions
Transportation and Warehousing Positions
Educational Services Positions
Public Transportation Positions

Agriculture, Forestry, Fishing, and Hunting  Jobs

Construction Jobs
Wholesale Trade Jobs
Information Jobs
Finance and Insurance Jobs
Professional, Scientific, and Technical Jobs
Services

Management of Companies and Jobs

Enterprises

Administrative and Support and Waste Jobs
Management and Remediation Services

Arts, Entertainment, and Recreation Jobs
Accommodation and Food Services Jobs
Other Services (Except Public Jobs

Administration)

Management of People

Consider the following scenarios how industries manage their employee turnover:

- Scenario 1: Replace employees by rehiring to the same role.
- Scenario 2: Replace headcount but the manager uses the headcount in a different job.
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- Scenario 3: Rehire employees to the same position, but the manager requests reallocation of budget to a
different post.

The following table displays suggestions of what the industry should use, either jobs or positions, in these three
scenarios:

Industry Scenario 1 Scenario 2 Scenario 3

Project (An industry that Positions Jobs Jobs
supports project-based forms of

organization in which teams of

specialists from both inside and

outside the company report to

project managers.)

Controlled (An industry that's Positions Positions Positions
highly structured in which all

aspects of work and remuneration

are well organized and regulated.)

Manufacturing Positions Jobs Positions

Retail Positions Jobs Positions

Education Positions Jobs Positions

Other Positions Jobs Jobs
Related Topics

- How Grades and Grade Rates Work with Jobs, Positions, Assignments, Compensation, and Payroll

Job and Position Structures

Job and position structures identify the descriptive flexfield structure that enables you to specify additional attributes
that you want to capture when you define jobs and positions.

Job and position attributes provide further detail to make jobs and positions more specific. You also use attributes to
define the structure of your jobs and positions. You can specify attributes at the enterprise level for jobs and positions,
at the business unit level for positions, and at the reference data set level for jobs. Job and position structures are
optional.

Enterprise-Level Job Attributes

When you define a job, you enter a value for the name of the job. To make job names more specific, set up attributes
to identify additional details about the job. This includes the nature of the work that is performed or the relative skill
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level required. If these attributes apply to all jobs within your enterprise, set up enterprise-level job attributes. Standard
capabilities mean that you can use the different segments of the name to:
- Identify common jobs or job holders for analysis or compensation.

- Group records in reports, such as to find all jobs of a specific job type.

Don't use attributes with values that change regularly, for example, salary ranges or expense approval levels that change
every year.

This figure illustrates how job type and job level provide further details for the HR Application Specialist job.

Job Attributes

Job Name Job Type i
3 ¥ !
HR Application
Specialist Cansultant 4

Enterprise-Level Position Attributes

Position attributes at the enterprise level are similar to those for jobs. Each position that you define identifies a specific
role in the enterprise, which you can manage independently of the person in the position. A position belongs to one
specific department or organization. The name of each position must be unique. To simplify the process of managing
unique names for positions, set up enterprise-level attributes to identify separate components of the position name.
For example, you can set up an attribute for position title and one for position number. When defining the attributes
that make up the structure of a position name, consider whether any of your attributes are part of the definition of

a common job type. Using job types for a position can help you manage common information that applies to many
different positions.

For example, you can:

1. Define a job type of Manager.Level 1.

2. Use it for comparison of positions across departments or lines of business or for setting common job
requirements.

3. Define multiple manager-type positions in your HR department, each of which has responsibility for a different
management function or group.
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This figure illustrates how title and position number provide further details for the manager position.

Position Attributes

Pasition Name Title Restion
Mumber
3 ¥ y
Assistant
Manager Store 10050
Manager

Business Unit-Level Attributes for Positions

If you have information that you want to capture for positions that are specific to each business unit, then you can
define attributes at the business unit level for positions. When you create positions, these attributes appear in addition
to any enterprise-level attributes. For example, you might want to identify the sales region for all positions in the sales
business unit. You can set up a text attribute called Sales Region and use it to enter the necessary information when
creating positions for the sales business unit.

Reference Data Set-Level Attributes for Jobs

If you have information for jobs that applies to specific reference data sets, set up attributes for jobs at the reference
data set level. When you create jobs, these attributes appear in addition to any enterprise-level attributes. For example,
you might want to identify all information technology (IT) jobs within a specific set. You can set up a text attribute called
Function and use it to enter IT in jobs that you create that perform an IT function within a specific set.

Workforce Structures Code Generation Methods

A code uniquely identifies either a position or a job. Currently, you can generate a code for position and job workforce
structures. Use the Manage Enterprise HCM Information task in the Workforce Structures work area to configure the
code generation method for positions and jobs.

You can generate the position code or the job code in one of these 3 ways:
Manually
- Automatically prior to submission

- Automatically upon final save

Manual: Use this method to manually enter the code when creating a position or a job. You can update the code in the
Details page. This is the default method for generating the position and job code.
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Automatic prior to submission: Use this method to automatically create and display the code when you create a
position or job. This method may create gaps in the code sequence if the transaction is canceled after the position or
job code is generated.

Automatic upon final save: Use this method to create position or job codes only after the create transaction is
approved. You can't see the position or job code when you're creating the respective workforce structure, but can see it
on the Details page after the transaction is approved. This method has less possibility of creating gaps in the generated
codes.

The Automatic prior to submission and Automatic upon final save methods use an enterprise number sequence. All
workforce structures' codes that are generated using the automatic methods are numeric only. By default, the sequence
starts from 1; however, you can change the starting number. The code increments by one for each new position or job
created.

You can change the position or job code generation method from Automatic prior to submission method to the
Automatic upon final save method and the other way around. You can also change from the automatic method to the
manual method and the other way around but you must be careful which method you choose if you have existing data.
You can't edit an automatically generated position or job code.

Initial Position and Job Code

You can specify the initial position or job code for your enterprise when you generate the code automatically. The
application uses this number for the first record that you create using the automatic position and job code setting and
increments the number by one for subsequent records. By default, the initial code is 1. The validation on the initial
position and job code helps you identify the starting code in automatic code generation when the method is changed
from manual to automatic.

Using the initial position and job code, you can retain the legacy codes for existing positions and jobs respectively.
Additionally, you can automate the number generation for new positions and jobs, starting from the last legacy person
number plus one. You can change the initial code.

Note: To avoid duplicate codes being generated, follow these recommendations.
- If you have been using the manual method of position or job code generation for sometime and now moving
to the automatic method, we recommend setting an initial code to a value higher than the old position or job
codes that were specified manually.

- When using HDL to load positions or jobs, the position and job code can be automatically generated, hence we
recommend you leave the code blank in the dat file.

Evaluation Criteria for Jobs and Positions

You can define evaluation criteria such as evaluation system, date, unit of measure, for for jobs and positions

By default, 2 evaluation systems are available. The Hay system is a predefined evaluation system. Another custom
evaluation system is available for which you need to define your own criteria and values..
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Enable Evaluation Criteria Section

The Evaluation Criteria section is hidden by default, you need to enable it in the Transaction Design Studio. For example,
here's how you can enable it in the Position Details page

Click My Client Groups > HCM Experience Design Studio.

Select the Position Details action.

Click Add to add a rule.

Enter a name and description for the rule.

In the Page Attributes section, select the Configure Save Options and Regions option.

For the Evaluation Criteria region, select Visible.

Select Evaluation Criteria from the Region list to ensure that the Evaluation System field is enabled in the
section.

8. C(lick Save and Close.

You can enable for the Job Details page similarly by selecting the Job Details action in Transaction Design Studioln the
Request a New Position and Request a Position Change flow, the Evaluation Criteria section is available in the Show or
Hide Regions section.

NOURWNRA

Points to Consider

- The evaluation criteria data associated to a job or position isn't copied when a job or position is duplicated.

- You can see only the Evaluation Date and the Evaluation System fields in the read-only job or position pages, if
there isn't any evaluation data.

- The Evaluation Date doesn't default to the start date of the job or position unlike the classic job and position
pages.

- The Evaluation Date can't be earlier than the start date of the job or position.

- Any updates to evaluation data are retained in the cache until you submit the data. Only the data submitted or
committed to the database is displayed on the page, irrespective of the earlier data updates.

If you want to remove the evaluation data for a job or position, you need to remove the Evaluation System
value. However, if the Evaluation System is defaulted and the field is hidden, you have to first unhide the field
and then remove the Evaluation System to delete the evaluation data.

Default Evaluation System

You can specify a default evaluation system for job and position flows on the Manage Enterprise HCM Information
page. If you specify a default evaluation system it applies to both jobs and positions. However, you can change it in the
respective flows.

Here are some key points to note about the evaluation system defaulting.

- The Evaluation System is defaulted when you specify an evaluation date in the Evaluation Criteria section.

- The Default Evaluation System configuration isn’t date effective on the Manage Enterprise HCM Information
page.

Related Topics
« Workforce Structures Flexfields

« Workforce Structures Lookups
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How FTE is Calculated in Positions

The full-time equivalent (FTE) value is the result of multiplying the working hours with the headcount and dividing by
the standard working hours.

For example, if the working hours are 30, the headcount is 2 and the standard working hours are 40, then the FTE value
is 1.5.

Ways to Calculate the FTE

You can either enter the FTE manually or calculate it automatically.
- Manually: Use the FTE field in the Budget Details section to enter a FTE value manually. If an FTE value is
already provided, you can update it based on the ratio of the working hours to standard working hours.

- Automatically: Select the Calculate FTE option in the Budget Details section to automatically calculate the FTE.
This check box is shown only when the Enable FTE Calculation in Positions profile option is set to Yes. Earlier,
the FTE value was automatically calculated only when a position was created. However, when this check box is
deselected automatic FTE calculation is disabled even when a position is created.

When the Calculate FTE option is selected and you edit the working hours or the headcount in the position
pages, the FTE is automatically calculated and the FTE field becomes read-only. However, you can override the
automatic calculation of FTE by deselecting the Calculate FTE option on the position pages.

This check box is available in these flows - Request a New Position, Request a Position Change, Update or
Correct Position, and Duplicate Position flows.

The Calculate FTE Option

Here are some points to note about Calculate FTE option.

- The Calculate FTE option is disabled for positions created before enabling automatic FTE calculation.
- The Calculate FTE setting is copied when a position is duplicated.

If FTE is configured as hidden in the Transaction Design Studio (TDS), then the Calculate FTE option is also
hidden even though the profile option is enabled.

Work Hours and Duration

Full-time equivalent (FTE) is the number of hours worked by an employee on a full-time basis.

It's calculated by dividing the working hours by standard working hours. For example, if the working hours are 20 and
the standard working hours are 40, the FTE is 0.5.

Organizations use FTE to determine their employees’ workload; specifically the number of part-time employees
required and the hours they work to add up to the same number of hours worked by full-time employees. Hence, the
general assumption is that an employee works 2,080 hours annually. This value is derived by calculating the number of
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hours worked by a full-time worker in a week multiplied by the number of weeks in a year - 8 hours per day x 5 days per
week x 52 weeks per year = 2,080 hours.

However, the working hours duration might vary across industries. For example, in the manufacturing sector, an annual
number of working hours contract may be in place due to seasonal fluctuations, with only premium pay applicable when
the prorated annual hours exceed the specified annual hours. In the education sector, the duration may be linked to the
academic teaching timetable.

In such cases, the FTE calculation needs to be adjusted for such employees. These work hours attributes defined in a
position help in determining the adjusted FTE.

Standard Working Hours - Standard working hours are usually those of a full-time worker. You define them for the
enterprise, legal employer, department, location, job, or position.

If you define standard working hours for more than one work structure, the application uses this hierarchy to derive
standard working hours for the position: Job > Location > Department > Enterprise. The application uses this hierarchy
to derive standard working hours for the worker assignment: Position > Job > Location > Department > Legal Employer
> Enterprise.

Working Hours - Working hours are the same as standard working hours, by default.

Working hours and standard working hours may remain the same. For example, if an employee is working the
department's standard working hours, standard working hours and working hours are the same. For part-time workers,
there is usually a difference between standard working hours and working hours. Where there is a difference, you
update the working hours for the position and the assignment.

Standard Annual Working Duration - You define the standard annual working duration for the enterprise, legal
employer, department, location, job, or position.

If you define the standard annual working duration for more than one work structure, the hierarchy to derive the
standard annual working duration is same as standard working hours.

Annual Working Duration — Annual working duration is same as the standard annual working duration. The value may
differ but the duration is the same as the duration defined for the standard annual working duration.

Workday Information Defaults

The Full-Time Equivalent (FTE) is the number of hours worked by a worker on a full-time basis and is typically used to
determine the workload.

You can either specify your own values or default the standard working hours, standard annual working duration, and
the unit of measure (UOM) values. The workday information is used to calculate the full-time equivalent (FTE) of a
worker.

You can default the workday information attributes from these entities in this order.

Job
Location
Department
4. Enterprise
Let’s look at how this works with the help of a diagram.

WN=
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ENTERPRISE

If values are specified in the enterprise,
then default standard working hours,
frequency, standard annual working
duration, and units of measure from
enterprise

The defaulting logic for the standard working hours, frequency, standard annual working duration, and units of
measure is given below.

Entity How it Works

Job The first check is on the job specified in the position. If values for any of these attributes are available
in the job, then these values are defaulted on the position.

Location If any of the attribute values aren't specified on the job, then the check is done on the location
specified in the position. If these values are specified in the location, then these values are defaulted on
the position.

Department If any of the attribute values aren't specified on the location, then the check is done on the department

specified in the position. If these values are specified in the department, then these values are
defaulted on the position.
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Enterprise If any of the attribute values aren't specified on the department, then the check is done on the
enterprise. If these values are specified in the enterprise, then these values are defaulted on the
position.

If you change the business unit, department, location, or job in the position, then the existing defaulted workday
information is also removed, if they are defaulted from any of these objects. However, this doesn't apply when you
duplicate a position.

In addition, the defaulting hierarchy gets recalibrated when you provide a value in any of the entities. For example, if
the standard annual working duration was earlier defaulted from the enterprise and you have specified a value for the
standard annual working duration for a department now. The latest standard annual working duration value will now be
defaulted from the department.

How You Match Position Valid Grades with Job Grades

You can enforce that valid grades of the position match with valid grades of the associated job by setting this profile
option value to yes: Validation to Match Position's Valid Grades With Job Valid Grades Enabled.

When the profile option is enabled, only valid grades specified in the selected job can be added in the position. An error
is shown when you add grades that aren'’t specified for the job.

A new position inherits the valid grades defined in the selected job. Valid grades for the position are those that are
active and associated with the common set or the set associated with the business unit. Valid grades are used in
assignments that use the position and subsequently in payroll calculation.

Position Synchronization

If position synchronization is enabled, assignments inherit specified values from the associated position.

Synchronized Attributes

You can select any of the following attributes for synchronization when position synchronization is enabled:

Department

- Job
Location

- Grade

- Grade Ladder
Manager
Full Time or Part Time
Regular or Temporary

- Assignment Category
FTE and Working Hours
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- Start Time and End Time
Probation Period
Union, Bargaining Unit and Collective Agreement

- Synchronize Mapped Flexfields

Position Changes

All active assignments that are synchronized from position automatically inherit changes from the position. Assignment
attributes synchronized from position automatically inherit changes from the position. For those attributes not
synchronized from position, you can either retain the existing values or update values from the position.

The Review page in the Edit Position page displays the list of impacted assignments with a status for each assignment.
The status indicates if there are any issues due to the position change. You must correct all errors before submitting the
position changes.

Assignment Changes

When you change the position in existing assignments you have a choice whether to inherit the values for those
attributes which aren't synchronized from the position. If you choose not to inherit, then the previous values remain
unchanged.

Position Synchronization Configuration Changes

If the position synchronization configuration is changed after person and assignments are created, then the
Synchronize Person Assignment from Position process must be run to apply the changes in assignments.

Position Hierarchy Configuration Changes

When the manager is synchronized from the HCM position hierarchy and you change the parent position, all
assignments inherit the new manager from the current parent position. When you remove a position from the hierarchy,
all child positions move one level up in the hierarchy. Hence, the grandparent position is the new parent position.

The incremental flattening process is triggered when you add or change a parent position. The flattening process will
update the changes in the position hierarchy.

When you change the position in an existing assignment, the manager value is updated based on the parent position of
the changed position. If the parent position doesn't have an incumbent, the incumbent in the position in the next level
up in the hierarchy is the new manager.

Uploading Changes Using HCM Data Loader and Workers REST API

When you create or update assignments using HCM Data Loader or Workers REST API, you can synchronize them from
positions. In this case, you must:

Enable position synchronization before you load the assignments. If you enable it after the assignments are
loaded, then you can synchronize from positions for current and future dates only.

- Set the Synchronize from Position (Position Override) attribute on the employment terms or assignment
objectto Y.

After loading the assignments using HCM Data Loader or Workers REST API, you must run the Synchronize Person
Assignments from Position process to synchronize the assignments.When you run the process, set the Past Period
to Be Considered in Days parameter to an appropriate value. For example, if you set this parameter to 60 days, then
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any assignment records with start dates during the previous 60 days are synchronized from positions. By default, Past
Period to Be Considered in Days is set to 30 days.

Note: If you're using the Compensation Workbench to promote your workers and have enabled position
synchronization, then after running the Transfer Workforce Compensation Data to HR process, you need to also
run the Synchronize Person Assignments from Position process. This will update the other synchronized position
attributes in the assignment.

Related Topics
» How Assignment Values Are Inherited from Position

» Synchronize Person Assignment from Position Process

Set Up Position Synchronization

Position synchronization is inheritance of values in an assignment from the values specified in the associated position.

You can enable position synchronization at the enterprise and legal entity levels using the Manage Enterprise HCM
Information and Manage Legal Entity HCM Information tasks (in the Setup and Maintenance work area) respectively.

Enterprise Level Setup

You can enable position synchronization either at the enterprise or the legal employer levels. Select the Enable Position
Synchronization attribute in the Edit Enterprise page to enable position synchronization for the enterprise. By default,
this attribute is deselected. You can also specify whether the inherited values can be overridden at the assignment level.

If you enable position synchronization at the legal entity and the enterprise levels, then the settings specified at the
legal employer level takes precedence over the settings specified at the enterprise level.

Legal Employer Level Setup

Set the Enable Position Synchronization attribute to Yes in the Position Synchronization page to specify the attributes to
be configured with the position for the legal employer.

Select No for the Enable Position Synchronization attribute, to exclude a specific legal employer.

You can also use the same settings as defined for the enterprise. In this case, you must select the Use Enterprise
option, which is the default value. If position synchronization is configured at the enterprise level, then the assignment
inherits the attribute values from the position selected. You can also override these values at the assignment level.

Enabling Position Synchronization Post Setup

Here are the steps to enable position synchronization for the enterprise or legal entity post setup..

1. Onthe Home page, under My Client Groups tab, click the Show More link to access more quick actions.
Navigate to Workforce Structures > Manage Enterprise HCM Information page or Manage Legal Entity
HCM Information page.

3. Under Position Synchronization Configuration section, select the attributes that you want to synchronize.

4. Select the Allow Override at the Assignment option if you want to exclude an assignment from
synchronization.
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5. Using HCM Data Loader, you need to update all assignments that you want to must be synchronized from the
position (as of the date you want to enable position synchronization).

6. Set the Synchronize from Position (position override check in HCM Data Loader) attribute on these
assignments to Y. This enables position synchronization even if you don't want to allow override at the
assignment.

7. Run the Synchronize Person Assignments from Position process to synchronize the assignments.

Related Topics
» Synchronize Person Assignment from Position Process

How Assignment Values Are Inherited from Position

If you enable position synchronization, assignments inherit specified values from the associated position. You can also
specify whether the inherited values can be overridden in the assignment.

You can specify this at the enterprise and legal entity levels using the Manage Enterprise HCM Information and Manage
Legal Entity HCM Information tasks respectively.

Overriding of Assignment Values

When you enable position synchronization, you specify which attributes the assignment inherits from the position

due to synchronization. Assignment attributes synchronized from position inherit their values from the position and
aren't editable. The restriction on editing values in the assignment applies only to the information that's entered in the
position. For example, if the Bargaining Unit isn't entered in the position, you can edit this value in the assignment even
though it's one of the attributes inherited from the position. If override is allowed at the assignment level, then you can
specify at the assignment level whether you want to synchronize from position or not. By default, the Synchronize from
Position attribute on the Edit Assignments page is set to Yes. If you prevent override at the assignment level, users can't
update the specified attributes that the assignment has inherited from the position. You can use personalization to
enable managers to specify a value for the Synchronize from Position field.

You can choose to either retain the existing values in the assignment or update the values from the position for any
attributes that aren't synchronized. So, if you don't select the grade attribute for synchronization and update the grade
value in the position, you can either retain the existing grade value in the assignment or update it from the position.

If a synchronized attribute is empty at the position, then this attribute won't be synchronized in the assignment. You can
enter any value for this attribute in the assignment. If a value already exists for this attribute, it will be retained and you
can change it to any other value.

Let’s see how assignments are impacted when position and position synchronization details are modified using
different applications.

Parameters Responsive HDL or HSDL REST Request a Position Synchronize Person
Employment Flows Change - Impacted Assignment from
Assignments Position Process
Position Attributes Yes Yes Yes Yes Yes
Position Flexfields Yes N/A N/A N/A Yes
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Parameters Responsive HDL or HSDL REST Request a Position Synchronize Person
Employment Flows Change - Impacted Assignment from
Assignments Position Process

Note: Only if the
mapping is defined
for the assignment

flexfield.
Manager from Yes N/A N/A N/A Yes
Position Hierarchy
Manager from Yes N/A N/A Yes Yes
Position
Synchronize Reports N/A N/A N/A N/A Yes
from Position
Hierarchy
Calculate FTE as per  Yes N/A N/A N/A Yes
Position Working
Hours

For example, if position synchronization is enabled and you change the position in the responsive employment flows,

all position parameters are synchronized except direct reports. If you load the position parameters changes using HCM
Data Loader (HDL), HCM Spreadsheet Data Loader (HSDL), or REST, then only the position attributes are synchronized.
The Synchronize Person Assignment from Position process updates all assignments irrespective of the application used.

These are some key points to note.

- Position attributes are synchronized irrespective of the application used for the update.

- Position flexfields are synchronized in responsive employment flows and when you run the Synchronize Person
Assignment from Position process. Flexfield data can also be updated in responsive employment flows.

- Line manager is defaulted from the position hierarchy in responsive employment flows, and when you run the
Synchronize Person Assignment from Position process.

- Line manager is defaulted from the position in responsive employment flows, when there is change in the
position, and when you run the Synchronize Person Assignment from Position process.

- Direct reports can be synchronized only when you run the Synchronize Person Assignment from Position
process.

- The assignment FTE is recalculated when you change the standard working hours, and the FTE and working
hours are selected attributes for synchronization.

- FTE is calculated based on the position working hours in responsive employment flows and when you run the
Synchronize Person Assignment from Position process.

For more information on the attributes that can be synchronized, refer to the topic Position Synchronization.

Note: If you choose to specify your own values for an assignment, then that assignment won't be synchronized with
any future position changes.
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HCM Position Hierarchy

Position hierarchy defines positions' relationships. The HCM position hierarchy is built based on these relationships.
You enable the HCM position hierarchy on the Manage Enterprise HCM Information page in the Setup and Maintenance
work area.

When you enable HCM position hierarchy:

- You can specify the parent position for a position on the Create and Edit Position pages in the Workforce
Structures work area. When you search for positions based on a parent position, it will show all child positions
for the specific parent position.

- You can also use the hierarchy to synchronize the line manager in the assignment from the line manager value
in the parent position.

- You can view the positions that are part of the HCM position hierarchy on the My Team page and view the
incumbents for a position.

- You can inactivate a position only if an incumbent with an inactive assignment exists.

Note: You can open the existing HCM Position Hierarchy from the Redwood Positions read-only page by clicking the
HCM Position Hierarchy option in the Actions drop-down menu.

Updating the Position Hierarchy

You can only correct the HCM position hierarchy. You can enable or disable the position hierarchy configuration by
flattening the existing hierarchy. You must run the Synchronize Person Assignments from Position process to flatten the
position hierarchy.

When the position hierarchy is flattened, then schedule to run the Synchronize Person Assignments from Position
process. This will apply the manager changes in assignments if the position hierarchy is changed after person and
assignments are created. The assignment changes can exist on the current date, date in the future, or in the past.

You can't change the position hierarchy configuration if the line manager is synchronized based on the HCM position
hierarchy. However, if line manager synchronization was configured as of a date in the past, then you can correct the
position hierarchy configuration.

Graphical Position Hierarchy

The HCM position hierarchy shows the relationship between positions and their parent positions. You can view and edit
the hierarchy on the HCM Position Hierarchy page, if your data security profile allows you.

You can identify a position's parent on the Manage Positions page if the Use HCM Position Hierarchy option is enabled
for the enterprise.

The nodes of the position hierarchy represent positions and parent positions. You can:
- Add child positions under a position either by creating a new position or by selecting an existing position as the
child.
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- Create a copy of an existing position by specifying a new name and code. The rest of the information is copied
from the original position to the copy. You can change any information that you want.

Edit the position.

- View the incumbent details including name, person type, person number, position entry and exit dates, and
their status as of the current date.

Delete any position that doesn't have any incumbents or child positions.
In each position node, you can view:
Position name and code.
Business unit, job, department, and location.
Number of incumbents for the position.
- Open Full Time Equivalent (FTE)

- Current incumbents in the position.

How You Create a Graphical Position Hierarchy

Vision Corporation is reorganizing its workforce and defining the hierarchy for all positions. You must create a position
hierarchy as shown here.
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Executive Vice
President

:

Vice President

v

:

Sales Director

Operations
Directar

Senior Sales

Senior Operations

Manager Manager
Operati
Sales Manager hﬁ:;a;rf

The following table summarizes the key decisions for this scenario.

Decisions to Consider In this Example
Which business unit do these positions Vision Corp. US
belong?

What is the method for position code Manual

generation?

You must do the following before creating the position hierarchy:

1. Onthe Manage Enterprise HCM Information page, enable HCM Position Hierarchy.

ORACLE
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2.
3.

4.

Ensure you have the Manage HCM Position Hierarchy privilege, which enables you to update the hierarchy.
Create the following positions -Executive Vice President, Vice President, Senior Sales Manager, and Senior
Operations Manager.

Display additional fields on the Create and Edit Position pages using personalization, if required.

Add a Parent Position to an Existing Position

—

OCOVOJOURARWNRA

On the My Client Groups tab, click Workforce Structures.

On the Manage Positions page, search and select the Vice President position.
On the Position: Vice President page, click Edit and select Update.

Select Reorganization.

Click OK.

Search and select the Executive Vice President position as the parent position.
Click Review.

Click Submit.

Click Yes.

Click OK.

Create a New Child Position

1.

2.

3.
4.

On the HCM Position Hierarchy page, click the orange arrow icon in the Vice President node and select Create
Child Position.
On the Create Child Position page, enter the following details:

Field Value

Name Sales Director
Code SALES_DIR

Job Director

Type Single Incumbent
FTE 1

Headcount 1

Click Save and Close.
For the Vice President node, repeat steps 1and 2 using the following details:

Field Value

Name Operations Director
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Field Value
Code OPS_DIR
Job Director
Type Single Incumbent
FTE 1
Headcount 1

5. Click Save and Close.

Add an Existing Position as a Child Position

1. Inthe Sales Director node, click the orange arrow icon and select Add Existing Position as a Child.

2. Search and select the Senior Sales Manager position.

3. Click OK.

4. On the Edit Position: Senior Sales Manager page, click Save and Close.

5. Inthe Operations Director node, click the orange arrow icon and select the Add Existing Position as Child
option.

6. Inthe Select Position window, search and select the Senior Operations Manager position.

7. Click OK.

8. On the Edit Position: Senior Operations Manager page, click Save and Close.

Create Duplicate Positions

1. In the Senior Sales Manager node, click the orange arrow icon. and select Duplicate Position.
2. On the Create Duplicate Position page, enter the following details:

Field Value

Name Sales Manager
Code SALES_MGR
Type Single Incumbent
FTE 1

Headcount 1

ORACLE
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3. Click Save and Close.
4. Inthe Senior Operations Manager node, click the orange arrow icon. and select Duplicate Position.

5. On the Create Duplicate Position page, enter the following details:

Field Value

Name Operations Manager
Code OPS_MGR

Type Single Incumbent
FTE 1

Headcount 1

6. Click Save and Close.

Move the Sales Manager Node
You added the Sales Manager node under the Sales Director node instead of under the Senior Sales Manager node. You
can drag the node and drop it on the Senior Sales Manager node.

1. Select the Sales Manager node and drop it on the Senior Sales Manager node. The Sales Manager position
automatically becomes a child of the Senior Sales Manager position.

If you created a node in a wrong place, you can just drag and drop the node to the correct place. The hierarchy
automatically adjusts itself when you do so.

Review and Submit the Position Hierarchy Changes

1. On the HCM Position Hierarchy page, click Review. This page shows the positions that you added to the
hierarchy or the changes made to existing positions.

2. Click Submit.

3. Click Yes.

4. Click OK. If approval rules are set up, you'll be able to see the hierarchy changes after they are approved/

Considerations for Using Position or Position Hierarchy
for Synchronizing Assignment Manager

To select a line manager synchronization option for the enterprise or for individual legal entities, use the Manage HCM
Enterprise Information and Manage HCM Legal Entity Information in the Setup and Maintenance work area respectively.
This topic discusses the line manager synchronization options available.
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HCM Position Hierarchy

Use the HCM Position Hierarchy to synchronize the line manager on the assignment with the incumbent of the parent
position in the position hierarchy.

When there is a change in the position hierarchy, you need to run the Synchronize Person Assignments from Position
process to update the affected assignments. Alternately, when you update a position using the HCM Data Loader also
you must run the Synchronize Person Assignments from Position process for the assignments to inherit the position
changes. For example, if a position is moved under a different parent position, if there are any direct reports they're
automatically reassigned to the incumbent in the new parent position. If there is no manager in the parent position, the
application checks for the incumbent in the grandparent position, or until it finds an incumbent. If there are multiple
incumbents in a parent position, the incumbent with the longest tenure in the position is assigned as the new manager,
You can change the manager to the other incumbent on the Employment page.

If you move a position or remove it from the hierarchy, the grandparent position becomes the new parent position for
all the child positions. For example, if you have a hierarchy as follows: Manager (grandparent), Team lead (parent), and
Developer (child), and you move the Team Lead position to a different branch. The Manager position is the new parent
position for the Developer position.

Note: If you're using HCM position hierarchy, remove the function privilege for the Manage Position Trees task in the
Setup and Maintenance work area for your users. You can also hide the Manager field on the Create Position and Edit
Position pages using personalization if you synchronize the line manager using position hierarchy.

Position Manager

Use the position manager to synchronize the line manager on the assignment with the line manager defined for the
position. You can use this option if you're not using the HCM Position Hierarchy and want to manually maintain the
manager at the position. .

Related Topics
 Guidelines for Loading Positions

Synchronize Assignment Action Reason From Position

You can synchronize the action reason in assignments with the action reason specified when a position is updated using
these flows and process.

- Update Position (from Position Details)
- Request a Position Change
- Synchronize Person Assignments from Position ESS process
The action reason is synchronized in the assignment if these conditions are satisfied.
- Position synchronization is enabled at the legal entity level.
- Action reason attribute is selected for synchronization in the position synchronization setup.
- Action reason is specified in the selected position.

- Synchronization from Position action has associated reasons configured.
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- Action reason specified in the position is one of the reasons associated with Synchronization from Position
(ORA_POS_SYNC) action and to action of type Update Position (PER_POS_UPD)

- Atleast one of the synchronized attributes is updated in the position apart from action reason.

A point to note is that the action reason is synchronized only when the first position synchronization record is created in
the assignment. If there’s a correction in the position, then all changed attributes from position will be synchronized in
the assignment apart from the action reason.

How You Enable Action Reason Synchronization

You need to enable position synchronization at the enterprise or legal entity level. These are the steps to enable position
synchronization at the enterprise-level.

1. Onthe Home page, click My Client Groups > Workforce Structures.

2. C(Click the Manage Enterprise HCM Information task.

3. Click Edit > Update.

4. Click OK.

5. In the Position Synchronization Configuration section, select Enable Position Synchronization and Action
Reason check boxes. Select any other attributes for synchronization.

6. Click Review to check your changes.

7. Click Submit.

8. Click OK.

After position synchronization is enabled, let's add action reasons to the Synchronization from Position and Update
position actions.

On the Home page, click My Client Groups > Workforce Structures.

Click the Configure Actions task.

Search for Synchronization from Position (ORA_POS_SYNC) action.

Click Continue.

In the Action Reasons section, Click Associate to associate the action reasons with the action.
Click Ok.

Click Submit.

Click Configure Actions task

Search for and click Update (PER_POS_UPD) action.

Click Continue in the Action section.

. Click Associate and add the same action reason you added to the Synchronization from Position action, for
example, Promotion.

Click Ok.

. Click Submit.

COPONCURAWNA
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Example of Action Reason Synchronization in
Assignments

You can synchronize the action reason in the position with the action reason in the assignment. Let's understand how
this works with an example.

Position synchronization is enabled at the Global Business Institute enterprise level and department, job, full time or
part time, and action reason attributes are enabled for synchronization.
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There are 3 positions - Architect, Sales Manager, and Director with these action reasons and jobs respectively.

Position Info

Position Name Action Reason Job

Architect Promotion Software Development
Sales Manager Organization Change Sales Manager - SAAS
Director Assignment Change Director - Operations

The Synchronization from Position action is associated with only promotion and Organization Change action reasons
and the Update Position action is associated with Assignment Change and Organization Change action reasons.

Action Reason Info

Action Associated Action Reason

Synchronization from Position « Promotion

- Organization Change

Update Position - Assignment Change

- Organization Change

Assignment Info

Person Position Job Action Reason Updated Job Updated Action
Reason

John Doe Architect Software Development NA NA (no update in the
assignment action
reason)

Bonnie Vickers Sales Manager Sales Manager - SAAS  NA Software Development Organization Change

David Steward Director Director - Operations =~ NA Software Development (no update in the
assignment action
reason)

Action Reason Synchronization in Assignment

- John Doe - There is no update in the assignment action reason because none of the attributes were updated in
the Architect position.

- Bonnie Vickers - The Sales Manager position was updated with a new job and the action reason specified
in the position is Organization Change. The Organization Change action reason is associated with both -
Synchronization from Position and Update position actions. Since all conditions are met, the assignment is
updated with the Organization Change action reason.

- David Steward - Though the Director position was updated with a new job, but the action reason (Assignment
Change) wasn't updated in the assignment because the action reason is associated only with Update Position
action type and not the Synchronization from Position action.
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Synchronize Assignment Flexfields From Position
Flexfields

You map position flexfields with assignment flexfields using the Manage Assignment Flexfields Mapping task in the
Functional Setup Manager.

Use the task to map assignment descriptive flexfield segments to position descriptive flexfield segments. Synchronizing
mapped flexfields includes the following steps:

1. Define flexfield mapping
2. Enabling flexfield synchronization
3. Synchronizing assignment flexfields from position flexfields

Define Flexfield Mapping

To map flexfields, follow these steps.

1. In the Functional Setup Manager, click the Manage Assignment Flexfields Mapping task.
2. Specify the following information.

Field Description

Source Context The context for the position descriptive flexfield. If you want to map a global position flexfield
segment, leave the source context blank

Source Segment The position descriptive flexfield segment of the selected context or the global segment if the
context was left blank

Destination Context The context for the assignment descriptive flexfield you want to map the position flexfield to.
If you want to map it to a global assignment flexfield segment, leave the destination context
blank.

Destination Segment The assignment descriptive flexfield segment of the selected assignment context or the global

segment if the context was left blank.

Enterprise Configuration: Enable Specify whether you want to use this flexfield mapping for position synchronization for the
Position Synchronization enterprise. Leave this field blank if the flexfield mapping applies to a specific legal employer.
Legal Employer Configuration: Legal Use this option if the flexfield mapping doesn't apply to the enterprise. You can select multiple
Employer legal employers. Select the legal employer.

Legal Employer Configuration: Enable ~ Specify whether you want to use this flexfield mapping for position synchronization for the
Position Synchronization selected legal employer.
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Field Description

3. Add more mappings as required and specify information described in step 2 for each row.
4. Save the mapping.

Enabling Flexfield Synchronization

To enable flexfield synchronization, follow these steps.

1. Inthe Setup and Maintenance work area, click the Manage Enterprise HCM Informationtask to enable the
setting for the enterprise, or click the Manage Legal Entity HCM Information task to enable the setting for a
specific legal entity.

2. Click Edit and select Update.

3. Select the Enable Position Synchronization and Synchronize Mapped Flexfields check boxes in the Position
Synchronization Configuration section.

4. Click Submit.

Synchronizing Assignment Flexfields from Position Flexfields

To synchronize assignment flexfields from position flexfields, follow these steps.

1. In the Navigator, click Scheduled Processes.
2. Click Schedule New Process.
3. Run the Synchronize Person Assignments from Positions process.

Related Topics
 Position Synchronization

» Considerations for Flexfield Mapping in Position Synchronization
« Synchronize Person Assignment from Position Process

Considerations for Flexfield Mapping in Position
Synchronization

You map position descriptive flexfields to assignment descriptive flexfields using the Manage Assignment Flexfield
Mapping task in Oracle Fusion Functional Setup Manager.

Use this mapping to automatically populate values for those assignment flexfields mapped to the position flexfields,
when position synchronization is enabled. This topic describes what to consider when you're mapping flexfields.

Enterprise or Legal Entity Levels

Before you map flexfields, you must decide whether you want the mapping to be available for the enterprise or for
specific legal entities only. You can reuse a mapping across different legal entities. Settings at the legal employer level
takes precedence over enterprise settings, if both are specified.
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You need to define the enterprise or legal employer mapping for each position flexfield segment by selecting each row
corresponding to the flexfield segment.

Note: If you have defined position synchronization at the legal employer level and haven’t defined flexfield mapping
for a legal employer, the position flexfields won't be synchronized at the assignment for that legal employer.

Context Specific or Global

You must decide whether to map context specific or global flexfield segments because you can't map a context specific
flexfield segment to a global flexfield segment. You can't map two or more segments of different contexts or multiple
position segments to the same assignment segment.

When you change the position value in an assignment, all synchronized global segments inherit the value from the new
position. You can manually update those segments that have a blank value in the position.

When you change the position value in an assignment, all context specific segments inherit the value from the new
position. If the new position has similar values to the old position and additional contexts defined, the assignments
retain the same values and inherit the additional values from the new position.

Selecting and removing a position in an assignment makes the context and segments editable but the current values
aren't removed if they're synchronized from the position.

Numeric or Character

You can map flexfields of the same type (for example, numeric-to-numeric or character-to-character only), same
precision, and the same value set (same value set ID).

Related Topics
 Position Synchronization

- Considerations for Managing Descriptive Flexfields

Synchronize Person Assignment from Position Process

To synchronize the position changes with the affected assignments, run the Synchronize Person Assignments
from Position process. The Initialize Position Synchronization process to load position synchronization changes is
incorporated into the Synchronize Person Assignments from Position process.

The Synchronize Person Assignments from Position process is triggered in these scenarios.
Assignment

- Assignment update causing a date-effective split.

Direct report assignment change because of change in assignment. This might be due to either position
change or termination of the manager.

Position
Position update causing a date-effective split.
Parent position change.
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Position Synchronization Configuration
- Position synchronization configuration update either at the enterprise or the legal entity level.
Run the Synchronize Person Assignment from Position to:

- Update affected assignments in the enterprise or legal entity if position synchronization is enabled (either
initially or later, as a change).

- Prevent data corruption
« Synchronize the line manager based on the HCM position hierarchy.

- Synchronize action reason based on the position action reason and the available action reasons under
Synchronization from Position action.

- Update assignments affected by the position changes, uploaded using HCM Data Loader.

Note: You must schedule this process to run on a regular basis. If you're synchronizing the manager, then it's
recommended to run this process daily.

Use the Schedule New Process page in the Scheduled Processes work area to run the Synchronize Person Assignment
from Position process.

Before you run the process, you must enable position synchronization on the Manage Enterprise HCM Information or
Manage Legal Entity HCM Information tasks in the Setup and Maintenance work area

Process Parameters
Past Period to Be Considered in Days

Number of days in the past to be considered for updating the attribute in the assignments. The default value is 30
days. Note that even if position synchronization was enabled in the past and you loaded position data with an effective
date of 6 months back, you don’t need to specify 180 days as the number of days. This is because the process detects
the effective date and the last updated date of the position data. You can enter 2 days as the parameter value though
changes are effective 6 months back.

Run at Enterprise Level
Select Yes to run the process for the enterprise, or No to run it for a specific legal entity.
Legal Entity

Legal entity for which you want to run the process.

Process Results

This process updates all affected assignments with the changes from the position. This includes:

- Changes due to position synchronization.

- Past or future-dated changes to the position hierarchy.

- Rollback of line manager changes in assignments for reverse termination.
- Line manager hierarchy changes

- Flexfield-mapping changes.

- Changes in position loaded using HCM Data Loader
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Create a Position Profile

Profiles help you in identifying the requirements and competencies for a position. You can associate an existing profile.
You can also create a new profile and associate it with the position by updating or correcting the position.

You can associate a profile to a position using any of these pages - Position Details, Position Change, and Request a
New Position. Here's how you create a position profile.

On the Home page, click My Client Groups.

Navigate to the quick actions and click the Show More link.

Under Workforce Structures, click Position Details.

Search for and click the position for which you want to associate the profile.
On the Position Details page, click Create Profile under the Actions menu.
On the Create Position Profile page, enter these details.

cCUupUNRA

Field Description

Position Responsibility Responsibilities that are required for the position.

Position Qualifications Quialifications that are required of the people in the position.

7. Click Save.

Associate Action Reasons in Position with Role

You can make the action and action reason role-specific on these position pages by selecting the applicable roles when
you configure the action and action reason.

- Request a New Position

- Request a Position Change

- Update Position (from Position Details)

. Correct Position (from Position Details)

- Duplicate Position (from Position Details)

After the configuration, the position pages will display the action and action reason that are specific to the worker's
logged in user role. You need to associate the action reasons on the Configure Actions page. In these steps, we will
create a new action reason and associate the role.

On the Home page, click My Client Groups > Workforce Structures > Action Reasons.
Click Add.

Enter a name, code, and description for the action.
Click Submit.

PUN
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5. Onthe Home page, click My Client Groups > Workforce Structures > Configure Actions.
6. Search and click the action with which you want to associate the specific action reason, for example, Update.
This table lists the flows associated with the action.

Action Code Applies to

Create PER_POS_NEW o Request a New Position

o Duplicate Position

Update PER_POS_UPD o Update Position

o Correct Position

o Request a Position Change

On the Edit Action page, click Continue in the Action section.
Click Associate.
Select the action reason you created.
10. Enter a start date for the association.
11. Select the roles you want to associate.
12. Click Submit.
In addition to the action reasons associated with the role, you can also see the action reasons that are available for all
users and not associated with any role in the Action Reasons LOV.

0 03

Upload Workforce Structures Using a Spreadsheet

Using a spreadsheet, you can upload multiple objects at a time, for the following workforce structures:

- Jobs
Locations
Departments
For example, to upload multiple jobs at a time:
- Select Manage Jobs in the Workforce Structures work area
Display the Create menu

- Select Create in Spreadsheet

Uploading Using a Spreadsheet

For each workforce structure, you can do the following:

Download a predefined spreadsheet template from the application

- Work on the spreadsheet offline, and upload the spreadsheet to the application when your changes are
complete

Upload the spreadsheet multiple times to accommodate revisions
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Effective Start Date

Ensure that the effective start date of the workforce structure is same as or earlier than the hire date of persons
associated with the workforce structure; for example, enter a job start date earlier than the hire date of persons
associated with the job. You may want to consider creating all objects as of a common early date, for example, create all
locations with the start date 1-1-1950.

Entering Descriptive Flexfield Values

Use the Attribute columns in the main sheet to enter values for the descriptive flexfields that are already defined for the
object. Use the DFF Reference sheet to understand which attribute columns map to which descriptive flexfields, since
this information isn't displayed in the main sheet.

I Note: You can't enter values in the DFF Reference sheet, you can only view details of the descriptive flexfields.

Uploading Jobs Using a Spreadsheet

When uploading jobs using a spreadsheet, you:

- Can't create a new job profile
- Can only associate an existing job profile

Must enter the name of an existing job profile in the spreadsheet

Related Topics
 Guidelines for Using Desktop Integrated Excel Workbooks

FAQs for Jobs and Positions

What's the difference between a job set and a job family?

Ajob family is a group of jobs that have different but related functions, qualifications, and titles. They are beneficial for
reporting. You can define competencies for job families by associating them with model profiles.

A job set is an organizational partition of jobs. For example, a job set can include global jobs for use in all business units,
or jobs for a specific country or line of business. When you select a job for a position or an assignment, you can view the
available jobs in your business unit set and the common set.

Related Topics
- What's ajob set?
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Why can't | see the position code for the new position?

Based on your enterprise settings, the position code is generated after the Create Position transaction is approved. For
example, once the transaction is approved, you can see the position code on the Position Details page.

When can | enable position synchronization?

You can enable position synchronization at any time but if there are existing assignments in an enterprise or legal
employer, you can enable it only as of the current or future date.

If you update an assignment as of a past date the values from the new position won't be updated in the assignment.
For example, if you create a transfer as of a past date before enabling position synchronization, the values from the new
position won't be updated in the assignment.

What happens if | specify a parent position?

You can specify a parent position when you enable HCM position hierarchy using the Manage Enterprise HCM
Information task in the Setup and Maintenance work area. A parent position is one, which is the next position up in the
position hierarchy.

On the Manage Positions page, click the parent position link to view the position details and click the icon next to the
parent position to refresh the search with the parent position.

As a prerequisite, you specify a parent position to synchronize the line manager from the parent position. When you
select to synchronize the line manager using the position hierarchy the incumbent in the parent position is populated as
the new manager.

Related Topics
 Position Synchronization

What happens if | specify the standard working hours in a
position?

In an assignment, the standard working hours are inherited from the position. The working hours and the standard
working hours provided in the position are used to calculate the FTE (Full Time Equivalent) in the assignment.

If there is a FTE value already existing in the position, you can choose to update it based on the ratio of the working
hours to standard working hours.

When position synchronization is enabled, even if FTE value exists for the position, it is not copied to the assignment
during synchronization. Instead, the assignment FTE value is calculated as a ratio of working hours to standard working
hours, if specified.
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What happens when grades are synchronized?

The profile options to default or enforce valid grades are ignored when grades are synchronized.

If multiple valid grades exist at the position, then you can select an appropriate grade in the assignment. If you hire a
person into the position, which has an entry grade specified, then the entry grade will be the default value in case of
multiple valid grades.

If the assignment has both position and job, then synchronization from the position always takes precedence and the
values at the job will be ignored. Let's say you haven't defined any valid grades for the position. However, valid grades
are defined for the job and the assignment has a position. Then any valid grades for the job are ignored.

How can | exclude some assignments from position
synchronization?

If you want to use position synchronization only for a section of workers, you need to enable position synchronization at
the legal employer level.

To exclude some assignments from synchronization, select Allow Override at the Assignment in the Position
Synchronization Configuration section on the Manage Enterprise HCM Information page.

To exclude a specific assignment from synchronization, select No in the Synchronize from Position field in the
assignment (even if override is allowed). All read-only fields become editable but the assignment won't be synchronized
and will no longer inherit any changes made at the position level. However, it isn't possible to exclude only some
synchronized attributes.

How do | override position synchronization at the attribute level?

If you want to capture a different value for one attribute only, leave that attribute blank at the position

Let's say the location attribute is synchronized from the position but except in a few cases it doesn't matter into which
location the person is hired, then you can leave the location field blank at the position. Since blank values aren't
synchronized, the location will be editable in the assignment enabling you to select a value manually.

What happens if | select Synchronize Mapped Flexfields?

When you select this option, assignment flexfields are synchronized with the mapped position flexfields.

You must first map position flexfields to assignment flexfields using the Manage Assignment Flexfield Mapping task
in the Functional Setup Manager, and then select this option in the Manage Enterprise HCM Information task. When
position synchronization is enabled, the position flexfields are inherited in the assignments.
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15 Grades, Grade Rates, and Grade Ladders

Grades

From the Manage Grades page, create grades to record the level of compensation for workers.
You can do these actions.
- Create grades for multiple pay components, such as salary, bonus, and overtime rates

Define one or more grades that are applicable for jobs and positions

This list of valid grades, combined with the settings for two profile options, enables you to restrict the grades that can
be selected when you set up assignments for a worker.

Grades and Sets

You assign each grade to a set. If you assign a grade to the common set, then the grade is available for use in all
business units. To limit a grade to a single business unit, you can assign it to a set that's specific to that business unit.

Grade Steps

Grade steps are distinct increments of progression within a grade. You can set up grades with or without grade steps.
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The following figure illustrates the difference between grades with and without steps.

Grades Without Steps

Traines

Grades with Steps

Pharmacy Technician

Pharmacy Technician |

Pharmacy Technician Trainee
Step 1
Step 2
Step 3

Pharmacy Technician Il

Pharmacy Technician |
Step 4
Step 5
Step 6
Step 7

Pharmacy Technician Il

Grade Rates

Pharmacy Technician Il
Step 8
Step 8
Step 10
Step 11

Pharmacy Technician Il
Step 12
Step 13
Step 14
Step 15

Grade rate values are the compensation amounts associated with each grade. You can set up rates at the same time that
you create grades, or set them up independently from grades.

For grades with steps, you set up the step rates when you include them in a grade ladder. Grade rates are optional.

Grade Ladders

You can combine grades into grade ladders to group your grades or grades with steps in the sequence in which your
workers typically progress. For example, you might create three grade ladders for your enterprise: one for technical

grades, another for management grades, and a third for administrative grades.

Related Topics

« Grade Rates
« Grade Ladders

- How Grades and Grade Rates Work with Jobs, Positions, Assignments, Compensation, and Payroll

- Examples of Grades, Grade Rates, and Grade Ladders
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Grade Rates

Grade rates contain the pay values that are related to each grade.

Grade rate values can be either a fixed amount or a range of values, and you can set up rates for different types of pay
such as salary, overtime, and bonuses.

Note the following:

- Grade rates for some jobs or positions might include an hourly salary rate and an overtime rate.

- Grade rates for other jobs or positions might contain a salary rate type with a range of amounts and a bonus
rate type with a fixed amount.

- Grade rates typically serve only as a guideline to validate that the salary you propose during the compensation
process for a worker on a certain grade is appropriate for that grade.

This figure illustrates a grade that has two rate types associated with it: Salary rate type that has a range of valuesBonus

Grade: Admin(1

Rate Type: Salary - .
te Type: Bonus
Frequency: Maonthly .
Minimum: 4,000 USD Friingcgﬁ?'ﬁnsu;w
Maximum: 7,000 USD Le:

rate type with a fixed amount
This figure illustrates a different grade that has two rate types associated with it:Salary rate type that has a fixed

Grade: Tech02
Rate Type: Salary Rate Type: Overtime
Frequency: Hourly Frequency: Hourly
Value: 7.25 USD Value: 525 USD

amountOvertime rate type that also has a fixed amount
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Rate Types

The types of rates that you can set up depend on the values for lookup type GRADE_PAY_RATE_TYPE. Examples of rate
types are salary, bonus, and overtime pay.

Grade Rates and Legislative Data Groups

You assign a legislative data group to each grade rate. Depending on how your enterprise is configured, you may have
several legislative data groups. You can set up grades that are shared across different areas of your business, and enter
rates that are specific to each legislative data group.

Grade Rates and Grades

You can do the following:

- Set up grade rates when you set up grades

- Set up grade rates independently from grades

For grades with steps, you enter rates when you attach the grades to a grade ladder.

Related Topics
- How Grades, Grade Rates, and Sets Work with Legislative Data Groups

» How Grades and Grade Rates Work with Jobs, Positions, Assignments, Compensation, and Payroll
» Examples of Grades, Grade Rates, and Grade Ladders

Grade Ladders

Grade ladders group grades and grades with steps in the sequence in which your workers typically progress.

You create grade ladders either from the Manage Progression Grade Ladders page (in the Compensation work area) or
from the Manage Grade Ladders page (in the Workforce Structures work area).

Grade ladders describe the grades and steps to which a worker is eligible to progress and compensation value
associated with that grade and step. You may create different grade ladders for your enterprise: one for technical grades,
another for management grades, and a third for administrative grades.

Ladders with Grades

You create ladders with grades by building a hierarchy of grades that were created without steps. When you set up
this type of ladder, only grades without steps are available to add to the ladder. You can't create a grade ladder with a
combination of both grades and grades with steps.

You don't define any grade rates when you set up a ladder with grades; the rates for the grades within the ladder are
inherited from the rates that were added when you set up the grades. To add or edit rates for grades, you must use the
Manage Grade Rates task.
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Ladders with Grade Steps

You create ladders with grade steps using grades that were created with steps. When you set up this type of ladder, only
grades with steps are available to add to the ladder.

You define step rates when you set up the ladder, and the rates are unique to each ladder. You can't share step rates
between grade ladders.

Related Topics
- Grade Rates

« Grades
- Examples of Grades, Grade Rates, and Grade Ladders
» How You Set Up Grade Ladders for Pay Scale Requirements

Lookup Types for Grades

The Lookup type for Grades task identifies the lookup type for managing grades that has an extensible configuration
level.

The GRADE_PAY_RATE_TYPE lookup type identifies compensation components you want to set up for grade rates. The
predefined values are salary, bonus, and overtime. Review these lookup values, and update them as appropriate to suit
enterprise requirements.

Grade Ladder on Worker Assignment

You can use the grade ladder in the worker assignment to ensure that workers are compensated according to the grade
structure defined in the job or position.

Selecting Grade Ladder for Worker Assignment

Transactions, such as New Hire, Add Assignment, and Create Work Relationship involve creating a new assignment.
During assignment creation, the grade ladder is automatically populated based on the selected job or position. This isn't
true for transactions that involve an assignment update (for example, promotion, transfer). You must manually select
the grade ladder when you update the assignment.

Note: The Grade Ladder field isn't displayed if a grade ladder isn't defined for the worker organization.

You must select from the grades populated for the grade ladder. If the selected grade includes steps, you can view
the steps and the associated salary rates by clicking the Grade Details icon. The step rate is displayed based on the
legislative data group associated with the assignment business unit.

The grade step progression process evaluates a worker's eligibility to progress to a new grade or step based on the
defined rules and updates the salary rate. The process can be run for workers associated with a particular grade ladder
to move them to a new grade or step and update their salary rate.
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If the grade ladder selected in the assignment is associated with an automatic grade step progression process, you can
exclude the worker from the process. To exclude the worker, deselect the Include in grade step progression check box.

Note: The Include in grade step progression check box isn't displayed if a grade ladder isn't defined for the worker
organization.

Related Topics
- Grade Ladders

« Grades
« Grade Rates

How Grades, Grade Rates, and Sets Work with Legislative
Data Groups

You assign grades to sets, and grade rates to legislative data groups from the Workforce Structures > Manage Grade
Rates page.
If you have grades that are common across multiple business units, you can:

- Assign them to the set that's associated with business units.

- Set up grade rates that are specific to each legislative data group.
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The following figure illustrates how you can use sets to share grades across multiple business units and change the
grade rates for each legislative data group.

InFusion Corporation

Grade Set 1D
EOD1 INFUS
EO02 INFUS
E03 INFUS
E04 INFUS
EOS INFUS
us UK Australia
Legislative Data Group Legislative Data Group Legislative Data Group
Set ID: INFUS Set ID: INFUS Set ID: INFUS
Us Dollar GB Pound AUS Dollar

Grade Rate Range

ED1 50,000 to 70,000
B0z 70,000 to 90,000
E03 80,000 to 110,000
E04 110,000 to 130,000

Grade Rate Range

EO1 30,000 to 50,000
E02Z 50,000 to 70,000
E03 70,000 to 90,000
E04 80,000 to 110,000

Grade Rate Range

EO1 90,000 to 100,000

EODZ2 100,000 to 120,000
EO3 120,000 to 140,000
E04 140,000 to 160,000

Grades and Sets

Sets enable you to share grades that are common across business units in your enterprise. You can assign grades to
either a specific set or to the common set to each grade. If you assign the grade to the common set, then the grade is

available for use in all business units.

Grade Rates and Legislative Data Groups

Grade rate values are associated with each component of compensation for your workers. While grades may be

common across different areas of your enterprise, grade rates vary among the countries in which you employ people.

For example, if your enterprise has engineer jobs in the United States, the United Kingdom, and Australia, you can
set up grades for a set that's shared between the countries, but set up different grade rates for each country in the

applicable currency.
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Related Topics

How Grades and Grade Rates Work with Jobs, Positions,
Assignments, Compensation, and Payroll

You use grades and grade rates in the following components of Oracle Fusion HCM to ensure that workers are
compensated according to the grade structure that you create.

- Jobs

-+ Positions

- Assignments
- Compensation

- Payroll

How Grades Work with Jobs and Positions

You can define one or more grades that are applicable for each job and position. Using this list of valid grades,
combined with the settings for two profile options you restrict the grades that can be selected when you set up
assignments for a worker.

Note the following:

- If you use positions, then the grades that you assign to jobs are the default grades for the positions that you
associate with each job.

- You can use the default grades for the position, remove ones that don't apply, or add new ones.

How Grades Work with Assignments

When you set up assignments, you can select the applicable grade for the job or position.

Two profile options determine the grades that are available for selection:

Profile Option Description

PER_ENFORCE_VALID_GRADES If you set this site-level profile option to Yes:

« Users can select a grade only from the list that you defined for the job or position.

o [If users select both job and position for the assignment, they can select grades that are valid for
the position only.

o [If valid grades are defined for neither job nor position, then users can select from all grades.

If you set this site-level profile option to No:
- User can select from all the grades

- This is also the default value
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Profile Option Description
PER_DEFAULT_GRADE_FROM_JOB_ If you set this site-level profile option to Yes and there is only one valid grade for a job or position:
POSITION

- The grade is used by default in the assignment.

o Ifanentry grade is defined for a position, then that grade is used by default when the user creates
a new assignment.

If you set this site-level profile option to No:
- User can select from all the grades

- This is also the default value

How Grades and Grade Rates Work with Compensation and Payroll

Depending on the configuration of the legal employer to which workers belong, their salary can be stored at the
assignment level. The grade rate can be linked to the salary basis within the salary record, in which case their salaries
are validated using the grade rates.

For example, assume an assignment record for a worker indicates they're in Grade A1 with the salary of USD 40000.00:

- The grade rate range that's attached to Grade A1is 30,000.00 USD to 50,000.00 USD. Therefore, the salary is
within the grade rate range and no warnings are issued.

If their manager or a human resource (HR) specialist changes their salary to 55,000.00 USD, a warning is issued
that the new salary is outside their salary range.

In addition, compa-ratios and salary range positions for workers are calculated using the minimum and maximum
amounts that are defined in the grade rates for their grades.

Payroll elements reference grades in the eligibility criteria. For example, assume you want to process a bonus for all
workers who are at grade level A2. To accomplish this, you would create an earnings element for the bonus and specify
A2 for the grade in the eligibility criteria. The result of this setup, when combined with additional eligibility criteria that
may be applied by the bonus plan, is that when payroll is processed, workers who are at grade level A2 and who meet
the additional eligibility criteria would receive the bonus.

Related Topics
» How Many Salary Bases to Create

Examples of Grades, Grade Rates, and Grade Ladders

The following examples illustrate how InFusion Corporation might set up different types of grades, rates, and ladders
for the different types of jobs within the company. The examples include grade structures for administrative workers,
managers, senior executives, and line workers.

Note: All amounts in the examples are US dollars.
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Grades with Steps

The grade structure for annual salary amounts for administrative workers in InFusion Corporation includes five grades,
and each grade includes five steps.

- When workers move from one grade to another in this ladder, they don't always start at step 1 of a grade.

- The next step is based on their previous salary plus two steps.
For example, a worker could move from Step 5 in Grade 1to Step 3 in Grade 2.

The following table lists the five grades, steps, and the rates associated with them for administrative workers at InFusion
Corporation.

Grade Step 1 Step 2 Step 3 Step 4 Step 5
1 17,803 18,398 18, 990 19,579 20,171
2 20,017 20, 493 21,155 21,717 21, 961
3 21,840 22,568 23,296 24,024 24,752
4 24,518 25,335 26,152 26, 969 27,786
5 27,431 28, 345 29,259 30,173 31,087

To set up your grade structure to reflect this table, perform the following tasks:

- Set up five different grades and add five steps for each grade.
- Set up a grade ladder using the Grades with Steps type, and select all five grades.

- Set up step rates for annual salary amounts using the rates in the preceding table.

Grades Without Steps

The grade structure for annual salary amounts for level 3 managers at InFusion Corporation includes grades without
steps. The grade rates are fixed amounts.

The following table lists the grades and associated rates for level 3 managers at InFusion Corporation.

Grade Annual Salary Amount
1 103, 900

2 M, 800

3 119, 900
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Grade Annual Salary Amount
4 127,800
5 135, 900
6 143,700
7 151, 800
8 155, 500

To set up your grade structure to reflect this table, perform the following tasks:

- Set up eight separate grades.
- For each grade, enter the rates from the preceding table.

- Set up a grade ladder with the Grades type and add all eight grades to the ladder.

Grades with Grade Rate Ranges

The grade structure for annual salary amounts for senior executives at InFusion Corporation includes grades with no
steps, and the rates are set up using ranges.

The following table lists the rate range for senior executives at InFusion Corporation.

Grade Minimum Annual Salary Amount Maximum Annual Salary Amount

SNREXEC 154, 300 243,900

To set up a grade structure to reflect this table, perform the following tasks:

- Create a single grade.

- Create a grade rate and enter the minimum and maximum amounts from the preceding table for the grade rate
range.

Grade Rates with Hourly Amounts

The grade structure for line workers at InFusion Corporation includes grades with steps, and the rates are hourly
amounts.

The following table lists the hourly rates for line workers at InFusion Corporation.

Grade Step 1 Step 2 Step 3 Step 4 Step 5

1 10.64 1.07 1.49 196 12.40
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Grade Step 1 Step 2
2 177 12.27
3 1292 13.46
4 14.03 14.63
5 15.20 15.83

To set up your grade structure to reflect this table, perform the following tasks:

- Create five grades, each with five steps.

- Set up a grade ladder using the Grades with Steps type, and select all five grades.
- Set up step rates for hourly amounts using the rates in the table.

How You Set Up Grade Ladders for Pay Scale

Requirements

Step 3

1276

13.98

15.21

16.46

Chapter 13
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Step 4

13.24

14.55

15.80

1712

Step 5

1372

15.07

16.39

1775

This example illustrates how to use a grade ladder to create a pay scale that's typical of technicians in the metal industry
in Germany. The ladder includes four grades, and each grade includes four steps.

The following table summarizes key decisions for the grades, rates, and grade ladder in this scenario.

Decision to Consider In This Example

Are steps required for the grades? Yes.

Which step in each grade should be the The last step in each grade.

ceiling step?
What type of rates are necessary? Salary rates only.

Will the ladder be created using grades or =~ Grades with steps.
grades with steps?

Summary of the Tasks

To set up the pay scale, complete these tasks:

- Create grades
- Create a grade ladder

ORACLE
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Create Grades

1. Under My Client Groups, In the Workforce Structures work area, click Manage Grades to open the Manage
Grades page.
2. Onthe Manage Grades page, click Create to open the Create Grade: Grade Details page.

3. Inthe Grade Details region of the Create Grade: Grade Details page, complete the fields as shown in this table,
using the default values unless otherwise indicated.

Field Value

Grade Set Common
Name Technicians 03
Code Tech03

4. Click Next to access the Create Grade: Grade Steps page.
In the Grade Steps region of the Create Grade: Grade Steps page, click Add Row.

6. Add four steps for the grade by completing the fields as shown in this table. You must click Add Row after
adding each step.

w

Field Value
Step Name Year 1
Step Name Year 2
Step Name Year 3
Step Name Year 4

Verify that Year 4 is the ceiling step.

Click Submit. You will add the grade rates when you create the grade ladder.
In the Warning dialog, click Yes.

1 In the Confirmation dialog, click OK.

11. Repeat steps 2 through 9 to add three more grades with steps. Complete the information for each grade using
the information in these tables. The ceiling step in each grade is Year 4.

© v ™y

Field Grade 2 Grade 3 Grade 4

Grade Set Common Common Common
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Field Grade 2 Grade 3 Grade 4

Name Technicians 04 Technicians 05 Technicians 06

Code Tech04 Tech05 Tech06

Field Value

Step Name Year 1

Step Name Year 2

Step Name Year 3

Step Name Year 4

Create a Grade Ladder

1.

In the Workforce Structures work area, click Manage Grade Ladders to open the Manage Grade Ladders page.

2. On the Manage Grade Ladders page, click Create to access the Create Grade Ladder: Grade Ladder Details

v oA

©CovooN0o

page.
In the Grade Ladder Details region of the Create Grade Ladder: Grade Ladder Details page, complete the fields
as shown in this table, using default values unless otherwise indicated.

Field Value

Grade Set Common

Name Metal Technicians
Grade Type Grade with steps

Click Next to access the Create Grade Ladder: Grades page.

In the Search Grades region of the Create Grade Ladder: Grades page, enter TECH in the Code field and click
Search.

Select Tech03 and click Add to Grade Ladder.
Select Tech04 and click Add to Grade Ladder.
In the Add to Grade Ladder Hierarchy dialog, select At the top and click OK.
Select Tech05 and click Add to Grade Ladder.
In the Add to Grade Ladder Hierarchy dialog, select At the top and click OK.
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11. Select TechO6 and click Add to Grade Ladder.

12. In the Add to Grade Ladder Hierarchy dialog, select At the top and click OK.

13. Verify that the grades appear in numerical order, with Tech06 at the beginning of the ladder and Tech03 at the
end of the ladder.

14. C(lick Next to access the Create Grade Ladder: Rate Values page.

15. On the Create Grade Ladder: Rate Values page, select the legislative data group for Germany.

16. In the Grade Step Rates region, click Add Row.

17. Compilete the following fields as shown in this table.

Field Value

Name Technician Ladder Rates
Rate Type Salary

Frequency Monthly

Annualization Factor 12

Currency EUR

18. In the Step Rate Values region, enter rates for the four steps in each grade by completing the fields as shown in

this table.

Grade Name Step Name Value
Technicians 03 Step 1 1,750.73
Technicians 03 Step 2 1,878.90
Technicians 03 Step 3 2,009.79
Technicians 03 Step 4 214392
Technicians 04 Step 1 2,238.57
Technicians 04 Step 2 2,408.39
Technicians 04 Step 3 2,577.68
Technicians 04 Step 4 2,744.81
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19.
20.
21.
22.

Relate
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Grade Name Step Name Value
Technicians 05 Step 1 2,831.87
Technicians 05 Step 2 3,04714
Technicians 05 Step 3 3,257.52
Technicians 05 Step 4 3,469.00
Technicians 06 Step 1 3,586.36
Technicians 06 Step 2 3,851.38
Technicians 06 Step 3 4,122.34
Technicians 06 Step 4 214392
Click Next.
On the Create Grade Ladder: Review page, review the grade ladder hierarchy and the rates, and click Submit.
In the Warning dialog, click Yes.
In the Confirmation dialog, click OK.
d Topics

« Example of Setting Up Grade Ladders for Spine Point Requirements
« Examples of Grades, Grade Rates, and Grade Ladders

Example of Setting Up Grade Ladders for Spine Point
Requirements

This example illustrates how you can use grades, rates, and a grade ladder to represent spine points. You manage grade
ladders using the Manage Grade Ladders task in the Workforce Structures work area.

Spine Points

Some

public sector organizations in the United Kingdom (UK) use spine points to structure their grades. Each spine

point corresponds to one or more steps within a grade, as grades often overlap each other.
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Grade Structure

You can use grade ladders to meet the requirements of a grade structure with spine points. The following table
illustrates a grade structure with spine points that's similar to the one used for university workers in the UK.

Spine Point Salary Grade

1 25674 1
2 26,361

3 27,088

4 27,796

5 30,304

6 31,778 2

7 32648

8 33,542

g 34 466
10 35425
11 38,441
12 38,510 3
13 40,634
14 41, 746
15 42814
16 44 118
17 45 358

To set up grades for the spine point structure, you must:

- Create three grades with steps and name each step using the spine point number.
- Create a grade ladder with all three grades.

- Create step rates with annual salary amounts.

Resulting Grades, Rates, and Grade Ladder

The following table lists the grades and steps needed to meet the requirements of the grade structure with spine points.

Grade Name Steps Ceiling Step
Grade 1 - Spine Point 1 Spine Point 5
Spine Point 2
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Grade Name

Grade 2

Grade 3

The following table lists the grades, steps, and rates to add to the ladder.

Grade Name

Grade 1

Grade 2

Grade 3

ORACLE

Steps

Spine Point 3
Spine Point 4
Spine Point 5
Spine Point 6

Spine Point 6
Spine Point 7
Spine Point 8
Spine Point 9
Spine Point 10
Spine Point 1
Spine Point 12

Spine Point 12
Spine Point 13
Spine Point 14
Spine Point 15
Spine Point 16
Spine Point 17

Steps

Spine Point 1
Spine Point 2
Spine Point 3
Spine Point 4
Spine Point 5
Spine Point 6

Spine Point 6
Spine Point 7
Spine Point 8
Spine Point 9
Spine Point 10
Spine Point 11
Spine Point 12

Spine Point 12
Spine Point 13
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Ceiling Step

Spine Point 11

Spine Point 17

Rates

- 25,674
- 26,631
- 27,068
- 27,796
- 30,394
- 31,778

- 31,778
. 32,648
. 33,542
- 34,466
. 35,425
. 38,441
- 39,510

- 39,510
- 40,634

258



Oracle Fusion Cloud HCM Chapter 13

Using Common Features for HCM Grades, Grade Rates, and Grade Ladders
Grade Name Steps Rates
- Spine Point 14 - 41,746
- Spine Point 15 . 42,914
- Spine Point 16 . 44,118
- Spine Point 17 . 45,358
Related Topics

« Examples of Grades, Grade Rates, and Grade Ladders
« How You Set Up Grade Ladders for Pay Scale Requirements

FAQs for Grades, Grade Rates, and Grade Ladders

Can | edit the legislative data group for a grade rate?

No. If you need to change the legislative data group for a grade rate, you must change the grade rate to inactive and
create a new grade rate with the correct legislative data group.

How can | add rates to grade steps?

Rates can be added to a grade with steps, when you add the grade to a grade ladder.

What's the difference between grade ladders and progression
grade ladders?

Grade ladders group grades and grades with steps in the sequence in which your workers typically progress.
Progression grade ladders are hierarchies used to group grades and steps and define their sequence.

They include the associated progression rules and rates for each grade and step within the ladders. Oracle Fusion
Human Capital Management has both a Grade Ladder and a Progression Grade Ladder For a specific grade ladder
definition; you should use one of these, but not both.

The differences between them are:

Progression Grade Ladders Grade Ladder

- Viewed in Manage Progression Grade - Viewed in Manage Grade Ladders page in Workforce Structures work area
Ladders page in Compensation work
area
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Progression Grade Ladders Grade Ladder

Required if you're using grade step
progression or rate synchronization
processes

Enables population of worker salary
record from grade or step rates
during employment transactions

Only one rate (grade rate or step rate)
allowed per progression grade ladder

- Associated with a single legislative
data group

How can | edit rates for a grade?

You can edit rates using the Manage Grade Rates task. However, you can't edit rates within the Manage Grades task,
because grades and rates have separate effective dates.

What's a grade ladder hierarchy?

The grade ladder hierarchy consists of grades. You can move the grades up and down within the hierarchy, and add or
remove grades. You can click any grade to view the details.

What's a ceiling step?

A ceiling step is typically the highest step within a grade to which a worker may progress. When a worker reaches the
ceiling step within a grade, typically any further progress must be made by moving the worker to another grade.

You can override the ceiling for individual assignments. In most cases, the ceiling step is the last step in the sequence.
For example, if the grade has steps 1through 5, step 5 is the ceiling step. However, you may have situations where you
want another step to be the ceiling. For example, in a grade with steps 1through 5, you might indicate that step 4 is the
ceiling step, and workers can progress from step 1to step 4, and then on to the next grade. You can use step 5 when

a worker isn't entitled to move to the next grade, perhaps because he doesn't yet have the required qualifications or
certificates, but you still want to increase his pay to reward him for many years of experience and good performance.
You can provide the pay increase by moving him to step 5.
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14 Workforce Structures - Configuration

Options

Workforce Structures Enterprise-Level Configuration

Let's look at the different configuration options for workforce structures and the minimum search characters
configuration for each workforce structure at the enterprise-level.

Workforce Structure Configuration Options

You can configure workforce structure-related options at the enterprise level using the Manage Enterprise HCM
Information task in the Setup and Maintenance work area. This table provides the description and default value for each

option.

Option

Default Effective Start Date

Default Location Country

Default Evaluation System

Guided Flows: Future-Dated Records Validation

ORACLE

Description

You can default the effective start date when
creating workforce structure objects such as
position, job, location and so on in responsive
and classic pages.

You can default a country for the location at
the enterprise level. This defaults the selected
country under the country field (Main Address)
from Location Details (Add) Quick Actions.

If the country value is not defaulted at
Enterprise setup then the default country is
United States

You can set a default evaluation system at
the enterprise level which would default the
specified evaluation system for both job and
position

You can use this option to control whether
users can update work structures with future-
dated records using the self-service work
structure related pages. You can select from
these values:

- None: No validation is displayed.

«  Error: An error message is displayed
indicating that the work structure has
a future-dated record, and the user
is prevented from updating the work
structure.

- Warning: A warning message is displayed
indicating that the work structure has a
future-dated record. The user can choose

Default Value

None

None

None

None
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Description Default Value

to ignore the message and continue with
the transaction.

You can specify the initial position for your 1
enterprise when you generate the code
automatically.

The application uses this number for the first
record that you create using the automatic
position code setting and increments the
number by one for subsequent records. By
default, the initial code is 1.

You can specify the initial job for your 1
enterprise when you generate the code
automatically.

The application uses this number for the first
record that you create using the automatic job
code setting and increments the number by one
for subsequent records. By default, the initial
codeis 1.

You can generate a code for job workforce None
structure. Use the Manage Enterprise HCM

Information task in the Workforce Structures

work area to configure the code generation

method for jobs for your enterprise.

You can generate the job code in one of these 3
ways:

- Manually

- Automatically prior to submission

- Automatically upon final save

You can generate a code for position workforce = None
structure. Use the Manage Enterprise HCM

Information task in the Workforce Structures

work area to configure the code generation

method for positions for your enterprise.

You can generate the position code in one of
these 3 ways:

- Manually

- Automatically prior to submission

- Automatically upon final save

Minimum Search Characters

You can define the minimum number of characters to search for workforce structure objects using the Manage
Enterprise HCM Information task in the Setup and Maintenance work area.

ORACLE

262



Oracle Fusion Cloud HCM
Using Common Features for HCM

Chapter 14

Workforce Structures - Configuration Options

The minimum search characters are used to search for the name and code for each search page depending on the
number of objects. For performance reasons, the minimum value is 1.

Note: If your organization has a detailed department structure with a large number of departments, it's
recommended that you use 3 characters to search for departments. But, if you have a few departments, then you can
set the value to 1 character to make the search easier.

Workforce Structure

Grade

Grade Ladder
Grade Rate
Job

Job Family
Location
Organization

Position

Minimum Search Suggested Characters

Effective Start Date Defaults

You can set the default effective start date for workforce structure objects in responsive and classic pages using the
Manage Enterprise HCM Information task in the Setup and Maintenance work area.

Default Value

None

None

None

None

None

None

None

None

This table lists the behavior of the effective date on responsive and classic pages in certain scenarios.

Scenario

Default Effective Start Date field is blank on
the Manage Enterprise HCM Informtion page
and an effective date isn't specified on the
search pages.

Default Effective Start Date field is blank on
the Manage Enterprise HCM Informtion page
and an effective date is selected on the search

pages.

Default Effective Start Date isn't blank on
the Manage Enterprise HCM Informtion page
and an effective date is selected on the search
pages.

Default Effective Start Date field on the
Manage Enterprise HCM Information page isn't
blank and an effective date isn't specified on
the search pages.

ORACLE

Behavior in Responsive Pages

Current date is defaulted when creating a new
workforce structure.

Current date is defaulted when creating a new
workforce structure.

Configured default date specified for the
enterprise is defaulted when creating a new
workforce structure.

Configured default date specified for the
enterprise is defaulted when creating a new
workforce structure.

Behavior in Classic Pages

1-Jan-1951is defaulted when creating a new
workforce structure.

When you search for a workforce structure
using an effective date, then this date is
defaulted when creating a new workforce
structure from the search page .

When you search for a workforce structure
using an effective date, then this date is
defaulted when creating a new workforce
structure from the search page ..

Configured default date specified for the

enterprise is defaulted when creating a new
workforce structure.
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Workforce Structures Profile Options

Use the Manage Administrator Profile Values task in the Setup and Maintenance work area to manage profile options.
You can configure these workforce structure-related profile options as required, to meet your enterprise requirements:

Profile Option Code Profile Display Name Default Value Description
ORA_PER_ALLOW_GLOBAL_ Allow global Collective Agreements No Allow global Collective Agreements
CAGR_ON_POSITIONS on Position to be associated to a Position.
ORA_PER_DEPARTMENT_LOV_ Search LOV Departments Starts 10000 Enable department search to start
STARTSWITH_NUMROWS With Row Count Threshold with characters entered when row
count is high. Row count is across
organization units, organization
unit classifications, location details
and sets
ORA_PER_DEPTTREE_LOV_ Search LOV Department Tree 10000 Enable department tree node
STARTSWITH_NUMROWS Nodes Starts With Row Count search to start with characters
Threshold entered when row count is high.
Row count is across department
tree nodes, organization units/
classifications
ORA_PER_ENABLE_ Title Attribute in Departments N Enable the Title attribute in
DEPARTMENT_TITLE Enabled Departments.
ORA_PER_GRADESTEP_LOV_ Search LOV Grade Steps Starts 10000 Enable grade step search to start
STARTSWITH_NUMROWS With Row Count Threshold with characters entered when row
count is high. Row count includes
rows across tables for grade steps
ORA_PER_GRADE_LOV_ Search LOV Grades Starts With 10000 Enable grade search to start with
STARTSWITH_NUMROWS Row Count Threshold characters entered when row count
is high. Row count includes rows
across tables for grades and sets
ORA_PER_JOB_LOV_ Search LOV Jobs Starts With Row 10000 Enable job search to start with
STARTSWITH_NUMROWS Count Threshold characters entered when row count
is high. Row count includes rows
across tables for jobs, job families
and sets
ORA_PER_LOCATION_LOV_ Search LOV Locations Starts With = 10000 Enable location search to start
STARTSWITH_NUMROWS Row Count Threshold with characters entered when row
count is high. Row count includes
rows across tables for locations,
territories and sets
ORA_PER_LOV_COMPACT_ Department LOV Compact Search =~ No Enable compact search to use only
DEPARTMENT_SEARCH Enabled department name when searching
for departments
ORA_PER_LOV_COMPACT_JOB_ Job LOV Compact Search Enabled = No Enable compact search to use only

SEARCH

ORACLE

job name and code when searching
for jobs

264



Oracle Fusion Cloud HCM

Using Common Features for HCM

Profile Option Code

ORA_PER_LOV_COMPACT_
LOCATION_SEARCH

ORA_PER_LOV_COMPACT_
POSITION_SEARCH

ORA_PER_ORGTREE_LOV_
STARTSWITH_NUMROWS

ORA_PER_POSITIONTREE_LOV_
STARTSWITH_NUMROWS

ORA_PER_POSITION_LOV_
STARTSWITH_NUMROWS

ORA_POS_HIRING_STATUS_FILTER

ORA_PER_POS_NUM_VALID_
GRADES_ALLWD

ORA_PER_MATCH_POS_GRADES_
WITH_JOB_GRADES_ENABLED

ORACLE

Profile Display Name Default Value
Location LOV Compact Search No

Enabled

Position LOV Compact Search No

Enabled

Search LOV Departments Starts 10000
With Row Count Threshold

Search LOV Position Tree Nodes 10000
Starts With Row Count Threshold

Search LOV Positions Starts With 10000
Row Count Threshold

ORA_POS_HIRING_STATUS_FILTER N

Number of Valid Grades Allowed 0
on a Position

Validation to Match Position's Valid N
Grades With Job Valid Grades
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Description

Enable compact search to use only
location name and code when
searching for locations

Enable compact search to use only
position name and code when
searching for positions

Enable organization tree node
search to start with characters
entered when row count is high.
Row count is across organization
tree nodes, organization units/
classifications

Enable position tree node search
to start with characters entered
when row count is high. Row count
is across position tree nodes,
positions, organization units/
classifications

Enable position search to start with
characters entered when row count
is high. Row count includes rows
across tables for positions, jobs
and departments

Enable Position List of Values
filtering based on Hiring Status.

In pending worker pages, the
position LOV isn't filtered, but
instead an error message is shown
if the user selects a position that
isn't approved for hiring. The same
validation also applies when using
HCM Data Loader (HDL). The
position filtering doesn't apply for
nonworkers.

Specify a number between 1and
5 to restrict the number of valid
grades allowed on a position.
Select O to specify any number of
valid grades.

Enable validation to match valid
grades on the position with valid
grades of the job.

Note: Compact Search/NUMROWS Profile Options - For all the above listed Compact Search Profiles a scheduled
process, "Optimize Workforce Structures LOV to Use Starts With" runs automatically on a daily basis. The process
switches the search from 'contains' to 'starts with' for all large workforce structures LOVs when the row threshold is
exceeded. The default for the threshold for the number of rows is 10,000. You can change the default value as per
your requirements. You can set it to O if you don't want the application to change the LOV search. This is because the
scheduled process won't consider the profile option if the value is <= O, or if it contains a non-numeric character.
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Workforce Structures Lookups

This topic identifies common lookups that are work structure-related and have user or extensible configuration levels.
Review these lookups and update them as appropriate to suit enterprise requirements. You review lookups using the
Manage Common Lookups task in the Setup and Maintenance work area.

Lookup Type Description Configuration Level

BARGAINING_UNIT_CODE Identifies a legally organized group of people User
which has the right to negotiate on all aspects
of terms and conditions with employers or
employer federations. This is applicable for

positions.

EVAL_SYSTEM Identifies the evaluation system used for the job Extensible
or position.

EVAL_SYSTEM_MEAS Measurement unit for evaluation criteria on job = Extensible
or position

GRADE_PAY_RATE_TYPE Shows rate types like salary, bonus, and over Extensible
time.

JOB_FUNCTION_CODE Description of the primary function of a job. User
Used for grouping and reporting jobs of like
function.

MANAGER_LEVEL Description of the seniority of a manager on the User
job

PROBATION_PERIOD Specifies the unit of measurement for the Extensible

Probation Period of a Position. For example,
365 "Day", 52 "Week", 12 "Month", 1"Year", and
soon.

SECURITY_CLEARANCE Classifies if security clearance is needed. Extensible

Workforce Structures Flexfields

Use the Manage Descriptive Flexfields and Manage Extensible Flexfields tasks in the Setup and Maintenance work area
to manage flexfields. You can configure these workforce structure-related flexfields as required, to meet your enterprise
requirements:

Application Table Name Descriptive Flexfield Code Name Used Availability
Organizations

HR_ALL_ORGANIZATION_ @ PER_ORGANIZATION_ Organization Attributes For storing additional Available for use.
UNITS_F UNIT_DFF information on

organizations
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Application Table Name

HR_ORGANIZATION_
INFORMATION_F

Grade and Grade Rates

PER_GRADES_F

PER_GRADE_LEG_F

PER_GRADE_LADDERS_F

PER_RATES_F

Jobs

PER_JOB_EVALUATIONS

PER_JOBS_F

PER_JOB_EXTRA_INFO_F

PER_JOB_LEG_F

PER_JOB_FAMILY_F

Locations

PER_LOCATION_DETAILS_F

PER_LOCATION_EXTRA_
INFO_F

PER_LOCATION_LEG_F

ORACLE

Descriptive Flexfield Code

PER_ORGANIZATION_
INFORMATION_EFF

PER_GRADES_DF

PER_GRADES_LEG_EFF

PER_GRADE_LADDERS_DF

PER_RATES_DF

PER_EVALUATION_
CRITERIA_DFF

PER_JOBS_DFF

PER_JOBS_EIT_EFF

PER_JOBS_LEG_EFF

PER_JOB_FAMILY_DFF

PER_LOCATIONS_DF

PER_LOCATION_
INFORMATION_EFF

PER_LOCATION_LEG_EFF

Name

Organization Information
EFF

Grade Additional Details

Grade Legislative
Information

Grade Ladder Additional
Details

Rate Additional Details

Evaluation Criteria
Attributes

Job Attributes

Job EIT Information

Job Legislative Information

Job Family Attributes

Location Attributes

Location Information EFF

Location Legislative EFF

Workforce Structures -

Used

For storing additional
organization information
as single and multiple
row extensible flexfield
contexts.

For storing additional grade
information.

For storing additional
legislative information
for grades as single and
multiple row extensible
flexfield contexts

For storing additional
information related to
grade ladder.

For storing additional grade
rate details.

For storing additional job
evaluation information.

For storing additional job
information.

For storing additional job
information as single and
multiple row extensible
flexfield contexts.

For storing additional
legislative information
related to job as single and
multiple row extensible
flexfield contexts

For storing additional job
family information.

For storing additional
location information.

For storing additional
location information
as single and multiple
row extensible flexfield
contexts.

For storing additional
location legislative
information as single and
multiple row extensible
flexfield contexts.

Chapter 14
Configuration Options

Availability

Available for use.

Available for use.

Available only for Oracle
localization use.

Available for use.

Available for use.

Available for use.

Available for use.

Available for use.

Available only for Oracle
localization use.

Available for use.

Available for use.

Available for use.

Available only for Oracle
localization use.
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Application Table Name Descriptive Flexfield Code Name Used Availability
Positions
PER_POSITION_EXTRA_ PER_POSITIONS_EIT_EFF Position EIT Information For storing additional Available for use.
INFO_F position legislative

information as single and

multiple row extensible

flexfield contexts.

PER_POSITION_LEG_F PER_POSITIONS_LEG_EFF  Position Legislative For storing additional Available only for Oracle
Information position legislative localization use.

information as single and

multiple row extensible

flexfield contexts.

HR_ALL_POSITIONS_F PER_POSITIONS_DFF Position Attributes For storing additional Available for use.
position information.

Parameters for Work Structure Extensible and
Descriptive Flexfields

Flexfield segments have list of values that are dependent on standard attributes. Workforce structure attributes can be
used as these objects:

- Flexfield parameters for workforce structure descriptive flexfields.

- Input parameters when creating a value set for a flexfield segment.

You can use workforce structure attributes and descriptive flexfields as parameters when you configure workforce
structure extensible flexfields (EFF) and workforce structure descriptive flexfields (DFF).

Note: If you have configured the value set or default conditions using parameters for the EFF, these values will be
reinitialized only when you navigate to the EFF field.

Grades

This table shows the parameters that you can use for these grade workforce structures EFF.

- PER_GRADES_LEG_EFF

Flexfield Code Parameter Code Data Type Parameter Description

PER_GRADES_LEG_EFF EFFECTIVE_START_DATE DATE Effective Start Date
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This table shows the parameters that you can use for these job workforce structures DFF and EFF.

- PER_JOBS_DFF
- PER_JOBS_EIT_EFF
- PER_JOBS_LEG_EFF

Flexfield Code

PER_JOBS_DFF
PER_JOBS_DFF
PER_JOBS_EIT_EFF
PER_JOBS_EIT_EFF

PER_JOBS_LEG_EFF

Locations

Parameter Code

EFFECTIVE_START_DATE
SET_ID
EFFECTIVE_START_DATE
SET_ID

EFFECTIVE_START_DATE

Data Type

DATE
NUMBER
DATE
NUMBER

DATE

Parameter Description

Effective Start Date
Set ID
Effective Start Date
Set ID

Effective Start Date

This table shows the parameters that you can use for these location workforce structures DFF and EFF.

- PER_LOCATIONS_DF

« PER_LOCATION_INFORMATION_EFF
- PER_LOCATION_LEG_EFF

Flexfield Code

PER_LOCATIONS_DF
PER_LOCATIONS_DF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

ORACLE

Parameter Code

EFFECTIVE_START_DATE
SET_ID

ACTION_REASON_CODE

ACTIVE_STATUS_CODE

ADDRESS_LINE_1

ADDRESS_LINE_2

ADDRESS_LINE_3

ADDRESS_LINE_4

BILL_TO_SITE

Data Type

DATE
NUMBER

VARCHAR2

VARCHAR?2

VARCHAR2

VARCHAR2

VARCHAR?2

VARCHAR2

VARCHAR2

Parameter Description

Effective Start Date
SetID

Action Reason Code

Active Status Code

ADDRESS_LINE_1

ADDRESS_LINE_2

ADDRESS_LINE_3

ADDRESS_LINE_4

Bill-to Site Flag
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Flexfield Code

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

ORACLE

Parameter Code

BUILDING

COUNTRY

DESIGNATED_RECEIVER_ID

DESIGNATED_RECEIVER_LIST_

NAME

EFFECTIVE_END_DATE

EFFECTIVE_START_DATE

FLOOR_NUMBER

GEOGRAPHIC_HIEARCHY_CODE

INTERNAL_LOCATION_CODE

INVENTORY_ORGANIZATION_

CODE

LEGISLATION_CODE

LOCATION_ID

OFFICE_SITE

POSTAL_CODE

RECEIVING_SITE

REGION_1

REGION_2

REGION_3

SET_CODE

SET_ID

SHIP_TO_LOCATION_CODE

Data Type

VARCHAR2

VARCHAR2

NUMBER

VARCHAR2

DATE

DATE

VARCHAR2

VARCHAR2

VARCHAR?2

VARCHAR2

VARCHAR2

NUMBER

VARCHAR2

VARCHAR2

VARCHAR?2

VARCHAR2

VARCHAR2

VARCHAR?2

VARCHAR2

NUMBER

VARCHAR?2
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Parameter Description

BUILDING

COUNTRY

Designated Receiver ID

Designated Receiver List Name

Effective End Date

Effective Start Date

FLOOR_NUMBER

Geographic Hierarchy Code

Location Code

Inventory Organization Code

Legislation Code

Location ID

Office Site Flag

POSTAL_CODE

Receiving Site Flag

REGION_1

REGION_2

REGION_3

Set Code

SetID

Ship-to Location Code
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Flexfield Code

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_INFORMATION_
EFF

PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF

PER_LOCATION_LEG_EFF

PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF

PER_LOCATION_LEG_EFF

PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF

PER_LOCATION_LEG_EFF

ORACLE

Parameter Code

SHIP_TO_LOCATION_SET_ID

SHIP_TO_SITE_FLAG

TOWN_OR_CITY

ACTION_REASON_CODE
ACTIVE_STATUS_CODE
ADDRESS_LINE_1
ADDRESS_LINE_2
ADDRESS_LINE_3
ADDRESS_LINE_4
BILL_TO_SITE

BUILDING

COUNTRY
DESIGNATED_RECEIVER_ID

DESIGNATED_RECEIVER_LIST_
NAME

EFFECTIVE_END_DATE
EFFECTIVE_START_DATE
FLOOR_NUMBER
GEOGRAPHIC_HIEARCHY_CODE
INTERNAL_LOCATION_CODE

INVENTORY_ORGANIZATION_
CODE

LEGISLATION_CODE
LOCATION_ID
OFFICE_SITE
POSTAL_CODE
RECEIVING_SITE
REGION_1

REGION_2

REGION_3

Data Type

NUMBER

VARCHAR2

VARCHAR?2

VARCHAR2
VARCHAR2
VARCHAR?2
VARCHAR2
VARCHAR2
VARCHAR?2
VARCHAR2
VARCHAR2
VARCHAR?2
NUMBER

VARCHAR2

DATE
DATE
VARCHAR2
VARCHAR?2
VARCHAR2

VARCHAR2

VARCHAR?2
NUMBER

VARCHAR2
VARCHAR?2
VARCHAR2
VARCHAR2
VARCHAR?2

VARCHAR2
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Parameter Description

Ship-to Location Set ID

Ship-to Site Flag

TOWN_OR_CITY

Action Reason Code
Active Status Code
ADDRESS_LINE_1
ADDRESS_LINE_2
ADDRESS_LINE_3
ADDRESS_LINE_4
Bill-to Site Flag
BUILDING

COUNTRY

Designated Receiver ID

Designated Receiver List Name

Effective End Date
Effective Start Date
FLOOR_NUMBER
Geographic Hierarchy Code
Location Code

Inventory Organization Code

Legislation Code
Location ID

Office Site Flag
POSTAL_CODE
Receiving Site Flag
REGION_1
REGION_2

REGION_3
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Flexfield Code

PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF
PER_LOCATION_LEG_EFF

PER_LOCATION_LEG_EFF

Organizations

Parameter Code

SET_CODE
SHIP_TO_LOCATION_CODE
SHIP_TO_LOCATION_SET_ID
SHIP_TO_SITE_FLAG

TOWN_OR_CITY

Data Type

VARCHAR2
VARCHAR2
NUMBER

VARCHAR2

VARCHAR2
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Parameter Description

Set Code

Ship-to Location Code
Ship-to Location Set ID
Ship-to Site Flag

TOWN_OR_CITY

This table shows the parameters that you can use for these organization workforce structures DFF and EFF.

- PER_ORGANIZATION_UNIT_DFF
« PER_ORGANIZATION_INFORMATION_EFF

Flexfield Code

PER_ORGANIZATION_UNIT_DFF
PER_ORGANIZATION_UNIT_DFF
PER_ORGANIZATION_UNIT_DFF

PER_ORGANIZATION_
INFORMATION_EFF

PER_ORGANIZATION_
INFORMATION_EFF

PER_ORGANIZATION_
INFORMATION_EFF

Positions

Parameter Code

EFFECTIVE_START_DATE
ORGANIZATION_ID
SET_ID

EFFECTIVE_START_DATE

ORGANIZATION_ID

SET_ID

Data Type

DATE
NUMBER
NUMBER

DATE

NUMBER

NUMBER

Parameter Description

Effective Start Date
Organization Id
Set ID

Effective Start Date

Organization Id

Set Id

This table shows the parameters that you can use for these position workforce structures DFF and EFF.

« PER_POSITIONS_DFF

« PER_POSITIONS_EIT_EFF
« PER_POSITIONS_LEG_EFF

Flexfield Code

PER_POSITIONS_DFF
PER_POSITIONS_DFF
PER_POSITIONS_DFF

PER_POSITIONS_DFF

ORACLE

Parameter Code

ASSIGNMENT_CATEGORY
BARGAINING_UNIT_CD
BUSINESS_UNIT_ID

COLLECTIVE_AGREEMENT_ID

Data Type

VARCHAR2
VARCHAR?2
NUMBER

NUMBER

Parameter Description

Assignment Category
Bargaining Unit Code
Business Unit Id

Collective Agreement Id
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Flexfield Code

PER_POSITIONS_DFF
PER_POSITIONS_DFF
PER_POSITIONS_DFF
PER_POSITIONS_DFF
PER_POSITIONS_DFF
PER_POSITIONS_DFF
PER_POSITIONS_DFF
PER_POSITIONS_DFF
PER_POSITIONS_DFF
PER_POSITIONS_EIT_EFF
PER_POSITIONS_EIT_EFF
PER_POSITIONS_EIT_EFF
PER_POSITIONS_EIT_EFF
PER_POSITIONS_EIT_EFF
PER_POSITIONS_EIT_EFF
PER_POSITIONS_EIT_EFF
PER_POSITIONS_EIT_EFF
PER_POSITIONS_EIT_EFF
PER_POSITIONS_EIT_EFF
PER_POSITIONS_EIT_EFF
PER_POSITIONS_EIT_EFF

PER_POSITIONS_LEG_EFF

ORACLE

Parameter Code

EFFECTIVE_END_DATE
EFFECTIVE_START_DATE
ENTRY_GRADE_ID
ENTRY_STEP_ID
GRADE_LADDER_ID
JOB_ID

LOCATION_ID
ORGANIZATION_ID
UNION_ID
ASSIGNMENT_CATEGORY
BARGAINING_UNIT_CD
BUSINESS_UNIT_ID
COLLECTIVE_AGREEMENT_ID
EFFECTIVE_END_DATE
EFFECTIVE_START_DATE
ENTRY_GRADE_ID
ENTRY_STEP_ID

JOB_ID

LOCATION_ID
POSITION_TYPE
UNION_ID

EFFECTIVE_START_DATE

Data Type

DATE
DATE
NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
NUMBER
VARCHAR2
VARCHAR2
NUMBER
NUMBER
DATE
DATE
NUMBER
NUMBER
NUMBER
NUMBER
VARCHAR2
NUMBER

DATE
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Parameter Description

Effective End Date
Effective Start Date
Entry Grade Id

Entry Step Id

Grade Ladder Id

Job Id

Location Id
Organization Id
Union Id

Assignment Category
Bargaining Unit Code
Business Unit
Collective Agreement
Effective End Date
Effective Start Date
Entry Grade Id

Entry Step Id

Job Id

Location Id

Position Type

Union Id

Effective Start Date
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15 Workforce Profiles

Overview of Profile Management

Profile management provides a framework for developing and managing talent profiles that meet your industry or
organizational requirements. Profiles summarize the qualifications and skills of a person or a workforce structure such
as a job or position.

Profiles are valuable for tracking workers' skills, competencies, and accomplishments, and for various talent
management activities, such as career planning, identifying training needs, performance management, and in the
recruitment process for identifying job requirements and suitable applicants.

Note:

If you are still using Classic Talent Profiles, you should upgrade to Enhanced Talent Profiles before release 21A.

In the Enhanced Talent Profiles feature, the display of the person profile and talent ratings has a more engaging and
responsive interface design. The new user experience enables features to be presented on both mobile and web pages.
The interfaces are simple, intuitive and are written in a more conversational language.

The administration enhancements provide increased product performance and extensibility. The enhanced solution
introduces content templates that represent the talent content (for example, Competencies, Certificates, Skills, and
Awards) required to support the Oracle Talent Management Suite. Each content template includes unique attributes.
These content templates can be used and reused to create the content sections necessary to capture talent data. The
templates can be used to design both person and model talent profiles.

Any relevant topics from this chapter have been updated and moved to My Oracle Support: Upgrading Oracle Cloud
HCM Profile Management (Doc ID 242196411).

This topic discusses:

Profile search
Profile comparison

Best-fit analysis

Profile Search

You can search for worker, job, and position profiles based on certain criteria. For example, a Human Resource (HR)
Specialist in London requiring to fill an Applications Developer position internally, can search for profiles of all workers
who are based in London and have experience with Java and PL/SQL.

Profile Comparison

Use the Compare option in the Organization Chart tab on the person gallery to compare profiles You can compare
profiles to determine next career moves or training needs for workers, and identify suitable candidates for jobs. For
example, John is looking for his next career move He can compare his profile to that of a job to determine whether his
competency ratings match the targeted competency ratings in a job profile. If his Teamwork rating is 3 and the rating
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requirement for the job is 4, he has a deficiency of -1. John and his manager can use this gap to drive development
plans and other talent management-related functions.

Best-Fit Analysis

Use the best-fit analysis to determine the person profile that most closely matches a job profile and vice versa. For
example, if you want to fill a Developer vacancy, and the job profile requires a B.S. degree in Computer Science, level 4
expertise in Java, and a rating of at least 3 in Teamwork, you can review an automatically-generated list of workers who
most closely match this set of requirements. You can also use the best-fit analysis to find workers who are similar to a
selected worker, or jobs that are similar to a selected job.

For more information about Best Fit, see My Oracle Support: Oracle Profile Management: Best Fit Analyses (Doc ID
20435431).

Related Topics
 Oracle Fusion Profile Management Components: How They Work Together

 Talent Profile Summary
- Comparing ltems
- How Best-Fit is Calculated

Enhanced Talent Profiles

Enhanced Talent Profiles provides a framework for developing and managing talent profiles that meet your industry or
organizational requirements. Profiles summarize the qualifications and skills of a person or a workforce structure such
as a job or position.

For more information, see Oracle Cloud HCM Profile Management

Oracle Fusion Profile Management Components: How
They Work Together

You can configure Oracle Fusion Profile Management to meet your business requirements using these components: the
content library, profiles and profile types, content subscribers, educational establishments, instance qualifier sets, and
rating models.
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This figure illustrates how the components of Profile Management fit together.
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Note: If you are still using Classic Talent Profiles, you should upgrade to Enhanced Talent Profiles before release
21A. In the Enhanced Talent Profiles feature, the display of the person profile and talent ratings has a more engaging
and responsive interface design. The new user experience enables features to be presented on both mobile and web
pages. The interfaces are simple, intuitive and are written in a more conversational language. The administration
enhancements provide increased product performance and extensibility. The enhanced solution introduces content
templates that represent the talent content (for example, Competencies, Certificates, Skills, and Awards) required

to support the Oracle Talent Management Suite. Each content template includes unique attributes. These content
templates can be used and reused to create the content sections necessary to capture talent data. The templates can
be used to design both person and model talent profiles. Any relevant topics from this chapter have been updated
and moved to My Oracle Support: Upgrading Oracle Cloud HCM Profile Management (Doc ID 2421964.1).
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Profile Types

Profile types are templates that you use to create profiles. Profile types determine:

- Whether the profile is for a person or for a workforce structure such as a job or a position.

- The content of the profile.

You select content types from the content library to create content sections for the profile type.

Profiles

You create person profiles for individual workers and model profiles for workforce structures, such as jobs or positions.
The profile type that you select for the model profile determines the information that you complete for the profile.

For example, a person profile might contain information about a person's education, language skills, competencies,
and activities and interests. A job profile might contain information about the requirements for the job, such as
competencies, language skills, degrees, or certifications.

Content Subscribers

Content subscribers are applications external to Profile Management that use content types.

Educational Establishments

You can define educational establishments to enable workers to add education information, such as degrees, to their
profile.

Instance Qualifier Sets

You assign instance qualifiers to content types. Instance qualifier sets uniquely identify multiple instances of a content
item on a profile. For example, if multiple people update a performance rating for a competency on a worker's profile,
instance qualifiers provide a unique identifier to each instance of the competency. The unique identifier enables you to
determine who provided each rating.

Rating Models

When you create content types in the content library, you can attach rating models to determine the scale for measuring
performance and proficiency. You can also use rating models to measure the risk and impact of loss for workers, and to
measure their potential.

Related Topics
« Profile Types

- Content Types
- Rating Models
« Instance Qualifier Sets
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Rating Models

Rating Models
Use rating models to rate workers on their performance and level of proficiency in the skills and qualities that are set up

on the person profile.

You can also use rating models to specify target proficiency levels for items on a model profile, so that the model profile
can be compared to workers' profiles. Use the Manage Profile Rating Models task in the Profiles work area to create a
rating model.

To rate workers on their performance and proficiency, attach rating models to the content types included in the
person profile. Then you can rate workers on the items within the type. For example, you can rate workers on the
Communication content item within the Competencies content type.

For model profiles, you can specify target proficiency levels for items on the profile, to compare model profiles with
worker profiles. Using the ratings:

Managers can compare a model profile to workers' profiles with and determine the best person suited to fill a
position.

- Workers can compare their profile to model profiles to identify:
o Suitable positions within the organization.
o Skill gaps and fill the gaps before applying for other positions.
Rating models that measure workers' potential and the impact and risk of loss are also available.
Rating models can include some or all of the following components, depending on the use for the model:
Rating levels
Review points

Rating categories

Distributions

Rating Levels
Rating levels identify the qualitative values, such as 1, 2, 3, or 4, that you use to rate a worker.

For rating models that are used by Oracle Fusion Performance Management, you must:

Define numeric ratings, particularly for rating models in performance documents that use calculated ratings.

Define rating levels using whole numbers, with the highest number indicating the best rating. Rating levels
determine high and low ratings in the analytics.

Review Points

Define review points for rating models in performance documents that use the average, sum, or band calculation
method. The review points and point ranges that you define for the rating model are used to calculate ratings.
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Rating Categories

Using rating categories you can group rating levels together for analysis tools used in the talent review process, such as
the box chart that is used in the talent review process. You can group rating levels into categories such as low, medium,
and high, and those categories then become the labels for the analytic. You should not change rating categories after
setting them up, as the changes could affect the analytic.

Distributions

Oracle Fusion Compensation Management and Oracle Fusion Performance Management both use rating model
distributions to determine the targeted minimum and maximum percentage of workers that should be given each rating
level. Compensation Management uses the distribution values that you set up directly on rating models. However,

you can set up distributions using the Manage Target Ratings Distribution task for rating models that are used in
Performance Management.

Related Topics
- How You Update Talent Ratings

« Box Chart Matrix Options

How You Update Talent Ratings

Talent ratings are used to evaluate a worker, including performance, potential, proficiency, readiness, and impact.

Ratings are used in multiple products within the HCM product family such as Oracle Fusion Profile Management, Oracle
Fusion Performance Management, and Oracle Fusion Talent Review.

Talent Rating Types

Depending on application settings and roles assigned, you can view, add, and update these talent ratings across
multiple products within the HCM product family.

Talent Ratings Description

Talent score Evaluate a person's overall value to the organization using a rating model your organization defines.
Performance rating Evaluate the overall performance document.

Potential level Evaluate a person based on the execution of their work.

Potential score Evaluate a person's attainable level of excellence or ability to achieve success.

N box cell assignment Evaluate a person's current contribution and potential contribution to the organization on a box chart

matrix with N boxes. N represents the number of boxes in the grid.

Advancement readiness Evaluate a person's readiness for the next position in their career development.

Risk of loss Evaluate the likelihood of a person leaving the company.
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Talent Ratings Description
Impact of loss Evaluate the real or perceived effects on an organization when the person leaves.
Proficiency Evaluate a person's skill level for a competency.
Behavior ratings Evaluate a person's actions for a behavior associated with a competency.

Updating Talent Ratings

You can update talent ratings depending on application settings and roles assigned to you. The following table shows
where you can update talent ratings.

Talent Ratings Can | Update This Can | Update This Can | Update Can | Update This Can | Update This
Rating on the Talent  Rating in Talent This Rating in Rating in Succession Rating in Talent
Ratings page? Review? Performance Management? Pools?

Management?

Talent score Yes Yes No No No

Performance rating Yes Yes Yes No No

Potential level Yes Yes No No No

Potential score No Yes No No No

N box cell assignment = No Yes No No No

Advancement Yes No No No No

readiness

Risk of loss Yes Yes No Yes Yes

Impact of loss Yes Yes No Yes Yes

Proficiency No No Yes No No

Note: You can update Behavior ratings under Competencies on the Edit Skills and Qualifications page for a person.

When you update talent ratings:
- The performance rating from the worker's performance document overall section is displayed on the worker's

profile when configured to do so in the performance template.
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- The talent review process uses talent ratings on the worker's profile to build talent review information. When
a talent review meeting concludes, a worker's profile is automatically updated with the calibrated ratings.
Therefore, the performance rating displayed in a worker's performance document might be different from the
one displayed in the worker's profile.

Related Topics
- Rating Models

Content Types and Content Items

Content Types

Content types are the skills, qualities, and qualifications that you want to track in talent profiles. The content library
contains predefined content types such as competencies, languages, and degrees, but you can create custom content
types as needed. You can also create free-form

Depending on your business requirements, you can use predefined content types or create custom content types. A
predefined or custom content type, can be a free-form content type or not.

Content Types Other than Free-Form

In addition to a code, name, and description, content types that aren't free-form contain the following details:

Properties: Represents the information that you want to capture for the content type. You define properties for
a content type on the Field Properties tab on the Edit Content Type page.

Note: On the Field Properties tab, the values of the following fields are automatically generated and can't be
edited:

o Content Type ID
o ContentlItem ID
o Name

o From Date

o Content Supplier

Relationships: Associations between content types, where one content type is a parent of another, or where
one content type supports another. You define relationships for a content type on the Relationships tab on the
Edit Content Type page. On the Relationships tab, the Proficiency Calculation Rule field is applicable for the
Behaviors content type only. The value of this field is set to Average by default and can't be edited.

You can specify whether one content type is a parent of another, or whether one content type supports
another. Content items inherit the relationship of associated content types. After you create a relationship, you
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can't delete it. You can only specify an end date for it so that the relationship is no longer applicable from the

end date.
You can't create:

o Two kinds of relationships between two content types. For example, the content type A can't be both the

parent and child of the content type B.

o Arelationship between a content type and itself. For example, a content type can't be related to itself.

Subscribers: Codes that represent other Oracle Cloud products or applications that use content types. To use
a content type in an Oracle Cloud application, you must add the predefined subscriber code associated with
the application to the content type. Custom subscriber codes aren't supported. You add subscriber codes to a

content type on the Subscribers tab on the Edit Content Type page.

Categories
Competencies
Components

Degree

Education Levels
Goals

Honors and Awards
Languages

Licenses and Certifications
Memberships

N Box Cell Assignment
Platforms

Platform codes
Product problem codes
Technical Post Details

Free-Form Content Types
A free-form content type contains only a code, name, and a description, and does not have any properties defined for it

until you add it to a profile type. Free-form content types do not include any content items.

Note: Free-form content types don't contain relationships or properties. You add properties for free-form content

types when you add them to a profile type.

You can use free-form content types when you don't need a content item because the attribute captured for the content
section is free-formed or less-structured. For example, you cant set up a free-form content type to store information for
career-related information.

Examples of predefined free-form content types are:

Accomplishments
Advancement Readiness

ORACLE
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- Areas of Study

- Career Preferences

- Career Potential

. Career Statement

« Criticality

Enrollments

Highest Education Level
Learning

Performance Rating
Previous Employment
Risk of Loss

- Special Projects

- Talent Score

- Work Requirements

Related Topics

Content Type Properties

Content Type Properties
Content Items

Considerations for Associating Behaviors with Competencies
Examples of Content Type Relationships

Content Subscribers

Chapter 15
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Content type properties represent the information that you want to capture for a content type. Content items inherit
the fields and field properties that you define for the content type to which the item belongs. Use the Manage Content
Types task in the

You define properties for content types that aren't free-form. For free-form content types, the properties are defined

when you add them as a content section to a profile type.

The values of the following content type properties for content types that aren't free-form content types are

automatically generated for a profile item and should not be modified:

- CONTENT_ITEM_ID

- CONTENT_SUPPLIER_CODE

- CONTENT_TYPE_ID

DATE_FROM
NAME

Note: The DATE_FROM property stores the start date information of a content item within the content type. This
field is used for maintaining the history of content items and isn't recommend to be displayed on the Ul

ORACLE
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Attributes of Content Type Properties

Each content type property has a field for which you set attributes. You determine attributes for each content type
property that will be used for defining the relevant content items. The attributes that you can set for each content type
property that you include for a content type are displayed in the following table.

Attribute

Default Value

Display

Label

Required

Source

Description

Value that appears by default for the property on the Ul

Determines if the property is editable, hidden, or display only for a content item

Label for the property displayed on Ul when the property is included within a content type

Determines if the user is required to populate the field

Name of the lookup type that provides values for the property. This attribute is specified for properties
ITEM_TEXT_1to ITEM_TEXT_10

Content Type Properties List

The following table describes a list of content type properties you can define for a content type that isn't free-form.
These properties appear on the Field Properties tab on the Edit Content Type page.

Content Type Property

COUNTRY_ID

ITEM_DATE_1to ITEM_DATE_10

ITEM_NUMBER_1to ITEM_NUMBER_7

ITEM_TEXT_1to ITEM_TEXT_10

ITEM_TEXT_11 to ITEM_TEXT_30

ITEM_TEXT_TL_1to ITEM_TEXT_TL_5

ITEM_TEXT_TL_6 to ITEM_TEXT_TL_10

ITEM_TEXT_TL_1to ITEM_TEXT_TL_15

ORACLE

Specifies

The country ID associated with the content item within the content type

Any date. Use these fields to enter dates for profile items

Any numeric data

Data that requires selecting values from a list. Each field can store up to 30 characters of data. You
provide values for ITEM_TEXT_1to ITEM_TEXT_10 properties by specifying a lookup type for their
Source attribute

Nontranslatable data, such as a code or serial ID. Each field can store up to 30 characters of data

Translatable data. Each field can store up to 240 characters of data

Translatable data. Each field can store up to 2000 characters of data

Translatable data. Each field can store up to 4000 characters of data
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Content Type Property Specifies
RATING_MODEL_ID The rating model. The rating model you specify for a content type is also applicable for content items

associated with the content type. However, for the content items added to the Competencies content
type, the rating model selected for the Competencies content section takes precedence

STATE_PROVINCE_ID The state ID associated with the content item within the content type

Related Topics
- Content Types

- Content Items

- Content Section Properties

» Create Custom Content Types and Content ltems
« Create Free-Form Custom Content Types

Content Subscribers

Content subscribers are codes that represent functional areas that use content types. You manage subscriber codes
using the Manage Content Subscribers task in the Profiles work area.

Note: If you are still using Classic Talent Profiles, you should upgrade to Enhanced Talent Profiles before release
21A. In the enhanced Enhanced Talent Profiles feature, the display of the person profile and talent ratings has a
more engaging and responsive interface design. The new user experience enables features to be presented on both
mobile and web pages. The interfaces are simple, intuitive and are written in a more conversational language. The
administration enhancements provide increased product performance and extensibility. The enhanced solution
introduces content templates that represent the talent content (for example, Competencies, Certificates, Skills, and
Awards) required to support the Oracle Talent Management Suite. Each content template includes unique attributes.
These content templates can be used and reused to create the content sections necessary to capture talent data.
The templates can be used to design both person and model talent profiles. Any relevant topics from this chapter
have been updated and moved to My Oracle Support: Upgrading Oracle Cloud HCM Profile Management (Doc ID
24219641).

To use a content type in a functional area, you must add the associated predefined subscriber code to the content type.

Example: You add a new custom content type Corporate Citizenship to the Person profile type. To view the content
section for Corporate Citizenship in the Skills and Qualifications work area, you must add the HRMS content subscriber
code to the new content type.

Note: Custom subscriber codes aren't supported.
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By default, the application provides predefined subscriber codes for:

- Oracle Fusion applications such as:

o

o

(o}

o

o

- Work areas within Oracle Fusion applications such as:

[e]

o

o

o

« Other Oracle Cloud applications such as Oracle Taleo Recruiting Cloud Service

Predefined Subscriber Codes for Oracle Fusion Applications

Talent Review

Succession Management
Performance Management
Network at Work

Resource Management

Person Management
Profiles

Chapter 15
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Note: Different subscriber codes are used to make content types available for job profiles and person

profiles in the Profiles work area.

Skills and Quialifications

Team Talent

To make a content type available within an Oracle Fusion application, you must add the associated predefined
subscriber code to the content type.

The following table displays the predefined subscriber codes and the corresponding Oracle Fusion application where the
subscribed content types are displayed.

Subscriber Code Oracle Fusion Application
HRTR Talent Review

SM Succession Management
HRA Performance Management
HRS Network at Work

RM Resource Management

Predefined Subscriber Codes for Work Areas

To make a content type available in a work area within the application, you must add the associated predefined
subscriber code to the content type.

ORACLE
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Note: If you are still using Classic Talent Profiles, you should upgrade to Enhanced Talent Profiles before release 21A.
Any relevant topics from this chapter have been updated and moved to My Oracle Support: Upgrading Oracle Cloud
HCM Profile Management (Doc ID 2421964.11).

The following table displays the predefined subscriber codes, the corresponding work area where the subscribed
content types are displayed, and the navigation to the work area.

Subscriber Code Work Area Navigation

HRMSSPC Person Management Select My Workforce then Person
Management on the Home page.

HRMSSPC Profiles (For person profiles) 1. Select My Workforce then Profiles on the
Home page.

2. Select the Person Profiles tab, search for a
person, and in the Search Results section,
click the person name to view the person's
profile on the Skills and Qualifications

page.

™ Profiles (For job profiles) 1. Select My Workforce then Profiles on the
Home page.
2. Select the Model Profiles tab, search for a
job, and in the Search Results section, click
the job name to view the job profile.

HRMS Skills and Qualifications Select About Me > Skills and Qualifications to
open the Skills and Qualifications work area.

HRMS Team Talent Select My Team then Team Talent on the
Home page.

Predefined Subscriber Codes for Other Cloud Applications

To make a content type available in Oracle Taleo Recruiting Cloud Service, you must add the predefined subscriber code
TALEO to the content type.

Related Topics
- Content Types

- Content Type Properties
- Content Section Properties
- Profile Types

Examples of Content Type Relationships

You can associate content items of related content types with each other using content relationships. Use the
Relationships tab on the Edit Content Type page to define content type relationships. The following scenarios illustrate
the use of content type relationships.
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Tracking Product Expertise

The Resource Manager component of Oracle Fusion Trading Community Model uses content type relationships to track
the areas of expertise of workers. Using the predefined content type relationship where the Categories content type

is a parent of Products, and Products is a parent of Components; resource managers can keep track of the categories,
products, and components that they consider as areas of expertise for their resources.

Note: Because these content types and relationships apply only to the Resource Manager component of Oracle
Fusion Trading Community Model, this product is the only predefined content subscriber to these content types.

Specifying Target Outcomes for Goals

Workers can manage their goals by associating their goals with target outcomes, which are content types such as
Competencies and Memberships. You can set up a relationship on the Competencies content type where Competencies
is supported by Goals. Workers can then set up goals that have a specific competency as a target outcome.

Related Topics
- Content Types

« How can | define a relationship between the Goals content type and other content types?

Content Items

Content items are the individual skills, qualities, and qualifications within the content types in the content library. For
example, within the Competencies content type, communication is a content item. Use the Manage Content Items task
in the Profiles work area to create content items

This topic discusses:

Item properties
Related content items

Proficiency descriptions

ltem Properties

Content items inherit the fields and field properties that you define for the content type to which the item belongs. For
example, one of the fields defined for the Memberships content type is ITEM_DESCRIPTION field. The attributes of this
field are set up so that the label is Description, the field is editable, and the field doesn't require an entry. When you set
up a content item for the Memberships content type, the application displays a field labeled Description, in which you
can enter text to describe the agency, but the field isn't required.

Related Content Items

If the content type for which you are creating an item has related content types, then you can enter the related content
items for the item. For example, if you have a content type relationship where the Goals content type supports the
Competencies content type, then on the content items for competencies, you can enter the related goals.
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Proficiency Descriptions

If the content item belongs to a content type that has a rating model defined for it, then you can either use the existing
descriptions for the ratings within the model, or define descriptions for the ratings that are specific to the content item.
When ratings exist for the content item, the descriptions defined for the item are used instead of those on the rating
model.

Related Topics
« Oracle Fusion Profile Management Components: How They Work Together

- Why can't | change the relationship type of a content item?
- Content Types

How You Enable Approvals for Content Types

By default, any changes to a talent profile aren't subject to approval. When you edit a talent profile, all changes are
visible immediately on the talent profile. HR specialists and implementors can enable approvals for each content type so
that worker edits on

Content types are defined as content sections in profile types. You can enable approvals for a content section when you
edit or create a profile type by using the Manage Profile Types task. You can open the task:

In the Setup and Maintenance work area. To open the Setup and Maintenance work area, select Navigator >
Setup and Maintenance.

In the Profiles work area. To open the Profiles work area, select Navigator > My Workforce > Profiles.

As an HR specialist or implementor, follow these steps to enable approval for a content section when you create or edit
the person profile type on the Manage Profile Types page:

On the Content Sections tab, click the link to the content section.

Click the content section link in the Content Sections region to open the Content Section page.
Select the Approval Required check box to enable approval for that content section.

4. C(lick OK to save your changes.

WN =

Note: You can enable approval for a content section added to only the Person profile type.

Related Topics
» Guidelines for Managing Approval Rules

« What happens if | enable custom approval rules for the person profile type?
 Profile Types

Create Custom Content Types and Content ltems

This example demonstrates how to set up a new custom content type and content items to track the corporate
citizenship activities of your workers so that you can rate them on their involvement in the organization. This example
also demonstrates how to set
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The following table summarizes key decisions for this scenario.

Decisions to Consider

Can a predefined rating model be used to
rate corporate citizenship?

Should the content type be a free-form
content type?

What field and properties should the
content type contain?

Does the content type need any content
subscribers?

What content items are needed to track
the required information?

When the content type is added to the
person profile as a content section, what
properties should the fields contain?

In This Example

No. The predefined rating models don't have relevant rating descriptions.

No. Content items are needed, and the content should be stored in the content library.

Add two fields to the content type:

- ITEM_TEXT_20

- RATING_MODEL_ID

The ITEM_TEXT_20 field uses a label Comments to enter comments about the workers' corporate
involvement. The RATING_MODEL_ID field uses a label Company Contribution to attach the rating
model for corporate citizenship to the content type.

Both fields should require entry and should be editable.

Yes. In order to be visible on the person profile, the new content type must be added to the HRMS
content subscriber code.

- Corporate social responsibility

- Corporate environmental responsibility
- Corporate industrial citizenship

- Corporate state citizenship

- Corporate borough, council, or municipal citizenship

Both the Comments and the Company Contribution fields:

- Display in the detail view of the content section
- Arerequired

- Must be included in search results

To track corporate citizenship for your workers, complete the following tasks:

- Create a rating model.
- Create a content type.

- Create content items.

- Add the content type to the person profile type.

Creating a Rating Model

1. Inthe Setup and Maintenance work area, search for the Manage Profile Rating Models task and click Go to

Task.

2. Onthe Manage Rating Models page, click Create.

ORACLE

291



Oracle Fusion Cloud HCM Chapter 15
Using Common Features for HCM Workforce Profiles

3. Onthe Create Rating Model page, complete the following fields, as shown in this table. Use the default values
except where indicated.

Field Value

Code Citizenship

Rating Name Corporate Citizenship

Description Rating model for corporate citizenship

4. Onthe Rating Levels tab, complete the following fields, as shown in this table.

Rating Level Name Short Description
1 Demonstrates limited or unused influence. Limited

2 Demonstrates clear evidence of influence. Clear Evidence

3 Provides a successful image of the Successful Image

company as socially responsible in limited
environments.

4 Actively called upon to use influence as Influential in Selected Environments
a corporate representative in selected
environments.

5 Demonstrates high level of influence and High Level of Influence
can operate effectively in all environments.

5. C(lick Save and Close.

Creating a Content Type

1. Inthe Setup and Maintenance work area, search for the Manage Profile Content Types task and click Go to
Task.

2. Onthe Manage Content Types page, click Create.

3. Onthe Create Content Type page, add a content type by completing the following fields, as shown in this table.
Use the default values except where indicated.

Field Value

Code Citizenship
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Field Value
Name Corporate Citizenship
Description Ratings for corporate citizenship behaviors for workers.

4. Set up the following field properties, as shown in this table. Use the default values except where indicated.

Field Name Field Label Required Display Option
ITEM_TEXT_20 Comments Selected Editable
RATING_MODEL_ID Company Contribution Selected Editable

Click Save and Close.

On the Manage Content Types page, select the Corporate Citizenship content type and click Edit.
On the Edit Content Type page, select the Subscribers tab.

On the Subscribers tab, click Add.

In the Subscriber Code field, select HRMS.

Click Save and Close.

OCvVvVoOgowWw

1

Creating Content Items

1. In the Setup and Maintenance work area, search for the Manage Profile Content Items task and click Go to
Task.

2. Onthe Manage Content Items page, click Create.

3. Inthe Create Content Item dialog box, complete the following fields, as shown in this table.

Field Value
Content Type Corporate Citizenship
Content Item Corporate Social Responsibility

4. On the Create Content ltem: Corporate Social Responsibility page, select the Corporate Citizenship rating

model in the Rating field.

Click Save and Close.

6. Repeat steps 2 through 5 to add content items for Corporate Environmental Responsibility, Corporate Industrial
Citizenship, Corporate State Citizenship, and Corporate Borough, Council, or Municipal Citizenship.

ui

Adding the Corporate Citizenship Content Type to the Person Profile Type

1. Inthe Setup and Maintenance work area, search for the Manage Profile Types task and click Go to Task.
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On the Manage Profile Types page, locate the Person profile type and click Edit.
On the Edit Profile Type: Person page, select the Content Sections tab.

In the Content Sections region, click Add Content Section.

In the Content Types dialog box, select Citizenship.

In the Content Sections region, click Citizenship.

On the Content Section page, set up the following field properties, as shown in this table. Use the default values
except where indicated.

N UAWN

Column Name Display Required Searchable
ITEM_TEXT240_1 Detail Selected Selected
RATING_LEVEL_ID1 Detail Selected Selected

8. On the Edit Profile Type: Person page, click Save and Close.
9. Inthe Content Access Section region, click Add.

10. In the Role field, select Employee.

11. Select the Update check box.

12. Click Add.

13. In the Role field, select Manager.

14. Click OK.

15. Click Add.

16. Inthe Role field, select HR Specialist.

17. Click OK.

18. On the Edit Profile Type: Person page, click Save and Close.

Related Topics
- Rating Models

« Content Types
« Content Subscribers
« Create Free-Form Custom Content Types

Create Free-Form Custom Content Types

This example demonstrates how to set up a free-form custom content type, add it to the HRMS content subscriber code,
and then add the content type to the person profile type.

Your company wants to track the previous employment information for workers, including employer name, dates of
employment, and job description. However, you don't want to set up and maintain content items for each employer,
and this information applies only to person profiles. You decide to use a free-form content type for this information.
You can set up the free-form content type with minimal information. Then when you add it to the person profile as a
content section, you can define properties for employer name, dates of employment, and job description. Workers can
complete their employment information on their profile based on how you set up the content section. The following
table summarizes key decisions for this scenario.
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Decisions to Consider

Must the content type be a free-form
content type?

Does the content type need any content
subscribers?

When the content type is added to the
person profile as a content section, what
fields are needed?

What properties are needed for the ITEM_
TEXT30_1 field?

What properties are needed for the ITEM_
DATE_1 field?

What properties are needed for the ITEM_
DATE_2 field?

What properties are needed for the ITEM_
TEXT240_1 field?

What role access must be granted for the
content section?

Chapter 15
Workforce Profiles

In This Example

Yes. Content items aren't needed, and the content must not be stored in the content library.

Yes. In order to be visible on the person profile, the new content type must be added to the HRMS
content subscriber code.

To capture the previous employer, a text field is needed. To capture employment dates, two date fields
are needed. To capture job description, another text field is needed. Therefore, the following fields
must be added:

- ITEM_TEXT30_1

- ITEM_DATE_1

- |ITEM_DATE_2

- ITEM_TEXT240_1
The field isn't required and the information isn't available as search criteria, so you must only set up
these field properties as follows:

- Label: Previous Employer

- Display: Detail (section must appear in detail view of profile)
The field isn't required and the information isn't available as search criteria, so you must only set up
these field properties as follows:

- Label: From Date

- Display: Detail
The field isn't required and the information isn't available as search criteria, so you must only set up
these field properties as follows:

- Label: To Date

- Display: Detail
The field isn't required and the information isn't available as search criteria, so you must only set up
these field properties as follows:

- Label: Job Description

- Display: Detail

Employees, managers, and HR specialists must all have access to update the section.

To set up a free-form content type to track previous employment information for workers, you must:

- Set up a free-form content type

- Add the free-form content type to the person profile type
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Setting Up a Free-Form Content Type

1.

2.
3.

00y U A

In the Setup and Maintenance work area, search for the Manage Profile Content Types task and click Go to
Task.

On the Manage Content Types page, click Create.

On the Create Content Type page, complete the following fields, as shown in this table.

Field Value

Code PREVEMP

Name Previous Employment

Description Track previous employment information for workers.

Select the Free-Form Type check box.

Click Save and Close.

On the Manage Content Types page, select the Previous Employment content type and click Edit.
On the Edit Content Type page, select the Subscribers tab.

On the Subscribers tab, select HRMS in the Subscriber Code field.

Click Save and Close.

Adding the Free-Form Content Type to the Person Profile Type

VA UWNA

6.
7.
8.

In the Setup and Maintenance work area, search for the Manage Profile Types task and click Go to Task.

On the Manage Profile Types page, select the Person profile type, and click Edit.

On the Edit Profile Type: Person page, select the Content Sections tab and click Add Content Section.

In the Content Types dialog box, select the Previous Employment content type.

In the Content Sections region, click the Previous Employment content type and enter the following properties
on the Content Section page, as shown in this table.

Column Name Label Display
ITEM_TEXT30_1 Previous Employer Detail
ITEM_DATE_1 From Date Detail
ITEM_DATE_2 To Date Detail
ITEM_TEXT240_1 Job Description Detail

In the Content Access Section region, click Add.
In the Role field, select Employee.
Select the Update check box.
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9. Click Add.
10. In the Role field, select Manager.
11. Click OK.
12. Click Add.
13. In the Role field, select HR Specialist.
14. Click OK.

15. On the Edit Profile Type: Person page, click Save and Close.

Related Topics
- Content Types

- What's a free-form content type?

Considerations for Associating Behaviors with Competencies

Behaviors are subcomponents of a competency. You must create a relationship between the Competencies and
Behaviors content types so that you can associate their content items. You associate behaviors with competencies using
the Relationships tab on the Edit Content Type page of the Behaviors

Manage Content Types task in the Profiles work area .
Manage Profile Content Types task in the Setup and Maintenance work area.
The following features aren't available for the Behaviors content type:
Print behaviors in the Talent Profile Summary report
- Search for persons or competencies based on behaviors using the advanced search
Upload behaviors content such as from a third-party supplier or HCM Data Loader
- Support for using behaviors in other Oracle Fusion products
When associating behaviors with competencies, you must decide:
- The type of relationship between the Behaviors and Competencies content types
- The duration of each relationship

Related content items

Deciding the Relationship

You can define the following relationships between the behavior and competencies content types:

Parent and child relationship: You can define Behaviors as a child of the Competencies content type. Using
this relationship, you define a hierarchy where Behavior content items are added to the Competencies content
item. For example, when Behaviors is a child of Competencies, you can add the Behaviors content items to
one or more Competencies content items. In this relationship, you must associate the same rating model with
Competencies and associated Behaviors.

- Supports or supported by relationship: You can enable Behaviors to support the Competencies content type,
and vice versa. The supported or supporting content items are not in a hierarchical relationship with one
another. That is, each content item associated with a content type is independent of the content items of the
other content type. Therefore, you can associate different rating models with each content type, and then add
their content items to a profile and review them together.
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Note: The proficiency calculation rule is applicable for the Behaviors content type only. The value of the Proficiency
Calculation Rule field on the Relationships tab on the Edit Content Type page for Behaviors is set to Average by
default and can't be edited. Using this rule, the application calculates the proficiency rating for the competency as the
average of the behavior ratings. The rating provided at the competency level is ignored by the application.

Deciding the Relationship Duration

You can define a duration for the relationship between the Behaviors and Competencies content types. There can be
multiple relationships provided their dates don't overlap. You can delete a relationship only when the content type or
its related content type is not added to any profiles (model or person). Once the content type or its related content type
is added to a profile, you cannot delete the relationship. However, you can enter a To Date for the relationship to end

it. You can also relate the content items of Competencies and Behaviors content types, and define the duration of the
relationship between content items. Further, you can delete or end the relationship between content items.

Deciding the Related Content Items

After you establish the relationship between the Behaviors and Competencies content types; you must:

1. Create the content items for each content type.

2. Relate the content items between each content type. You relate a content item of a content type with content
items of another content type using the Related Content Items tab. The tab is available on the Edit Content Item
page. You open the Edit Content Item page by using the Manage Content Items task in the Profiles work area
or Setup and Maintenance work area. On the Related Content ltems tab, you can view the relationship type
between the two content types. You can also decide the duration until when the content items are related with
each other.

Related Topics
- Content Types

- How You Update Talent Ratings
« Examples of Content Type Relationships

Talent Profiles

Profile Types

Profile types include person profile types and model profile types. Use the Manage Profile Types task in the Profiles or
Setup and Maintenance work area to create a profile type.

Note: If you are still using Classic Talent Profiles, you should upgrade to Enhanced Talent Profiles before release 21A.
Any relevant topics from this chapter have been updated and moved to My Oracle Support: Upgrading Oracle Cloud
HCM Profile Management (Doc ID 2421964.1).
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Person Profile Types
The person profile type:

Is the template that you use to create profiles of your workers or nonworkers.

- Contains the skills, qualities, and qualifications that you want to track for your workers.

Model Profile Types
The model profile type:

Is a template for workforce structures such as jobs and positions. You can set up multiple model profile types.

Note: You must use the Job profile type to create profiles for jobs or positions.

Identifies the targeted and required skills and qualifications for a job or position.

Identifies work requirements, such as work schedule and travel frequency.

About Defining Profile Types

To define profile types, you first specify whether the profile type is a person or model profile. For model profiles, you
also specify the workforce structures for which the model profile can be used. However, to create a position profile you
must use the Job profile type as the template. To define the structure of the profile type, you add one or more content
sections using content types from the content library and free-form content types. Define the following for each content
section:

Instance qualifier sets

- Section properties

Role access

Note: You access the Behaviors content section only after you select the Competencies content section on the Edit
Profile Type page.

Instance Qualifier Sets

If you have defined instance qualifier sets for the content type, you select the instance qualifier set to use for the
sections. You can't define instance qualifiers for the Behaviors content type.

Section Properties

The properties determine the fields and how they are displayed when you create profiles based on the type. For
example, properties determine the label for the field, whether the field is required, and whether the field should be
included in profile searches.

You define all of the properties for free-form content types.

Role Access

You can specify user roles such as Employee or Manager, which define who can view the content section, and who can
update the section.
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Effective Dates of Profiles

You can associate multiple profiles with a workforce structure. However, only one profile can be in effect at a time for
the workforce structure. Therefore, the effective start and end dates of multiple profiles associated with a workforce
structure must not overlap.

Related Topics
- Content Types

- Content Section Properties
« Profile Management

How You Create Person Profiles

The person profile is a profile type you create for individual workers. Person profile data, such as the skills,
qualifications, accomplishments, and career preferences of a person, is displayed on Skills and Qualifications and Career
Planning pages on a worker's person profile.

HR specialists or implementors can create person profiles from the application, or implementors can upload them using
tools such as HCM Data Loader.

The application provides the functionality to automatically create person profiles for person records. You can enable or
disable this functionality using the Autocreate Person Profiles check box. By default, this check box is already selected.
The Autocreate Person Profiles check box is available on the Edit Profile Type page of the person profile type. Use the
Manage Profile Types task in the Profiles or Setup and Maintenance work area to edit the person profile type.

When the Autocreate Person Profiles check box is selected:

- The application automatically creates the person profile for that person when someone accesses the Skills and
Qualifications page for a person.

- The person profile added for a pending worker is activated on the effective hire date for an employee or the
effective placement date for a contingent worker.

If you choose to deselect the Autocreate Person Profiles check box for the person profile type and no profile exists
for a person, the application displays an error message to create or upload profile when you access that person's Skills
and Quialifications page. However, when uploading talent profile data from external sources, you must deselect the
Autocreate Person Profiles check box to avoid duplication of person profiles.

Related Topics
« Person Records

How You Upload Talent Profile Data

Talent profile data is the person and job profiles data displayed on Skills and Qualifications and Career Planning pages.
You access these pages for a worker in the worker's person spotlight.

Examples of talent profile data include ratingsand corresponding rating models, content items, and educational
establishments. You can upload talent profile data for initial migration or mass data entry.
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The following tools support upload of talent profile data:

- Oracle ADF Desktop Integration (ADFdi) workbook (only for Classic Talent Profiles).
- Oracle Fusion HCM Data Loader (for Classic Talent Profiles and Enhanced Talent Profiles).
- Oracle Fusion HCM Spreadsheet Data Loader (for Classic Talent Profiles and Enhanced Talent Profiles).

Note: The tools available to you for uploading talent profile data depend on the setting of the HCM Data Loader
Scope parameter. The ADFdi workbook isn't affected by the HCM Data Loader Scope parameter. You can continue
to upload competencies using the ADFdi workbook regardless of the parameter setting. The ADFdi workbook is only
available for classic Talent Profiles. To load content items in Enhanced Talent Profiles, use HCM Data Loader or the
HCM Spreadsheet Data Loader.

For more information about:

- Uploading content items using an ADFdi workbook, see Uploading Competencies and Content Items into Oracle
Fusion Profile Management (1453118.1) on My Oracle Support at https://support.oracle.com.

- All data loaders mentioned earlier, see Oracle Human Capital Management Cloud Integrating with Oracle HCM
Cloud Guide.

Uploading Actions

The following table displays the type of talent profile data you typically upload and the actions you perform to load that
data.

Note: Use the Open Competency Excel Template option to generate the ADFdi workbook for uploading
competencies. The option is available on the Manage Content Items page in the Profiles work area.

Uploading Tool Talent Profile Data Type Actions
ADFdi workbook - Content item (only Competency) . Create
- Update
HCM Data Loader - Educational establishment - Create
- Talent profile rating model - Update
- Talent profile type (only Person and Job) - Delete

- Talent profile content item

- Talent profile content item relationship

HCM Spreadsheet Data Loader « Educational establishment - Create
- Talent profile rating model - Update
- Talent profile type (only Person and Job)
- Talent profile content item

- Talent profile content item relationship

Related Topics
« Guidelines for Using Desktop Integrated Excel Workbooks
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Add Content to a Worker's Profile

Depending on the content section access settings for HR specialists and managers, they can edit content or add it to a
worker's profile.

To view, add, or edit content of a worker's profile, they must use the worker's Skills and Qualifications page.

Note: If you are still using Classic Talent Profiles, you should upgrade to Enhanced Talent Profiles before release 21A.
Any relevant topics from this chapter have been updated and moved to My Oracle Support: Upgrading Oracle Cloud
HCM Profile Management (Doc ID 2421964.1).

As an HR specialist, follow these steps to either edit the content or add it to the worker's profile:
1. Click My Client Groups > Profiles to open the Search: Profiles page.
2. C(lick the name of the worker in the Results section to open the Skills and Qualifications page of that worker.

Tip: Alternatively, use the Manage Talent Profile task in the Person Management work area to open a
person's Skills and Qualifications page.

3. Click Edit on the Skills and Qualifications page to either edit the content, or add it to the worker's profile.
As a manager, follow these steps to either edit the content or add it to a report's profile:

1. Click My Team > Team Talent.
2. C(lick a report's person card to open the Skills and Qualifications page for the report.
3. Click Edit on the Skills and Qualifications page to either edit the content, or add it to the report's profile.

Talent Profile Summary

The Talent Profile report provides talent-related information for a worker. This topic describes options that you can
select when printing the report.

To print the report, select the Manage Talent Profile task in the Person Management work area. On the Edit Profile page,
select Actions - Print Profile. Talent review meeting participants can also print the report for one or more workers from
the Talent Review dashboard.

Note: If you are still using Classic Talent Profiles, you should upgrade to Enhanced Talent Profiles before release 21A.

Any relevant topics from this chapter have been updated and moved to My Oracle Support: Upgrading Oracle Cloud
HCM Profile Management (Doc ID 2421964.1).

Report Sections

The Talent Profile report can contain a person summary and five configurable sections. This table describes the
contents of each section.

Report Section Contents

Experience Current and previous assignments.
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Report Section

Talent Overview

Education and Quialifications

Career Options and Interests

Goals

Print Formats

Chapter 15
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Contents

Performance evaluation information for up three years. The section includes the evaluation period,
overall rating, overall comments, and a bar graph comparing the performance ratings. You can also
include talent ratings.

Competency ratings and evaluation types, degrees, licenses and certifications, honors and awards, and
memberships.

Career preference and advancement readiness information, including willingness to travel, relocate,
consider part-time employment, or adopt flexible work schedules. You can also include preferred
career moves and any jobs in a worker's interest list.

Development and performance goal information, such as goal names, completion dates, statuses, and
descriptions. This section includes a graph of goal achievements for the worker.

You can print the Talent Profile Summary in the following formats:

Print Format

PDF

RTF

Microsoft Excel

HTML

Content Sections

Content Sections

Description

Includes a photograph of the worker and all selected graphs.

Includes a photograph of the worker and all selected graphs.

Includes all selected workers in an Excel workbook, with one profile per worksheet and the worker's
name as the tab label. This format doesn't include the photograph, performance history, or goals
graphs.

Includes selected graphs but doesn't include the photograph.

Content sections are sections in a profile, person or model, containing profile items. The properties for the content
sections are configured under the profile type. You define properties for each content section. However, the accessibility
of a content section for person profiles is dependent

Content Section Properties

Content section properties or content properties are attributes that are used to define data included in a profile. A free-
form content type doesn't have any properties defined for it until you add it to the profile type as a content section.
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Therefore, you define all properties for free-form content types. You can change content section properties inherited
from the content library and free-form content types or add new properties, as needed. Use the Manage Profile Types
task in the Profiles or Setup and Maintenance work area to select and edit a content section associated with a profile
and define its properties. You must have the HR specialist or implementor role or privileges to perform this task.

Content Section Approval

For a content section in a profile type, you can specify whether the approval is required when a worker adds the content
section that the worker can access to a profile. Use the Approval Required check box on the Content Section page to
enable or disable approval for a content section. You open the Content Section page, when you add or edit a content
section for the person or job profile type on the Manage Profile Types page in the Profiles or Setup and Maintenance
work area. You must have the HR specialist or implementor role or privileges to perform this task.

Content Section Access

For accessing the content for person profiles, you must give the required access for the content section to a role. You
can specify the level of access as view, edit, or report for each role. For example, users in the line manager role can be
given edit access to add and edit the Competencies content and view access to only read the Degrees content for their
workers. You can include content-type data in Oracle Business Intelligence Publisher reports. Use the Manage Profile
Content Section Access task in the Setup and Maintenance work area to secure access to content sections in person
profiles. You must have the IT Security Manager role or privileges to perform this task.

If you search for person profiles, the search results display profiles that match the search criteria. However, you can view
content sections details of a person profile based on the access level given to your role. You search for person profiles
on the Search: Profiles page in the Profiles work area.

Content sections in person profiles are unsecured when person profiles are included in:

- Best-fit analyses
- Profile comparisons

- Oracle Transactional Business Intelligence reports

No access is required for content sections added to model profiles as their content aren't secured.

Related Topics
- Content Section Properties

« Examples of Person Profile Content Access for Roles
- What's a free-form content type?
« How You Secure Content Sections in Person Profiles

Content Section Properties

Content sections are sections in a profile, person or model, containing profile items. The properties for the content
sections are configured under the profile type. Content section properties are attributes that are used to define data
included in a profile. Use the Manage Profile
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Attributes of Content Section Properties

The following table displays a list of attributes that you can set for each content section property that you included for a
content section.

Attribute Description
Default Value Value that appears by default for the content section property on the profile
Display Determines if the content section property is displayed on the profile. If yes, then whether the property

is displayed on the content section summary, content section details area, or both

Label Label for the content section property displayed on the profile when the property is included within a
content section

Required Determines if the user is required to enter a value for the property
Searchable Determines if the content section property name must be included in profile searches
Value Set Name Name of the lookup type or a predefined value set that provides values for the content section

property. You specify a lookup type for properties ITEM_TEXT30_6 to ITEM_TEXT30_15. The value set
is already defined for a predefined content section property, if applicable. For custom content types,
you can specify only a lookup type as the value for this attribute

View Attribute Specifies the attribute in the predefined value set that provides the list of values for a content section
property. You enter a value for this attribute only for predefined content section properties and when
you mention a predefined value set in the Value Set Name attribute. The view attribute is already
defined for a predefined content section property, if applicable. You can't use this attribute for custom
content types

I Note: The functionality associated with the Searchable attribute isn't available for use in the application.

Content Section Properties List

The following table describes a list of content section properties that appear on the pages with a profile item that
belongs to the content section.

Content Section Property Specifies

COUNTRY_ID The country ID associated with the profile item. Ensure that the value of the Value Set Name attribute
is CountryPVO and View Attribute attribute is GeographyName, where CountryPVO is the name of the
value set and GeographyName is the attribute in the CountryPVO value set that provides a list of values
for the COUNTRY_ID property

DATE_FROM The start date information of a content section. This property is used for maintaining the history of
profile items and isn't recommend to be displayed on the Ul
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Content Section Property

DATE_TO

ITEM_DATE_1to ITEM_DATE_10
ITEM_DECIMAL_1to ITEM_DECIMAL_5
ITEM_NUMBER_1 to ITEM_NUMBER_10
ITEM_TEXT30_1to ITEM_TEXT30_5

ITEM_TEXT30_6 to ITEM_TEXT30_15

ITEM_TEXT_240_1to ITEM_TEXT_240_15

ITEM_TEXT2000_1to ITEM_TEXT2000_5
IMPORTANCE

INTEREST_LEVEL

MANDATORY

QUALIFIER_ID1 to QUALIFIER_ID2

LAST_UPDATE_DATE

RATING_LEVEL_ID1to RATING_LEVEL _
ID3
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Specifies

The end date information of a content section. This property is used for maintaining the history of
profile items and isn't recommend to be displayed on the Ul

Any date. Use these properties to enter dates for profile items

Numeric data that includes decimals. For example, price USD 2.99

Numeric data that doesn't include decimals. For example, age 29 years

Data that requires selecting values from a check box

Data that requires selecting values from a list. Ensure that the value of the Value Set Name attribute is
a lookup type. For example, HRT_RISK_REASON is a lookup type for selecting risk of loss reasons

A simple text string, such as a name. Each property can store up to 240 characters of data. If the ITEM_
TEXT_240_1 property is used in:

- A predefined free-form content type, you can't enter duplicate data for this property for a profile
item

- A custom free-form content type, you can enter duplicate data for this property for a profile item

- A predefined or custom content type that aren't free-form, you can't enter duplicate data for this

property for a content item

Long text data, such as a comment. Each property can store up to 2000 characters of data

The priority of the content section. The value of this property is used in the best-fit algorithm

The level of interest. This property is added to the Competency content section. The value of this
property is based on the Interest Rating Model and is automatically generated for a profile item

Whether the item in a content type is required or not. This property is used by content types that are
added to the Job profile type. Ensure that the value of the Value Set Name attribute is YES_NO. If
added to a content type, the label for this property, is displayed as a check box column for content
items within the content type for a job profile. The default label for this property is Required

The instance qualifier information assigned to the profile content section. To uniquely identify different
instances of competencies, you must not modify the predefined value of the QUALIFIER_ID1and
QUALIFIER_ID2 properties for the Competency content section included in the Person profile type

The last updated date of the content section. The value of this property is automatically generated for
a profile item

The rating level information of a profile content section
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Content Section Property Specifies

RATING_MODEL_ID1to RATING_MODEL_ The rating model information of a profile content section. The RATING_MODEL_ID1 property is used
ID3 for storing the rating model information for the Competencies content section associated with a job or
person profile type. The default value for this property is Proficiency Rating Model

STATE_PROVINCE_ID The state ID associated with the profile item. This property is used in conjunction with the COUNTRY_
ID property. Ensure that the value of the Value Set Name attribute is StateProvincePVO and
View Attribute is GeographyName, where StateProvincePVO is the name of the value set and
GeographyName is the attribute in the StateProvincePVO value set that provides a list of values for the
STATE_PROVINCE_ID property

Note:
- For content sections associated with free-form content types, the values of the properties CONTENT_TYPE_ID
and DATE_FROM are automatically generated for a profile and should not be modified.

- For content sections associated with content types that aren't free-form, the values of the properties
CONTENT_TYPE_ID, CONTENT_ITEM_ID, and DATE_FROM are automatically generated for a profile and
should not be modified.

- The SOURCE_ID property isn't used by the application and can be ignored.

Related Topics
« Content Sections

» How You Add Common Lookup Types to a Content Section Property
- Content Type Properties

- What's a free-form content type?

- What happens if | don't add a label for a content section property?

Examples of Person Profile Content Access for Roles

You must identify which job roles and abstract roles need access to content sections and the level of access each role
needs. This topic provides examples of content-section access for some roles and identifies tasks that users with those
roles can perform.

Scenario

The First Software organization associates the following content sections with the person profile type. These content
sections are available as searchable profile content.

- Competencies

- Degree
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- Languages

- Licenses and Certifications

The organization has employee, line manager, and license manager roles. An appropriate person security profile is
assigned to each role. According to the person security profile:

- Users with the employee role can search for workers according to their access privileges for person records in
the directory and manage their own records.
- Users with the line manager role can manage the person records of their reports.

- Users with the license manager role can manage the person records of workers in their department.

The access level for each content section for a role is defined as shown in the following table.

Content Section Access Level for the Employee Access Level for the Line Access Level for the License
Role Manager Role Manager Role

Competencies Edit Edit None

Degree Edit Edit None

Languages Edit Edit None

Licenses and Certifications View Edit Edit

Content Access for Employees
As the employee role has the edit access level for all content sections in the organization, all users associated with the
role can do the following tasks:

- Search for all workers in the directory and view the publicly accessible content of a person profile

- Search for their own person profile using the searchable profile content

- View their own person profile content for which they have edit or view access. In the example, all employees can
view their competencies, degree, languages, and licenses and certifications content on their profile

- Edit their own person profile content for which they have edit access. In the example, all employees can edit
their competencies, degree, and languages content on their person profile

- View, add, and remove attachments for their person profile content

Content Access for Line Managers

As the line manager role has the edit access level for all content sections in the organization, all users associated with
the role can do the following tasks:

- Search for direct reports within their own person security profile on the Team Talent page

- View secured content of person profiles of their direct reports within their own person security profile. In this
example, all line managers can view competencies, degree, languages, and licenses and certifications content
on their reports’ person profile
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Edit secured content of person profiles of their direct reports within their own person security profile. In this
example, all line managers can edit competencies, degree, languages, and licenses and certifications content
on their reports' person profile

- View, add, and remove attachments for person profile content of their direct reports within their own person
security profile

Content Access for License Managers

As the license manager role has the edit access level for only the Licenses and Certifications content section in the
organization, all users associated with the role can do the following tasks:

- Search for workers within their own person security profile in the directory using the searchable profile content
- View Licenses and Certifications content for person profiles of workers within their own person security profile

Edit Licenses and Certifications content of person profiles of workers within their own person security profile

Related Topics
« Content Sections

« How You Secure Content Sections in Person Profiles

Instance Qualifier Sets

An instance qualifier set is a group of codes that uniquely identify different occurrences of the same profile item such as
competency content section or a performance rating. Use the Manage Instance Qualifiers task in the Profiles work area
to view and edit

Purpose

Instance qualifiers identify the role of a person or the application that updated a content type. For example, if a worker,
the worker's peer, and the worker's manager all enter a rating for a competency on the worker's profile, instance
qualifier sets uniquely identify each instance, or the rating given by each different role. Uniquely identifying different
instances of competencies enables you to specify which instance is used when you view or compare profiles. Instance
qualifiers also affect data entered for content types. For example, if configured, a worker with an employee profile can
enter a competency with the Evaluation Type instance qualifier as Self only.

Properties

Each instance qualifier contains a code and a description, which indicate the role or the application that updated the
content type.

The following examples list the instance qualifiers displayed on the Ul or Bl reports when the content type is updated by:

- An application: If an employee's potential rating is updated in a talent review meeting, the instance qualifier of
the rating appears as TRPOTENTIAL in Bl reports. Similarly, if the rating is updated on the employee's Career
Planning page, the instance qualifier appears as PROFILEPOTENTIAL in Bl reports.

- Arole: If a competency is updated by an employee, the value of the Evaluation Type instance qualifier appears
as Self on the employee's Edit Skills and Qualifications page and Bl reports. Similarly, if the competency is
updated by a manager, the value of the Evaluation Type qualifier appears as Supervisor.

309
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=s20060275

Oracle Fusion Cloud HCM Chapter 15
Using Common Features for HCM Workforce Profiles

Each instance qualifier has the following properties:

Priority
Employee and manager views
- Search ability

Default instance qualifier for employee and manager

Priority

Priority determines:

- The order in which different instances of a competency are displayed.

- Which instance to use when searching and comparing profiles. The lowest number indicates the highest
priority. The lowest number is displayed on the competency gap chart, comparison results for profiles, and
best-fit results for a profile.

Employee and Manager Views

If the security privileges associated with employee and manager roles enables them to view or edit a content section,
then you can use employee and manager views to determine which instances are visible to employees and to managers.

Search Ability

You can specify whether items that have been assigned the instance qualifier code should be included in profile
searches. For example, you might not want the ratings for competencies given by peers to display when other workers
are searching person profiles.

Default Instance Qualifier

You can specify the default instance qualifier to use when managers and employees update a competency. Each time an
employee or manager updates a competency, the record is assigned the instance qualifier code that is identified as the
employee or manager default code.

Related Topics
- Content Section Properties

Lookups

Profile Management Lookups

This topic identifies common lookups that are profile management-related and have user or extensible configuration
levels. Review these lookups, and update them as appropriate to suit enterprise requirements.

Profile Management Lookups
Profile management lookups are described in the following table.
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Lookup Type

HRT_CONTENT_SUPP_CODE

HRT_COMPETENCY_EVAL_TYPE

HRT_DEGREE_LEVEL

HRT_DURATION

HRT_EDUCATION_LEVEL

HRT_IMPORTANCE

HRT_NOTES_TYPE

HRT_PAY_FREQUENCY

HRT_READINESS

HRT_RISK_REASON

HRT_SATISFACTION_METHOD

ORACLE

Description

Codes to identify where the content type
originated, such as from the customer or from
a third party. Human Resource (HR) Specialists
assign supplier codes when setting up new
content types.

Types of competency ratings, such as self,
supervisor, and peer. Evaluation types are used
in instance qualifier sets to identify the role of
the person who provided a competency rating
for a worker.

Required levels of education for a job or
position profile, such as a Bachelor's Degree or
Masters degree.

Time periods for when a worker would like to
make a career move. Workers select a duration
for their career move in the career preferences
information on the career planning card.

Types of education that a degree provides, such
as a Bachelor's degree or one year college. HR
Specialists use education levels when creating
content items in the Degrees content type.

Values for the importance level of each content
type. Importance values are used in the best-fit
analysis calculation.

Values for categories of notes, such as external
and internal.

Frequencies at which a worker is paid. Workers
specify a preferred pay frequency when they
edit their work requirements on the experience
and qualifications card.

Time periods in which a worker is ready for
advancement to a specified job or position
profile. Managers and HR Specialists use
readiness levels when editing the talent ratings
information on workers' career planning cards.

Reasons for why a worker is at risk for leaving
the company. Managers and HR Specialists use
risk reasons when editing the talent ratings
information on workers' career planning cards.

Methods by which an item such as a
competency is verified, such as assessment or
demonstration. Managers and HR Specialists
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Configuration Level

Extensible

User

User

User

User

User

User

User

User

User

User
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Lookup Type

HRT_TASK_PRIORITY

HRT_TASK_TYPE

HRT_TRAVEL_FREQUENCY

HRT_VALIDITY_PERIOD

HRT_WORK_DAYS

HRT_WORK_HOURS

Description

use these values to identify the method that
was used to evaluate the proficiency of a worker
in a particular skill or quality.

Codes for the priority of a task, such as High
and Medium. Talent review facilitators specify
a priority when assigning tasks during a talent
review.

Categories of tasks, such as Preparation and
Presentation. Talent review facilitators specify a
task type when assigning tasks during a talent
review.

Percentages of time a worker is expected

to travel for a job or position, for example,

25 percent or 50 percent. Managers and HR
specialists specify the required travel frequency
on job and position profiles. Workers also
specify a travel frequency when they edit their
work requirements on the experience and
qualifications car

Periods of time for which content items such as
licenses and certifications are valid. Managers
and human resource (HR) specialists select
validity periods when setting up content items
for the Licenses and Certifications content type.

Work days for a job or position, such as Monday
through Friday. Managers and HR specialists
specify the expected work days on job and
position profiles.

Work hours for a job or position, such as 9:00
a.m. to 5:00 p.m. Managers and HR specialists
specify the expected work hours on job and
position profiles.
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Configuration Level

Extensible

Extensible

User

User

User

User

How You Add Common Lookup Types to a Content Section

Property

Associate common lookup types with a content section property when defining content sections for a profile type.
You can then provide a list of values for the content section property. For example, you can add a list of industries to a

content section

ORACLE
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Note: This functionality doesn't apply to these content section properties when they are associated with the following
content sections: Career Preferences, Potential, Risk, Advancement Readiness, Career Statement, Talent Score,
Performance Rating, and Work Requirements.

Related Topics
« Overview of Lookups

« Add Common Lookups to a Content Section Property

Add Common Lookups to a Content Section Property

This example illustrates how to use common lookup types to create a list of values for a content section property.

Development Readiness

The Human Resource (HR) department at InFusion Corporation wants to track development readiness for employees
using the person profile. They would also like to indicate whether a worker is a candidate for serving as a mentor to
another worker.

Values for Development Readiness
The HR department has decided on three possible levels for a worker's development readiness:

« 1to 2 years
. 3to5vyears
Ready Now

To indicate whether a worker is a candidate for being a mentor, they want three choices:

- Yes
No
Maybe

InFusion analyzes the existing content types in the content library, and decides that none of the content types works.
They must create a free-form content type called Development Readiness. The content type is free-form because
content items aren't needed, and the information needn't be stored in the content library.

Next, they analyze the existing common lookups, and determine that they can use an existing lookup type,
HRT_READINESS but add lookup codes and meanings to suit their needs. For the indicator for mentorship, they must
create a common lookup.

After creating the content type and lookup and changing the lookup codes for HRT_READINESS, they must add the
content type as a content section to the person profile. Adding the content section to the person profile enables HR
Specialists and managers to add the section to workers' profiles. they can then rate workers on their readiness level and
ability to be a mentor.

Note: You can attach lookup values to only these content section properties: ITEM_TEXT30_6 through
ITEM_TEXT30_15.
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Resulting Setup

To track development readiness for workers, InFusion must complete the following setup:

1. Using the Manage Common Lookups task in the Setup and Maintenance work area, locate the
HRT_READINESS lookup type.

2. Add codes for 1to 2 years, 3 to 4 years, and Ready Now.

3. Using the Manage Common Lookups task, create a common lookup called HRT_MENTOR, and add the three
values of Yes, No, and Maybe.

4. Using the Manage Content Types task in the Setup and Maintenance work area, create a free-form content type
called Development Readiness. Add HRMS and TM as the content subscribers.

5. Using the Manage Profile Types task in the Setup and Maintenance work area, select the Person profile type
and add Development Readiness to it.

6. Using the Manage Profile Types task, select the Development Readiness content section to access the Content
Section page.

Set up the content section by adding two properties as described in this table.

Property Label Display Value Set Name
ITEM_TEXT30_6 Development Readiness Summary HRT_READINESS
ITEM_TEXT30_7 Potential Mentor Summary HRT_MENTOR

7. Inthe Content Section Access region on the Content Section page, add the HR Specialist and Manager roles.
Select the option for each role to be able to edit the content section.

Note: Don't add the Employee role.

HR specialists and managers can then access worker profiles and add the Development Readiness content section to
the profiles.

Related Topics
« Overview of Lookups

Writing Assistant

How You Upload Writing Assistant Data Using Spreadsheets

Human resource (HR) specialists can upload and associate new Writing Assistant data for competencies using an
application-generated spreadsheet.

Use the Export option on the Manage Content Items page in the Profiles work area to generate the spreadsheet for
uploading writing assistant data. The uploaded data is associated with each separate competency.
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The application-generated spreadsheet for uploading Writing Assistant data contains the following two worksheets:

Feedback Suggestions - Upload feedback suggestions for each proficiency level for each competency.

Development Tips - Upload development tips associated for each competency.

Generate the Spreadsheet
Here's how you generate the spreadsheet to upload and associate data for Writing Assistant with competencies:

1. Navigate to the Profiles work area.

2. Search for and select the Items Catalog task.

3. Inthe Search Results region, click Actions > Open Writing Assistant Excel Template. A File Download dialog
box appears.

4. Click Save. Select a destination on your local hard disk to save the CompetencyFeedbackSuggestion.xIsx
spreadsheet.

Upload and Update Feedback Suggestions

To upload feedback suggestions, specify all the required columns in the Feedback Suggestions worksheet and click
Upload. After you click Upload, click Save to commit the feedback suggestions for proficiency levels for associated
competencies into the application database.

To update an existing feedback suggestion, click Download to download all feedback suggestions for competencies into
the spreadsheet. You can then update the suggested text and click Upload. After you click Upload, click Save to commit
the feedback suggestions for proficiency levels for associated competencies into the application database.

I Note: You can enter the same suggestion text for multiple competencies and for multiple proficiency levels.

Upload and Update Development Tips

To upload development tips, specify all the required columns in the Development Tips worksheet and click Upload.
After you click Upload, click Save to commit the development tips for associated competencies into the application
database.

To update an existing development tip, click Download to download all development tips for competencies into the
spreadsheet. You can then update the suggested text and click Upload. After you click Upload, click Save to commit the
updated development tips for associated competencies into the application database.

Note: You can enter the same suggestion text for multiple competencies.

Related Topics
« Writing Assistant

« Guidelines for Using Desktop Integrated Excel Workbooks
« How Writing Assistant Works with Performance Documents
« How You Set up Writing Assistant for Performance Documents
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Writing Assistant

Writing Assistant is a tool that provides suggestions for a manager when writing comments or feedback for a worker's
competency or rating level during performance evaluation.

Writing Assistant suggests statements associated with competencies and proficiency levels within those competencies,
to help describe a worker's observed and wanted actions. The Writing Assistant data is displayed in the form of
feedback suggestions and development tips. Use Actions > Open Writing Assistant Excel Template on the ltem
Catalogs page in the Profiles work area to generate the spreadsheet for uploading writing assistant data.

Requirements for Using Writing Assistant Data
Here's how you use the Writing Assistant tool:
- HR specialists upload data associated with a competency using an application-generated spreadsheet
- Managers select a proficiency level for a competency
- Managers view suggested comments for the selected proficiency level or for the competency as a whole
- Managers can copy and edit the suggested comments

Did you know that the application enables suggestions only for competencies that have a rating?

Related Topics
« How You Upload Writing Assistant Data Using Spreadsheets

- How Writing Assistant Works with Performance Documents
» Guidelines for Setting Up Performance Templates

Questionnaires

Questionnaires

You can create questionnaires to gather information in applications that support them. For example, you can use
questionnaires to collect feedback in a performance evaluation.

A questionnaire consists of several questions, and you create questionnaires based on questionnaire templates. You can
create questions using the question library and then add the questions to questionnaire templates and questionnaires.
This topic describes aspects of questionnaire creation and maintenance.

You create and update questions, questionnaire templates, and questionnaires from the Setup and Maintenance work
area.

To access this work area, click the arrow next to your photo on the global header, open the Settings and Actions menu,
and select Setup and Maintenance.

Next, select Workforce Development from the Setup list, and select Questionnaires from the Functional Areas list.
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Using these tasks, you can configure each of these sections:

- Question Library
« Questionnaire Templates

- Questionnaires

Subscriber Applications

Applications which are eligible to use questionnaires are called subscriber applications. In addition to Oracle
Performance Management, other subscriber applications include Oracle Learning, Oracle Time and Labor, Oracle
Recruiting, and many more. You must select the subscriber application for each questionnaire. When you select the
subscriber on the Questionnaires page, you can create questionnaires for the selected subscriber only. In addition, the
subscriber filters your search results to display only questionnaires created for that subscriber.

Note: Some subscriber applications use Setup and Maintenance tasks to manage questionnaire components
while others provide their own tasks or don't allow modification of questionnaires. See the documentation for the
subscriber applications for more information.

Folders

You maintain folders to store questionnaires. For each subscriber application, you can create as many folders as
required to differentiate or identify the questionnaires.

Questionnaire Templates

All questionnaires are based on templates, which promote consistency. When creating a questionnaire, you must

select a template on which to base the questionnaire. The template can provide default settings or enforce mandatory
requirements such as specific sections and questions that must be in all questionnaires created using the template. You
can configure templates for:

- Specific applications
- General audiences, such as an entire organization or all internal customers

- Targeted audiences, such as particular roles (managers, for example)

- Specific purposes, such as providing feedback for performance evaluation periods or rate worker potential in an
assessment for a talent review

You can create questionnaires only from templates that were created for the same subscriber as the questionnaire.

Questionnaire Presentation
You can specify how the questionnaire appears in the subscriber application. For example, you can:

- Add sections to group questions by type or other classification.
- Define the question order to appear in the sequence defined or in random order in a section.

- Mark questions as required.

When a section is defined for Random question order, you can specify the sample size that isn't less than the required
number of questions and more than the number of questions in the section.

I Note: Conditional questions aren't included in the random sample questions.
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Questionnaire and Question Scoring

For subscriber applications that support scoring, you can configure questions that score the responses provided by
respondents. You can configure questionnaires to calculate the cumulative total of responses (Sum), the average score,
or the percentage based on the maximum available score.

Tip: You can define a high score for a question that can be more than 3 digits. This facilitates to have higher number
of questions with each of these questions having higher scores in a questionnaire. Thus, the high score can result into
an overall high score too.

You can define the score for question answers directly in each questionnaire. For questions that are reused across
multiple questionnaires, you can define a different score for the question in each questionnaire. If you don't change the
question score in the questionnaire, the default score from the question is used.

Questionnaire and Template Access

You can control access to questionnaires and templates by setting privacy options. If you set the Privacy option to
Private, only the named owner can edit the questionnaire or template. Otherwise, anyone with access can edit the
questionnaire or template.

How You Create Questions

When creating a question, you specify the question type, additional instructions about the question, images and
attachments, if any, response type for the question, scoring options, and more.

You create questions in the question library. To create, review, or edit questions, select these in the Setup and
Maintenance work area:

- Setup: Workforce Development
- Functional Area: Questionnaires
- Task: Question Library

Follow these steps to create a question, for example:

1. After selecting the options mentioned above, select the subscriber from the Questions page.
Click the Create icon. The Create Questions page appears.

3. Select the folder, status, and privacy options, as required. The Question Code and Question Version Number are
generated automatically.

4. Inthe Question Text field, type the question that you want to ask. For example, “How many states are there in
the US?”

5. Inthe Image field, click the Manage Attachments icon to add an accompanying image to the question. For
example, if your question reads, "What does this sign mean?", add the image of a sign in this field.

6. Inthe Instructions text box, include additional information or provide additional context about the question.
You can format the information that you add by using the toolbar. You can also add an URL using the Add Link
icon on the toolbar.

Note: The URL that you add here will open in the same window as the questionnaire. You may want to add a
note in the Instructions text box to let the respondents know that they must open the URL in a new window
to avoid losing any unsaved changes.

7. Select the question type. Options are Text, Single Choice, Multiple Choice, and No Response.
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12.

13.

14.
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Select the Display the question conditionally check box if you want to display the question based on a specific
response that’s provided to another question called the controlling question. For example, if respondents
answer “No” to a controlling question such as, “Are you happy with the learning module?”, you can configure a
text question to appear conditionally, asking them to provide more details. For more information, refer to the
Conditional Questions section in this topic.

For Single-Choice and Multiple-Choice question types, you can provide scoring options by selecting the Score
Question check box.

For more information, refer to the Response Scoring section in this topic.

Select the type of response that a respondent must provide to the question. Each question type has a list of

response types that you can choose from.

To allow respondents to upload attachments with their responses, select the Allow Attachments check box.
For example, you have the question, "Provide proof of the right to work in this country". The respondent can
upload an attachment to show proof of the right to work.

Note: Respondents can add attachments for all types of questions, including No Response questions.

Select the Allow Additional Comments check box, if you'd like respondents to provide additional comments or
reasons for their responses. This option is available only for Date responses of the Text question type and for
all responses of the Single Choice and Multiple Choice question types.

Note: When you create a new version of a question or copy a question that has additional comments
enabled, this option is available in the new question as well. However, it’s not available for existing questions
that are already published. This option may not be available in certain run-time and setup pages in Oracle
Recruiting, Oracle Health and Safety Incidents, Wellness, and Journeys.

In the Minimum Length and Maximum Length fields, specify the length of text responses, or the start and
end dates of date responses.
Click Save and Close.

Question Types

Four types of questions are available in the Question Type list:

Text

- Single choice

- Multiple choice

No response

For each question type, you also configure responses and select a presentation method. For example, for single-choice
questions, you can specify that the possible responses appear either in a list or as radio buttons.

This table describes the types of questions and their response types.

Type

Text

ORACLE

Description

Respondents can
either enter free-form
text as the answer to
the question, or they
can enter a date using
a date picker.

Sample Question

How can we improve
this class?

Response Type

Date
Plain Text Box

Rich Text Box

Sample Response

The class is too long
and should be broken

into 2 half-day classes.

Notes

For text responses,
you can specify

the minimum and
maximum number of
characters. You can
also allow rich text that
uses formatting, such
as bold and underline.

319



Oracle Fusion Cloud HCM Chapter 15
Using Common Features for HCM Workforce Profiles

Type Description Sample Question Response Type Sample Response Notes

For date responses,
you can set the
minimum or
maximum dates, or
both. Respondents
must choose a date
on or before the
maximum date and on
or after the minimum
date. For example,

if respondents have
to enter their date

of joining between
12/01/2021and
12/31/2021, set these
as the minimum and
maximum dates.

Single Choice Respondent chooses Is Performance - Single Choice Yes
only one correct Management a from List
answer. subscriber application

for questionnaires? * Radio Button List

- Radio Button
with Image

- Single Choice
- Horizontal
Buttons
(applicable only
for Touchpoints
and Journeys
Surveys
subscribers)

Multiple Choice Respondent can Which applications are . Check Multiple Oracle Performance
choose more than one  subscriber applications Choices Management, Oracle
answer. for questionnaires? Learning, Oracle

+ CheckBoxwith  eaith and Safety,
Image Oracle Recruiting

- Multiple Choices
from List

- Multiple Choice
- Horizontal
Buttons
(applicable only
for Touchpoints
and Journeys
Surveys
subscribers)

No Response Instructional text Attach any supporting
only; no response is documentation that
allowed. relates to this person's

performance for this
period.
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Subscriber Applications

Subscriber applications are applications that can use questionnaires, for example, Oracle Performance Management.
When creating a question, you must select a subscriber application for the question and a folder in which to include

it. You can create folders for each subscriber application to store questions for the subscriber. For example, folders for
Oracle Recruiting might be named for locations, where the organization has offices, such as San Francisco, Austin, Los
Angeles, Tokyo, Bangalore, and Shanghai. A question is only available to questionnaires with the same subscriber.

Conditional Questions

When you select the Display the question conditionally check box, you need to specify the controlling question code
and response. When the respondent answers the controlling question with the controlling response, the conditional
guestion appears.

For example, for a controlling question such as, Did you receive assistance with this form?, if the controlling response
is Yes, then you can display the conditional question, Which type of assistance did you receive?

Note: Add both the conditional question and the controlling question to the same section of the questionnaire.

You can also add response feedback visible to respondents to display a targeted message to their response, if the
subscribing application uses response feedback.

Tip: You can assign your own response codes to the responses that you create in choice-based questions. The
application provides the response code by default. But you can remove the response code and enter a code of your
choice so that it's meaningful and helpful in organizing your setup. If you enter a response code, please note the code
must be unique for the entire set of responses across all questions and not just for a specific question. For example,
you can only have one response code, “Yes” across all your questions.

Single-Choice and Multiple-Choice Questions

For single-choice questions, respondents select one response from several. You specify whether the responses appear
in a list or as radio buttons. An example of a single-choice question is, "Have you completed a similar class?" Only one
response for the options is expected, Yes or No.

You can select a rating model to quickly provide consistent responses. When you select a rating model, the rating levels
appear as responses. For example, you create the questions "How do you rate your performance in this performance
period?" and you associate the Performance Rating Model, which has 5 rating levels defined as Outstanding, Exceeds
Expectations, Meets Expectations, Inconsistent, and Unsatisfactory. These 5 rating levels are automatically added as
the response choices for the questions. You can add, remove, or edit the responses. If you change the rating model, for
example, to the Language Rating Model, which has 3 ratings (High, Moderate, Low), the response choices will change,
but the text for the question stays the same unless you edit it.

You can add feedback to display messages to users reviewing a completed questionnaire if the subscribing application
has enabled this feature. The response feedback appears when the respondent submits the questionnaire.

When you configure a single-choice question as a radio button and specify that it isn't required, the No opinion
response appears automatically as a response. This option allows respondents to change their responses to no opinion
if they already selected a response that they can't deselect.

For multiple-choice questions, respondents can provide one or more answers. Specify whether the responses are
presented as check boxes or a choice list. You can set both a minimum and maximum number of required responses.
As with single-choice questions, you can associate a rating model with the response type. You can add responses

to multiple-choice questions, as with single-choice questions. An example of a multiple-choice question is "Indicate

321
ORACLE



Oracle Fusion Cloud HCM Chapter 15
Using Common Features for HCM Workforce Profiles

which of the following grades you have taught. Select all that apply.” A respondent can check grade levels, such as
Kindergarten, first, second, third and so on.

Tip: You can assign your own response codes to the responses that you create in choice-based questions, single-
choice or multiple-choice. You can assign meaningful identifiers to the questions by using your own question codes. If
you don't want to, you can use the application-generated codes.

For choice-based question responses, you can add images when defining the response. To do this, enable one of these
options in the Allow Response Types section of the questionnaire template:

- Check box with image

- Radio button with image

Outside the questionnaire, when defining an independent question, you can add an image to any type of question. For
responses to choice-based questions, ensure that you select one of these options for Response Type.

« Check box with image

- Radio button with image

Response Scoring

You can configure single- and multiple-choice questions to be scored. To score the responses, you can either set them
up to use user-defined scoring or select a rating model to use the predefined numeric rating. Responses using rating
models are only scored when the question is configured for scoring. The application uses the score from the responses
to calculate the score of questionnaires that are configured to be scored. With the rating models, you can edit the short
description and the score.

Note: For the Touchpoints subscriber, scoring is enabled by default as pulse scores can be computed and displayed
as graphs in Oracle Touchpoints only if it's enabled.

Editing a Question

When you edit a question, you can either create a new version or update it. You can see the version number when you
edit a question. However, the version number is incremented only when you create a new version of the question and
not when you update an existing version.

When you create a new version of the question, it won't be automatically included in a questionnaire that's in use
and referencing an older version of the question. To include the new version, you need to create a new version of the
qguestionnaire and add the question.

Randomized Questions and Answers

Just as questions can be randomized in a questionnaire section, the answer choices can be randomized. Randomized
qguestions and answers help prevent users from copying answers from others or memorizing questions and answers to
share with others.

You can have two kinds of randomization:

- Position Randomization - This refers to the sequence of response choices for a given question. If 5 choices are
available (a, b, ¢, d, e), the order in which these are shown to the respondent is randomized. For example, the
choices can appear in the order g, d, ¢, b, a for one respondent. For another respondent, the choices can appear
in the order a, ¢, b, e, d.
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- Selection Randomization - This refers to randomizing the response choices shown to the respondent from an
available list of choices. For example, you set up a question that has a sample of 10 answer choices. You can
show 5 random choices from the list of 10. The correct answer or answers are always included in the selection
shown to the respondent.

You can set up single- and multiple-choice responses in random response order.

In addition to randomization in questions and answers, you can randomize the order of sections in a questionnaire.

Put Your Sections, Questions, and Answers in Random Order (Position
Randomization)
This shows how to put sections and questions in random order. Optionally you can also put answers in random order.

Go to the Settings and Actions menu.

In the Administration area, select Setup and Maintenance.

From Setup, select Workforce Development > Questionnaires.

Search for or create a questionnaire. Note that you can't edit a questionnaire if it's in Active status.
Select the Subscriber, for example, Performance 360.

If needed, edit the Basic information and click Next.

For the Section Order, select Random.

In the Sections area, under the Question Order column, select Random.

NSV AUWNA

Note: You can achieve position randomization for answers when you select Random for the Response Order in the
Sections area.

Put Your Answers in Random Order (Position Randomization)
This shows how to make the answers for a single question appear in random order.

Go to the Settings and Actions menu.

In the Administration area, select Setup and Maintenance.

From Setup, select Workforce Development > Questionnaires.

On the right side of the page, click Question Library.

Select the Subscriber, for example, Performance 360. If you have multiple libraries, select a specific library.
Search for or create a question. Note that you can't edit a question if it's in Active status.

In the Response area, select Random for the Response Order .

Enter a Sample Size that matches the number of answer choices that you define for the question. Sample size
determines the number of answer choices shown to the respondent.

Enter the possible answers in the table by clicking the Add icon. Make sure that you enter the correct answers in
the table and indicate they're correct by selecting Yes in the Correct Response column.

NSV AUWNA

0

When the sample size matches, position randomization is enabled.

Create a Question with Randomized Answers (Selection Randomization)
This shows how to enable a higher level of randomization by randomizing the answer choices shown for a question.

1. Go to the Settings and Actions menu.
2. Inthe Administration area, select Setup and Maintenance.
3. From Setup, select Workforce Development > Questionnaires.
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On the right size of the page, click Question Library.

Select the Subscriber, for example, Performance 360. If you have multiple libraries, select the library.

Search for or create a question. Note that you can't edit a question if it's in Active status.

For the Question Type, select Multiple Choice or Single Choice.

For the Response order, select Random.

Enter the Sample Size for the answers. Sample size determines the number of answer choices shown to the
respondent.

Enter a number in the Minimum Number of Selections, for example, 1. The minimum number of selections
determines how many choices the respondent must select at the minimum.

Enter a number in the Maximum Number of Selections, for example, 2. The maximum number of selections
determines the number of correct responses that will be shown to the respondent in the choices presented.
Enter the possible answers in the table by clicking the Add icon. Make sure that you enter the correct answers in
the table and indicate they're correct by selecting Yes in the Correct Response column.

Example of a Question with Randomized Answers

Question Details Notes Sample Information

Question text Which of these countries is in Asia?
Question type Multiple Choice

Response order Random

Sample size Number of choices shown to the respondent 6

Minimum number of selections Number of choices the respondent must select = 1

Maximum number of selections Number of correct responses that will be shown 2

to the respondent

Number of correct answers 2

In the answer table, you enter the responses and indicate which are the correct ones.

Short Description Correct Response
India Yes
South Korea Yes
France No
Columbia No
Zimbabwe No
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Short Description

Lebanon
Canada
New Zealand
Ethiopia

Greenland

Chapter 15
Workforce Profiles

Correct Response

No

No

No

No

No

Because you set the sample size as 6, the respondent will see 6 possible answers.

Which of these countries is in Asia?

France
South Korea
Zimbabwe
India
Greenland
6. Ethiopia

A UWNR

Because you set up selection randomization, another respondent might see the question with different responses, such

as:

Which of these countries is in Asia?

Lebanon
India

New Zealand
France
Columbia
South Korea

oA WNA

How You Configure Questionnaire Templates

This topic describes how questionnaire template options determine the features of questionnaires. After creating a
qguestionnaire from a template, you can override or change some of these options in the questionnaire.

To create a questionnaire, go to the Setup and Maintenance work area, and select these options:

- Setup: Workforce Development

- Functional Area: Questionnaires

- Task: Questionnaire Templates

Click Create in the Questionnaire Templates page that appears.

ORACLE
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Questionnaire Scoring and Calculation Rules

You can select Score Questionnaire to configure the questionnaire to calculate scores based on responses.
Questionnaires made from the template can then be scored. However, it's not always necessary that a questionnaire
created from a scored template has to be scored. To score a questionnaire, you must also select the overall score
calculation rule that specifies the formula used to calculate scores.

Note: Scoring only applies to subscriber applications that allow scoring. For the Touchpoints subscriber, scoring is
enabled by default as pulse scores need to be computed and displayed as graphs in Oracle Touchpoints.

If you edit the template and deselect Score Questionnaire, existing questionnaires created from the template aren't
affected. Only questionnaires created in the future from the template aren't scored.

Section Presentation and Order

A questionnaire has at least one section. You can use sections to group questions by type or category, for example.

The Section Presentation option controls how the questionnaire uses sections. This table describes the Section
Presentation values.

Value Description
No Sections One section appears that contains all questions.
Stack Regions Multiple sections appear as specified on the Section Order option.

The Section Order option controls section order. This table describes the Section Order values.

Value Description
Sequential One section appears that contains all questions.
Random Each respondent views the sections in a different order. Reviewers view the sections in sequential

order to provide consistency when reviewing responses.

You can specify whether questionnaires based on this template can override these values.

Allowed Response Types

The Allowed Response Types controls the types of questions that are included in a questionnaire template. However,
this doesn't limit users from adding questions with other response types to a questionnaire created from this template.

Sections

The Allow Additional Questions option controls whether authorized users can add questions in the subscriber
application. For example, for performance documents, that could be managers or workers.

If you select the Required option, then respondents must answer all questions in the section.
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Question and Response Order

The Question Order and Response Order values control the order that questions and possible responses appear
to a respondent. Response order only applies to single-choice and multiple-choice questions, which contain a list of
responses.

This table describes the Question Order and Response Order values.

Value Description
Vertical Questions appear in the specified order.
Random Each respondent views the questions in a different order. Reviewers view the questions in sequential

order to provide consistency when reviewing responses.

You can override the default values of these options for individual sections. You can also specify whether questionnaires
based on this template can override these values.

Questions and Responses in Sections
In the Questions section, you manage questions for a selected section. You can:

- Add questions from the question library. You can change the response type for these questions after adding
them to the template.

- Create questions, either those that are scored, or aren't. Questions you create become part of the question
library. You must also add the question to the section after creating it from the section.

- Edit questions. Your edits are also reflected in the question library.
- Remove questions.

- Change question order by dragging them in the section. Questions appear in this order in the questionnaire if
question order is Vertical for the section

If the section itself isn't required, then you can mark individual questions as required. Otherwise, respondents must
answer all questions.

Note: You can't change the response type to Plain Text or Rich Text for questions that were originally created to
accept date responses. Similarly, you can't change the response type to Date for questions that were originally created
to accept text responses.

Review

As the final step, you can review the sections, questions, responses, response feedback, and test scoring, before saving
the questionnaire template.

Note: Once a questionnaire is created from a template, you can’t delete the template. But you can inactivate the
template.
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How You Create a Questionnaire

This topic explains how to create a questionnaire for incidents by selecting a questionnaire template and specifying
relevant information in the questionnaire. It also lists the points to consider while editing a questionnaire. Note that for
inspections, you can also create a basic questionnaire from the Inspection Items page. For more information, see the
Manage Inspection ltems topic.

Select the Questionnaire Template

In the Setup and Maintenance work area, select these options:

- Setup: Workforce Development
- Functional Area: Questionnaires

- Task: Questionnaires

If you use Performance Management, you can also go to My Client Groups > Performance > Questionnaires.

1. In the Folders section of the Questionnaires page, select the subscriber application for the questionnaire, for
example Performance 360, Recruiting, or Learning Assessments.

2. Inthe Search Results section, click Create.

3. Enter Questionnaire Template ID or Name values, if available. Alternatively, click Search to list all available
templates.

4. Inthe Search Results section, select a template and click OK.

Enter Questionnaire Basic Information

A unique numeric questionnaire ID appears automatically. You can change this value.
If this is a scored questionnaire, an overall score calculation rule appears. You can select a different rule.
Enter a Name and select a Folder. Use folders to organize questionnaires by type or purpose.

Leave the Owner field blank and the Privacy value set to Public if anyone who can access the questionnaire
can edit it. Otherwise, select an owner and set Privacy to Private.

Leave the Status value set to Draft until the questionnaire is ready.
For the Touchpoints and Journey Surveys subscribers, select a pagination option from the Display Format list.

P WNA

o w

Note: When you display one section per page, section instructions, if any, appear below the section title.
When you display all questions on a single page, questionnaire instructions and section instructions appear
below the respective titles.

7. Inthe Instructions and Help Materials section, enter and format any instructions for questionnaire users. This
text appears at the top of page one of the questionnaire.

8. Add file or URL attachments, if appropriate. Links appear at the top of the questionnaire and beneath any
instruction text.

9. Click Next.

Enter Questionnaire Contents

The Section Order and Section Presentation values are as specified in the questionnaire template, for example,
Sequential as the Section Order and Stack Regions as the Section Presentation. Depending on template settings,
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you may be able to change these values. Depending on template settings, you can edit some or all section settings. You
can also delete predefined sections and create additional sections.

1. Select the first section to view its questions in the Questions section. You can delete a question or change its
response type and Required setting.

2. If you create additional sections, you add questions to them. In the Questions section, click Add. Search for
a question, select it, and click OK. The question is added below the question that appears highlighted in the
Questions section. You can reorder the questions by dragging them by the expandable arrow that appears in
the first column and dropping them in another row.

Note: You can view the version number of the question in the Search Results section. If this column doesn't
appear, click the View menu and select Columns > Question Version Number.

3. You can also create questions for a section. Select a section, and in the Questions section, click Create.

4. Select the Folder, and enter question and response details, and click Save and Close. The question becomes
available in the question library as well. Add the question to the section using the instruction in step 2.

5. Edit questions as required. Select a question and click Edit. Enter question and response details, and click Save
and Close. The question is updated in the questionnaire and the question library.

Note: Although you can override the response types for questions while defining a questionnaire, you can't
change the response type to text for questions that accept date responses or change the response type to
date for questions that accept text responses.

o

When all sections and questions are complete, click Next.
7. Click Preview to preview the questionnaire. For scored questionnaires, click Test to verify the scoring.

Note:

o When you click Reset after testing, the previously filled responses are retained in the
questionnaire. This allows you to modify specific responses as per your needs and test the
behaviour of the questionnaire again.

o The questions in a section are displayed in the order specified in the Section Order field.

o Questionnaire surveys that are created for both Touchpoints and Journey Surveys subscribers
are distributed to respondents using the Journeys application. So, when you preview the
questionnaire survey in ADF-based pages, the response options appear in a drop-down list.
However, when you view the survey in the Journeys application, you can see the horizontal
button responses and the question display format that you've chosen.

8. C(lick OK and then click Save.

Note: If a questionnaire isn't in use, you can still add new questions that accept date response types, or create a new
version of the questionnaire to add such questions. When you edit the response type for a question in a questionnaire
that isn't in use, the updated response type is reflected in the questionnaire definition.

Editing a Questionnaire

To edit a questionnaire, go to the Questionnaires setup page, and select a questionnaire from the Search Results
section and click Edit.
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A few points about editing a questionnaire:
Set the questionnaire Status value to Active when the questionnaire is ready for use.

If a questionnaire isn't in use, you can still add new questions that accept date response types, or create a new version
of the questionnaire to add such questions. When you edit the response type for a question in a questionnaire that isn't
in use, the updated response type is reflected in the questionnaire definition.

You no longer need to go into the edit mode to preview a questionnaire. You can preview it from the Search Results
section of the Questionnaires setup page. You can preview draft, active, and inactive questionnaires.

Related Topics
- What happens if | edit a questionnaire that's in use?

How You Use Questionnaires to Create General Surveys

Use questionnaires to create stand-alone, generic surveys that aren’t linked to specific HCM product flows such as
performance or recruiting. For example, you can create an organization-wide annual survey to gather employee
feedback on specific organization functions or create an end-of-project survey to understand customer satisfaction
levels.

To create a general survey questionnaire, define a questionnaire template with the subscriber as General Surveys, and
then create the questionnaire based on the template. While creating the template and the questionnaire, select the
folder as General Surveys.

When creating general surveys, you can use all the features of questionnaires such as conditional questions, questions
with images, or questions with text or date type of responses. After creating the questionnaire, you use REST APIs for
accessing it and publishing it to specific participants.

Using REST APIs to Manage General Surveys and Responses

Use the existing questionnaire REST API resource to read and manage questionnaires, questions, and answers for
general surveys. In addition, use these REST API resources to manage the responses to general surveys:

* questionnaireParticipants

* questionnaireResponses (Chl]d resource of questionnaireParticipants)

* questionResponses (Chl]d resource of questionnaireParticipants)

Using the API resources, you can do these:
- Create a questionnaire for the General Survey subscriber.
- Access the questionnaire to review the questionnaire setup.
- Post responses to the questionnaire and update them.

- Retrieve responses from the questionnaire and view them.

Note: While these APIs allow for setting up questionnaires and posting responses to store them in HCM Cloud,
publishing the survey to specific employees is not within their scope. The user interface to publish the survey and
collect individual inputs from employees is also external to HCM Cloud.
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Secure responses posted to general surveys using a person security profile. You can only access responses from
participants that you have access to, through their person security profile.

You must have these security privileges to perform specific operations on the questionnaire Participants REST API:

Security Privilege Supported Operations
HRQ_REST_SERVICE_ACCESS_ - GET
QUESTIONNAIRE_PARTICIPANTS_RO_
PRIV
HRQ_REST_SERVICE_ACCESS_ - GET
QUESTIONNAIRE_PARTICIPANTS_PRIV

DESCRIBE

POST

PATCH

DELETE

Question Scoring Setup Options

For eligible subscriber applications, you can configure questions to calculate a score based on responses. This topic
describes aspects of creating questions that can be used to score questionnaires.

Use the Question Library task in the Setup and Maintenance work area for this task.

Eligible Question Types

Two question types are eligible for scoring:

- Single choice

- Multiple choice

If you select single choice, the question score is the value of the selected response. For multiple-choice questions, the
total value of all selected responses is the question score.

Score Question

To score the question, select Score Question. Scored questionnaires use scored questions to determine the
questionnaire score. You set the default calculation rule in the template, but this can be overridden in the questionnaire.

If a question is in use, you can't change whether it's scored or not. To create a scored question, create a new question or
copy an existing question.

You can add scored questions to questionnaires that aren't scored. In questionnaires that aren't scored, response scores
aren't available.

Tip: Use the Preview feature to ensure that the scoring works as you anticipated.
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Minimum and Maximum Calculated Scores

For multiple-choice questions you can define either, or both, minimum and maximum calculated scores. These are the
maximum and minimum scores the question can attain, regardless of how many responses the respondent selects, or
the score of the responses.

You can define the maximum and minimum calculated scores to keep them within a range that aligns with your
business process. For example, you can set maximum and minimum scores to ensure that:

- Questions in a questionnaire have consistent maximum and minimum values

- Questions aren't weighted too heavily with either too high a positive or too low a negative score

If you don't define the maximum calculated score or maximum number of responses, the maximum possible score is
the sum of all responses. When you update the score of a question, the maximum possible score of the questionnaires
that include this question are automatically updated, provided they aren't in use. However, if you have the scores
overridden for these questions at the questionnaire level or if the questionnaire is in use, then these scores will remain
unaffected by your updates to the question score.

Response Configuration

To provide responses for users to select, you must add responses. You can then specify additional configuration for the
responses.

Minimum and Maximum Number of Selections

For multiple-choice questions, you can optionally define the minimum and maximum number of selections that
respondents make to the question. If respondents don't select the specified number of responses, an error message
appears.

Short Description

When you add responses, you can define the score for the response. You must enter a short description, which appears
to respondents. You can enter any score for the response and as many responses as your business process requires.

The scores can be the same or varied. For example, you can have five responses with 5 as the score for each. Or, you
can have five responses with values of 1, 2, 3, 4, and 5.

Tip: After adding responses, use the Preview feature in the questionnaire to ensure that the list of responses isn't to
long for respondents to view effectively.

Rating Model

You can select a rating model to provide a predefined short description and score. However, you can edit both the short
descriptions and scores.

Response Feedback

You can add feedback to display messages associated with the responses selected by the respondent. This feedback
may appear to the respondent or to a reviewer depending upon configuration in the subscribing application.
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Preview

Use the Preview feature in the Questionnaire to review the questions and responses in the questionnaire. Select
answers and click Test to see the resulting score and any response feedback. Click Reset to clear the scores and test
again.

Related Topics
« How You Configure Questionnaires for Questionnaire Scoring

How You Use Translation Editor with Questionnaires and
Questions

You can translate questionnaire templates, questionnaires, and questions using the translation editor. With the
translation editor, you can review and translate text for more than one language at a time without signing out of your
current session.

For each translatable field, the translation editor helps to ensure your data is translated the way you intend. The
translations appear wherever the questionnaire templates, questionnaires and questions appear.

Eligible Languages

The languages that you can translate are those that are that are installed and active in the application. The translated
text appears in the application for the respective language a user selects when signing in.

Text that Can Be Translated

Using the translation editor, you can translate any text fields that you can edit in questionnaire templates,
guestionnaires, or questions. For questionnaires and templates, you can translate:

Name, description, and introduction

- Section title, description, and introduction

For questions, you can translate:

» Question text
- Question response short description

- Question response feedback

Translation Editor Usage

Click the Translation Editor icon to edit the translatable text in a questionnaire, questionnaire template, or question.
The icon appears on the pages and sections where the fields you can appear. In the Edit Translation dialog box that
appears, you can enter text for any available language for each field. The translated text appears in the application

for the respective language a user selects when signing in. For example, if you translate a question from English to
Spanish, a Spanish-speaking user sees the Spanish translation. If the translated text is in a language that's the same as
the language of your current session, you can see the translation apply to the Ul immediately.
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When you create a new questionnaire, template, or question, you must first save it before using the translation editor.
Once the object is saved to the database, the translation editor becomes available.

Translation Inheritance

Questionnaires inherit translations from the template. You can edit the translations to change them. Question
translations that you configure are also inherited by that question if it's used later in another questionnaire or template.
You can edit the translation either in the Question Library, or in the questionnaire or template in which it's used.

How You Configure Questionnaires for Questionnaire Scoring

You can configure questionnaires to calculate a score based on responses to questions in the questionnaire. This topic
describes aspects of creating questionnaires that are scored.

You must create a questionnaire template from which to create a questionnaire. Use the Questionnaire Templates and
Questionnaires tasks in the Setup and Maintenance work area.

Subscriber Applications

Only eligible subscriber applications can use scored questionnaires. Recruiting is an eligible subscriber to use scored
questionnaires.

Questionnaire Scoring Setup

To score a questionnaire, in the questionnaire template, select Score Questionnaire. All questionnaires made from the
template can then be scored. If you edit the template and deselect Score Questionnaire, existing questionnaires made
from the template aren't affected. Only questionnaires made in the future from the template aren't scored.

Scored Questions
To create a questionnaire that can be scored, you must add questions that have responses configured for scoring to the
section. You can either add questions from the question library or create scored questions in the section itself.

You can add questions that aren't configured for scoring to a scored questionnaire. These questions aren't included in
the overall score calculation.

Overall Score Calculation Rule

The calculation rule determines the method used to calculate the overall questionnaire score from the question scores
of scored questions. The table shows the calculation rules and the formula each uses to calculate the questionnaire
score.

Overall Score Calculation Rule Formula to Calculate Questionnaire Score

Sum Sum of question scores

Percentage (Sum of question scores / Sum of maximum possible question scores) * 100
Average Sum of question scores / Number of scored questions

334
ORACLE



Oracle Fusion Cloud HCM Chapter 15
Using Common Features for HCM Workforce Profiles

When calculating the score, questions that are configured for scoring, if no score is provided, the application considers
such questions as no value.

Questionnaire Score Calculation Example
As an example for calculating the score, consider a questionnaire with the attributes shown in the table.

Attribute Value
Calculation rule Average
Total number of questions 10
Number of questions configured for 9
scoring

Number of questions that can't be scored 1

Maximum value of each response 5

For this questionnaire, the maximum possible score is 45 (9 x 5). The maximum average score is 5 (45/9).

A respondent responds to the questionnaire and selects the maximum value of 5 for eight of the nine scored questions,
leaving one blank. The respondent also selects a response for the question that isn't scored. The application calculates
the questionnaire score in the following manner:

- The sum of the responses is 40 (8 x 5). The question that isn't scored doesn't affect the score.

- Using the Average calculation rule, the final questionnaire score is 4.44 (40/9).

Preview

Click Preview to review the questionnaire questions and scoring. Select answers and click Test to see the resulting
questionnaire score and any response feedback. Click Reset to clear the scores and test again.

Related Topics
¢ Question Scoring Setup Options

Export and Import of Questionnaire Data

Streamline the mass upload of Questions, Questionnaire Templates, and Questionnaires by using HCM Data Loader and
HCM Spreadsheet Data Loader. Import any type of questions within the questionnaire, including the response choices
in choice-based questions.

Note: You can import images for questions and responses and import attachments for questionnaire information
using HCM Data Loader.
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You can create questionnaire objects or manage the existing ones. You can load data for Questions and Question
Answer Responses by using the Question data file. You can create questionnaire templates and questionnaires
including the sections, questions, and answers that are a part of the questionnaire.

You can load the translation data of these business objects by using the translation data files. To use HCM Spreadsheet
Data Loader in the Data Exchange work area, you need to first create a spreadsheet template, then upload it using the
Load Spreadsheet Data task.

Related Topics
« Overview of Loading Questions, Questionnaire Templates, and Questionnaires

« Guidelines for Loading Questions, Questionnaire Templates, and Questionnaires
« Examples of Loading Questionnaires

- Examples of Loading Questionnaire Templates

» Examples of Loading Questions

What happens if | edit a questionnaire that's in use?

When you edit a questionnaire that's in use, you're prompted to either create a new version of the questionnaire or
update the existing version.

When you update the questionnaire, the existing responses could become invalid. So it might be better to create a new
version of the questionnaire.
Here's what happens when you update an existing questionnaire:

- If respondents answered questions and saved the questionnaire before the update, their saved responses
continue to appear when they reopen the questionnaire after the update.

« The status remains Active.
- The questionnaire version remains the same.

- TheIn Use status is Yes.

Note: You can edit the questionnaire as needed, but it's best to limit the edits to those that have a minimal impact,
such as changing text. Adding questions, marking questions as required, or changing responses to choice-based
questions can result in issues for questionnaires that are already completed. This applies to questionnaires used in
performance documents, anytime performance documents, requested feedback, and check-ins.

You can update these attributes in a questionnaire that's In Use:

- Name of the questionnaire

- Folder (category) of the questionnaire
- Owner

- Status

» Privacy

- Description

+ Instructions

- Attachment for questionnaire
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- Section order (if allowed from base questionnaire template)

- Section presentation (if allowed from base questionnaire template)

- Response order (positional randomization for answers)

- Name, description, and instruction text of section (if allowed from base questionnaire template)
- Position of questions (drag and drop feature is allowed)

The changes take effect as soon as you save the questionnaire. Respondents see the changed version in these
scenarios:

- Creating a new performance document that includes a questionnaire
- Editing a questionnaire in a performance document that's in progress
- Reopening a previously completed performance document to edit the questionnaire

- Check-in documents always refer to the latest version of the questionnaire referenced in the check-in template.
If you need a new version of a questionnaire for new check-in documents, it's recommended you create a
new check-in template that includes a new questionnaire, instead of creating a new version of the existing
questionnaire. This helps you preserve the questionnaire responses in existing check-in documents.

Here's what happens when you create a new version of a questionnaire:

- The previous version isn't affected.

- The status of the new version is set to Draft.

- The questionnaire version number increases by one.
- The In Use status is set to Prior Version.

When a questionnaire is completed using this version, the In Use status changes to Yes. The changes take effect when
you set the status to Active and save the questionnaire. Respondents see the new version in these scenarios:

- Creating a new performance document that includes a questionnaire
- Editing a questionnaire in a performance document that's in progress:

o If respondents answered questions and saved the questionnaire prior to the new version, their saved
responses don't appear when they reopen the new version. Instead, they see the new version of the
questionnaire.

- Reopening a previously completed performance document to edit the questionnaire.

o The questionnaire version you see for completed performance documents before reopening is the
version in which it was completed.

- Creating a new check-in document

- Opening an existing check-in document to edit the questionnaire
- Creating a new requested feedback

- Editing a questionnaire in requested feedback that's in progress:

o If respondents answered questions and saved the questionnaire prior to the new version, their saved
responses don't appear when they reopen the new version. Instead, they see the new version of the
questionnaire.

What happens if | edit a question that's in use?

Editing questions when responses already exist can invalidate responses. It's recommended that you copy the question
over to a new questionnaire and then make the changes you want.
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Anytime Feedback

Overview of Anytime Feedback

Anytime feedback is unsolicited feedback you give to anyone in your organization. You may also receive anytime
feedback from anyone in the organization. This feedback is independent of the participant feedback process in
performance documents.

You can create feedback for yourself or any other person, and also edit and delete the feedback that you create. All
feedback have visibility rules set for them, which determines who can see them. The person who provides the feedback
decides the visibility rules.

Related Topics
- Considerations for Configuring Anytime Feedback Visibility Options

« Anytime Feedback Notifications
« Add and Hide Components Using Page Composer

View Anytime Feedback Given to You

There are many ways to view anytime feedback that you received.
Here are some ways to do it:

« Go to Me > My Public Info. Click Show More on the left navigation pane and select Feedback
- Go to Me > Career and Performance > Feedback
- Go to Me > Quick Actions > Show More > Career and Performance > Feedback

The Feedback Given to Me section on the Feedback page lists the feedback you received. You can filter the list based on
the author of the feedback or period of feedback (for example, past six months).

For each feedback, you can view these details:

Name of the employee who gave the feedback
Date of the feedback
- Visibility of the feedback
- Contents of the feedback
Note: If the feedback is set to Visible to Everyone or Visible to Managers, Peers, and [Employee], you can hide it
by clicking the Hide link. The person who receives feedback and the HR specialist who has administrative oversight of

the person can hide the feedback, if the content isn't appropriate. Only the person who hides the feedback can unhide
it. The author can view the feedback and see that it's hidden.

You can thank the feedback provider by selecting Send Thank You from the Actions menu. You can thank the feedback
provider multiple times for the same feedback. Any others (including HR specialists) who can view the feedback can also

338
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=s20043669

Oracle Fusion Cloud HCM Chapter 15
Using Common Features for HCM Workforce Profiles

thank the feedback provider multiple times for the same feedback. When you send the thank you note, the feedback
provider receives an email notification about it. They can also view the thank you note from their worklist.

Note:

- The thank you feature is available only if the notification template Worker Thanks Anytime Feedback Provider,
which is a part of the Anytime Feedback Provided alert, is enabled in Alerts Composer. Even if the feedback
notification in Talent Notifications is disabled, you can still use this feature as long as the Anytime Feedback
Provided alert is enabled.

- The thank you note is not saved in the application. Therefore, it's visible only in feedback provider’s email
notification or worklist.

Related Topics
« Overview

- Anytime Feedback Notifications

View Anytime Feedback Given to Others

There are many ways you can view anytime feedback that you gave to others.
Here are some ways to do it:
« Go to Me > My Public Info. Click Show More on the left navigation pane and select Feedback.

- Go to Me > Career and Performance > Feedback
- Go to Me > Quick Actions > Show More > Career and Performance > Feedback

On the Feedback page that's displayed, you can filter the feedback list based on the recipient's name or feedback
period.

For each feedback, you can view these details:

Recipient's name

Date of the feedback
- Visibility of the feedback
- Contents of the feedback

View Anytime Feedback Received for Your Employees

As a manager or HR specialist, there are many ways you can view anytime feedback received for your direct and indirect
reports, or the employees in your organization.

However, you can view this feedback only if the feedback visibility is set to Everyone, Managers Only, Managers,
peers, and [Employee], or Manager and [Employee].

As a manager, you can view anytime feedback in some of these ways, for example:
- Go to My Team > My Team. Click the Actions menu (shown by three dots) next to the employee's name, and
select Feedback.
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- Go to My Team > Quick Actions > Career and Performance > Feedback, and search for, or select the name of
the employee.

As an HR specialist, you can use some of these navigation paths, for example:

- Go to My Client Groups > Quick Actions > Show More > Talent > Feedback. Select an employee.

- Search for an employee using the Search bar on the global header and click their name from search results.
Click Show More from the left navigation pane and select Feedback.

The Feedback Given to [Employee Name] section on the Feedback page lists the anytime feedback that the employee
has received. You can filter the list based on the author's name or period of feedback.

For each feedback, you can view these details:

Name of the person who gave the feedback
Date of the feedback

- Visibility of the feedback

- Contents of the feedback

You can thank the feedback provider by selecting Send Thank You from the Actions menu. You can thank the feedback
provider multiple times for the same feedback. Any others who can view the feedback can also thank the feedback
provider multiple times for the same feedback. When you send the thank you note, the feedback provider receives an
email notification about it. They can also view the thank you note from their worklist.

Note:

- The thank you feature is available only if the notification template Manager/HR Thanks Anytime Feedback
Provider, which is part of the Anytime Feedback Provided alert, is enabled in Alerts Composer. Even if the
feedback notification in Talent Notifications is disabled, you can still use this feature as long as the Anytime
Feedback Provided alert is enabled.

- The thank you note is not saved in the application. Therefore, it's visible only in feedback provider’s email
notification or worklist.

Related Topics
« Overview

- Anytime Feedback Notifications

Provide Anytime Feedback as a Manager or HR Specialist

As a manager or HR specialist, you can provide anytime feedback to your report, team member, or others in your
organization.

1. You can access the Feedback page in many ways. Here are some options:
o Go to My Team > My Team, and select an employee's name. Click Show More on the left navigation pane,
and select Feedback.
o Go to My Client Groups > Quick Actions > Show More > Talent > Feedback.

2. In the Feedback Given to [Employee Name] section, click Add.
3. Select who can view your feedback and enter the feedback comments.
4. Click Save.
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Provide Anytime Feedback as a Worker

Workers can provide anytime feedback for other workers in several ways. For example, using Person Spotlight or Quick
Actions.

Provide Feedback Using Person Spotlight

1. Search for an employee using the Search bar on the global header, and click their name from search results.

2. Click the More Information menu (shown by three dots) on the person’s image, and select Feedback. The
Feedback page appears.

3. Click Add in the Feedback Given to [Employee Name] section.

4. Select who can view your feedback and enter the feedback comments.

5. Click Save.

Providing Feedback Using Quick Actions

1. Go to Me > Quick Actions > Show More > Career and Performance > Provide Feedback.
2. Enter the feedback recipient's full or partial name. A list of matching names appears in the list.
3. Select the person you want to provide feedback for.

Note: If you want to provide feedback for another recipient instead of the current one, click the Remove
[Recipient Name] icon, and select another.

4. Select who can view your feedback and enter the feedback comments.
5. Click Submit.

You can also add anytime feedback for yourself by navigating to Me > Career and Performance > Feedback >
Feedback Given to Me.

Edit or Delete Anytime Feedback

Your role determines whether you can edit or delete anytime feedback and change its visibility settings. The different
permissions depending on the role are described here.

Author of the feedback

If you created an anytime feedback for yourself or for others, you can revise, delete, or change the visibility settings of
the feedback.

Manager

As a manager, you can't edit or change the visibility settings for anytime feedback that others have given to your
reports. You can delete that feedback only if you're the author of the feedback, or if you also have the HR specialist role.
If you need edit permissions, contact your administrator for the required privileges.

HR Specialist

HR specialists can delete anytime feedback received by the employees in the organization, when the feedback visibility
is set to Everyone, Managers Only, Managers, peers, and [Employee], or Managers and [Employee]. They can
delete any feedback that they create, regardless of the visibility setting.
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They can hide public feedback that they haven't authored, if the feedback visibility is set to Everyone or Managers,
Peers, and [Employee].

HR specialists must have the Hide HCM Person Note and Delete HCM Person Note aggregate privileges in order to
delete or hide the anytime feedback.

Note: When others provide anytime feedback for you, you can hide the feedback, if the visibility is set to Everyone.
You can't delete or edit the feedback.

To edit or delete anytime feedback, follow these steps:

1. Go to the Feedback page.

2. Inthe Feedback Given to [Employee Name] section, you can optionally filter the list by the recipient's name or
feedback period.

3. Click Edit next to the feedback that you want to revise or delete.
4. Change the visibility or edit comments, as required, and click Save. To delete the feedback, click Delete.

To edit or delete the anytime feedback you added for yourself, go to Me > Career and Performance > Feedback >
Feedback Given to Me and follow the same procedure as above.

Note: Using HCM Data Loader, HR specialists can delete anytime feedback responses for multiple employees at once.

Anytime Feedback Notifications

You can notify workers and their managers when they receive anytime feedback in their Feedback spotlight page and in
Connections.

You can enable or disable notifications sent to the manager or worker using the Talent Notifications task. You can
access the task in one of these ways:

- Go to the Setup and Maintenance work area, select Workforce Deployment from Setup, and select Workforce
Profiles in Functional Area. Select the Talent Notifications task and click the Profile Management tab.

- Go to My Client Groups > Performance > Talent Notifications and click the Profile Management tab.
Enable or disable these options as per your business needs:

- Feedback Notification to Manager

- Feedback Notification to Worker

The settings affect all workers and managers throughout the application.

Considerations for Configuring Anytime Feedback Visibility
Options
You can configure feedback visibility options and default options to specify who can see feedback.

Use the Manage Feedback Visibility task in the Setup and Maintenance work area, Workforce Deployment (or
Workforce Development) offering, Workforce Profiles functional area.
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I Note: You must have the Manage Feedback Visibility functional privilege to access this configuration task.

Feedback Context

You can set feedback for the following contexts:

- ORA_NO_CONTEXT: Used for feedback notes for a person in the person spotlight, person smart navigation,
and elsewhere throughout Oracle Fusion applications.

- ORA_TALENT_REVIEW_TYPE: Used for feedback notes only for talent review meetings. Notes created in
a talent review are visible as Feedback elsewhere in Oracle Fusion applications, but no Feedback created
elsewhere appears in talent review meetings.

- ORA_CELEBRATION_TYPE: Used for configuring visibility settings for the Celebrations feature in Oracle Fusion
Cloud Touchpoints. When an employee or manager sends a celebration card to others using Touchpoints, they
can choose from one of the visibility settings available for this context type: Managers and worker, and Only
worker and me.

Visibility Options and Defaults

Select roles to make them eligible to view feedback. Users can select the roles when they create feedback so that the
roles can view it. All settings are available unless you deselect them.

The options and descriptions for each visibility option are shown in the table.

Visibility Option Description
Everyone A public note visible to any person in the organization.
Managers only Visible to only the managers in the hierarchy of the worker for whom the feedback is created. Visible to

HR specialists as well.

Managers and worker Visible to managers in the hierarchy of the worker, and the worker who receives the feedback. Visible to
HR specialists as well.

Managers, peers, and worker Visible to managers in the hierarchy of the worker, and the worker who receives the feedback. Also
visible to peers of the worker who report to the same manager as the feedback recipient in one or more
active or suspended assignments. Visible to HR specialists as well.

Only me A private note created by an author about themselves or about another person and is visible only to
the author.
Only worker and me A private note created by an author about the worker and is visible only to the worker and the author.

Note: For peers to view notes that have the Managers, peers, and worker feedback visibility option, they need to
have the View HCM Person Note Shared with Peers data privilege.

HR specialists can view all feedback except those with these visibility settings:

- Only me
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- Only worker and me

Note: Feedback visibility is also determined by data security; you can only create or see notes for people whom you
have authorization to view.

Defaults

You can edit the default value that appears in the Visibility choice list when a person creates feedback. If you select the
No default option, no predefined option appears in the field. Users can select the available options whether a default is
set or not. Default settings for the contexts are as follows:

o ORA_NO_CONTEXT: No default
- ORA_TALENT_REVIEW_TYPE: Managers only
- ORA_CELEBRATION_TYPE: Managers and worker

If you don't edit the visibility options or defaults, the default settings apply.

Deleted Context Settings

If you delete context settings, users can still add and view feedback, but you can no longer edit the context settings.
When you delete feedback context settings, the following rules apply:

If you delete only ORA_NO_CONTEXT, the predefined default values for ORA_NO_CONTEXT applies for the
person feedback. All visibility options are available, and the default setting is No default.

If you delete only ORA_TALENT_REVIEW_TYPE, the ORA_NO_CONTEXT settings apply for both the person
feedback and talent review feedback.

« If you delete both ORA_NO_CONTEXT and ORA_TALENT_REVIEW_TYPE, the predefined default values for
ORA_NO_CONTEXT apply for both the person feedback and talent review feedback.

How to Enable the Rich Text Editor Toolbar in Feedback or Notes

Using the Rich Text Editor (RTE) toolbar, users can provide their feedback or notes with formatted text, images, and
URLs.

When you enable the RTE toolbar, it appears in all pages that use feedback or notes across Talent Review, Goals,
Performance Management, and so on. The exception to this behavior is the Provide Feedback page (from Quick
Actions). When you enable it on the Provide Feedback page, the changes aren’t carried over to other feedback pages
and vice versa.

Note: You can’t enable the toolbar in feedback pages that are a part of VBCS-based applications such as Connections
or Touchpoints.

Before you start
Create a sandbox with the Structure and Page Composer tools in it, and activate the sandbox.

Here's what to do

1. Open a feedback page. For example, go to My Team > Quick Actions > Show More > Feedback.
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2. Select an employee, and click Add in the Feedback Given to <Employee Name> section.
3. Click your user name or image in the global header, and select Edit Pages.

4. Click the Structure tab. A component panel appears at the end of the page. Drag it to the middle of the page to view
the list of page components.

5. Click the What do you want to say? section heading on the Feedback page. If a dialog box appears, prompting you
to confirm editing of the component, click Edit.

6. In the component panel, you will find that the corresponding component, panelLabelAndMessage: What do you
want to say?, is highlighted. Select the Text component displayed below this component.

7. On the component panel’s toolbar, click the Show the properties of Text icon.

8. In the dialog box that appears, change the value of Toolbox Layout field from none to one or more toolbar icons that
you want displayed on the toolbar. For example, enter this text:

font history mode color formatAll justify list indent link

9. Click Apply, and then click OK.
10.Click Close on the top right of the page to exit the Edit Pages mode.

Results:
The What do you want to say? section now has the toolbar icons enabled.

Related Topics
« Create and Activate Sandboxes

FAQs for Workforce Profiles

What's a rating category?

A label for a grouping of rating levels. Rating categories are used in talent management processes such as performance
management and talent reviews to group ratings for analysis tools (performance and potential box chart, for example.)

Why are some content type relationships not editable?

Predefined content type relationships aren't editable. You can only edit content type relationships that you define.

How can | define a relationship between the Goals content type
and other content types?

Set up the relationship on the content type that you want to relate to goals using the relationship type: Is supported by.
For example, to define a relationship between the Goals and the Competencies content types, set up the relationship on
the Competencies content
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What's a free-form content type?

Free-form content types enable you to capture information in a profile that you needn't store in the content library. For
example, you can set up a free-form content type to store information about the previous employment information for
your workers. Use the Manage Content

A free-form content type contains only a code, name, and a description, and doesn't have any properties until you add
it to a profile type. Free-form content types don't include any content items. You can use free-form content types when
you don't need a content item because the attribute captured for the content section is free-formed or less-structured.
For example, you can set up a free-form content type to store information for accomplishments, career statements, and
honors and awards.

Why can't | change the relationship type of a content item?

You can't change a content item's relationship type because it is derived from its content type. You can only change
relationships at the content type level from the Edit Content Type page in the Profiles work area. You can't change
predefined relationships.

How can | delete an attribute from the person profile?

You must have the HR specialist role to delete an attribute from the person profile.

I Note: You can hide predefined attributes, but you can't delete them.

To delete an attribute that isn't a predefined attribute from the person profile:

Click Manage Profile Types on the Tasks tab in the Profiles work area.

Search for the Person profile type and select the row for the profile type in the Search Results section.
Click Edit in the Search Results section to open the Edit Profile Type page.

On the Content Sections tab, select the content section that includes the attribute you want to delete.

In the Content Sections region, click the selected content section link to open the Content Section page.
In the Content Properties section, select the row for the attribute and click Delete.

CUPAWNRD

What happens if | enable custom approval rules for the person
profile type?
HR specialists and implementors can enable custom approval rules for the person profile type:

- They can define approval rules for each content section related to the person profile type.

- When a worker submits changes for all approval-enabled content through the Edit Skills and Qualifications
page of the worker's talent profile, notification is sent to approvers based on the default approval rules.
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To enable the custom approval rules for the person profile type, select the Person profile type on the Manage Profile
Types page and click Edit. You then select the Enable Custom Approval Rules check box on the Edit Profile Type page.
For configuring approval rules for person profiles, use the Manage Approval Rules interface.

Related Topics
» Guidelines for Managing Approval Rules

» How You Enable Approvals for Content Types
« How You Create Person Profiles

Can | edit skills and qualification data of a person's profile?

Yes. Depending on the content section access settings for your role, you can view and edit any of the predefined or
custom content of a worker's profile.

How can | add content to my profile?

Select Me > Skills and Qualifications on the Home page. Click Edit on the Skills and Qualifications page to edit or add
the content to your profile.

Depending on the content section access settings for your role, you can view and edit any of the predefined or custom
content on your profile.

What happens if | don't add a label for a content section property?

If you don't enter a value in the Label field for a content section property, the application uses the value in the Column
Name field as the default value. To open the Content Section page, click the Manage Profile Types task in the

How can | diagnose issues with Oracle Fusion Profile Management
data?

After populating the Oracle Fusion Profile Management data tables, you can run the Profile Management Integrity
Validations test if you have access to the Diagnostic Dashboard. Select Run Diagnostic Tests from the Setting and
Actions menu in the global area. The validations test

For Profile Management, the test validates four categories of data integrity:

Business Group Validation: Checks the business group is valid and exists in the Oracle Fusion Global Human
Resources business group table.

Foreign Key Validation: Foreign key attributes must not be null.
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Field Level Validation: Field level attributes must match the business rules set up in Profile Management

Row Count Validation: The row count on the setup tables must be greater than O.
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16 Workflow Notifications and Approvals

Overview of Notifications and Approvals

Approval management uses human workflow to automate tasks that are passed from a user or an application to
another user or group for consideration or action. Workflows are routed in a predefined sequence to achieve an end
result.

Examples of tasks include approving a time card or completing an employee performance appraisal.
Approval management enables administrators to do these tasks:

- Control workflows for business processes such as hiring an employee or managing promotions.
Define task routing policies that can be as simple or as complex as needed.

Derive approvers based on the supervisory hierarchy, areas of responsibility (such as HR or Benefit
Representatives) and other criteria, such as job levels because approval management is fully integrated with
HCM.

For workflows, Oracle Fusion Applications uses the approval management extensions of the human workflow services
from Oracle Service-Oriented Architecture (SOA) Suite as well as the Oracle Business Process Management (BPM)
Worklist application.

Here are the main features of Oracle SOA Suite:

It's a comprehensive software suite used to build, deploy, and manage service-oriented architectures.
Provides a human workflow service that handles all interactions with users or groups in business processes.

For more information about using human workflow in SOA Suite, see Developing SOA Applications with Oracle SOA
Suite.

Oracle BPM Worklist provides an interface for:

Users to access tasks assigned to them and perform actions based on their roles in the workflow.

Implementors to perform approval management setup, to define who should act on which types of transactions
under what conditions.

For more information about working on tasks, see Managing and Monitoring Processes with Oracle Business Process
Management.

Roles That Give Workflow Administrators Access

Workflow administrators for a specific product family need a predefined, family-specific workflow role to access tasks
and manage submitted tasks for that family. To configure workflow tasks, they also need BPM Workflow System Admin
Role (BPMWorkflowAdmin).

For example, administrators with the family-specific roles can do things like reassign submitted tasks, but they also
need BPM Workflow System Admin Role to define approval rules. Other than the family-specific workflow roles, there's
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also BPM Workflow All Domains Administrator Role (BPMWorkflowAlIDomainsAdmin). This gives administrators access
to all product families. Assign to the administrators a role that contains the workflow roles appropriate for their needs.

Workflow Roles

Here are the roles that give access to workflow administration.

Product Family

All

All

Financials

Higher Education

Human Capital Management

Incentive Compensation

Procurement

Project Management

Sales

Supply Chain Management

Role Name

BPM Workflow All Domains Administrator Role

BPM Workflow System Admin Role

BPM Workflow Financials Administrator

BPM Workflow Higher Education Administrator

BPM Workflow Human Capital Management

BPM Workflow Incentive Compensation
Administrator

BPM Workflow Procurement Administrator

BPM Workflow Project Administrator

BPM Workflow Customer Relationship
Management Administrator

BPM Workflow Supply Chain Administrator

Things to Know About the Roles

Here are some things to know about how these workflow roles should be used and what the roles let administrators do.

Role Code

BPMWorkflowAllIDomainsAdmin

BPMWorkflowAdmin

BPMWorkflowFINAdmin

BPMWorkflowHEDAdmin

BPMWorkflowHCMAdmin

BPMWorkflowOICAdmin

BPMWorkflowPRCAdmin

BPMWorkflowPRJAdmin

BPMWorkflowCRMAdmin

BPMWorkflowSCMAdmin

- If your administrators manage workflow for multiple product families, you should give those users a custom
role with the appropriate family-specific workflow roles added.

- If your administrators manage workflow for all product families, give them a custom role with BPM Workflow All

Domains Administrator Role.

CAUTION: Assign BPM Workflow All Domains Administrator Role only if your administrators really do need
access to workflow tasks from all product families. For access in multiple product families, but not all, use the
workflow roles for the corresponding families instead.

- All administrators can see to-do tasks, no matter which role they have for workflow administration.
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- Only administrators with either BPM Workflow All Domains Administrator Role or BPM Workflow System Admin
Role would have Skip Current Assignment as an action to take on workflow tasks.

Related Topics
-« Assign Roles to an Existing User

- Edit Job Role and Abstract Role

- Role Copying or Editing

 Actions and Statuses for Workflow Tasks
- Create Roles in the Security Console

Search for Workflow Tasks to Configure

Some workflow setup applies to all tasks, but most of the time you configure specific tasks. To work on a specific
workflow task in BPM Worklist, you first run a search and then select the task from the search results.

1. Inthe Setup and Maintenance work area, go to the Manage Task Configurations task in the Application
Extensions functional area. Or, depending on your offering, you might use a different functional area or
another approval setup task.

2. In BPM Worklist, on the Task Configuration tab, run a search in the Tasks to be configured pane.

3. If you don't get any results, or the ones you want, change your search term and try again.

Here are some things to know about the search:

- This searches against various attributes, for example the task title (the one on the General subtab that appears
on the Task Configuration tab after you select a task from the search results), application name, and category.
But, the search doesn't match against the task name you see in the search results.

- The search is case-sensitive.
- Search by * if you want all tasks in the search results.

- Only default tasks are included in the search results. You can click Show and select the Active Versions check
box to get both default and active tasks.

Related Topics
» How do | update existing setup data?

Disable or Enable Workflow Notifications

If you have BPM Workflow System Admin Role (BPMWorkflowAdmin), you can disable or enable email and in-
app notifications for all users. For example, disable when testing changes to approval rules, to avoid sending test
notifications. When done testing, reenable notifications.

When workflow tasks are assigned to users, they can get email notifications, as well as in-app notifications from a few
places:

- The Things to Finish section on the home page.
- The notifications list in the global header.
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- The Notifications page, which users can open from either of the first two places to see all their in-app
notifications.

Here are things to know about disabling workflow notifications:
- You disable only email notifications that are sent as part of workflow tasks, not all emails in general.

Users can still find their workflow tasks in the Worklist: Notifications and Approvals work area.

I Note: If the Approvals work area is enabled, it replaces the Worklist: Notifications and Approvals work area.

Set the Notification Mode

Here's how you disable or enable workflow notifications:

Click the Notifications icon in the global header.

Click Show All.

On the Notifications page, click the Worklist button.

In BPM Worklist, click your user name and select Administration.

On the Administration tab, open the Application Preferences page and go to the Notification section.
Select a value from the Notification Mode list:

cuhAhUNA

o All: This is the default value.

- Email notifications are enabled.
- Workflow naotifications are included in the global header, home page, and Notifications page.
o None:

- Email notifications are disabled.
- Workflow notifications aren't included in the global header, home page, and Notifications page.
o Email:

- Email notifications are enabled.
- New workflow notifications won't appear in the global header, home page, and Notifications page.
o In-app:

- Email notifications are no longer sent.
- Workflow notifications in the global header, home page, and Notifications page are enabled.
7. Click Save.

Related Topics
« More Setup for Workflow Email Notifications

« Send Test Workflow Email Notifications to One Address

« View and Act On Notifications
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Synchronize Notifications in the Global Header and
Home Page with Workflow Tasks

Users can get in-app notifications for the same workflow task in various Uls, as well as email notifications. The
Synchronize Notifications in Global Header scheduled process ensures that all the in-app notification Uls reflect the
latest task status.

When workflow tasks are assigned to users, they can get an email as well as a notification in the global header and
in the Things to Finish section on the home page. Updates they make to tasks from the global header, for example
approving them, are automatically reflected in the Things to Finish section. Same goes the other way around, too.

But, the notifications don't immediately reflect changes to the task status if users take action through email, the
Worklist: Notifications and Approvals work area, or BPM Worklist. For example, after you approve a task from email, you
can still see the notification in the global header and home page asking for approval. Another case like that's when a
task is assigned to an approval group, and everyone in the group gets a notification. Say you approve that task from the
Things to Finish section. Your notification is removed from that section and the notifications list in the global header,
but the same notification is still there for everyone else in the approval group.

Note: If the Approvals work area is enabled, it replaces the Worklist: Notifications and Approvals work area.

So, use the Synchronize Notifications in Global Header scheduled process to synchronize notifications with the latest
task status for all users:

- This affects the notifications list in the global header, the Things to Finish section, and the Notifications page
that shows all notifications, not just what's pending for the user.

- The process includes notifications not just for tasks that require action, but also ones that are just FYI.

- The process doesn't update the title of notifications in the global header, home page, or Notifications page. Like
email subjects, the notification titles are static.

Note: No matter what the task status is, the scheduled process also removes notifications that are older than 30 days
from the notifications list, Things to Finish section, and Notifications page.

Even when notifications aren't in sync with the latest workflow task status, users can still find the latest task status in the
Worklist: Notifications and Approvals work area.

I Note: If the Approvals work area is enabled, it replaces the Worklist: Notifications and Approvals work area.

Schedule the Process

In the Scheduled Processes work area, submit the Synchronize Notifications in Global Header process to run on a
schedule. It's recommended that you schedule the process to run every two hours. How often you should run the
process depends on the volume of approvals. For example, there might be more during month-end or year-end
activities. But if you do need to run the process more frequently, don't schedule it to run more often than every 30
minutes.
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How long the process takes to run also depends on the volume of approvals. If you're running the process for the first
time, or it hasn't run in a very long time, then the process might take hours to finish.

You need to have the Manage Scheduled Job Definition (FND_MANAGE_SCHEDULED_JOB_DEFINITION_PRIV) privilege
to run this process. Your security administrator can assign a custom job role with this privilege.

What Happens After Synchronization

One key thing that affects what users see in the notifications list, Things to Finish section, or Notifications page is
whether the workflow task is pending for the user. Here's an example of what happens before and after the scheduled
process runs:

1. A notification is pending a user's approval.

2. The user approves the task from email. The task status changes, but the notification requesting approval is still
in the global header and Things to Finish section.

3. After synchronization, because the task status is Completed and the task is no longer pending for the user,
here's what happens to the notification:

o It's removed from the list in the global header.
o It's nolonger a card in the Things to Finish section.
o On the Notifications page, it moves from the Assigned to Me tab to the All tab.

Related Topics
« Submit Scheduled Processes and Process Sets

How You Define Approvals for Human Capital
Management

You can manage approval policies using the tasks Manage Approval Transactions for Human Capital Management and
Manage Task Configurations for Human Capital Management.

Managing Approval Transactions

Using the Manage Approval Transactions page, you can configure approval policies for many HCM tasks, including, but
not limited to, the following:
Hire
Promote
- Transfer

. Terminate

You can select approvers for a task, arrange approvers in the required sequence, define approval rules for each
approver, and configure conditions for each rule.
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Managing Task Configurations
The Manage Task Configurations for Human Capital Management task navigates to the BPM Worklist. You can use
the BPM Worklist to review and configure approval policies for HCM tasks; however, we recommend that you use the
Manage Approval Transactions for Human Capital Management task. Using either Ul, you can configure the following
approval details:

- When to issue approval notifications

- Who can access task contents

- What actions are available to approvers

- What to do when errors occur during approval routing

- When tasks expire or when should tasks be escalated

- When approvers can add additional approvers

Note: The HCM Simplified Ul does not allow you to modify rules that were created using Advanced Mode in the BPM
Worklist. If you originally created your rule conditions using Advanced Mode in the BPM Worklist, you must continue
to use the BPM Worklist to make changes.

Approval Flow

Approval Management configuration options for Oracle Fusion Human Capital Management determine most of the
actions that are available to the participants in the approval process. For example:

Either approver can reject the transaction. By default, the approval process stops when the transaction is
rejected.

- The second-level manager can push the transaction back to the first-level manager, who then has a second
opportunity to review the transaction and either approve or reject it, as appropriate.

Insertion of approvers in the approval list is permitted.

- Approvers can delegate their approval responsibilities to other approvers.

If you change the default settings of the Approval Management configuration options for a task, then different actions
or action outcomes become available to this approval flow.

Related Topics
« How You Manage HCM Approval Transactions

How You Manage HCM Approval Transactions

Use the Transaction Console to easily monitor daily tasks related to HCM approvals.
In the Navigator menu, select Tools and then Transaction Console.
The Transaction Console provides diagnostic information and search capabilities that enable HCM Administrators to:

- See the current status of all of the approval tasks in the application.
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- Monitor tasks that have failed and take appropriate actions like withdraw or reassign to resolve stuck
transactions.

- Search approval tasks based on user defined criteria.
- Save search criteria.

- Export the queried results to a spreadsheet.

- Set up approval rules and routing policies.

- Set up transaction flows to bypass approvals.

Approval Rules Tab

To view or configure the approval rules for a transaction, search for the transaction and click the Configure button in the
Rules column in the search results. This opens the Rules configuration page where you can edit and save approval rules.

For more information, see the Basics of Approval Rules document on Oracle HCM Cloud Common Features Release 13
Transaction Console (2430452.1) on My Oracle Support at https://support.oracle.com.

Transaction Summary Tab

You can monitor all the tasks in the application and can search and filter the results based on various criteria. The
Transaction Summary tab provides information on whether a process has failed or is pending, and how many instances
of the process have failed or are pending. An approval process may fail due to various reasons, for example, if there is a
network or database outage or an issue in the approval rules setup. An approval process may also remain in a pending
state waiting for approval. For failed processes, you can view the error message generated in the application, and for
pending processes, you can view the list of approvers. You can also view the current status of the approval which shows
who the transaction is with or who might have already approved it. You can either withdraw a failed process or configure
the approval rules and resubmit the process. If you withdraw the process, then the process is canceled and you can
either start or submit a new transaction.

You can select a transaction and drill-down to the details page to download a diagnostic log that gives you more
information on the transaction. In addition, if there are any attachments in the transaction, you can view those details as
well in the log.

Archived Transaction Summary Tab

The Archived Transaction Summary tab of the Transaction Console lists transactions that have been archived by the
Archive Transaction Console Completed Transactions scheduled process. You need to have the Review Archived
Approval Transactions privilege to view this tab. This tab lists the details of the archived transactions and the time the
Archive Transaction Console Completed Transactions scheduled process was last run. You can filter the transactions
on this tab by these attributes:

- Transaction ID
- Object name

« Process name

Click the object name to view its details such as approval history, comments and attachments, issue comments, and
timeline. You can download the details of the archived transactions.
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Bypassing Approvals

The application automatically initiates the approval process upon submitting a transaction, if the transaction has
approvals configured. You can override this behavior by enabling the Bypass Approvals option for the transaction. If you
bypass approval for a transaction, the transaction is committed immediately upon submit and is not routed for approval.

Note: When you submit a termination transaction, you can select the Deferred processing option to postpone
processing the transaction until the termination date. This option is typically used in future-dated terminations.
However, if you enable Bypass Approvals for the termination transaction, the Deferred processing option will not be
available for selection.

For more information, see The Basics of Approval Rules in Oracle HCM Cloud Common Features Release 13 Transaction
Console (2430452.1) on My Oracle Support at https://support.oracle.com.

Diagnostic Log

You can select a transaction and drill-down to the details page to download a diagnostic log that gives you more
information on the transaction. In addition, if there are any attachments in the transaction, you can view those details in
the log too.

If you download the diagnostic log for a pending or error transaction, you can see the details in the Task Level
Configuration and Transaction History sections.

Note: The display of the Task Level Configuration and Transaction History sections is controlled through a profile
option which you need to create and set to False.

How You Simulate Approval Rules

You can simulate approval rules to test the approval routing of a pending, in-progress, or failed transaction.

You use Test Rules > Simulate when you drill-down to the Approval Rules page for a process. By simulating a rule, you
can test a specific transaction according to the rule configuration. This way you don’t have to recreate or submit the
transactions again later.

Not all processes support testing rules. If testing of rules is available for a process, you'll see Test Rules on the
Approvals Tab.

On using Test Rules, you're taken to the Transaction Manager: Rules page, where you can search for a transaction based
on the transaction name or the user name of the person who submitted the transaction. You can also use the statuses
to filter the transaction and choose the one for which you want to simulate the approval rule.

When you use Simulate, if the configuration passes the test, you can use the rule. If the configuration has issues, an
error message displays. You then need to correct the configuration, commit and test the rules again to verify if the
errors are removed.

Note: Testing of rules is applicable only to supported processes or responsive actions in Employment flows.
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Related Topics
- Simulate Approval Rules

Simulate Approval Rules

You can configure and test approval rules to correct any errors instead of recreating and submitting the rules again.
Before you begin, do the following:

. Create a new profile option HCM_TEST_APPROVAL_RULES_ENABLED and enable it. Make it updateable at the
site level. Set it to true.

Ensure that you have the Review HCM Approval Transactions as Administrator
(ORA_PER_REVIEW_HCM_APPROVAL_TRANSACTIONS) duty role which includes the Test Approval Rules
(PER_TEST_APPROVAL_RULES_PRIV) function privilege.

® Watch video

1. Navigate to the Transaction Console, click the Approvals tab.

2. Search for the rule you want to test either by specifying the transaction name, user name, or the status of the
submitted transaction.

If testing is available for the process, the Test Rules icon is displayed.
3. Click the Test Rules icon to go to the Approval Rules configuration page.
4. In the Test Approvals Rules page, click Simulate.
Review the processing message and check for errors.
5. In case of errors, navigate back to Configure Rules, make changes, commit the changes and then test the rules again.

Related Topics
« How You Simulate Approval Rules

Export and Import Rules Using SOA Composer

You can export and then import approval rules from one environment to another.

Before you start

Ensure you have the BPM Admin Role (BPMProcessAdmin) to be able to import or export rules.

Ensure the source and target environments must be at the same patch level as well as the same release version
of the composites or the import process will fail.

Export SOA runtime changes, that is modified tasks and rules only.

Modify the exported file to include only specific composites for import in case there are saved or uncommitted
approval rule changes unwanted in the target instance.
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® Watch video

Here's what to do

1. Open SOA Composer in the source environment using the URL: https://host:port/soa/composer.
2. Go to the Export/Import menu and click Export SOA Changes.
Wait for the processing to complete. The process creates an archive file.
3. When complete, click Download and save the archive onto your local drive.
4. Use the appropriate application such to open the archive.
5. From the archive, extract the cs_soa_Exportrist.txt file and then do these steps:
a. Edit to include only the composites you want to import.
b. Save, then drag and drop this file back to the archive.
c. Click Yes to confirm. The jar is ready for import.
6. In SOA Composer in the target environment, go to the Export/Import menu and click Import SOA Changes.
Click Choose File and select the modified archive to import, then click Import.

8. When the import is complete, check the rule configurations in the Transaction Manager: Rules page to verify if the
migrated rule appears.

~

Run Diagnostics Test for a Failed Transaction

You can run a diagnostic test to identify the cause of a failed transaction. The diagnostic test generates a report of the
transaction, which can then be used to further analyze the problem.

@ Watch video

1. Inthe Transaction Console, filter by failed transactions. Enter a keyword to find the failed transaction in a specific
process. For example, search using 'Person’ to find the failed transactions in the Change Personal Information
process.

2. Click on the transaction to drill-down for the transaction details. Copy the transaction ID from this page. You'll use
the ID to complete the details to run the report.

3. Navigate to your user image or name in the global header, and from the Settings and Actions menu, select Run
Diagnostic Tests.

In the Diagnostic Dashboard, enter Fetch transaction in the Test Name field.

In the search results, select the Fetch Transaction Details check box. Then click Add to Run.

In the Run Tests section, click the Required Input Values Missing warning icon.

In the Input Parameters dialog box, paste the Transaction ID in the New Value column. Click OK.
Enter a name in the Run Name field and click Run.

. Click OK in the confirmation message.

10.In the Run Status section, click Refresh to update the status of the diagnostic test.

11. When the test run is completed, expand the folder and click the View Test Results icon in the Report Column.
12. On the details page, click Transaction Details Report.

13. Download this diagnostic report.

You can now include this report in your SR for further analysis.

©®mNo v
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